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1 INTRODUCTION 

1.1 OVERVIEW 

This report documents the verification of RESRAD-OFFSITE Version 4.0 and describes, 

where necessary, the verification of the following: 

• The data comprising the standard dose and risk coefficient libraries in the RESRAD 

database files Master_dcf_ICRP07.mdb and Master_dcf_2k.mdb. 

• The extraction and transfer of the data from the selected database file to the 

computational code by the RESRAD-OFFSITE 4.0 interface, ResOWin.exe. 

• The different processes that are modeled by the main computational code in RESRAD-

OFFSITE 4.0, ResOMain.exe. 

• The data displayed in the graphical and text reports. 

Many verifications were performed as part of the quality assurance quality control 

program associated with the development and release of RESRAD-OFFSITE 4.0, namely, 

• developer testing, 

• internal independent testing, and 

• release testing. 

Some were also performed in response to questions from users regarding the performance 

of the code. The main text of the report focuses on summarizing a subset of those tests, both 

independent and developer tests that verified the computations performed by the code. The 

verifications included in this report served as the basis for the development of the release tests of 

the computational executables and provided the quantitative results to be compared with the code 

output.  

The input and output interfaces and the data transfers between the various executables of 

the code were tested while performing the verification testing. They were tested intentionally 

during release testing.  

This report also provides some basic information to help in understanding the activities 

that were verified. The report  

• outlines the components of RESRAD-OFFSITE 4.0 and the interconnections between 

these components, 

• outlines the processes modeled by the computational code, 

• provides summary figures and tables to offer confirmation of the verification of the 

computational components of the code,  
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• reproduces the verifiers’ reports, if available, in individual appendices, 

• refers to the previous verification report (Yu et al. 2011) for more details about some of 

the verifications, and 

• reproduces the test cases and the testers’ reports from the release testing in individual 

appendices, when possible. 

1.2 COMPONENTS OF RESRAD-OFFSITE 4.0 

RESRAD-OFFSITE 4.0 consists of eight executables and one compiled html help file 

and accesses data from two database files and a number of ASCII and binary data files. While 

Appendix 1 describes the components and interconnections in greater detail, this section focuses 

on the aspects of the components from the perspective of verification.  

Executables: 

• ResOwin.exe is the main interface. It performs the following verifiable tasks:  

o Accepts inputs and writes them in a format that can be read by the computational 

code ResOCalc.exe. 

o Queries the appropriate database file to extract the relevant dose and risk 

coefficients. 

o Writes the dose and risk coefficients to a number of files. 

• ResOCalc.exe is the main computational code. It performs the following verifiable 

computations and tasks: 

o Reads the input and data files and writes the inputs, dose factors, and risk factors 

to text reports. 

o Computes the following: 

▪ Temporal variation of the thickness and mixing of the primary 

contamination. 

▪ Temporal variation of radioactivity in the primary contamination 

 under a number of  conceptualizations of the primary 

contamination and 

 under a number of transfer mechanisms. 

▪ Temporal variation of the releases from the primary contamination 

 under a number of  conceptualizations of the primary 

contamination and 

 under a number of transfer mechanisms. 

▪ Atmospheric transport of  

 all (respirable and non-respirable) particulates, 

 respirable particulates, and 

 3H and 14C in vapor or gaseous form. 

▪ Atmospheric transport of radon and three of its progeny and the 

radiological transformations that occur during transport. 

▪ Groundwater transport of  
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 a temporal flux input at the upgradient face of the transport zone, 

to determine the 

‒ temporal flux out of the zone and 

‒ temporal concentration in pore water at the end of the zone, 

 a temporal pulse input distributed over a length of the transport 

zone, to determine the 

‒ temporal flux out of the zone and 

‒ temporal concentration in pore water at the end of the zone, 

 an instantaneous pulse input distributed over a length of the 

transport zone, to determine the 

‒ temporal flux out of the zone and 

‒ temporal concentration in pore water at the end of the zone. 

▪ Groundwater transport from a submerged source. 

▪ Transfer of material eroded from the primary contamination to the offsite 

locations (farmed lands and the surface water body). 

▪ Accumulation in the farmed lands. 

▪ Accumulation in the surface water body. 

▪ Temporal variation of the concentration of radionuclides in plants. 

▪ Temporal variation of the concentration of radionuclides in meat. 

▪ Temporal variation of the concentration of radionuclides in milk. 

▪ Temporal variation of the concentration of radionuclides in aquatic food. 

▪ Dose and risk from external radiation from the primary contamination and 

from the accumulation in the farmed lands. 

▪ Dose and risk from the inhalation of respirable particulates while on the 

primary contamination and on the farmed lands. 

▪ Dose and risk from the ingestion of plant foods. 

▪ Dose and risk from the ingestion of meat. 

▪ Dose and risk from the ingestion of milk. 

▪ Dose and risk from the ingestion of water. 

▪ Dose and risk from the ingestion of aquatic food. 

▪ Dose and risk from the incidental ingestion of soil. 

▪ Dose and risk from the inhalation of radon isotopes and three of their 

progeny. 

▪ Additional models for 3H and 14C. 

o Writes the doses, risks, concentrations, and other intermediate output. 

• GrphCnv5.exe 

o Reads the binary output of ResOCalc.exe and writes text outputs of doses, risks, 

and concentrations for use by the plotting program. 

• WResPlot.exe 

o Reads the text files created by GrphCnv5.exe or by GrphCnvP.exe and displays 

temporal plots of dose, risk, and concentration. 

o Outputs the data used to generate the selected plot. 
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• LHSRO.exe 

• CorRegRO.exe 

• GrphCnvP.exe 

o Reads the binary output of ResOCalc.exe and writes text outputs of doses, risks, 

and concentrations for each probabilistic realization for use by the plotting 

program. 

• ResDCF.exe 

Database files: 

• Master_dcf_2k.mdb 

• Master_dcf_ICRP07.mdb 
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2 VERIFICATION OF THE PRIMARY CONTAMINATION FORMULATIONS 

The primary contamination formulations in Version 2.5 of RESRAD-OFFSITE were 

verified in Chapter 2 of NUREG/CR-7038 (Yu et al. 2011). The leaching release formulation in 

Version 2.5 is retained in Version 4.0 as the “RESRAD-ONSITE exponential release” option. 

But the underlying coding was modified to allow the first-order leach rate to vary with time and 

model transport within the primary contamination. Thus, three representative cases from that 

verification, Cases 1, 3, and 4, were reverified using the output of the candidate version of 

RESRAD-OFFSITE 4.0 prior to its release. The inputs that were changed from the 

defaults/placeholders of the code are listed in Table 2.1.  

Table 2.1 Inputs Used in Verification of RESRAD-ONSITE Exponential Release Model 

Inputs   ↓ Case → 1 3 4 

Transformation data ICRP-38 ICRP-38 ICRP-38 

Number of calculation time points 1024 1024 

Largest reporting time, y 994 994 

Thickness of cover, m (0)a 0.3 

Thickness of primary contamination, m (2) 1 

Nominal erosion rate of cover, m y-1
 

b n ac 0.001 

Nominal erosion rate of primary contamination, m y-1
 

b 0.01 0 

Rainfall and runoff factor (160) 7.58929 

Slope length steepness factor 3.49 2 

Cover and management factor 0.3 1 

Soil erodibility factor in cover, tons acre-1 n a 0.470588 

Soil erodibility factor in primary contamination, tons acre-1 (0.4) 0 

Dry bulk density of cover, g (cm)-3 n a 1.6 

Dry bulk density of unsaturated zone, g (cm)-3 1.7 1.7 

Thickness of 14C evasion layer, m n a n a 0.5 
14C evasion flux rate s-1 n a n a 6.338 10-8 

a Values in parenthesis are the default/placeholder values of RESRAD-OFFSITE. 

b The erosion rates computed using other inputs are used in the verification; the nominal erosion rate is 

for information only. 

c n a = not applicable. 

2.1 FORMULATIONS FOR CLEAR COVER, CONTAMINATED MIXING LAYER, 

AND UNDISTURBED PRIMARY CONTAMINATION 

The expressions used to calculate the erosion rate of the primary contamination and the 

temporal variation of the thickness of the unmixed portion of the primary contamination are 

verified in Figure 2.1 for Case 1, which involves an eroding primary contamination with no 

cover. The same equations are verified in Figure 2.2 for Cases 3 and 4, which involve an eroding 

cover that is initially thicker than the mixing layer. The expressions used to compute the volume 

fraction of material from the primary contamination that are in the mixing layer are verified in 

Figure 2.3 for Cases 3 and 4, which involve an eroding cover that is initially thicker than the 

mixing layer. 
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Figure 2.1 Temporal Variation of Thicknesses of Contaminated Mixing Layer and Unmixed 

Primary Contamination When There Is No Cover above an Eroding Primary Contamination 

 

Figure 2.2 Temporal Variation of Thicknesses of Clean Cover, Contaminated Mixing Layer and 

Unmixed Primary Contamination When There Is an Eroding Cover above a Non-eroding Primary 

Contamination 
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Figure 2.3 Temporal Variation of the Volume Fraction of Material from Primary Contamination in 

the Mixing Layer When There Is an Eroding Cover above a Non-eroding Primary Contamination 

2.2 CONCENTRATION OF RADIONUCLIDES IN THE PRIMARY 

CONTAMINATION FOR THE “RESRAD-ONSITE EXPONENTIAL RELEASE” 

OPTION 

The expressions used to compute the radionuclide concentration in the soil under the 

“RESRAD-ONSITE exponential release” option are verified in Figure 2.4 through Figure 2.11. 

Figure 2.10 and Figure 2.11 also verify the functionality to model time-varying removal rates, 

which was added post-Version 2.5, in this case for the evasion rate. 
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Figure 2.4 Temporal Variation of Concentration of 238U in the Primary Contamination Due to 

Leaching under the RESRAD-ONSITE Exponential Release Option and Radiological Decay 

 

Figure 2.5 Temporal Variation of Concentration of 234U, Derived from 238U, in the Primary 

Contamination Due to Leaching under the RESRAD-ONSITE Exponential Release Option and 

Radiological Transformations 
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Figure 2.6 Temporal Variation of Concentration of 230Th, Derived from 238U, in the Primary 

Contamination Due to Leaching under the RESRAD-ONSITE Exponential Release Option and 

Radiological Transformations 

 

Figure 2.7 Temporal Variation of Concentration of 226Ra, Derived from 238U, in the Primary 

Contamination Due to Leaching under the RESRAD-ONSITE Exponential Release Option and 

Radiological Transformations 
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Figure 2.8 Temporal Variation of Concentration of 210Pb, Derived from 238U, in the Primary 

Contamination Due to Leaching under the RESRAD-ONSITE Exponential Release Option and 

Radiological Transformations 

 

Figure 2.9 Temporal Variation of Concentration of 210Po, Derived from 238U, in the Primary 

Contamination Due to Leaching under the RESRAD-ONSITE Exponential Release Option and 

Radiological Transformations 
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Figure 2.10 Temporal Variation of Concentration of 3H in the Primary Contamination Due to 

Evapotranspiration, Leaching under the RESRAD-ONSITE Exponential Release Option and 

Radiological Transformations 

 

Figure 2.11 Temporal Variation of Concentration of 14C in the Primary Contamination Due to 

Evasion, Leaching under the RESRAD-ONSITE Exponential Release Option and Radiological 

Transformations 
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2.3 RELEASE OF RADIONUCLIDES TO INFILTRATION UNDER THE “RESRAD-

ONSITE EXPONENTIAL RELEASE” OPTION 

The expressions used to compute the release of radionuclides under the “RESRAD-

ONSITE exponential release” option are verified in Figure 2.12 through Figure 2.17. 

 

Figure 2.12 Temporal Variation of the Release of 238U to Infiltration at the Bottom of the Primary 

Contamination under the RESRAD-ONSITE Exponential Release Option 
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Figure 2.13 Temporal Variation of the Release of 234U to Infiltration at the Bottom of the Primary 

Contamination under the RESRAD-ONSITE Exponential Release Option 

 

Figure 2.14 Temporal Variation of the Release of 230Th to Infiltration at the Bottom of the Primary 

Contamination under the RESRAD-ONSITE Exponential Release Option 
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Figure 2.15 Temporal Variation of the Release of 226Ra to Infiltration at the Bottom of the Primary 

Contamination under the RESRAD-ONSITE Exponential Release Option 

 

Figure 2.16 Temporal Variation of the Release of 210Pb to Infiltration at the Bottom of the Primary 

Contamination under the RESRAD-ONSITE Exponential Release Option 
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Figure 2.17 Temporal Variation of the Release of 210Po to Infiltration at the Bottom of the Primary 

Contamination under the RESRAD-ONSITE Exponential Release Option  
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2.4 RELEASE OF RADIONUCLIDES IN PARTICULATES TO THE ATMOSPHERE 

UNDER THE “RESRAD-ONSITE EXPONENTIAL RELEASE” OPTION 

 The release of radionuclides associated with the release of particulates to the atmosphere 

was verified as described in Appendix 2. The expressions used to calculate the release of 90Sr in 

particulates to the atmosphere are verified in Figure 2.18 for two cases:  

• The sum of the initial thicknesses of the cover, 0.05 m, and the primary contamination, 

0.1 m, is equal to the thickness of the mixing layer, 0.15 m; 

• The sum of the initial thicknesses of the cover, 0.05 m, and the primary contamination, 

1.2 m, is greater than the thickness of the mixing layer, 0.15 m. 

 

Figure 2.18 Temporal Variation of the Release of 90Sr in Particulates to the Atmosphere  



 

17 

2.5 RELEASE OF RADIONUCLIDES IN PARTICULATES BY EROSION TO 

RUNOFF UNDER THE “RESRAD-ONSITE EXPONENTIAL RELEASE” OPTION 

The release of radionuclides in particulates that are eroded and carried away by runoff 

was verified as described in Appendix 3. The expressions used to calculate the release of 90Sr in 

particulates to runoff are verified in Figure 2.19 for two cases.  

• The sum of the initial thicknesses of the cover, 0.05 m, and the primary contamination, 

0.1 m, is equal to the thickness of the mixing layer, 0.15 m; 

• The sum of the initial thicknesses of the cover, 0.05 m, and the primary contamination, 

1.2 m, is greater than the thickness of the mixing layer, 0.15 m. 

 

Figure 2.19 Temporal Variation of the Release of 90Sr in Particulates Eroded and Carried Away by 

Runoff 

The verification performed in this chapter provided the basis for the release testing of the 

primary contamination.  
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3 VERIFICATION OF GROUNDWATER TRANSPORT FORMULATIONS 

The longitudinal groundwater transport formulations in Version 2.5 of RESRAD-

OFFSITE were verified in Chapter 3 of NUREG/CR-7038 (Yu et al. 2011). The basic 

longitudinal groundwater transport formulations in Version 2.5 are retained in Version 4.0 and 

applied to the contaminated layer in addition to the uncontaminated layers in the unsaturated and 

saturated groundwater transport layers. These groundwater transport formulations were 

reverified prior to release of Version 4.0 and are discussed in this section. The verification 

performed in this chapter provided the basis for the release testing of the groundwater transport. 

3.1 GROUNDWATER TRANSPORT OF A TEMPORALLY DISTRIBUTED FLUX 

INPUT ACROSS THE UPGRADIENT SURFACE OF THE TRANSPORT ZONE 

The formulations were verified for four different radionuclide transport velocities for 

eight radionuclides to cover a wide range of conditions. The inputs used to model the transport 

velocities in the transport zone are show in Table 3.1. The computed radionuclide transport 

velocities and dispersion coefficients are shown in Table 3.2. The half-life of the radionuclide is 

an argument of the formulation. The eight radionuclides in Table 3.3 were selected because they 

cover a wide range of half-lives. The formulations were verified using two triangular input fluxes 

as described in Chapter 3 of NUREG/CR-7038 (Yu et al. 2011) using the RESRAD-OFFSITE 

feature allowing overriding the internal release model and specifying the desired triangular 

fluxes instead. 

Table 3.1 Inputs Used to Model the Radionuclide Transport Velocities and the 

Associated Dispersion Coefficients in the Unsaturated Zone for the Verification of 

Transport of Flux Inputs 

 Case 1 Case 2 Case 3 Case 4 

Characteristic Value 

Precipitation rate, m y-1 (1)a,b 

Runoff coefficient (0.2) 

Irrigation applied per year, m (0.2) 

Evapotranspiration coefficient (0.5) 

Transport distance, m (4) 

Saturated hydraulic conductivity, m y-1 (10) 

Parameter b of Clapp-Hornberger equation (5.3) 

Field capacity (0.3) 

Total porosity (0.4) 

Effective porosity (0.2) 

Dry bulk density, g (cm)-3 (1.5) 

Distribution coefficient, (cm)3 g-1 0 1 10 100 

Time horizon, y 4 20 200 2000 

Longitudinal dispersivity, m (0.1) 

Number of calculation time points (128) 

a Values in parenthesis are the default/placeholder values of RESRAD-OFFSITE. 

b Values in the central column apply to all four cases. 
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Table 3.2 Radionuclide Transport Velocities and Dispersion Coefficients Used in 

Verification of Transport of Flux Inputs 

 Case 1 Case 2 Case 3 Case 4 

Computed Characteristic  Computed Value 

Darcy velocity, m y-1 0.5a 

Saturation ratio 0.8023 

Total moisture content 0.3209 

Effective moisture content 0.1605 

Retardation factor 1 5.674 47.74 468.4 

Advective contaminant transport velocity, m y-1 3.116 0.5492 0.06527 0.006652 

Dispersion coefficient of contaminant, m2 y-1 0.3116 0.0549 0.00653 0.000665 

Advective travel time, y 1.28 7.28 61.3 601 

a Values in the central column apply to all four cases. 

Table 3.3 ICRP-38 Half-lives of Radionuclides Used in the Verification of Groundwater Transport 

Radionuclide 60Co 3H 90Sr 137Cs 63Ni 226Ra 14C 238U 

Half-life, y 5.271 12.35 29.12 30 96 1600 5730 4.468×109 

The verification of the longitudinal transport of the flux inputs of the eight radionuclides 

at the upgradient surface are illustrated in Figure 3.1 through Figure 3.4 for the four cases. The 

advective velocity and the dispersion coefficient for these cases are in Table 3.2. As seen in 

Figure 3.1, the loss due to radiological transformations is not sufficient to make a noticeable shift 

in the time of the peaks of the curves at the high transport velocity and dispersion of Case 1. But 

the effect of the loss is reflected in the progressive lowering of the peak in the eight plots in the 

figure. The forward shift of the time of the peak of the 60Co curve in Figure 3.2, due to the 

increasing loss from radiological transformations over time, is noticeable at the transport velocity 

and dispersion of Case 2. The forward shifts of the times of the peaks in the 60Co and 3H curves 

in Figure 3.3, due to the increasing loss from radiological transformations over time, are 

noticeable at the transport velocity and dispersion of Case 3. 

There is very good agreement between the spreadsheet calculated transfer rates and the 

transfer rates output by RESRAD-OFFSITE for the four longer-lived radionuclides 238U, 14C, 
226Ra, and 63Ni at the transport velocity and dispersion of Case 4. There is very good agreement 

between the spreadsheet calculated transfer rates and the transfer rates output by RESRAD-

OFFSITE for the two radionuclides with half-lives that are approximately one twenty-fifth of the 

width of the peak with no decay, 137Cs and 90Sr, over most of the time range. But the spreadsheet 

calculated curves in Figure 3.4 are smooth at and near the initial part, while the RESRAD-

OFFSITE curves are sharp and lag the spreadsheet curves initially. The formulations 

implemented in RESRAD-OFFSITE are truncated at four “dispersion standard deviations,” 

√
2𝜃𝑎𝐷𝑡

𝜃𝑐+𝐾𝑑𝜌𝑏
, on either side of the advective travel distance to ensure the accuracy of the final 

results by using only the precise digits of intermediate quantities. This was not implemented in 

the spreadsheet calculations, leading to smoother curves initially, but also to some negative 
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results initially, too. Negative results can occur when the imprecise digits of the intermediate 

calculations influence the final results. Thus, the need to truncate in the coding. 

There are significant differences between the spreadsheet calculated curves and the 

RESRAD-OFFSITE curves for 3H and for 60Co, radionuclides with half-lives that are less than 

one-sixtieth of the width of the undecayed peak. This too is due to the truncation discussed in the 

previous paragraph. As seen from Figure 3.4, the rates at which these radionuclides exit the 

transport zone for these short-lived radionuclides diminished by nine and sixteen orders of 

magnitude over the large travel time in the transport zone. Thus, this truncation is not expected to 

have a practical impact on the conclusions derived from the output of RESRAD-OFFSITE.  
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Figure 3.1 Temporal Variations of the Rates at which Radionuclides Exit a Transport Zone 

following Triangular Input Fluxes of the Same Radionuclides at the Upgradient Surface of the 

Transport Zone, Case 1 
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Figure 3.2 Temporal Variations of the Rates at which Radionuclides Exit a Transport Zone 

following Triangular Input Fluxes of the Same Radionuclides at the Upgradient Surface of the 

Transport Zone, Case 2 
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Figure 3.3 Temporal Variations of the Rates at which Radionuclides Exit a Transport Zone 

following Triangular Input Fluxes of the Same Radionuclides at the Upgradient Surface of the 

Transport Zone, Case 3 
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Figure 3.4 Temporal Variations of the Rates at which Radionuclides Exit a Transport Zone 

following Triangular Input Fluxes of the Same Radionuclides at the Upgradient Surface of the 

Transport Zone, Case 4 
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3.2 GROUNDWATER TRANSPORT OF A PULSE INPUT THAT IS DISTRIBUTED 

BOTH OVER TIME AND OVER A LENGTH OF THE TRANSPORT ZONE 

The formulations were verified for three different radionuclide transport velocities for 

eight radionuclides to cover a wide range of conditions. The inputs used to model the transport 

velocities in the transport zone are shown in Table 3.4. The computed radionuclide transport 

velocities and dispersion coefficients are shown in Table 3.5. The eight radionuclides in 

Table 3.3 were used in this verification to cover a wide range of half-lives. The formulations 

were verified using two triangular input fluxes, as described in Chapter 3 of NUREG/CR-7038 

(Yu et al. 2011), using the RESRAD-OFFSITE feature allowing overriding the internal release 

model and specifying the desired triangular pulses instead.  

Table 3.4 Inputs Used to Model the Radionuclide Transport Velocities and the Associated 

Dispersion Coefficients in the Saturated Zone for the Verification of Transport of 

Temporally Distributed Pulse Inputs 

 Case 1 Case 2 Case 3 

Characteristic Value 

Length of primary contamination, m (100)a, b 

Width of primary contamination, m (100) 

Saturated hydraulic conductivity, m y-1 500 

Hydraulic gradient (0.02) 

Precipitation rate, m y-1 (1) 

Runoff coefficient (0.2) 

Irrigation applied per year, m (0.2) 

Evapotranspiration coefficient (0.5) 

Total porosity (0.4) 

Effective porosity (0.2) 

Dry bulk density, g (cm)-3 (1.5) 

Longitudinal dispersivity, m 20 

Lateral horizontal dispersivity, m 3 

Lateral vertical dispersivity, m 0.15 

Distribution coefficient, (cm)3 g-1 0 1 10 

Time horizon, y 32 128 1024 

Number of calculation time points 128 

Inputs for surface water body, used to verify the flux output:  

  Distance from downgradient edge of contamination, m 800 

  Distance from plume centerline to right edge, m -150 

  Distance from plume centerline to left edge, m 150 

  Depth of aquifer intercepted, m (5) 

Inputs for well, used to verify the concentration output:  

  Distance from downgradient edge of contamination, m 800 

  Distance from plume centerline, m (0) 

  Well pumping rate, m3 y-1 5100 

  Depth of aquifer intercepted, m 5 

a Values in parenthesis are the default/placeholder values of RESRAD-OFFSITE. 

b Single values in the central column apply to all three cases. 
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Table 3.5 Radionuclide Transport Velocities and Dispersion Coefficients Used in Verification of 

Transport of Pulse Inputs 

 Case 1 Case 2 Case 3 

Characteristic Value 

Average transport distance, m 850a 

Darcy Velocity, m y-1 10 

Infiltration rate, m y-1 0.5 

Depth of penetration of the pulse input into the saturated zone, m 5 

Retardation factor 1 4.75 38.5 

Contaminant transport velocity, m y-1 50 10.53 1.299 

Longitudinal dispersion coefficient of contaminant, m2 y-1 1000 210.6 25.97 

Lateral horizontal dispersion coefficient of contaminant, m2 y-1 150 31.58 3.896 

Lateral vertical dispersion coefficient of contaminant, m2 y-1 7.5 1.579 0.1948 

Advective travel time, y 16-18 76–85.5 616-693 

Time to peak output for 238U, y 15.8 75.3 610 

Time to peak output for 14C, y 15.8 75.2 608 

Time to peak output for 226Ra, y 15.8 75.1 603 

Time to peak output for 63Ni, y 15.8 73.4 513 

Time to peak output for 137Cs, y 15.6 69.8 402 

Time to peak output for 90Sr, y 15.6 69.6 399 

Time to peak output for 3H, y 15.2 63.7 300 

Time to peak output for 60Co, y 14.5 54.3 212 

Width of aquifer intercepted by well, m 51 

a Single values in the central column apply to all three cases. 

The verifications of the longitudinal transport of a pulse input, distributed over a length 

of the transport zone, of the eight radionuclides are illustrated in Figure 3.5 through Figure 3.10 

for the three cases. There are two figures for each case, one shows the verification of the rate at 

which the radionuclide exits the zone and the other shows the verification of the concentration in 

well water at the downgradient edge of the zone. 

As can be seen in Figure 3.5 and Figure 3.6, these formulations for transport, capable of 

modeling the loss due to radiological transformations during advective-dispersive transport, 

show a noticeable shift in the times of the peaks of the curves for the two radionuclides with 

short half-lives, even at the high transport velocity and dispersion of Case 1. The loss is also 

reflected in the progressive lowering of the peak with decreasing half-life of the radionuclides in 

the eight plots in the figures. There is very good agreement between the spreadsheet calculations 

and the RESRAD-OFFSITE calculations for all 8 radionuclides in this case. 

The forward shift of the time of the peak of the curves in Figure 3.7 and Figure 3.8, due 

to the increasing loss from radiological transformations over time, is noticeable for four of the 

eight radionuclides at the intermediate transport velocity and dispersion of Case 2. There is very 

good agreement between the spreadsheet calculations and the RESRAD-OFFSITE calculations 

for all eight radionuclides in this case, too. 
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There is very good agreement between the spreadsheet calculations and the RESRAD-

OFFSITE calculations for four of the radionuclides, good agreement between the calculations for 

two of the radionuclides, and significant differences for two of the radionuclides at the low 

transport velocity and dispersion of Case 3, Figure 3.9 and Figure 3.10. This is similar to the 

observations at the low transport velocity and dispersion of Case 4 for the flux input in 

Section 3.1 and occurs for the same reason. As seen in Figure 3.9 and Figure 3.10, peaks for 

these short-lived radionuclides diminish by ten and seventeen orders of magnitude over the large 

travel time in the transport zone. Thus, this truncation is not expected to have a practical impact 

on the conclusions derived from the output of RESRAD-OFFSITE.    
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Figure 3.5 Temporal Variations of the Rates at which Radionuclides Exit a Transport Zone 

following Temporally Triangular Input Pulses of the Same Radionuclides Uniformly Distributed 

over an Upgradient Length of the Transport Zone, Case 1 
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Figure 3.6 Temporal Variations of the Concentration of Radionuclides in Well Water Due to 

Temporally Triangular Input Pulses of the Same Radionuclides Uniformly Distributed over an 

Upgradient Length of the Transport Zone, Case 1 
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Figure 3.7 Temporal Variations of the Rates at which Radionuclides Exit a Transport Zone 

following Temporally Triangular Input Pulses of the Same Radionuclides Uniformly Distributed 

over an Upgradient Length of the Transport Zone, Case 2 
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Figure 3.8 Temporal Variations of the Concentration of Radionuclides in Well Water Due to 

Temporally Triangular Input Pulses of the Same Radionuclides Uniformly Distributed over an 

Upgradient Length of the Transport Zone, Case 2 
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Figure 3.9 Temporal Variations of the Rates at which Radionuclides Exit a Transport Zone 

following Temporally Triangular Input Pulses of the Same Radionuclides Uniformly Distributed 

over an Upgradient Length of the Transport Zone, Case 3 
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Figure 3.10 Temporal Variations of the Concentration of Radionuclides in Well Water Due to 

Temporally Triangular Input Pulses of the Same Radionuclides Uniformly Distributed over an 

Upgradient Length of the Transport Zone, Case 3  
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4 VERIFICATION OF ATMOSPHERIC TRANSPORT FORMULATIONS 

The atmospheric transport formulations in Version 2.5 of RESRAD-OFFSITE were 

verified in Chapter 4 of NUREG/CR-7038 (Yu et al. 2011). These formulations are used in 

RESRAD-OFFSITE Version 4.0 to compute atmospheric transport to all offsite locations other 

than the watershed of the surface water body. A formulation capable of modeling atmospheric 

transport to receptor locations that overlap the primary contamination was added to RESRAD-

OFFSITE in Version 4.0. These formulations are verified for RESRAD-OFFSITE 4.0 in 

Appendix 4 and are summarized in the second subsection that follows. 

4.1 /Q AT OFFSITE LOCATIONS THAT DO NOT OVERLAP THE PRIMARY 

CONTAMINATION 

The verification of the ratio of the concentration in air at the offsite location to the rate of 

release to the atmosphere, /Q or chi over Q, at five different locations, each under different 

atmospheric condition, is summarized in Figure 4.1. None of these five offsite locations overlap 

the primary contamination from which the particles containing the radionuclides are released. 

4.2 DEPLETED SOURCE STRENGTH WITH DISTANCE OF ATMOSPHERIC 

TRANSPORT 

The verifications of the depleted source strength, the fraction of the released material 

remaining in the plume, at distances ranging from 0 to 3000 m of transport distance are 

summarized in Figure 4.2 for depletion by dry deposition and in Figure 4.3 for depletion by wet 

deposition. Some of the locations overlap the primary contamination while others are outside the 

primary contamination. Each figure shows five curves, showing the verification at five different 

atmospheric conditions. 



 

36 

 

Figure 4.1 Summary of Chi over Q, (/Q), the Concentration to Release Ratio, under Different 

Conditions at Different Locations 
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Figure 4.2 Depleted Source Strength over Distances of 0 to 3000 m under Different Conditions with 

Dry Deposition 
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Figure 4.3 Depleted Source Strength Over Distances of 0 to 3000 m under Different Conditions with 

Wet Deposition 

The verification performed in this chapter provided the basis for the release testing of the 

atmospheric transport.  
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5 VERIFICATION OF ACCUMULATION AT OFFSITE LOCATIONS 

The formulations for the accumulation at offsite locations in Version 2.5 of RESRAD-

OFFSITE were verified in Chapter 5 of NUREG/CR-7038 (Yu et al. 2011). The formulation in 

RESRAD-OFFSITE Version 4.0 for the accumulation in land-based offsite locations includes 

input of radionuclides that deposit from particles carried by runoff. The surface water body 

accumulation model was updated in RESRAD-OFFSITE 4.0. The verification performed in this 

chapter provided the basis for the release testing of the accumulation at offsite locations. 

5.1 ACCUMULATION IN SURFACE WATER BODY 

The pre-release verification of the new surface water body model in Version 4 of the 

code is described in Appendix 5 and is summarized in this sub-section. Figure 5.1 and Figure 5.2 

illustrate the verification of the concentration of 99Tc in surface water resulting from the influx of 
99Tc by all four transport pathways included in the new model: 

• Deposition of material eroded from the primary contamination carried by runoff. 

• Deposition of airborne material on the surface water body. 

• Washout of airborne material that was deposited on the catchment/watershed. 

• 99Tc leached from the primary contamination by infiltration to groundwater that is 

intercepted by the surface water body. 

The influx with groundwater dominates in Figure 5.1. Figure 5.2 shows the verification 

when the other three transport pathways make an appriciable contribution. Figure 5.3 illustrates 

the verification of the concentration of 234U in surface water resulting from the influx of 234U by 

the first three transport pathways. Figure 5.4 shows the verification of the concentration of 90Sr 

in surface water that was carried out as part of the verification of dose from the ingestion 

pathways. 
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Figure 5.1 Temporal Variation of the Concentration of 99Tc in Surface Water Primarily 

Due to Influx of 99Tc Carried by Groundwater Infiltrating through Primary Contamination 

and Flowing into the Surface Water Body 

 

Figure 5.2 Temporal Variation of the Concentration of 99Tc in Surface Water Due to Influx 

of 99Tc Carried by Eroded Material into the Surface Water Body, Atmospheric Deposition 

on the Surface Water Body, and Washout of Atmospheric Deposition on the Catchment and 

by Groundwater, before the Groundwater Contribution Dominates 
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Figure 5.3 Temporal Variation of the Concentration of 234U in Surface Water Due to Influx of 234U 

Carried by Eroded Material into the Surface Water Body, Atmospheric Deposition on the Surface 

Water Body, and Washout of Atmospheric Deposition on the Catchment 

 

Figure 5.4 Temporal Variation of the Concentration of 90Sr in Surface Water 
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5.2 ACCUMULATION IN OFFSITE SOILS 

The pre-release verification of the accumulation model for offsite soils in Version 4 of 

the code is described in Appendix 6 and is summarized below. 

• Figure 5.5 illustrates the verification of the concentration of four radionuclides in soil, 

each at different offsite locations, resulting from the influx of radionuclides by all three 

transport pathways: 

o Deposition of material eroded from the primary contamination carried by runoff. 

o Deposition of airborne material. 

o Irrigation with water from the well and or the surface water body. 

• Figure 5.6 shows the verification of the concentration of 14C in soil at an offsite location 

due to each of the three radionuclide transport pathways listed above. 

• Figure 5.7 shows the verification of the concentration of 90Sr in soil at four offsite 

locations from the influx of 90Sr by all three transport pathways listed above. This was 

part of the verification of the dose from the ingestion pathways. 

 

Figure 5.5 Temporal Variation of Concentration of Radionuclides in Offsite Soils 
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Figure 5.6 Temporal Variation of 14C Concentration in Offsite Soil Due to the Three Different 

Radionuclide Transport Pathways 
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Figure 5.7 Temporal Variation of Concentration of 90Sr in Soil at Four Different Offsite Locations 
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6 VERIFICATION OF TRANSFER AND ACCUMULATION IN PLANT FOOD, 

ANIMAL FEED, MEAT, MILK, AND AQUATIC FOOD 

The concentration of 90Sr in food ingested by the receptor and in animal feed was verified 

during the pre-release verification of the dose from the ingestion pathways. This was performed 

as outlined in Chapter 5 of NUREG/CR-7038 (Yu et al. 2011). 

• The verification of concentration of 90Sr in plant food and in animal feed at the time of 

harvest is shown in Figure 6.1.  

• The radionuclides are transferred to different parts of the plant by three transport 

pathways: 

o Foliar interception of particulates followed, if necessary, by translocation to the 

part that is ingested. 

o Foliar interception of irrigation water followed, if necessary, by translocation to 

the part that is ingested. 

o Root uptake from accumulation in the agricultural land. 

• In this case, the concentrations in the leaf are dominated by the sum of the two foliar 

interception transport pathways, while the concentrations in the other parts of the plant 

are dominated by root uptake from accumulation in soil. This leads to the two different 

temporal profiles seen in Figure 6.1.  
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Figure 6.1 Temporal Concentration of 90Sr in Plant Food and Animal Feed 

The verification of concentration of 90Sr in meat and milk at the time of harvest is shown 

in Figure 6.2.  

 

Figure 6.2 Temporal Concentration of 90Sr in Meat and Milk 

The verification of the concentration of 90Sr in fish, crustacea, and mollusks at the time of 

harvest is shown in Figure 6.3.  
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Figure 6.3 Temporal Concentration of 90Sr in Fish, Crustacea, and Mollusks 

The verification performed in this chapter and the next provided the basis for the release 

testing of the concentrations in vegetables, livestock feed, meat, and milk.  
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7 VERIFICATION OF RADIOLOGICAL DOSE FROM THE 

INGESTION PATHWAYS 

 The pre-release verification of the dose from the ingestion pathways and the incidental 

soil ingestion pathway of Version 4.0 of RESRAD-OFFSITE are described in Appendix 7 and 

Appendix 8 respectively. The verification of the ingestion pathways, summarized below, 

provided the basis for the release testing of the ingestion pathways.  

• Figure 7.1 shows the verification of the 90Sr dose from the five ingestion sub-pathways. 

• Figure 7.2 shows the verification of the dose from the soil ingestion pathway. 

 

Figure 7.1 Temporal Variation of Dose from the Ingestion of 90Sr in Food and Water 



 

50 

 

Figure 7.2 Temporal Variation of Dose from the Incidental Ingestion of Soil at Onsite and Offsite 

Locations  
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8 VERIFICATION OF RADIOLOGICAL DOSE FROM INHALATION OF 

RESPIRABLE PARTICULATES 

The pre-release verification of the dose from the inhalation pathway of Version 4.0 of 

RESRAD-OFFSITE is described in Appendix 9 and is summarized below.  

• Figure 8.1 shows the verification of the 26Al inhalation dose at four receptor locations. 

• Figure 8.2 shows the verification of the 137Cs inhalation dose at four receptor locations. 

 

Figure 8.1 Temporal Variation of Dose from the Inhalation of 26Al in Particulates 
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Figure 8.2 Temporal Variation of Dose from the Inhalation of 137Cs in Particulates 

The verification performed in this chapter provided the basis for the release testing of the 

inhalation pathway.  
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9 VERIFICATION OF RADIOLOGICAL DOSE FROM EXTERNAL RADIATION 

FROM OFFSITE SOILS 

The pre-release verification of the dose from the external radiation pathway of 

Version 4.0 of RESRAD-OFFSITE is described in Appendix 10. The verification of the 

external radiation dose from 26Al, 137Cs, 60Co, and 54Mn in soil at offsite locations is illustrated in 

Figure 9.1. The verification of the external radiation dose from the primary contamination is 

shown in Table 9.1. The verification performed in this chapter provided the basis for the release 

testing of the external radiation pathway. 

 

Figure 9.1 Temporal Variation of External Radiation Dose from the Accumulation of 

Radionuclides at the Offsite Locations 
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Table 9.1 Comparison of External Radiation Dose to Onsite Receptor 

 

Source area = 1000000 m2 

Source thickness = 50 cm 

Source radius = 100 m2 

Source thickness = 5 cm 

 Time integrated dose during the first year, mrem Time integrated dose during the first year, mrem 

Radionuclide RESRAD-OFFSITE Calculated RESRAD-OFFSITE Calculated 

26Al 17.3 17.3 5.82 5.92 
57Co 0.331 0.326 0.187 0.184 
60Co 15.1 15.2 5.20 5.20 
137Cs 3.37 3.37 1.32 1.31 
54Mn 3.57 3.54 1.34 1.32 
234U 4.01E-04 4.02E-04 2.71E-04 2.86E-04 
235U 0.757 0.757 0.390 0.385 
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10 VERIFICATION OF ADDITIONAL MODELS FOR TRITIATED WATER 

The pre-release verification of the formulations to model the movement and exposure 

from 3H in the form of tritiated water in addition to the movement and exposure from 3H in 

particulates is documented in this chapter. The verification performed in this chapter provided 

the basis for the release testing of the special models for tritium, 3H. 

10.1 TEMPORAL CONCENTRATION IN PRIMARY CONTAMINATION 

The calculation of the concentration of 3H in the primary contamination has an additional 

term to model the release of tritiated water vapor from the primary contamination due to 

evapotranspiration. The spreadsheet calculations of the initial loss/removal rate of 3H from the 

primary contamination and the erosion rate, in the tab “inputs,” are outlined in Figure 10.1. The 

calculations of the three components of this loss rate, the radiological transformation rate, the 

leach rate under the RESRAD-ONSITE exponential release model, and the initial evasion rate 

are detailed in Figure 10.2, Figure 10.3, and Figure 10.4, respectively. 

 

Figure 10.1 Screen Shot of Spreadsheet Calculations of the Initial Loss/Removal Rate of 3H and the 

Erosion Rate  
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Figure 10.2 Screen Shot of Calculation of the Radiological Transformation Rate of 3H Using the 

ICRP-107 Half-life 

 

Figure 10.3 Screen Shots of Estimation of the Leach Rate of 3H under the RESRAD-ONSITE 

Exponential Release Option  
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Figure 10.4 Screen Shot of Calculation of the Initial Evasion Rate of 3H from the Primary 

Contamination 

The calculation of the rate at which the cover above the primary contamination erodes is 

shown in Figure 10.5. This erosion rate is used to compute the time-dependent thickness of the 

cover and the time dependence of the fraction of the evasion depth that is contaminated. The 

computation of the concentration of 3H remaining in the primary contamination at a specific 

time, 3/16 year, is shown in Figure 10.6; this figure also shows the verification of the 

concentrations at four different times. Figure 10.7 illustrates the verification of the temporal 

concentration of 3H remaining in the primary contamination. 
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Figure 10.5 Screen Shot of Calculation of the Erosion Rate of the Cover above the Primary 

Contamination 

 

Figure 10.6 Screen Shot of Calculation of the Concentration of 3H Remaining in the Primary 

Contamination 

 

Figure 10.7 Temporal Variation of the Concentration of 3H Remaining in the Primary 

Contamination  
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10.2 CONCENTRATION IN PLANT 

The movement of tritiated water from soil through the roots is modeled as being the same 

as the movement of water from soil. The calculation of the equivalent root transfer factor is 

illustrated in Figure 10.8. 

 

Figure 10.8 Screen Shot of Calculation of Root Transfer Factor of 3H for Each Plant Type 

The 3H in plant from the foliar deposition of particles containing it are modeled in the 

same manner as for the other radionuclides. The computation of the air-to-plant concentration 

ratios that are used in this model are in shown in Figure 10.9. 

 

Figure 10.9 Screen Shot of Calculation of Air-to-Plant Concentration Ratios, which Are Used to 

Model Foliar Deposition 

The calculation of the concentration of 3H in plant at a specific time, 0.25 years, and the 

verification of the code calculated value at that time and at six other times around it, are shown 

in Figure 10.10. The concentrations of 3H in the soil and in air used in these calculations were 

obtained for RESRAD-OFFSITE output. The calculation of concentration in offsite soils was 

verified in Section 5.2. The component calculations for the concentration in air were verified in 

Sections 2.4 and 4.1. The verification of the temporal concentration of 3H in plant is shown in 

Figure 10.11. The figure on the left shows the verification when the concentration is high, while 
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the figure on the right shows the verification during early times when the concentration is orders 

of magnitude lower and is mainly due to foliar deposition. 

 

Figure 10.10 Screen Shot of Calculation and Verification of Concentration of 3H in Plants 

 

Figure 10.11 Verification of Temporal Concentration of 3H in Plant 

10.3 CONCENTRATION IN MEAT AND MILK 

The transfer of 3H ingested by the livestock to milk and meat is modeled as being the 

same as the transfer of H2O to meat and milk, both as water and in the feed that is ingested by the 

livestock. The calculation of the intake to the concentration in meat factor and intake to the 

concentration in milk factor for 3H are shown in Figure 10.12. The use of these factors to 

compute the concentrations of 3H in meat and milk from livestock water, pasture and silage, feed 

grain, and the soils associated with the livestock feeds is illustrated in Figure 10.13. The 

verification of the temporal concentrations of 3H in milk and meat are shown in Figure 10.14 and 

Figure 10.15, respectively. The plots on the left of both figures show the verification when the 

concentration is high, while the plots on the right of both figures show the verification during 

early times when the concentration is orders of magnitude lower and is mainly due to foliar 

deposition. 
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Figure 10.12 Screen Shot of Calculation of Intake to Concentration in Meat and Intake to 

Concentration in Milk Factors for 3H 

 

Figure 10.13 Screen Shot of Calculation and Verification of Concentration of 3H in Milk and Meat 

 

Figure 10.14 Verification of Temporal Concentration of 3H in Milk 
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Figure 10.15 Verification of Temporal Concentration of 3H in Meat 

10.4 INHALATION 

The 3H inhalation dose in RESRAD-OFFSITE 4.0 is modeled as being from the 

inhalation of tritiated water. The evapotranspiration of tritiated water is modeled as paralleling 

that of regular water. The spreadsheet computations of the infiltration rate, the evapotranspiration 

rate, and the moisture content in soil are illustrated in Figure 10.16. These computed values are 

used in the spreadsheet computation of the rate of evasion of water from the evasion depth, as 

shown in Figure 10.17.The spreadsheet calculation of the cover and depth factor for the evasion 

of 3H is in Figure 10.18. The calculation of the concentration of 3H in the air above the primary 

contamination per unit concentration of 3H in the primary contamination is illustrated in 

Figure 10.19. This was found to be within the bounds computed by the spreadsheet in 

Figure 10.20. 

 

Figure 10.16 Screen Shots of Spreadsheet Computations of Infiltration Rate and Moisture Content 

in Soil and Evapotranspiration Rate 
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Figure 10.17 Screen Shot of Spreadsheet Calculation of Evasion Rate of 3H from the Entire Evasion 

Depth 

 

Figure 10.18 Screen Shot of the Calculation of the Cover and Depth Factor for the Evasion of 

Water 

 

Figure 10.19 Screen Shot of the Calculation of the Ratio of the Concentration of 3H in the Air above 

and in the Soil in the Primary Contamination 
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Figure 10.20 Screen Shot of the Calculation of the Upper Bound for the Ratio of the Concentration 

of 3H in the Air above and in the Soil in the Primary Contamination 

Figure 10.21 shows the spreadsheet computation of the rate of release of 3H by 

evapotranspiration from the primary contamination per unit concentration in the primary 

contamination. The computation of the annual time-integrated concentration of 3H in the primary 

contamination using the trapezoidal approximation is illustrated in Figure 10.22. The 

instantaneous concentration in the primary contamination was verified in Section 2.2. As 

illustrated in Figure 10.23, the annual time-integrated concentration of 3H in the air above the 

primary contamination was computed by multiplying the annual time-integrated concentration in 

soil by the ratio calculated in Figure 10.19. Figure 10.24 shows the computation of the annual 

time-integrated concentration of 3H in the air at offsite locations as the product of three 

quantities: the annual time-integrated concentration in soil, the rate of release per unit 

concentration in the primary contamination calculated in Figure 10.21, and the chi over Q, 

(
𝜒

𝑄
)
𝑜𝑓𝑓𝑠𝑖𝑡𝑒

𝑔𝑎𝑠
, for transport of a gas from the primary contamination to the offsite location. The chi 

over Qs were verified in Section 4.1. 

 

Figure 10.21 Screen Shot of the Calculation of the Release Rate of 3H per Unit Concentration in the 

Primary Contamination 
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Figure 10.22 Screen Shot of Time Integration of the Concentration in the Primary Contamination 

over a Year Using the Trapezoidal Approximation 

 

Figure 10.23 Screen Shot of Computation of the Time-Integrated Concentration in the Air above 

the Primary Contamination over the First Year 

 

Figure 10.24 Screen Shot of Computation of the Time-Integrated Concentration in the Air at an 

Offsite Location over the First Year 

The aggregation of the inputs to compute the dose from inhalation, the dose conversion 

factor, the inhalation rate, and the indoor and outdoor occupancies in the onsite and offsite 

dwellings is shown in Figure 10.25. The calculation of the annual time-integrated 3H inhalation 

dose while the receptor is at the various locations is shown in Figure 10.26 for a specific time 

interval of 1 year beginning at 0.25 years. Figure 10.27 verifies the RESRAD-OFFSITE 4.0 3H 

inhalation dose over the time horizon where that dose is significant. 
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Figure 10.25 Screen Shot of the Aggregation of Inhalation Dose Pathway Inputs 

 

Figure 10.26 Screen Shot of Spreadsheet Calculation of the Annual Time-Integrated 3H Inhalation 

Dose Beginning at 0.25 years 
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Figure 10.27 Verification of the Annual Time-Integrated 3H Inhalation Dose  
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11 VERIFICATION OF ADDITIONAL MODELS FOR 14C 

The pre-release verification of the formulations to model the movement and exposure 

from 14C in the form of carbon dioxide (14CO2) in addition to the movement and exposure from 
14C in particulates is documented in this chapter. The verification performed in this chapter 

provided the basis for the release testing of the special models for 14C. 

11.1 TEMPORAL CONCENTRATION IN PRIMARY CONTAMINATION 

The calculation of the concentration of 14C in the primary contamination has an 

additional term to model the evasion of 14CO2 out of the primary contamination. The spreadsheet 

calculations of the initial loss/removal rate of 14C from the primary contamination and the 

erosion rate, in the tab “inputs,” are outlined in Figure 11.1. The calculations of the three 

components of this loss rate, the radiological transformation rate, the leach rate under the 

RESRAD-ONSITE exponential release model, and the initial evasion rate are detailed in 

Figure 11.2, Figure 11.3, and Figure 11.4, respectively. 

 

Figure 11.1 Screen Shot of Spreadsheet Calculations of the Initial Loss/Removal Rate of 14C from 

the Primary Contamination and the Erosion Rate of the Primary Contamination 
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Figure 11.2 Screen Shot of Calculation of the Radiological Transformation Rate of 14C Using the 

ICRP-107 Half-life 

 

Figure 11.3 Screen Shots of Estimation of the Leach Rate of 14C under the RESRAD-ONSITE 

Exponential Release Option 

 

Figure 11.4 Screen Shot of Calculation of the Initial Evasion Rate of 14C from the Primary 

Contamination 
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Figure 11.5 illustrates the calculation of the initial rate of loss of 14C from the primary 

contamination. The calculation of the rate at which the cover above the primary contamination 

erodes is shown in Figure 11.6. This erosion rate is used to compute the time-dependent 

thickness of the cover and the time dependence of the fraction of the evasion depth that is 

contaminated. The computation of the concentration of 14C remaining in the primary 

contamination at a specific time, 3/16 year, is shown in Figure 11.7; this figure also shows the 

verification of the concentrations at five different times. Figure 11.8 illustrates the verification of 

the temporal concentration of 14C remaining in the primary contamination. 

 

Figure 11.5 Screen Shot of Calculation of the Initial Rate of Removal of 14C from the Primary 

Contamination Due to Evasion, Radiological Transformations, and Leaching under the RESRAD-

ONSITE Exponential Release Option 

 

Figure 11.6 Screen Shot of Calculation of the Erosion Rate of the Cover above the Primary 

Contamination 

 

Figure 11.7 Screen Shot of Calculation of the Concentration of 14C Remaining in the Primary 

Contamination at a Specific Time 
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Figure 11.8 Verification of the Temporal Variation of the Concentration of 14C Remaining in the 

Primary Contamination 

11.2 CONCENTRATION IN PLANT 

The movement of 14C from the soil to plant by root uptake and from air by photosynthesis 

are modeled as being the same as the movement of stable carbon. The computation of the soil-to-

plant root uptake transfer factor for 14C, based on the fraction of root uptake-derived carbon in 

the plant, is shown in Figure 11.9. 

 

Figure 11.9 Screen Shot of Calculation of Root Transfer Factor of 14C for Each Plant Type 

The 14C in plants from the foliar uptake of 14CO2 followed by photosynthesis is modeled 

using air-to-plant concentration ratios when the agricultural fields are not collocated with the 

primary contamination. The calculation of the air-to-plant concentration ratio is shown in 

Figure 11.10. The 14C in plants from the foliar uptake of 14CO2 and photosynthesis is modeled 

using the soil-to-air-to-plant concentration ratios for contamination in the agricultural fields. The 

calculation of the soil-to-air-to-plant concentration ratio is shown in Figure 11.11. The 
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calculation of the cover and depth factor for photosynthesis from secondary contamination at the 

offsite location is shown in Figure 11.12. 

 

Figure 11.10 Screen Shot of Calculation of Air-to-Plant Concentration Ratios which Are Used to 

Model Photosynthesis following Atmospheric Transport 

 

 

 

  

Figure 11.11 Screen Shots of Calculation of Soil-to-Air-to-Plant Concentration Ratios which Are 

Used to Model Photosynthesis from Contaminated Soil in the Farmed Areas 



 

74 

 

Figure 11.12 Screen Shot of Calculation of Cover and Depth Factor for Photosynthesis Resulting 

from Secondary Contamination in the Offsite Location 

The 14C in plants from the foliar deposition of particles containing it is modeled in the 

same manner as for the other radionuclides. The computation of the air-to-plant concentration 

ratios that are used in this model are in shown in Figure 11.13. 

 

Figure 11.13 Screen Shot of Calculation of Air-to-Plant Concentration Ratios which Are Used to 

Model Foliar Deposition of particulates 

The calculation of the concentration of 14C in plants (fruit, grain, and leafy vegetables) at 

a specific time, 0.25 years, and the verification of the code calculated value at that time are 

shown in Figure 11.14. The concentration to release ratios, (
𝜒

𝑄
)
𝑜𝑓𝑓𝑠𝑖𝑡𝑒

𝑔𝑎𝑠
, for transport of a gas from 

the primary contamination to the offsite locations and the concentrations of 14C in the soil and in 

air used in these calculations were obtained for RESRAD-OFFSITE output. The chi over Q 

ratios were verified in Section 4.1. The calculation of the concentration in offsite soils was 

verified in Section 5.2. The component calculations for the concentration of particulates in air 

were verified in Sections 2.4 and 4.1. The verification of the temporal concentration of 14C in 

plants (pasture and silage) is shown in Figure 11.15. The figure on the left shows the verification 

when the concentration is high, while the figure on the right shows the verification during later 

times when the concentration is orders of magnitude lower. 



 

75 

 

Figure 11.14 Screen Shot of Calculation and Verification of Concentration of 14C in Plants 

 

Figure 11.15 Verification of Temporal Variation of 14C Concentration in Plants 

11.3 CONCENTRATION IN MEAT AND MILK 

The transfer of 14C ingested by the livestock to milk and meat is modeled as being the 

same as the transfer of stable 12C that is ingested by the livestock to meat and milk. The 

calculations of the intake to concentration in meat factor and the intake to concentration in milk 

factor for 14C are shown in Figure 11.16. The use of these factors to compute the concentrations 

of 14C in meat and milk from livestock water, pasture and silage, feed grain, and the soil 

associated with the livestock feeds is illustrated in Figure 11.17. The verification of the temporal 

concentrations of 14C in milk and meat are shown in Figure 11.18 and Figure 11.19, respectively. 
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The plots on the left of both figures show the verification when the concentration is high, while 

the plots on the right of both figures show the verification during early times when the 

concentration is orders of magnitude lower and is mainly due to foliar deposition. 

 

Figure 11.16 Screen Shot of Intake to Concentration in Meat and Intake to Concentration in Milk 

Factors for 14C 

 

 

Figure 11.17 Screen Shot of Calculation and Verification of 14C in Meat and Milk 
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Figure 11.18 Verification of Temporal Concentration of 14C in Milk 

 

Figure 11.19 Verification of Temporal Concentration of 14C in Meat 

11.4 INHALATION 

The 14C inhalation dose in RESRAD-OFFSITE 4.0 is modeled as being from the 

inhalation of both 14C in respirable particles and 14CO2. The calculation of the inhalation dose 

from the 14C in respirable particles is shown in Figure 11.20. The calculation of the concentration 

of 14C in the air above the primary contamination per unit concentration and the calculation of 

the rate of release of 14C per unit concentration of 14C in the primary contamination are shown in 

Figure 11.21. The calculation of the time-integrated concentration of 14C in the air above the 

primary contamination over a period of a year beginning at 0.25 years is shown in Figure 11.22. 

The calculation of the time-integrated concentration of 14C in the air above the offsite dwelling 

location over a period of a year beginning at 0.25 years is shown in Figure 11.23. The calculation 

of the inhalation dose from inhaling 14CO2 is shown in Figure 11.24. The computation of the 14C 

inhalation dose from both the respirable particles and carbon dioxide is shown in Figure 11.25. 

The temporal variation of the 14C inhalation dose is verified in Figure 11.26.  
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Figure 11.20 Screen Shot of Computation of Inhalation Dose from 14C in Respirable Particulates 

 

Figure 11.21 Screen Shot of Calculation of the Concentration of 14C in Air above the Primary 

Contamination per Unit Concentration in the Primary Contamination and the Rate of Release of 
14C per Unit Concentration in Primary Contamination 
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Figure 11.22 Screen Shot of the Calculation of the Annual Time-Integrated Concentration of 14C in 

Air above the Primary Contamination at 0.25 Years 

 

Figure 11.23 Screen Shot of the Calculation of the Annual Time-Integrated Concentration of 14C in 

Air above the Offsite Dwelling Site at 0.25 Years 

 

Figure 11.24 Screen Shot of Computation of Inhalation Dose from the Inhalation of 14CO2 
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Figure 11.25 Screen Shot of the Calculation of the 14C Inhalation Dose from Respirable Particles 

and Carbon Dioxide  

 

Figure 11.26 Verification of the Temporal Variation of the 14C Inhalation Dose 
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APPENDIX 1: COMPONENTS OF RESRAD-OFFSITE VERSION 4.0 

1.1 MAIN USER INTERFACE, RESOWIN.EXE 

Purpose of ResOwin.exe: This is the main interface of RESRAD-OFFSITE which pops up 

when the code is launched. It is used to perform the following: 

1. To activate the exposure pathways, to input the site-specific values, to make choices to 

define the scenario being analyzed, and to write this information to the input files to be 

used by some of the other executables. 

2. To specify the radionuclide transformation data and associated inputs to be used for the 

analysis and to generate the transformation chain data for the computational code. 

3. To select the dose and slope factor library to be used for the analysis and to write the dose 

and risk factor library files for the computational code. 

4. To specify sensitivity analysis on inputs. 

5. To specify probabilistic/uncertainty analysis and to specify relationships between input 

variables. 

6. To facilitate the computation of area factors using the probabilistic analysis feature with 

relationships. 

7. To launch the appropriate FORTRAN executables to perform deterministic, sensitivity, and 

probabilistic/uncertainty analyses. 

8. To view the text output. 

9. To launch the deterministic graphics viewer. 

10. To view the probabilistic/uncertainty graphics. 

11. To view help information about any input or option in the interface. 

12. To view pdf files of the User’s Manual, the user’s guide to the code. 

13. To launch the dose conversion factor editor. 

Data Files Read by ResOwin.exe: 

1. RESRADOF.INI is an ASCII file that contains the user preferences for the appearance of the 

interface and the names of the directories that contain the dose conversion factor files, the 

meteorological files, and the input files. The interface will create this file if it is missing. It 

will also rewrite this file every time the code is exited to reflect current user preferences. 

2. VARIABOF.inf is an ASCII file that contains for each variable, the active pathway codes, 

the bounds, the default value, the FORTRAN name, the descriptive name and units, the name 

of the primary form the variable resides in, and the RESRAD default distribution. 

3. NewICRP38.idx is an ASCII file that contains the radionuclide transformation data in 

International Commission on Radiological Protection Pub. 38 (ICRP-38) (ICRP 1983) and 

the RESRAD default distribution coefficients for each radionuclide. 

4. ICRP-07.NDX is an ASCII file that contains the radionuclide transformation data in 

International Commission on Radiological Protection Pub. 1047 (ICRP-107) (ICRP 2008). 
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5. ICRP-07_Kd.NDX is an ASCII file that contains the RESRAD default distribution 

coefficients for the radionuclides in ICRP-107. 

6. NucDist.inf is an ASCII file that contains the RESRAD default probabilistic distributions for 

radionuclide-dependent properties. 

7. The DCF database files Master_dcf_2k.mdb and Master_dcf_ICRP07.mdb contain the dose 

conversion factors, slope factors, and transfer factors for the ICRP-38 and ICRP-107 

radionuclides, respectively. 

8. Current.lib is an ASCII file created by the interface, and it contains the dose and risk factors 

from the currently selected library. It is rewritten every time the dose or slope factor library is 

changed in the Title form. 

9. Default.lib is an ASCII file created by the interface that contains the dose and risk factors 

from the current default library. It is rewritten every time a dose or slope factor library 

change in the Title form necessitates a new default library. 

10. MyFonts.dat is an ASCII file containing information about the fonts and the printer driver 

installed on the computer. It is generated by the code if it is missing. It should be regenerated 

if the fonts installed on the computer are changed.  

11. Message.fil is a single-line text file indicating the computation being performed in the 

FORTRAN executables.  

12. Input file name.NID.CSV is a comma-separated values file containing all the radionuclide-

independent inputs in the input file currently in the interface. 

13. Input file name.NDP.CSV is a comma-separated values file containing all the radionuclide-

dependent inputs in the input file currently in the interface. 

Pdf Files Available from ResOwin.exe: 

1. UsersGuide.pdf, Volume 2 of the User’s Manual for RESRAD-OFFSITE code Version 4 is 

accessible via the Help menu. 

2. UsersManual.pdf, Volume 1 of the User’s Manual for RESRAD-OFFSITE code Version 4 is 

accessible via the Help menu. 

3. MapGuideRO.pdf describes how to use the map interface and is accessible via a button on 

the map interface. 

4. GWFlowlineRO.pdf describes how to input a curved flow path in the map interface and is 

accessible via a button on the trace groundwater path view of the map interface. 

5. AreaFactors.pdf describes the procedure for computing area factors. 

Data Files Written by ResOwin.exe: 

1. RESRADOF.INI is an ASCII file that contains the user preferences for the appearance of the 

interface and the names of the directories that contain the dose conversion factor files, the 

meteorological files, and the input files. The interface will create this file if it is missing. It 

will also rewrite this file every time the code is exited to reflect the current user preferences. 

2. Input file name.ROF is an ASCII file containing the values for all the input variables used in 

RESRAD-OFFSITE to define the scenario. 
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3. Input file name.CHN is an ASCII file containing the transformation chain data for the 

radionuclides in the scenario being analyzed.  

4. Input file name.LHS is an ASCII file containing the probabilistic/uncertainty distributions for 

the variables selected for probabilistic/uncertainty analyses in the scenario being analyzed. 

5. Input file name.CR is an ASCII file specifying the probabilistic/uncertainty outputs that are 

to be subjected to linear regression analysis with the variables selected for 

probabilistic/uncertainty analyses in the scenario being analyzed. 

6. Input file name.DEF is an ASCII file containing the default values for all the variables used 

in RESRAD-OFFSITE to define the scenario. This file is deleted when the computational 

code completes its calculations. 

7. Input file name.REL is an ASCII file containing any relationships between variables, with 

variables selected for probabilistic/uncertainty analysis being among the “independent” 

variables. 

8. Input file name.NID.CSV is a comma-separated values file containing externally formatted 

values for all the radionuclide-independent inputs in the input file currently in the interface. 

9. Input file name.NDP.CSV is a comma-separated values file containing externally formatted 

values for all the radionuclide-dependent inputs in the input file currently in the interface. 

10. Current.lib is an ASCII file that contains the dose and risk factors from the currently selected 

library. It is rewritten every time the dose or slope factor library is changed in the Title form. 

11. Default.lib is an ASCII file that contains the dose and risk factors from the current default 

library. It is rewritten every time a dose or slope factor library change in the Title form 

necessitates a new default library. 

12. UniqueNuc.txt is a text file containing the number and names of all the radionuclides in the 

transformation chain of the radionuclides in the current input file. 

13. NoDataNuclides.txt is a text file containing a list of radionuclides missing one or more dose 

or slope factor. 

14. Current_External_DCF.txt is a text file containing the default external exposures dose 

factors, the scenario-specific external exposure dose and slope factors, and the fitting factors 

for all the radionuclides in the current input file. 

15. MyFonts.dat is an ASCII file containing information about the fonts and the printer driver 

installed on the computer. It is generated by the code if it is missing. It should be regenerated 

if the fonts installed on the computer are changed. 

16. RELVARIN.DAT is an ASCII file containing the description of the dependent related 

variables, the relationship between the variables, and the sample values of the dependent 

related variables.  

17. FileforWresplot.dat contains the names of the graphics file and the input file. 

Batch File Written by ResOwin.exe: 

1. ResOCalc.bat is the set of instructions for executing the FORTRAN executables necessary to 

perform the calculations for the current input file. 
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Data Transfer Diagram for ResOWin.exe 

Text Reports Read and Displayed in the Text Viewer within ResOWin: 

1. SUMMARY.REP or Input file name.par contains the table of contents and the text of the 

main report consisting of the input echo, dose attributed to the initially present radionuclides, 

soil guideline, and run time information. 

2. INTRISK.REP or Input file name.rsk contains the table of contents and the text of the intake 

and risk report. 

3. DAUDOSE.REP or Input file name.pro contains the table of contents and the text of the dose 

attributed to the radionuclides at the location and time of exposure report. 

4. MCSUMMAR.REP or Input file name.prb contains the table of contents and the probabilistic 

text report. 

5. LHS.REP or Input file name.smp contains the probabilistic sampling report of LHS.exe, 

EXAMPLE1.UN6, with a table of content added to it. 

6. Regression.REP or Input file name.reg contains the regression coefficient of the dependent 

variables sorted in the order of importance. 

7. AreaFactorText.REP or Input file name.AF contains tables of the area factors for each 

radionuclide in file executed under generate area factors option. 
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Data Files Read and Displayed in the Probabilistic Graphics Viewers within ResOWin: 

1. Input file name.LHS.don, identical to Input file name.LHS , is an ASCII file containing the 

probabilistic/uncertainty distributions for the variables selected for probabilistic/uncertainty 

analyses in the scenario being analyzed. This file is created after the input variables have 

been sampled to indicate that the sampling has been performed. 

2. Input file name.pin, identical to LHSBIN.DAT, is an ASCII file containing the sample values 

for each variable selected for probabilistic/uncertainty analysis. This file is created after the 

input variables have been sampled to indicate that the sampling has been performed. 

3. Input file name.rel is an ASCII file containing any relationships between variables, with 

variables selected for probabilistic/uncertainty analysis being among the “independent” 

variables and the sample values for any related variables. 

4. Input file name.pds, identical to UNCPEAK.ASC, is an ASCII file containing the peak doses 

and the times of the peak doses (grand total, total for each pathway, and total for each 

radionuclide) for each probabilistic simulation. 

5. Input file name.prk, identical to UNCPEAKR.ASC, is an ASCII file containing the peak risks 

(grand total, total for each pathway, and total for each radionuclide) for each probabilistic 

simulation. 

6. Input file namei.PTG, where i is any number from 1 to the number of repetitions, is an ASCII 

file containing the probabilistic temporal graphics data. 

 

Data Transfer Diagram for the Text and Probabilistic Graphics Viewers in ResOWin.exe 

1.2 MAIN COMPUTATIONAL CODE, RESOCALC.EXE 

Purpose of ResOCalc.exe: This is the main computational executable of RESRAD-OFFSITE 

which computes the dose, risk, and concentration for deterministic, sensitivity, and 

probabilistic/uncertainty runs. 
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Description of ResOCalc.exe: This computational executable reads the data files; performs a 

sequence of computations to calculate the concentration in environmental media, radiological 

dose, and excess cancer risk to a single receptor; and outputs the results to a number of text and 

binary files. The executable repeats the sequence of calculations for sensitivity and 

probabilistic/uncertainty simulations after changing the values of the variables selected for 

sensitivity or probabilistic/uncertainty analysis. 

This computational code does the following in sequence: 

1. Reads the dimensions for dynamically allocatable variables from the DB Name list part of 

the input file; use these to allocate the variables just before the call to the subroutine that 

uses the variables. 

2. Reads from Current_External_DCF.txt the external exposure dose (default and current) and 

slope (current) factors and fitting factors for all the radionuclides in the current input file.  

3. Reads the default values and the scenario-specific values of the inputs from the default 

(*.DEF) and the input (*.ROF) files. 

4. Reads from the chain file (*.CHN) the radionuclide transformation data. 

5. Performs the calculations that need to be done only once for an input file; these are the 

calculations that do not need to be repeated for different calculation times nor for 

sensitivity nor probabilistic runs. 

6. For probabilistic runs, reads the probabilistic distributions and the probabilistic sample 

values for each variable selected for probabilistic/uncertainty analysis. Also reads in 

sample values for any related variables. 

7. For sensitivity runs, sets the current sensitivity analysis input to the appropriate value. 

Resets previous sensitivity analysis input to base value. 

8. Performs the calculations that need to be done once for a deterministic run and once for 

each sensitivity or probabilistic/uncertainty simulation. 

9. Computes or reads the activity in and the releases from the primary contamination for each 

computation time. 

10. Performs atmospheric transport calculations for each computation time. 

11. Performs groundwater transport calculations to compute the concentration in well water 

and input rate to a surface water body at each computation time; or reads the concentration 

in well water. 

12. Computes or reads the concentration in the surface water at each computation time. 

13. Computes the concentrations in the agricultural areas, in plant, meat, and milk at each 

computation time. 

14. Computes dose and risk from each of the nine exposure pathways and finds the peak dose. 

15. Writes text reports. 

16. For runs that include both sensitivity analysis and probabilistic/uncertainty analysis, sets 

the last sensitivity analysis input to its base value. 

17. Determines the statistics for the probabilistic dose and risk. 
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Data Files Read by ResOCalc.exe: 

1. Input file name.ROF is an ASCII file containing the values for all the input variables used in 

RESRAD-OFFSITE to define the scenario. 

2. Input file name.CHN is an ASCII file containing the transformation chain data for the 

radionuclides in the scenario being analyzed.  

3. Input file name.LHS is an ASCII file containing the probabilistic/uncertainty distributions for 

the variables selected for probabilistic/uncertainty analyses in the scenario being analyzed. 

4. LHSBIN.DAT is an ASCII file containing the sample values for each variable selected for 

probabilistic/uncertainty analysis. 

5. RELVARIN.DAT (Input file name.REL) is an ASCII file containing any relationships 

between variables, with variables selected for probabilistic/uncertainty analysis being among 

the “independent” variables and the sample values for any related variables. 

6. Input file name.DEF is an ASCII file containing the default values for all the variables used 

in RESRAD-OFFSITE to define the scenario. This file is deleted when the computational 

code completes its calculations. 

7. UniqueNuc.txt is a text file containing the number and names of all the radionuclides in the 

transformation chain of the radionuclides in the current input file. 

8. Current_External_DCF.txt is a text file containing the default external exposures dose 

factors, the scenario-specific external exposure dose and slope factors, and the fitting factors 

for all the radionuclides in the transformation chain of the radionuclides in the current input 

file. 

9. TCTST195.RRB is a binary file containing area factor information for seven different 

thicknesses of cover, six different thicknesses of contamination, twelve different radii, and 23 

different levels of gamma energies. 

10. pathchk.dat is a text file containing active pathway codes for the inputs as listed in the order 

they appear in Default.inc and thus in the input echo. 

11. DEFAULT.dat an ASCII file listing the default values of the inputs in name lists for each 

form. 

12. UNCGRPTO.BIN is a binary file containing the total dose at each graphic time point for each 

probabilistic simulation.  

13. WSCONC.DAT is a user-created text file containing the concentrations of the radionuclides 

in the water in the surface water body. 

14. WWCONC.DAT is a user-created test file containing the concentrations of the radionuclides 

in well water. 

Files Written by ResOCalc.exe: 

1. Output.fil, a text file listing the progress of the computational code as it works its way 

sequentially through the calls. 

2. DEFAULT.dat is an ASCII file listing the default values of the inputs in name lists for each 

form. 
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3. SUMMARY.OUT, containing the text of the main report consisting of the input echo, dose 

attributed to the initially present radionuclides, soil guideline, etc., is appended to 

SUMMARY.REP, which initially contains the table of contents to the report. 

4. INTRISK.OUT, containing the text of the intake and risk report, is appended to 

INTRISK.REP, which initially contains the table of contents of the report. 

5. DAUDOSE.OUT, containing the text of the dose attributed to the radionuclides at the 

location and time of the exposure report, is appended to DAUDOSE.REP, which initially 

contains the table of contents of the report. 

6. MCSUMMAR.OUT, containing the probabilistic text report, is appended to 

MCSUMMAR.REP, which initially contains the table of contents of the report. 

7. LHS.REP contains the probabilistic sampling report of LHS.exe. 

8. UNCPEAK.ASC is an ASCII file containing the peak doses and the time of the peak doses 

(grand total, total for each pathway, and total for each radionuclide) for each probabilistic 

simulation. 

9. UNCPEAKR.ASC is an ASCII file containing the peak risks (grand total, total for each 

pathway, and total for each radionuclide) for each probabilistic simulation. 

10. UNCGRPTO.BIN is a binary file containing the total dose at each graphic time point for each 

probabilistic simulation.  

11. Input file namei.PTG, where i is any number from 1 to the number of repetitions, is an ASCII 

file containing the probabilistic temporal graphics data. 

12. LHSVAR.DAT is an ASCII file containing the probabilistic sample values for the current 

probabilistic simulation.   

13. RELVAR.DAT is an ASCII file containing the sample values of the dependent related 

variables for the current probabilistic simulation.  

14. OFFSITE.DAT is a binary file containing information about the current run including the 

number of radionuclides, the parent and progeny pointers, the number of environmental 

media, the number of reporting and calculation times, units. 

15. Offsite.RA, Offsite.RB, and Offsite.RC are binary files containing risk, dose, and 

concentration, respectively, at graphical times for the deterministic simulation, for each 

sensitivity simulation, and for each probabilistic simulation. 

16. Message.fil a single-line text file indicating the computation being performed.  

17. CHIOVERQ.OUT is an ASCII file containing the atmospheric concentrations to release 

(chi/Q) ratios for each radionuclide at the different offsite exposure locations.   

18. SectorDepletedFraction.OUT is an ASCII file which has 17 columns of data; the first is the 

distance from the point release, and the next 16 contain the depleted source strengths at the 

distances in the first column in each of the 16 sectors, expressed as fractions of the release. 

The 16 columns are in the order N, NNE, NE, ENE, E, ESE, SE, SSE, S, SSW, SW, WSW, 

W, WNW, NW, and NNW. 

19. DistanceIntegratedSectorDF.OUT is an ASCII file which has 17 columns of data; the first is 

the distance from the point release, and the next 16 contain the integrals of the depleted 

source strengths over the distance in the first column in each of the 16 sectors. The 16 

columns are in the order N, NNE, NE, ENE, E, ESE, SE, SSE, S, SSW, SW, WSW, W, 

WNW, NW, and NNW. 
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20. PROFILEW.OUT is an ASCII file containing data on the horizontal and vertical 

concentration profiles of each radionuclide in the aquifer in the plane containing the well.  

21. PROFILES.OUT is an ASCII file containing data on the horizontal and vertical 

concentration profiles of each radionuclide in the aquifer in the plane containing the surface 

water body.   

22. QRFAIL.LOG is an ASCII file listing information about groundwater transport calculations 

that reached the upper limit of numerical integration points before achieving the user-

specified convergence criterion.  

23. RadonFlux.OUT is an ASCII file listing the release rates of the radon isotopes (g) from the 

primary contamination and from the accumulations in offsite locations. 

24. Summary.REP is the main text report with a table of content, consisting of the input echo, 

dose attributed to the initially present radionuclides, soil guideline, etc. The other text 

reports, INTRISK.REP, DAUDOSE.REP, and MCSUMMAR.REP, are created in a similar 

fashion by adding tables of contents to the corresponding OUT files. 

25. AIFLUXIN.DAT is an ASCII file listing the release, attached to particulates, to the 

atmosphere from the surface layer, in pCi/yr. 

26. AQFLUXIN.DAT is an ASCII file listing the release, in the aqueous phase, to water at the 

downgradient edge of the primary contamination, in pCi/year. 

27. AQTRANIN.DAT is an ASCII file listing the transfer to infiltration or gradual injection in 

the part of the primary contamination that is above the water table, in pCi/yr, and the 

instantaneous injection in the part of the primary contamination that is above the water table, 

in pCi. 

28. GWtoSWBFLUX.DAT is the transfer, in aqueous phase, from the aquifer to the surface 

water body, in pCi/year. 

29. SFSIN.DAT is the concentration in the primary contamination, in pCi/g, averaged over the 

primary contamination. Currently includes the release immune form for all transfer options 

and the release susceptible form for the rate-controlled and the equilibrium dissolution 

transfer mechanisms, but not the aqueous or adsorbed phases of the radionuclides in transit in 

the primary contamination. 

30. WTFLUXIN.DAT is the transfer, in aqueous phase, across the water table to the aquifer, in 

pCi/yr. 

31. SWFLUXIN.DAT is the release, in eroded material, to surface runoff from the surface layer, 

in pCi/yr. It includes the mass of material eroded from the primary contamination and the 

surface layer, in g/yr, the mass of suspended sediment in the surface water body, in g, and the 

mass of bottom sediment on which the radionuclides are in adsorption-desorption 

equilibrium with the water in the surface water body. 

32. CZTHICK3.DAT contains columns listing the calculation times in years, the concentration 

of the radionuclides in the surface mixing layer of the soil as a fraction of the concentration 

in the physically undisturbed primary contamination, the thickness of the clean cover in 

meters, the thickness of the contaminated mixing layer in meters, and the thickness of the 

physically undisturbed (unmixed) thickness of the primary contamination. 
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Data Transfer Diagram for ResOCalc.exe 

 

Intermediate Data Diagram for ResOCalc.exe 
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Overriding User Data Input Diagram for ResOCalc.exe 

1.3 DETERMINISTIC GRAPHICS DATA CONVERTER, GRPHCNV5.EXE 

Purpose of GrphCnv5.exe: This FORTRAN executable reads the dose, risk, and concentration 

from the RESRAD-OFFSITE binary output files and writes the ASCII deterministic and 

sensitivity graphics data file, GRAPHICS.ASC, that will be read by WResPlot.exe. 

Description of GrphCnv5.exe: This is a small, simple code that reads the data in the four files 

listed below and writes the dose, concentration, and risk data to an ASCII file in a format that 

can easily be used by the deterministic graphics executable WResPlot.exe.  

Files Read by GrphCnv5.exe: 

1. Offsite.dat is a binary file containing information about the current run including the number 

of radionuclides, the parent and progeny pointers, the number of environmental media, the 

number of reporting and calculation times, units. 

2. Offsite.RA, Offsite.RB, and Offsite.RC are binary files containing risk, dose, and 

concentration, respectively, at graphical times for the deterministic simulation, for each 

sensitivity simulation, and for each probabilistic simulation.  

Files Written by GrphCnv5.exe: 

1. GRAPHICS.ASC is an ASCII file containing the dose, concentration, and risk data in a 

format that can be used by WResPlot.exe. 
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1.4 DETERMINISTIC GRAPHICS VIEWER, WRESPLOT.EXE 

Purpose of WResPlot,exe: This executable displays the deterministic and sensitivity output 

(dose, risk, or concentration) of the RESRAD-OFFSITE (and the RESRAD-ONSITE) code in 

graphical form. 

Data Files Read by WRESPLOT.exe: 

1. FileforWresplot.dat to read the name of the graphics file. 

2. VARIABOF.INF to read in the description of the variables for use when sensitivity analysis 

is performed. 

3. GRAPHICS.ASC, Input file name.grp is an ASCII file containing the dose, concentration, 

and risk data. 
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APPENDIX 2: VERIFICATION OF AIR RELEASE FROM THE 

SURFACE MIXING LAYER 

The spreadsheet calculations of the air release of particulates from the surface layer at the 

primary contamination are performed for 90Sr using the equations described in G.15 of Appendix 

G of the RESRAD-OFFSITE Manual. First, the concentration in the mixing layer using Equation 

G.67 is calculated, and after that, the air release is calculated using Equation G.69. Releases 

associated with both respirable and total particulates can be calculated. Special models are used 

for gaseous/vapor releases of tritium (3H) as water vapor, 14 C as carbon dioxide, and radon 

(220Rn and 222Rn). Verification of special radionuclides is done separately. The spreadsheet 

calculations are compared with the code output file AIFLUXIN.DAT. 

Table A2.1 lists parameters used in calculating air release rate from the surface layer. 

Table A2.1 Parameters Used in Air Release Calculations 

Radionuclide and Radionuclide-Specific Parameters 90Sr 

Half-life (yr) 29.12 

Cut-off half-life (d) 30 

Primary Contamination and Cover Parameters 
 

Rainfall and runoff factor (/yr) 160 

Dry bulk density (g/cm3) 1.5 

Soil erodibility factor 0.4 

Slope-length-steepness factor 0.4 

Cover and management 0.003 

Support practice factor 1 

Depth of soil mixing layer (m) 0.15 

Deposition velocity of all particulates (to compute atmospheric release) (m/s) 0.001 

Mass loading of all particulates (g/m3) 0.0001 

Primary contamination thickness (m) Case 1 – 0.1 

Case 2 – 1.2 

Cover thickness (m) 0.05 

Area of primary contamination (m2) 10000 

The comparison is done for two thicknesses of primary contamination (two input files 

used are air release comp sr90.rof and air release comp case2.rof). Figure A2.1 shows the Case 1 

comparison of the calculated air release rate using an EXCEL spreadsheet with the air release 

rate from the code. The detailed comparison is in the EXCEL spreadsheet (air-release-

case1.xlsx). Figure A2.2 shows the Case 2 comparison of the calculated air release rate using an 

EXCEL spreadsheet with the air release rate from the code (air-release-case2.xlsx). The 

spreadsheets can be used for comparing results for other cover and primary contamination 

thicknesses. The EXCEL spreadsheet calculations in general match the code output. 
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Figure A2.1 Air Release to Atmosphere from the Surface Layer (Case 1) 

 

Figure A2.2 Air Release to Atmosphere from the Surface Layer (Case 2)  
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APPENDIX 3: VERIFICATION OF EROSION RELEASE FROM 

PRIMARY CONTAMINATION 

The spreadsheet calculations of the erosion release of particulates from the primary 

contamination are performed for 90 Sr using the equations described in the Appendix G of the 

RESRAD-OFFSITE Manual. First, the eroded material rate is calculated using Equations G.24 

and G.25, and after that, the erosion rate is calculated using Equation G.68. The two input files 

used are erosion release comp case1.rof and erosion release comp case2.rof. The spreadsheet 

calculations are compared with the code output file SWFLUXIN.DAT. 

Table A3.1 lists the parameters used in calculating the air release rate from the surface 

layer. 

Table A3.1 Parameters Used in Erosion Release Calculations 

Radionuclide and Radionuclide-Specific Parameters 90Sr 

Half-life (yr) 29.12 

Cut-off half-life (d) 30 

Primary Contamination and Cover Parameters 
 

Rainfall and runoff factor (/yr) 160 

Dry bulk density (g/cm3) 1.5 

Soil erodibility factor 0.4 

Slope-length-steepness factor 0.4 

Cover and management 0.003 

Support practice factor 1 

Depth of soil mixing layer (m) 0.15 

Primary contamination thickness (m) Case 1 – 0.1 

Case 2 – 1.2 

Cover thickness (m) 0.05 

Area of primary contamination (m2) 10000 

Figure A3.1 shows the comparison of the calculated erosion rate for Case 1 using an 

EXCEL spreadsheet with the erosion rate from the code. The detailed comparison is in the 

EXCEL spreadsheet “erosion-release-case1.xlsx.” Figure A3.2 shows the comparison of the 

calculated erosion rate for Case 2 using an EXCEL spreadsheet with the erosion rate from the 

code. The detailed comparison is in the EXCEL spreadsheet “erosion-release-case2.xlsx.” The 

spreadsheets can be used for comparing the results for other cover and primary contamination 

thicknesses. The EXCEL spreadsheet calculations in general match the code output. 
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Figure A3.1 Erosion Release from Primary Contamination – Case 1 

 

Figure A3.2 Erosion Release from Primary Contamination – Case 2 
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APPENDIX 4: VERIFICATION OF ATMOSPHERIC TRANSPORT MODEL 

The atmospheric transport model used in RESRAD-OFFSITE is a Gaussian plume 

dispersion model based on an area source release. As a radioactive plume travels downwind, its 

radionuclide content decreases due to deposition on the ground. The model considers two 

deposition mechanisms, dry and wet, to account for radionuclide depletion from the plume.  

The earlier versions of the code (before Version 4.0) computed the concentration in the 

air above the offsite receptor and accumulation locations that did not overlap with the primary 

contamination. A formulation to compute the deposition on a catchment that could potentially 

overlap the primary contamination was added to Version 4. Details of the model are presented in 

Appendix I of the RESRAD-OFFSITE User’s Manual Yu et al. (2020).  

The RESRAD-OFFSITE V&V report (Yu et al. 2011) verified the earlier model. Six 

input files (air dispersion run1.rof, air dispersion run2.rof, … air dispersion run6.rof) are created 

based on the information in the V&V report and are run with the new version. Table A4.1 shows 

the site layout and atmospheric transport parameters used in air dispersion calculations. The 

results in Tables 4-2 and 4-3 in the V&V report are compared with Version 4 results. Table A4.2 

and Table A4.3 show the comparison of the old spreadsheet calculations, old code results, and 

Version 4 results for CHIOVERQ (normalized air concentration). Version 4 results are taken 

from the CHIOVERQ.OUT file created after each run in the directory where RESRAD-

OFFSITE code is installed. There is practically no difference in the spreadsheet calculations and 

Version 4 results.  

Table A4.1 Site Layout and Atmospheric Transport Parameters Used in Point-to-Point Air 

Dispersion Calculations 

Receptor Area 

Distance, 

m Direction 

Elevation, 

m 

Directional 

Frequency 

Stability 

Category 

Wind  

Speed (m/s) 

Fruit grain non-leafy vegetable 

plot 

100 North 0 0.05 A 0.89 

Leafy vegetables plot 200 South 5 0.1 B 2.46 

Pasture, silage growing area 500 East 10 0.25 D 6.93 

Grain field 1000 West 15 0.2 C 4.47 

Dwelling site 10000 Northeast 20 0.4 F 9.61 

Note: Elevation is only used with plume rise. 

Note that only wet deposition was not checked in the V&V report. A new spreadsheet 

incorporating RESRAD-OFFSITE Manual Appendix I equations is made to calculate the 

normalized air concentration for different stability classes. The spreadsheet includes both 

Pasquill-Gifford and Briggs dispersion models but only includes wet deposition. A separate 

RESRAD-OFFSITE input file (air dispersion run7) is used. Table A4.4 compares the spreadsheet 

calculations with RESRAD-OFFSITE Version 4 results with no deposition for both Pasquill-

Gifford and Briggs dispersion models and wet deposition only with the Pasquill-Gifford 

dispersion model. 
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Table A4.2 Comparison of RESRAD-OFFSITE Normalized Air Concentrations (s/m3) in 

V&V Report (with Plume Rise) with RESRAD-OFFSITE Version 4 

  Values from V&V Report Table 4-2  

  Spreadsheet 

Spreadsheet x Directional 

Frequency 

Previous 

OFFSITE 

OFFSITE 

Version 4 

Run 1 - Briggs Rural Dispersion Coefficients, no dry or wet deposition 

Fruit grain non-leafy vegetable plot 1.12E-03 5.60E-05 5.68E-05 5.60E-05 

Leafy vegetables plot 1.70E-04 1.70E-05 1.69E-05 1.69E-05 

Pasture, silage growing area 2.55E-05 6.38E-06 6.39E-06 6.38E-06 

Grain field 6.14E-06 1.23E-06 1.23E-06 1.23E-06 

Dwelling site 5.22E-07 2.09E-07 2.09E-07 2.09E-07 

Run 2 - Pasquill-Gifford dispersion coefficient with dry deposition, no wet deposition 

Fruit grain non-leafy vegetable plot 1.54E-03 7.69E-05 7.81E-05 7.69E-05 

Leafy vegetables plot 2.00E-04 2.00E-05 1.99E-05 1.98E-05 

Pasture, silage growing area 3.12E-05 7.79E-06 7.80E-06 7.79E-06 

Grain field 7.26E-06 1.45E-06 1.45E-06 1.45E-06 

Dwelling site 4.34E-07 1.74E-07 1.74E-07 1.74E-07 

Run 3 - Pasquill-Gifford dispersion coefficient with dry deposition and wet deposition 

Fruit grain non-leafy vegetable plot 1.51E-03 7.56E-05 7.68E-05 7.56E-05 

Leafy vegetables plot 1.98E-04 1.98E-05 1.97E-05 1.96E-05 

Pasture, silage growing area 3.08E-05 7.71E-06 7.71E-06 7.70E-06 

Grain field 7.02E-06 1.40E-06 1.40E-06 1.40E-06 

Dwelling site 4.27E-07 1.71E-07 1.71E-07 1.72E-07 

Note: The spreadsheet calculations do not include the directional wind frequency. 
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Table A4.3 Comparison of RESRAD-OFFSITE Normalized Air Concentrations (s/m3) in V&V 

Report (without Plume Rise) with Version 4 

 Values from V&V Report Table 4-3  

  Spreadsheet 

Spreadsheet x directional 

frequency 

Previous 

OFFSITE 

OFFSITE 

Version 4 

Run 4 - Pasquill-Gifford rural dispersion coefficients, no dry or wet deposition  

Fruit grain non-leafy vegetable plot 1.57E-03 7.86E-05 7.94E-05 7.86E-05 

Leafy vegetables plot 2.02E-04 2.02E-05 2.01E-05 2.00E-05 

Pasture, silage growing area 3.14E-05 7.86E-06 7.87E-06 7.86E-06 

Grain field 7.34E-06 1.47E-06 1.47E-06 1.47E-06 

Dwelling site 4.52E-07 1.81E-07 1.81E-07 1.81E-07 

Run 5 - Pasquill-Gifford dispersion coefficient with dry deposition, no wet deposition  

Fruit grain non-leafy vegetable plot 1.55E-03 7.73E-05 7.81E-05 7.73E-05 

Leafy vegetables plot 2.01E-04 2.01E-05 1.99E-05 1.98E-05 

Pasture, silage growing area 3.12E-05 7.79E-06 7.80E-06 7.79E-06 

Grain field 7.26E-06 1.45E-06 1.45E-06 1.45E-06 

Dwelling site 4.36E-07 1.74E-07 1.74E-07 1.74E-07 

Run 6 - Pasquill-Gifford dispersion coefficient with dry deposition and wet deposition  

Fruit grain non-leafy vegetable plot 1.52E-03 7.61E-05 7.68E-05 7.60E-05 

Leafy vegetables plot 1.98E-04 1.98E-05 1.97E-05 1.96E-05 

Pasture, silage growing area 3.08E-05 7.71E-06 7.72E-06 7.70E-06 

Grain field 7.03E-06 1.41E-06 1.40E-06 1.40E-06 

Dwelling site 4.29E-07 1.72E-07 1.72E-07 1.72E-07 
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Table A4.4 Comparison of RESRAD-OFFSITE (Version 4) Normalized Air Concentration with 

New Spreadsheet Calculations 

  

New 

Spreadsheet 

Spreadsheet x 

Directional Frequency Version 4.0 

Run 1 - Briggs rural dispersion coefficients, no dry or wet deposition  

Fruit grain non-leafy vegetable plot 1.12E-03 5.60E-05 5.60E-05 

Leafy vegetables plot 1.69E-04 1.69E-05 1.69E-05 

Pasture, silage growing area 2.55E-05 6.38E-06 6.38E-06 

Grain field 6.14E-06 1.23E-06 1.23E-06 

Dwelling site 5.21E-07 2.09E-07 2.09E-07 

Run 4 - Pasquill-Gifford rural dispersion coefficients, no dry or wet deposition  

Fruit grain non-leafy vegetable plot 1.57E-03 7.86E-05 7.86E-05 

Leafy vegetables plot 2.02E-04 2.02E-05 2.00E-05 

Pasture, silage growing area 3.14E-05 7.85E-06 7.86E-06 

Grain field 7.34E-06 1.47E-06 1.47E-06 

Dwelling site 4.52E-07 1.81E-07 1.81E-07 

Run 7 - Pasquill-Gifford dispersion coefficient with wet deposition  

Fruit grain non-leafy vegetable plot 1.55E-03 7.73E-05 7.73E-05 

Leafy vegetables plot 2.00E-04 2.00E-05 1.98E-05 

Pasture, silage growing area 3.11E-05 7.77E-06 7.77E-06 

Grain field 7.10E-06 1.42E-06 1.42E-06 

Dwelling site 4.45E-07 1.78E-07 1.78E-07 

The code outputs the intermediate results of the atmospheric transport calculations of the 

deposition in the catchment to the SectorDepletedFraction.OUT file. The file includes the 

distance from the point release and the depleted source strength in the 16 sectors at the distance 

in the first column, expressed as fraction of the release. The values in this file are compared with 

the EXCEL spreadsheet calculations for both wet and dry deposition by considering wet and dry 

deposition individually. Table A4.5 and Table A4.6 compare the RESRAD-OFFSITE source 

depletion due to dry and wet deposition, respectively, at few select distances from the 

spreadsheet calculations. Differences of less than 1 percent are observed in all stability classes. 

The full comparison is in the EXCEL spreadsheet wet and dry depleted fraction comparison.xlsx.  
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Table A4.5 Comparison of RESRAD-OFFSITE Deposition Depletion Due to Dry Deposition with 

Spreadsheet Calculations 

  Depleted Fraction from the Code (Dry Deposition - Run 5) 
Depleted Fraction Due to Dry Deposition Calculated Using 

Spreadsheet 

Distances 

(m) 

North - A 

(0.89 

m/s) 

Northeast 

-F (9.61 

m/s) 

East - D 

(6.93 

m/s) 

South - B 

(2.46 

m/s) 

West - C 

(4.47 

m/s) 

 A (0.89 

m/s) 

F (9.61 

m/s) 

D (6.93 

m/s) 

B (2.46 

m/s) 

C (4.47 

m/s) 

2.03E+01 9.93E-01 1.00E+00 9.99E-01 9.97E-01 9.98E-01 9.93E-01 1.00E+00 9.99E-01 9.97E-01 9.98E-01 

5.22E+01 9.88E-01 9.98E-01 9.97E-01 9.95E-01 9.97E-01 9.88E-01 9.98E-01 9.97E-01 9.95E-01 9.97E-01 

1.01E+02 9.84E-01 9.96E-01 9.96E-01 9.93E-01 9.95E-01 9.84E-01 9.96E-01 9.96E-01 9.93E-01 9.95E-01 

2.00E+02 9.79E-01 9.94E-01 9.94E-01 9.91E-01 9.93E-01 9.79E-01 9.94E-01 9.94E-01 9.91E-01 9.93E-01 

5.02E+02 9.75E-01 9.90E-01 9.92E-01 9.88E-01 9.91E-01 9.75E-01 9.90E-01 9.92E-01 9.88E-01 9.91E-01 

1.00E+03 9.73E-01 9.86E-01 9.89E-01 9.86E-01 9.89E-01 9.73E-01 9.86E-01 9.89E-01 9.86E-01 9.89E-01 

1.50E+03 9.72E-01 9.83E-01 9.88E-01 9.85E-01 9.88E-01 9.73E-01 9.83E-01 9.88E-01 9.85E-01 9.88E-01 

2.00E+03 9.72E-01 9.81E-01 9.87E-01 9.84E-01 9.87E-01 9.72E-01 9.81E-01 9.86E-01 9.84E-01 9.87E-01 

Table A4.6 Comparison of RESRAD-OFFSITE Depletion Due to Wet Deposition with Spreadsheet 

Calculations 

  Depleted Fraction from the Code (Wet Deposition - Run 5) 
Depleted Fraction Due to Wet Deposition Calculated Using 

Spreadsheet 

Distances 

(m) 

North - A 

(0.89 

m/s) 

Northeast 

-F (9.61 

m/s) 

East - D 

(6.93 

m/s) 

South - B 

(2.46 

m/s) 

West - C 

(4.47 

m/s) 

A (0.89 

m/s) 

B (2.46 

m/s) 

C (4.47 

m/s) 

D (6.93 

m/s) 

F (9.61 

m/s) 

2.03E+01 9.97E-01 1.00E+00 1.00E+00 9.99E-01 9.99E-01 9.97E-01 9.99E-01 9.99E-01 1.00E+00 1.00E+00 

5.22E+01 9.91E-01 1.00E+00 9.99E-01 9.97E-01 9.98E-01 9.91E-01 9.97E-01 9.98E-01 9.99E-01 1.00E+00 

1.01E+02 9.83E-01 1.00E+00 9.98E-01 9.94E-01 9.97E-01 9.83E-01 9.94E-01 9.97E-01 9.98E-01 1.00E+00 

2.00E+02 9.67E-01 1.00E+00 9.96E-01 9.88E-01 9.93E-01 9.66E-01 9.88E-01 9.93E-01 9.96E-01 1.00E+00 

5.02E+02 9.20E-01 9.99E-01 9.89E-01 9.70E-01 9.83E-01 9.18E-01 9.69E-01 9.83E-01 9.89E-01 9.99E-01 

1.00E+03 8.46E-01 9.98E-01 9.79E-01 9.41E-01 9.67E-01 8.42E-01 9.40E-01 9.66E-01 9.78E-01 9.98E-01 

1.50E+03 7.79E-01 9.98E-01 9.68E-01 9.14E-01 9.51E-01 7.73E-01 9.11E-01 9.50E-01 9.68E-01 9.98E-01 

2.00E+03 7.16E-01 9.97E-01 9.58E-01 8.86E-01 9.36E-01 7.10E-01 8.83E-01 9.34E-01 9.57E-01 9.97E-01 
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APPENDIX 5: VERIFICATION OF SURFACE WATER MODEL 

A limited verification of the surface water body model in RESRAD-OFFSITE code is 

performed for 99Tc and 238U contamination. The water concentration in the surface water body 

for the principal radionuclide from an EXCEL spreadsheet calculation is compared with the code 

surface water concentration.  

Verification is done all four modes of entry of radionuclides into the surface water body: 

(1) influx of dissolved radionuclides in the water intercepted from the aquifer; (2) influx of 

radionuclides adsorbed on soil eroded from the primary contamination; (3) influx of 

radionuclides transported by air, then deposited on the catchment, and ultimately washed out into 

the surface water body; and (4) influx of radionuclides transported by air and deposited on the 

surface water body.  

The code considers four ways of removal of radionuclides from the surface water body: 

(1) loss of radionuclides, both dissolved in the water and adsorbed on the suspended sediments, 

in the stream outflow; (2) loss of radionuclides, both dissolved in the water and adsorbed on the 

suspended sediments, in the water extracted for use; (3) loss of radionuclides dissolved in the 

water that seeps into the aquifer; and (4) loss of radionuclides adsorbed on the deeper layers of 

the sediments that are assumed to be isolated from the water by the recently buried sediments. 

The surface water body is modeled as being continuously mixed throughout the year. The 

radionuclides dissolved in the water are modeled as being in adsorption-desorption equilibrium 

with the radionuclides in the suspended sediment and the radionuclides in the recent bottom 

sediments. The equations in Section J.2 (Yu et al. 2020) are used in the EXCEL spreadsheet for 

calculations. 

For comparing surface water concentration from the influx of dissolved radionuclides in 

the water intercepted from the aquifer, the rate at which radionuclide enters the surface water 

body with the water that is intercepted from the aquifer is taken from the code 

(GWtoSWFLUX.DAT). For comparing surface water concentration from the influx of 

radionuclides adsorbed on soil eroded from the primary contamination, the release in eroded 

material to surface runoff from the surface layer is taken from the code (SWFLUXIN.DAT). For 

comparing the surface water concentration from the influx of radionuclides transported by air, 

then deposited on the catchment, and ultimately washed out into the surface water body, the rate 

at which radionuclide is deposited over the catchment is taken from the code 

(SectorDepletedFraction.OUT). For comparing the surface water concentration from the influx 

of radionuclides transported by air and deposited on the surface water body, the release rate of 

radionuclide particulates in air from primary contamination was taken from the code 

(AIRFLUXIN.DAT). 

The RESRAD-ONSITE exponential release model is used. Test 1 is at all default 

parameter values except cover = 5 cm, primary contamination zone thickness = 15 cm. Figure 1 

shows the surface water concentration for 99Tc in Test Case 1. 
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In Test 2, cover = 0 cm, settling velocity of sediment = 0.01 cm/s, density of bottom 

sediment = 1.2 gm/cm3, volume of surface water body = 100,000 m3. Figure 2 shows the surface 

water concentration for 99Tc in Test Case 2. The surface water concentration from the 

spreadsheet calculations matches the code results, as shown in Figure 1 and Figure 2. The same 

calculations were repeated with 234U. The results are shown in Figure 3 and Figure 4 for Test 

Case 1 and Test Case 2, respectively.  

RESRAD-OFFSITE input files used in the surface water model are: SURF-WATER-

CHECK-TC99-TEST1.ROF, SURF-WATER-CHECK-TC99-TEST2.ROF, SURF-WATER-

CHECK-U234-TEST1.ROF, and SURF-WATER-CHECK-U234-TEST2.ROF, and the EXCEL 

spreadsheets that show the calculations are: “surface water conc verification-Tc99-test1.xlsx,” 

“surface water conc verification-Tc99-test2.xlsx,” “surface water conc verification-U234-

test1.xlsx,” and “surface water conc verification-U234-test2.xlsx.”  
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APPENDIX 6: VERIFICATION OF ACCUMULATION IN OFFSITE SURFACE SOIL 

A limited verification of the accumulation in offsite surface soil in the RESRAD-

OFFSITE code is performed. The radionuclide concentration in the surface soil for the principal 

radionuclide from the EXCEL spreadsheet calculation is compared with the code’s surface soil 

concentration.  

The code models the influx of radionuclides from the primary contamination in the 

surface soil layer at the offsite locations by three mechanisms: irrigation with contaminated 

water from the well or from the surface water body, deposition of contaminated particulates 

following atmospheric transport, and deposition of eroded material transported by runoff. At 

offsite locations, it considers mixing of the surface layer, erosion of the surface layer, linear 

adsorption-desorption partitioning between the solid and aqueous phases of the surface layer, and 

radiological transformations of each radionuclide and its parent radionuclides. 

Verification is accomplished for all three modes of entry of radionuclides into the surface 

soil for non-leafy vegetable field with 14C. Different radionuclides (137Cs for pasture and silage 

field, 41Ca for leafy vegetable field, and 60Co for grain field) were used to verify offsite soil 

concentrations at different offsite locations. For 14C, 137Cs, and 60Co surface water was used for 

irrigation and 41Ca groundwater was used for irrigation. The equations in Appendix J (Yu et al. 

2020) were used in an EXCEL spreadsheet for the calculations. 

For comparing offsite soil concentrations from the influx of radionuclides adsorbed on 

soil eroded from the primary contamination, the release in eroded material to surface runoff from 

the surface layer is taken from the code (SWFLUXIN.DAT). For comparing the offsite soil 

concentrations from the deposition of particulates containing radionuclides from the atmosphere, 

the concentration in air at an offsite location is taken from the code. For comparing the offsite 

soil concentration from irrigation, the irrigation water concentration is taken from the code. 

RESRAD-ONSITE exponential release model is used. Table A6.1 shows some of the 

input parameters used in RESRAD-OFFSITE code run. 
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Table A6.1 Input Parameters Used in RESRAD-OFFSITE Code Run 

Parameters Values 

Deposition velocity (m/s) 0.001 

Storage time (d) 0 

Precipitation rate (m/yr) 1 

Sediment delivery to offsite location 1 

Radionuclide Parameters 
 

14C half-life, yr 5730 
14C distribution coefficient (cm3/g) 0 
41Ca half-life (yr) 140000 
41Ca distribution coefficient (cm3/g) 50 
60Co half-life (yr) 5.271 
60Co distribution coefficient (cm3/g) 1000 
137Cs half-life (yr) 30 
137Cs distribution coefficient (cm3/g) 4600 

Offsite Soil Parameters in Different Agricultural Areas 
 

Fraction of area directly over primary contamination 0 

Irrigation applied (m/yr) 0.2 

Evapotranspiration coefficient 0.5 

Runoff coefficient 0.2 

Mixing depth (m) 0.15 

Volumetric water content 0.3 

Dry bulk density (g/cm3) 1.5 

Soil erodibility factor 0.4 

Slope-length-steepness factor 0.4 

Cover and management 0.003 

Support practice factor 1 

Duration of growing season for fruit, grain, and leafy vegetables (yr) 0.17 

Duration of growing season for leafy vegetables (yr) 0.25 

Duration of growing season for pasture and grass (yr) 0.08 

Duration of growing season for grain (yr) 0.17 

Weathering removal constant for all plant types (per yr) 20 

Foliar interception factor for irrigation for all plant typesa 0.25 

Foliar interception factor for dust for all plant types 0.25 

a For 14C, the foliar interception factor for irrigation = 0. 

The EXCEL spreadsheet calculations are in the following files: 

soil conc accumulation in leafy field-Ca-41.xlsx,  

soil conc accumulation in pasture field-Cs-137.xlsx,  

soil conc accumulation in grain field-Co-60.xlsx, and  

soil conc accumulation in nonleafy field-C-14.xlsx.  
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The seven RESRAD-OFFSITE input files used in the verification were: offsite-

accumulation-test1.rof, offsite-accumulation-test2.rof, offsite-accumulation-Test3.rof, offsite-

accumulation-Test4.rof, offsite-accumulation-Test4-air-dep-only.rof, offsite-accumulation-

Test4-erosion-only.rof, and offsite-accumulation-Test4-surface-water-only.rof. 

Figure A6.1 shows the comparison of 41Ca soil concentration in leafy vegetable field. The 

“offsite-accumulation-test1.rof” RESRAD-OFFSITE file is used, and the calculations are in the 

“soil conc accumulation in leafy field-Ca-41.xlsx” spreadsheet. 

 

Figure A6.1 Ca-41 Soil Concentration in Leafy Vegetable Field  
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Figure A6.2 shows the comparison of 137Cs soil concentration in the pasture and silage 

field. The “offsite-accumulation-test2.rof” RESRAD-OFFSITE file is used, and the calculations 

are in the “soil conc accumulation in pasture field-Cs-137.xlsx” spreadsheet. 

 

Figure A6.2 137Cs Soil Concentration in Pasture and Silage Field  
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Figure A6.3 shows the comparison of 60Co soil concentration in a grain field. The 

“offsite-accumulation-test3.rof” RESRAD-OFFSITE file is used, and the calculations are in the 

“soil conc accumulation in grain field-Co-60.xlsx” spreadsheet. 

 

Figure A6.3 60Co Soil Concentration in Grain Field  
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Figure A6.4 shows the comparison of 14C soil concentration in a nonleafy vegetables 

field. The “offsite-accumulation-test4.rof” RESRAD-OFFSITE file is used, and the calculations 

are in the “soil conc accumulation in nonleafy vegetable field-C-14.xlsx” spreadsheet. 

 

Figure A6.4 14C Soil Concentration in Fruit, Grain, and Nonleafy Vegetables Field  
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Figure A6.5 shows the comparison of 14C soil concentration in a nonleafy vegetables 

field from erosion in the primary contaminated area. The “offsite-accumulation-test4-erosion-

only.rof” RESRAD-OFFSITE file is used, and the calculations are in the “soil conc 

accumulation in nonleafy vegetable field-C-14.xlsx” spreadsheet. 

Figure A6.6 shows the comparison of 14C soil concentration in a nonleafy vegetables 

field from air particulate deposition. The “offsite-accumulation-test4-air-dep-only.rof” 

RESRAD-OFFSITE file is used, and the calculations are in the “soil conc accumulation in 

nonleafy vegetable field-C-14.xlsx” spreadsheet. 

Figure A6.7 shows the comparison of 14C soil concentration in a nonleafy vegetables 

field from irrigation with contaminated surface water. The “offsite-accumulation-test4-surface 

water only.rof” RESRAD-OFFSITE file is used, and the calculations are in the “soil conc 

accumulation in nonleafy vegetable field-C-14.xlsx” spreadsheet. 

 

Figure A6.5 14C Soil Concentration in Fruit, Grain, and Nonleafy Vegetables Field from 

Erosion 
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Figure A6.6 14C Soil Concentration in Fruit, Grain, and Nonleafy Vegetables Field from Air 

Particulate Deposition 

 

Figure A6.7 14C Soil Concentration in Fruit, Grain, and Nonleafy Vegetables Field from 

Irrigation  
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APPENDIX 7: VERIFICATION OF PLANT, MEAT, MILK, AND AQUATIC FOOD 

CONCENTRATIONS AND INGESTION PATHWAY DOSES 

Verification of the accumulation of radionuclides in plants, meat, milk, and aquatic foods 

in RESRAD-OFFSITE code is performed for 90Sr. The concentrations along with intake rates 

and ingestion dose coefficient are used to calculate pathway doses. 

The code models the root uptake from the primary and secondary contaminations, the 

foliar interception of particulates released from the primary contamination but not from the 

secondary contamination, foliar interception of contaminated irrigation water, translocation of 

the radionuclides intercepted by the foliage to the edible part of the plant, and losses due to 

weathering. The code models two classes of vegetables (leafy and fruit, grain, and nonleafy) and 

two classes of animal feed (grain and pasture and silage). 

The code computes the concentrations of the radionuclides in meat and milk using 

transfer factors that are in essence ratios of the concentrations to the intake rates. It models the 

intake of radionuclides from ingesting livestock feed and water and the incidental ingestion of 

soil with the feed. 

The code computes the concentrations of the radionuclides in two classes of aquatic 

food—fish and crustaceans—using transfer factors or bioaccumulation factors. These factors are 

simply the ratios of the concentrations in the aquatic food to the concentrations in the water 

where the fish lived. 

The formulations as described in Appendix J (J.4, J.5, and J.6) of RESRAD-OFFSITE 

Manual (Yu et al. 2020) were used in the EXCEL spreadsheet for calculating food 

concentrations (plant-meat-milk-aquatic-food-conc-verification-comprehensive-sr90.xlsx). The 

spreadsheet results are compared with the concentrations available in the deterministic graphics. 

The formulations as described in Section 4.4 of the RESRAD-OFFSITE Manual 

(Yu et al. 2020) were used in the EXCEL spreadsheet for calculating the ingestion pathway dose 

from food and water. 

The RESRAD-OFFSITE exponential release model is used. It is assumed surface water is 

used for human consumption, animal intake, and irrigation. The eroded material from primary 

contamination by runoff is deposited in the surface water body. The site layout, atmospheric 

parameters, and surface water body parameters are kept at code defaults. Table 1 lists other 

parameters used in calculating plant, meat, milk, and aquatic food concentrations and pathway 

doses. 
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Table 1 Parameters Used in Food Concentrations and Ingestion Pathway 

Dose Calculations 

Radionuclide and Radionuclide Specific Parameters 90Sr 

Half-life (yr) 29.12 

Cut-off half-life (d) 30 

Distribution coefficient (cm3/g) 30 

Plant root uptake transfer factor (pCi/kg per pCi/kg) 0.3 

Meat transfer factor (pCi/kg per pCi/d) 0.008 

Milk transfer factor (pCi/L per pCi/d) 0.002 

Fish bioaccumulation factor (pCi/kg per pCi/L) 60 

Crustacea bioaccumulation factor 100 

General Parameters  Values 

Deposition velocity of all particulates (m/s) 0.001 

Storage time (d) 0 

Precipitation rate (m/yr) 1 

Depth of soil mixing layer (m) 0.15 

Contaminated zone thickness (m)  

Cover thickness (m)  

Dry bulk density of contaminated zone and cover (g/cm3) 1.5 

Soil erodibility factor for contaminated zone and cover 0.4 

Slope-length-steepness factor 0.4 

Cover and management 0.003 

Support practice factor 1 

Irrigation applied (m/yr) 0.2 

Evapotranspiration coefficient 0.5 

Runoff coefficient 0.2 

Offsite Soil Parameters in Different Agricultural Areas  
Fraction of area directly over primary contamination 0 

Irrigation applied (m/yr) 0.2 

Evapotranspiration coefficient 0.5 

Runoff coefficient 0.2 

Mixing depth (m) 0.15 

Volumetric water content 0.3 

Dry bulk density (g/cm3) 1.5 

Soil erodibility factor 0.4 

Slope-length-steepness factor 0.4 

Cover and management 0.003 

Support practice factor 1 
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Table 1 (Cont.) 

Plant Accumulation Parameters  
Wet crop yield for fruit, grain, and leafy vegetables (kg/m2) 0.7 

Wet crop yield for leafy vegetables (kg/m2) 1.5 

Wet crop yield for pasture and silage (kg/m2) 1.1 

Wet crop yield for grain (kg/m2) 0.7 

Foliage to food transfer coefficient for fruit, grain, and leafy vegetables 0.1 

Foliage to food transfer coefficient for leafy vegetables 1.0 

Foliage to food transfer coefficient for pasture and grass 1.0 

Foliage to food transfer coefficient for grain 0.1 

Duration of growing season for fruit, grain, and leafy vegetables (yr) 0.17 

Duration of growing season for leafy vegetables (yr) 0.25 

Duration of growing season for pasture and grass (yr) 0.08 

Duration of growing season for grain (yr) 0.17 

Weathering removal constant for all plant types (per yr) 20 

Foliar interception factor for irrigation for all plant types 0.25 

Foliar interception factor for dust for all plant types 0.25 

Meat and Milk Cow Intake Parameters  
Beef cattle water intake (L/d) 50 

Dairy cow water intake (L/d) 160 

Beef cattle pasture intake (kg/d) 14 

Dairy cow pasture intake (kg/d) 44 

Beef cattle grain intake (kg/d) 54 

Dairy cow grain intake (kg/d) 11 

Beef cattle soil intake from pasture and silage (kg/d) 0.1 

Dairy cow soil intake from pasture and silage (kg/d) 0.4 

Beef cattle soil intake from grain (kg/d) 0.4 

Dairy cow soil intake from grain (kg/d) 0.1 

Dose Coefficient  
Ingestion dose coefficient (mrem/pCi) 0.0001136 

Human Consumption Parameters 
 

Drinking water (L/yr) 510 

Fish intake (kg/yr) 5.4 

Crustacea intake (kg/yr) 0.9 

Non-leafy vegetable intake 160 

Leafy vegetable intake 14 

Meat intake (kg/yr) 63 

Milk intake (L/yr) 92 

Soil intake (g/yr) 36.5 

Fraction from Affected Area 
 

CF drinking water 1 

CF fish 0.5 

CF crustacea 0.5 

CF non-leafy 0.5 

CF meat 1 

CF milk 1 
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Separate EXCEL spreadsheets for calculating surface water concentration and 

accumulation in different offsite agricultural areas were created for 90Sr contamination and were 

used in this verification. The surface water model and the accumulation in offsite locations were 

verified separately. 

Plant Concentration Comparisons 

For calculating plant concentrations, it is assumed plants are grown in agricultural areas 

that are not on primary contamination. The soil concentration in agricultural areas is taken from 

spreadsheets “soil conc accumulation in nonleafy field-Sr-90.xlsx,” “soil conc accumulation in 

leafy field-Sr-90.xlsx,” “soil conc accumulation in pasture field-Sr-90.xlsx,” and “soil conc 

accumulation in grain field-Sr-90.xlsx” in the “Soil accumulation in agricultural areas” 

subfolder; surface water concentration is taken from the spreadsheet “surface water conc 

verification-sr90.xlsx” in the “surface water concentration calculations” subfolder. The other 

inputs used in the EXCEL spreadsheet include the release rate to air from primary contamination 

(AIRFLUXIN.DAT), erosion release (SWFLUX.DAT), and CHIOVERQ files (intermediate 

results generated in the code). 

Figures 1-4 show the comparison of the calculated plant concentrations using the EXCEL 

spreadsheet in four different types of plants with the concentrations from the code. The detailed 

comparison is in the EXCEL spreadsheet “plant-meat-milk-aquatic-food-conc-verification-

comprehensive-sr90.xlsx” under the “plant food concentration” worksheet. The EXCEL 

spreadsheet calculations in general match the code output. 
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Meat and Milk Concentrations Comparison 

For calculating meat and milk concentrations, the soil concentration in the livestock feed 

areas is taken from spreadsheets “soil conc accumulation in pasture field-Sr-90.xlsx” and “soil 

conc accumulation in grain field-Sr-90.xlsx” in the “Soil accumulation in agricultural areas” 

subfolder; surface water concentration is taken from the spreadsheet “surface water conc 

verification-sr90.xlsx” in the “surface water concentration calculations” subfolder; and the 

pasture and grain concentration is taken from the “plant food concentration” worksheet. The 

calculated meat and milk concentrations are in the “meat and milk concentration” worksheet in 

the “plant-meat-milk-aquatic-food-conc-verification-comprehensive-sr90.xlsx” EXCEL 

spreadsheet. 

Figures 5 and 6 compare the calculated meat and milk concentrations using the EXCEL 

spreadsheet with the concentrations from the code. The detailed comparison is in the EXCEL 

spreadsheet “plant-meat-milk-aquatic-food-conc-verification-comprehensive-sr90.xlsx” under 

the “meat and milk concentration” worksheet. The EXCEL spreadsheet calculations in general 

match the code output. 
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Aquatic Food Concentrations Comparison 

For calculating aquatic food (fish and crustacea) concentrations, the surface water 

concentration is taken from the spreadsheet “surface water conc verification-sr90.xlsx” in the 

“surface water concentration calculations” subfolder. The calculated fish and crustacean 

concentrations are in the “aquatic food concentration” worksheet in the “plant-meat-milk-

aquatic-food-conc-verification-comprehensive-sr90.xlsx” EXCEL spreadsheet. 
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Ingestion Pathway Doses from Food and Water 

For calculating the ingestion pathway dose from food and water, the surface water 

concentration is taken from the spreadsheet “surface water conc verification-sr90.xlsx” in the 

“surface water concentration calculations” subfolder. The plant food concentrations are taken 

from the “plant food concentration” worksheet; the meat and milk concentrations are taken from 

the “meat and milk concentration” worksheet; and the aquatic food concentrations are taken from 

the “aquatic food concentration” worksheet. The calculated ingestion pathway doses are in the 

“ingestion pathway doses” worksheet in the “plant-meat-milk-aquatic-food-conc-verification-

comprehensive-sr90.xlsx” EXCEL spreadsheet. 

The instantaneous dose rates calculated at the calculation time points are used to calculate 

the time-integrated dose over a period of 1 year, as described in Appendixes E.1 and E.2 of the 

RESRAD-OFFSITE Manual (Yu et al. 2020), and compared with the code results. Figures 9-13 

compare the EXCEL spreadsheet integrated dose with the code results from different foods and 

water ingestion. 
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APPENDIX 8: VERIFICATION OF SOIL INGESTION PATHWAY DOSE 

RESRAD-OFFSITE computes the exposure from the incidental ingestion of soil by 

summing the product of the dose conversion factor or slope factor for the radionuclide from the 

chosen dose factor library, the incidental ingestion rate of the soil, the fraction of time spent at 

the onsite or offsite location, and the concentration of the radionuclide in the soil at the onsite or 

offsite location. For the onsite location, if the area is less than 1000 m2, an area factor correction 

(ratio of contaminated area/1,000) is applied. 

For verifying soil ingestion pathway doses, four test cases are used. In all four test cases, 

the ICRP-38 nuclide database and FGR-11 internal dose library are used. Table A8.1 lists some 

of the parameters that are different from the code defaults used in the dose calculations. For two 

test cases, the receptor was outside on the primary contaminated area, and for the other two test 

cases, the receptor was in different agriculture fields. Table A8.1 also lists the input files used in 

different runs. 

Soil Ingestion When Receptor Is on Primary Contamination 

For verifying the dose when the receptor was on the primary contamination, two test 

cases (soil-ingestion-1.rof and soil-ingestion-2.rof) were used. The receptor was placed outside 

on the primary contamination, and the contaminated area, thickness, and cover thickness were 

varied. Table A8.1 lists the parameters used in the run that are different from the code defaults. 

Only the soil ingestion pathway was kept active in the run, and the soil ingestion pathway dose 

for two radionuclides with varying half-lives was noted from the graphic interface. The graphic 

interface results for the soil ingestion pathway doses were compared with the calculated dose 

from the EXCEL spreadsheet results. 

For EXCEL spreadsheet calculations, the primary contamination soil concentration was 

taken from the code (graphic interface) and the surface layer concentration was calculated. The 

surface layer concentration along with the area factor, occupancy factor, soil ingestion rate, and 

ingestion dose coefficients were used to calculate the soil ingestion dose. The detailed 

calculations are in two EXCEL spreadsheets (soil-ingestion-pathway-onsite-receptor-case1 and 

soil-ingestion-pathway-onsite-receptor-case2). Figures A8.1-A8.4 compare the calculated soil 

ingestion dose with the soil ingestion dose from the code. 
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Figure A8.1 Soil Ingestion Dose Comparison for 26Al Contamination – Case 1 

 

Figure A8.2 Soil Ingestion Dose Comparison for 137Cs Contamination – Case 1 
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Figure A8.3 Soil Ingestion Dose Comparison for 26Al Contamination – Case 2 

 

Figure A8.4 Soil Ingestion Dose Comparison for 137Cs Contamination – Case 2 
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Soil Ingestion When Receptor Is Offsite 

For verifying dose when the receptor was offsite, two test cases (soil-ingestion-3.rof and 

soil-ingestion-4.rof) were used. In Case 3, the receptor was placed outside in the pasture and 

silage field, and in Case 4, the receptor was placed outside in the non-leafy agricultural area. 

Table A8.1 lists the parameters used in the run that are different from the code defaults. Only the 

soil ingestion pathway was kept active in the run, and the soil ingestion pathway dose for two 

radionuclides with varying half-lives was noted from the graphic interface. The graphic interface 

results for inhalation pathway doses were compared with the calculated dose from the EXCEL 

spreadsheet results. 

For EXCEL spreadsheet calculations, the soil concentration in agricultural areas was 

taken from the code (graphic interface). The soil concentration in agricultural areas along with 

the occupancy factor, soil ingestion rate, and ingestion dose coefficients were used to calculate 

the soil ingestion dose. The detailed calculations are in the EXCEL spreadsheets (soil-ingestion-

pathway-offsite-receptor). Figures A8.5-A8.8 compare the calculated soil ingestion dose with the 

soil ingestion dose from the code. 

 

Figure A8.5 Soil Ingestion Dose Comparison for 26Al Contamination – Case 3 
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Figure A8.6 Soil Ingestion Dose Comparison for 137Cs Contamination – Case 3 

 

Figure A8.7 Soil Ingestion Dose Comparison for 60Co Contamination – Case 4 
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Figure A8.8 Soil Ingestion Dose Comparison for 54Mn Contamination – Case 4 

Table A8.1 Parameters Used in Different Test Cases That Are Different from Code Defaults 

Test 

Case 

Receptor 

Occupancy & 

Location 

Radionuclides 

Selected 
PC Parameters 

Cover 

Parameters 

Sediment 

Deliver 

Ratio 

RESRAD-

OFFSITE 

Input File 

1 
100% outside on 

PC 
26Al and 137Cs 

Area = 100 m2, 

thickness = 0.05 m, 

density = 1.6 g/cm3  

None  None 

soil-

ingestion-

1.rof 

2 
100% outside on 

PC 
26Al and 137Cs 

Thickness = 0.5 m, 

density = 1.6 g/cm3  

Thickness = 

0.05 m 
None 

soil-

ingestion-

2.rof 

3 

100% time in 

pasture field 

(1450 m away 

from PC) 

26Al and 137Cs 

Thickness = 0.05 

m, density = 1.6 

g/cm3  

None  

100% to 

pasture 

field 

soil-

ingestion-

3.rof 

4 

100% time in 

non-leafy field 

(Code default 

location) 

60Co and 54Mn 

Thickness = 0.05 

m, density = 1.6 

g/cm3,  

None  

100% to 

non-leafy 

field 

soil-

ingestion-

4.rof 

Note: 26Al Kd was changed from default to 1000 cm3/g in the contaminated zone in Test Cases 1-3.  
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APPENDIX 9: VERIFICATION OF PARTICULATE INHALATION PATHWAY DOSE 

The code calculates the inhalation pathway dose/risk from the primary contamination and 

the secondary contamination for indoor and outdoor receptors. The inhalation pathway dose is 

the product of dose conversion factor or slope factor for the radionuclide from the chosen dose 

factor library, an occupancy and indoor filtration factor to account for the time spent at the 

location and for the filtration of dust by any building components while indoors, the inhalation 

rate, and the concentration of the radionuclide in air at the exposure location. 

The concentration of radionuclides in the air above the primary contamination depends 

on the mass loading of particulates in the air above the primary contamination, the concentration 

of radionuclides in the surface soil, and the area factor that accounts for uncontaminated dust 

from outside the primary contamination. For calculating the area factor, it is assumed a very 

large area is contaminated. The concentration of radionuclides attached to respirable particulates 

in the air above the primary contamination is the product of the respirable fraction of particulates 

and the total air concentration. 

The concentration of radionuclides in air at an offsite location has two components. The 

first is the concentration of radionuclides attached to particulates released from the primary 

contamination and transported by air to the offsite location. The second is the concentration of 

radionuclides attached to particulates that are re-suspended from the accumulation at the offsite 

location. 

For verifying inhalation pathway doses, four test cases are used. In all four test cases, the 

ICRP-107 nuclide database and the DCFPAK3.02 adult internal dose library are used. 

Table A9.1 list the parameters that are different from the code defaults used in dose calculations. 

For two test cases, the receptor was outside on the primary contaminated area, and for other two 

test cases, the receptor was on the dwelling site. Table A9.1 also lists input files used in different 

runs. 

Table A9.1 Parameters That Are Different from Code Defaults in the Test Cases 

Test 

Case 

Receptor Occupancy 

& Location 

Radionuclides 

Selected 

Primary 

Contamination 

Parameters 

Cover 

Parameters 

RESRAD-

OFFSITE Input 

File 

1 100% outside on PC 26Al and 137Cs 

Area = 1000000 m2, 

thickness = 0.5 m, 

density = 1.6 g/cm3  

None  

inhalation-1.rof 

2 100% inside on PC 26Al and 137Cs 

Area = 100 m2, 

thickness = 0.1 m, 

density = 1.6 g/cm3  

Thickness = 

0.05 m  
inhalation -2.rof 

3 
100% time outside 

on the dwelling site 
26Al and 137Cs 

Thickness = 0.5 m, 

density = 1.6 g/cm3  
None  

inhalation -3.rof 

4 
100% time inside on 

the dwelling site 
26Al and 137Cs None  None  

inhalation -4.rof 
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Inhalation Dose When Receptor Is on Primary Contamination 

For verifying dose when the receptor was on the primary contamination, two test cases 

(inhalation-1.rof and inhalation-2.rof) were used. The receptor was placed outside/inside on the 

primary contamination, and the contaminated area, thickness, and cover thickness were varied. 

Table A9.1 lists the parameters used in the run that are different from the code defaults. Only the 

inhalation pathway was kept active in the run, and the inhalation pathway dose for two 

radionuclides with varying half-lives was noted from the graphic interface. The graphic interface 

results for the inhalation pathway doses were compared with the calculated dose from the 

EXCEL spreadsheet results. 

For EXCEL spreadsheet calculations, the primary contamination soil concentration was 

taken from the code (graphic interface) and the surface layer concentration and air concentration 

above the primary contamination were calculated. The air concentration along with the respirable 

fraction, area factor, occupancy factor, inhalation rate, and inhalation dose coefficients were used 

to calculate the inhalation pathway dose. The detailed calculations are in two EXCEL 

spreadsheets (“inhalation-pathway-onsite-receptor-case1” and “inhalation-pathway-onsite-

receptor-case2”). Figures A91-A9.4 compare the calculated inhalation pathway dose with the 

inhalation pathway dose from the code. 

 

Figure A9.1 Inhalation Dose Comparison for 26Al Contamination – Case 1 
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Figure A9.2 Inhalation Dose Comparison for 137Cs Contamination – Case 1 

 

Figure A9.3 Inhalation Dose Comparison for 26Al Contamination – Case 2 
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Figure A9.4 Inhalation Dose Comparison for 137Cs Contamination – Case 2 

Inhalation Dose When Receptor Is offsite 

For verifying dose when the receptor was offsite, two test cases (inhalation-3.rof and 

inhalation-4.rof) were used. In Case 3, the receptor was placed outside on the dwelling site, and 

in Case 4, the receptor was placed inside on the dwelling site. Table A9.1 lists the parameters 

used in the run that are different from the code defaults. Only the inhalation pathway was kept 

active in the run, and the inhalation pathway dose for two radionuclides with varying half-lives 

was noted from the graphic interface. The graphic interface results for the inhalation pathway 

doses were compared with the calculated dose from the EXCEL spreadsheet results. 

In the EXCEL spreadsheet, the air concentration at the offsite location was calculated for 

both components. The concentration of radionuclides attached to particulates released from the 

primary contamination and transported by air to the offsite location was calculated from the 

release rate of the radionuclides from the primary contamination and CHIOVERQ. CHIOVERQ 

was taken from the code (from the CHIOVERQ.OUT file generated after the run in the code’s 

root directory), and the air release rate from the primary contamination was calculated. For 

calculating the air release rate from the primary contamination, first, the surface layer 

concentration was calculated. For calculating the surface layer concentration, the primary 

contamination concentration was taken from the graphic interface. 

The concentration of radionuclides attached to particulates that are re-suspended from the 

accumulation at the offsite location was calculated from the offsite soil concentration and the 

mass loading of particulates at the offsite location. The offsite location soil concentration was 

taken from the code (graphical interface).  
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Figure A9.5 Inhalation Dose Comparison for Al-26 Contamination – Case 3 

The air concentration at the offsite location along with the respirable fraction, occupancy 

factor, inhalation rate, and inhalation dose coefficients were used to calculate the inhalation 

pathway dose. The code dose results were taken from the graphic interface. The detailed 

calculations are in the EXCEL spreadsheets (inhalation-pathway-offsite-receptor). 

Figures A9.5-A9.8 compare the calculated inhalation dose with the inhalation dose from the 

code. 
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Figure A9.6 Inhalation Dose Comparison for 137Cs Contamination – Case 3 

 

Figure A9.7 Inhalation Dose Comparison for 26Al Contamination – Case 4 
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Figure A9.8 Inhalation Dose Comparison for 137Cs Contamination – Case 4  
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APPENDIX 10: VERIFICATION OF EXTERNAL MODEL AND EXTERNAL 

EXPOSURE PATHWAY DOSE 

RESRAD-OFFSITE calculates the external pathway dose/risk from the primary 

contamination and secondary contamination for indoor and outdoor receptors. The exposure for 

each of the situations is computed as the product of the following: 

• The dose conversion factor or slope factor for external radiation, for a volume source of 

infinite thickness and infinite area, from the chosen dose factor library ([mrem/yr]/[pCi/g] 

or [risk/yr]/[pCi/g]); 

• The concentration of the radionuclide in the soil (pCi/g); 

• An occupancy and indoor shielding factor to account for the time spent at the location 

and for the shielding from any building components while indoors; 

• A cover and depth factor to account for the finite thickness of the contamination and for 

any intervening clean cover between the contamination and the receptor; and 

• An area and shape factor to account for the finite area and shape of the contaminated soil 

and for the position (location) of the receptor in relation to the contaminated area. 

All the above factors, with the exception of the occupancy factor, depend on the 

radionuclide. The shape of the primary contamination can be specified to be circular or 

polygonal. The location of the onsite and offsite dwellings in relation to the primary 

contamination can also be specified. The offsite areas (dwelling and agricultural areas) are 

assumed to be circular, with the receptor located at the center of the circle, when calculating the 

exposure from external radiation. 

For verifying the external model and the external exposure pathway doses, four test cases 

are used. In all four test cases, the ICRP-38 nuclide database and the FGR-12 external exposure 

dose library are used.  

External dose from Primary Contamination 

For verifying the dose from primary contamination, two test cases (external-1.rof and 

external-2.rof) were used. The receptor was placed outside on the primary contamination, and the 

contaminated area and thickness were varied. The yearly average external pathway dose for 

seven radionuclides with varying half-lives was estimated with the RESRAD-OFFSITE code and 

compared with the calculated dose at time zero. For calculations, the dose was taken from the 

ANL/EAD/TM-84 (Kamboj et al. 1998) report and was corrected for decay. The code results 

were taken from the summary report. Table A10.1 shows the comparison. The dose results 

obtained with the code match (less than 1% difference) the calculated results. 
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Table A10.1 Comparison of External Exposure Pathway Dose for Onsite Receptor 

        
Source area = 1000000 m2, thickness = 
50 cm Source radius = 100 m2, thickness = 5 cm 

Radionu
clide Half-life, yr 

Decay 
Constant 
(/yr) 

Yearly 
Average 
Concentrat
ion, pCi/g 

Yearly 
Dose 
(Code), 
mrem/yr 

Calculated, 
mrem/yr 

ANL/EAD
/TM-84, 
mrem/yr 

Yearly 
Dose 
(Code), 
mrem/yr 

Calculated, 
mrem/yr 

ANL/EAD/T
M-84, 
mrem/yr 

26Al 7.16E+05 9.68E-07 1.00E+00 1.73E+01 1.73E+01 1.73E+01 5.82E+00 5.92E+00 5.92E+00 

57Co 7.42E-01 9.35E-01 6.50E-01 3.31E-01 3.26E-01 5.01E-01 1.87E-01 1.84E-01 2.83E-01 

60Co 5.27E+00 1.32E-01 9.37E-01 1.51E+01 1.52E+01 1.62E+01 5.20E+00 5.20E+00 5.55E+00 

137Cs 3.00E+01 2.31E-02 9.89E-01 3.37E+00 3.37E+00 3.41E+00 1.32E+00 1.31E+00 1.33E+00 

54Mn 8.56E-01 8.10E-01 6.85E-01 3.57E+00 3.54E+00 5.16E+00 1.34E+00 1.32E+00 1.93E+00 

234U 2.45E+05 2.83E-06 1.00E+00 4.01E-04 4.02E-04 4.02E-04 2.71E-04 2.86E-04 2.86E-04 

235U 7.04E+08 9.85E-10 1.00E+00 7.57E-01 7.57E-01 7.57E-01 3.90E-01 3.85E-01 3.85E-01 

Note: Used high Kd in contaminated zone (at least 1000 cm3/g), very less erosion (support practice factor = 0.001). 

The code results are taken from the summary report (page 44) at time zero after the run. 

The dose results in ANL/EAD/TM-84 are at time zero for the instantaneous dose (do not account for yearly average). 

The calculated results correct ANL/EAD/TM-84 results for the yearly average dose. 

External Dose from Secondary Contamination 

For comparing the external dose from the secondary contamination, two test cases 

(external-3.rof and external-4.rof) were developed. In both test cases, the secondary 

contaminated areas were very far, so there was no direct external exposure. In one case,  the 

receptor was located 100% of the time in the pasture and silage field (external-3.rof), and in the 

other case, the receptor was located 100% of the time in the non-leafy vegetable field (external-

4.rof). Only the external exposure pathway was active. The code-generated external pathway 

dose from the graphical interface was compared with the calculated dose. For calculating dose, 

the soil concentration in the agricultural field was taken from the code and the depth-cover-factor 

and area-shape factors were taken from the ANL/EAD/TM-84 report for different radionuclides. 

Figures A10.1-A10.4 compare the results. The detailed calculations are in the external-exposure-

pathway.xlsx spreadsheet. 
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Figure A10.1 External Dose from 26Al Contamination in Pasture and Silage Field 

 

Figure A10.2 External Dose from 137Cs Contamination in Pasture and Silage Field 
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Figure A10.3 External Dose from 60Co Contamination in Non-leafy Vegetable Field 

 

Figure A10.4 External Dose from 54Mn Contamination in Non-leafy Vegetable Field 
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APPENDIX 11: TEST CASES FOR RELEASE TESTING OF 

RESRAD-OFFSITE VERSION 4.0 

The test cases were copied from the test case, quality control, and quality assurance document. 

The testers were to perform the test as stipulated in the document. These test cases are reproduced here 

without editing to retain the text in the test case document in order to maintain authenticity.  

 

11.1 TEST CASE 001 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-001 

Test 

Summary 

Test installation and operation on various operating systems 

Created 

By/Date 

DJL 8/22/2019 

Test 

Objective 

Test installation and operation on various operating systems 

Procedure Install and run software on the range of operating systems the version is designed for. Note and 
document any issues.  Specifically test for font installation. 

Steps: 

• Install 

• Look at ReadMe 

• Launch code 

• Run QA file, BASIC RESRAD-OFFSITE INSTALLATION QA.ROF ( up one folder level, then in 

the QAFiles folder.  Make sure folder is the one just installed.) 

• Open graphics, report, look at font 

• Do file comparison in DOS (fc like below) or equivalent for a set of output result files. 
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Required 

Data 

 

Expected 

Results 

Successful installations. Should see only expected differences (e.g., date and time in reports) 
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11.2 TEST CASE 002 

 

Project RESRAD-OFFSITE 

Test Case ID RESOFF-TEST-002 

Test Summary Tests OFFSITE Nuclide Decay and Ingrowth 

Created By/Date DJL 11/14/2019 

Test Objective Test features of OFFSITE Nuclide Decay and Ingrowth 

Procedure Run case 1, compare to expected results below, consult 
Verification report and V&V folder: ‘NRC7038_Source Term’ 

Required Data VROFF_Case1.ROF 

Expected Results Verification of RESRAD-OFFSITE Verification Report, Table 2.10 (below) 
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11.3 TEST CASE 003-001 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-003-001 

Test 

Summary 
Tests OFFSITE Source Term Mixing Concentration 

Created 

By/Date 

DJL 7/29/2019 

Test 

Objective 

Test features of OFFSITE Source Term Mixing Concentration 

Procedure Run case 2, compare with expected results, consult Verification report and V&V folder: 
‘NRC7038_Source Term’ 

Required 

Data 

VROFF_Case2.ROF 

Expected 

Results 

Verification of RESRAD-OFFSITE Table 2.5  (below) 
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11.4 TEST CASE 003-002 

 

Project RESRAD-OFFSITE 

Test Case ID RESOFF-TEST-003-002 

Test Summary Tests OFFSITE Source Term Mixing Concentration 

Created By/Date DJL 7/29/2019 

Test Objective Test features of OFFSITE Source Term Mixing Concentration 

Procedure Run case 3, compare with expected results, consult Verification report and V&V 
folder: ‘NRC7038_Source Term’ 

Required Data VROFF_Case3.ROF 

Expected Results 

 

Verification of RESRAD-OFFSITE Table 2.6  (below) 
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11.5 TEST CASE 003-003 

 

Project RESRAD-OFFSITE 

Test Case ID RESOFF-TEST-003-003 

Test Summary Tests OFFSITE Source Term Mixing Concentration 

Created By/Date DJL 7/29/2019 

Test Objective Test features of OFFSITE Source Term Mixing Concentration 

Procedure Run case 8, compare with expected results, consult Verification report and V&V 

folder: ‘NRC7038_Source Term’ 

Required Data VROFF_Case8.ROF 
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Expected Results 

 

Verification of RESRAD-OFFSITE Table 2.8  (below) 
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11.6 TEST CASE 005 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-005 

Test 

Summary 

 

Tests OFFSITE Source Term Leaching 

Created 

By/Date 

DJL 7/29/2019 

Test 

Objective 

Test features of OFFSITE Source Term Leaching 

Procedure Run cases 1; compare with expected results, consult Verification report and V&V folder: 
‘NRC7038_Source Term’ 

 

Required 

Data 

VROFF_Case1.ROF 
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Expected 

Results 

Verification of RESRAD-OFFSITE Table 2.16 (below) 
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11.7 TEST CASE 020-001 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-020-001 

Test 

Summary 

 

Tests OFFSITE gaseous and particulate C-14 inhalation pathways 

Created 

By/Date 

DJL 1/14/20 (based on EG verification) 

Test 

Objective 

Test features of OFFSITE gaseous and particulate C-14 inhalation pathways 

Procedure Run file; compare with expected results, consult Verification report and V&V folder: ‘Special 
radionuclides’ 

 

Required 

Data 

‘INHALATION OF CARBON-14.ROF’ 

Expected 

Results 

‘C14 inhalation.xlsx’ in ‘Special radionuclides’ V&V folder 
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11.8 TEST CASE 020-002 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-020-002 

Test 

Summary 

 

Tests OFFSITE tritium inhalation pathways 

Created 

By/Date 

DJL 1/14/20 (based on EG verification) 

Test 

Objective 

Test features of OFFSITE tritium inhalation pathways 

Procedure Run file; compare with expected results, consult Verification report and V&V folder: ‘Special 
radionuclides’ 

 

Required 

Data 

‘INHALATION OF HYDROGEN-3.ROF’ 

Expected 

Results 

‘H3 inhalation.xlsx’ in ‘Special radionuclides’ V&V folder 
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11.9 TEST CASE 020-003 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-020-003 

Test 

Summary 

 

Tests OFFSITE Rn-222 inhalation pathways 

Created 

By/Date 

DJL 1/14/20 (based on EG verification) 

Test 

Objective 

Test features of OFFSITE Rn-222 inhalation pathways 

Procedure Run file; compare with expected results, consult Verification report and V&V folder: ‘Special 
radionuclides’ 

 

Required 

Data 

‘RN222 FROM HOUSEHOLD WATER USE.ROF’ 

Expected 

Results 

‘Rn 222 household water.xlsx’ in ‘Special radionuclides’ V&V folder 
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11.10 TEST CASE 020-004 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-020-004 

Test 

Summary 

 

Tests OFFSITE Rn-220 inhalation pathways 

Created 

By/Date 

DJL 1/14/20 (based on EG verification) 

Test 

Objective 

Test features of OFFSITE Rn-220 inhalation pathways 

Procedure Run file; compare with expected results, consult Verification report and V&V folder: ‘Special 
radionuclides’ 

 

Required 

Data 

‘RN220 FROM HOUSEHOLD WATER USE.ROF’ 

Expected 

Results 

‘Rn 220 household water.xlsx’ in ‘Special radionuclides’ V&V folder 
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11.11 TEST CASE 027-001 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-27-001 

Test 

Summary 

Test the presentation of output reports.  

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the presentation of output reports. 

Procedure 1) Run the code with initial concentration of 100 pCi/g for U-238. 

2) Three report files should be generated: Summary.rep, DAUDOSE.REP, and 

INTRISK.REP 

3) Open Summary.rep from report Reviewer, and check the following 

a. whether it includes Code name, version, T½ limit, running time, and page number, 

report type (Parent Dose Report), title, and input file name on each page 

b. Table of Contents should include the following elements and their corresponding 

page numbers. 

i. DCF summary including DCF library, the values involved in the calculation 

including current values, default value, and parameter name 

ii. Site-specific parameter summary, echoing all the inputs parameters and 

some calculated intermediate parameters, including input value, default 

value, code computed value, and parameter name.  

iii. Contaminated zone and Total Dose Summary: size and dimensions, initial 

radionuclides and concentrations, total dose at each report time, and 

maximum total dose. 

iv. Total Dose Components for each report time: dose contribution for each 

radionuclide and pathway 

v. Dose/Source Ratios Summed Over All Pathways 

vi. Single Radionuclide Soil Guidelines 

vii. Dose Per Nuclide Summed Over All Pathways 

viii. Soil Concentration Per Nuclide 

ix. Run Time Information 
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4) Open DAUDOSE.REP and check the following 

a. whether it includes Code name, version, T½ limit, running time, and page number, 

report type (Parent Dose Report), title, and input file name on each page 

b. Table of Contents should include total dose components summed to progeny: Total 

Dose Contribution for each individual Radionuclides and Pathways  

5) Open INTRISK.REP and check the following 

a. whether it includes Code name, version, T ½ limit, running time, and page number, 

report type (Parent Dose Report), title, and input file name on each page 

b. Table of Contents should include  

i. Cancer Risk Slope Factors summary table should include library name, and 

parameter values (current value and default) and parameter name 

ii. Excess Cancer Risk for each individual radionuclide and pathway at each 

report time 

Required 

Data 

None. 

Expected 

Results 

The reports should have the required content and format.  
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11.12 TEST CASE 027-002 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESROFF-TEST-27-002s 

Test 

Summary 

Test the functionality of report Viewer 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of report Viewer 

Procedure 1) Run the code with initial concentration of 100 pCi/g for Ac-227. 

2) Click View->Text Output -> Parent Dose Report, the report Viewer should pop up and 

open SUMMARY.REP file.  

3) The File menu should function as its self-description. 

4) Edit menu should enable to select and copy of the present page 

5) Help menu should open the help file for the code with Report Viewer topic page opened.  

6) The Tool bar icons are also self-explained.  

a. The page up/down should work.  

b. Put the cursor on the page number box, type 3, and the press Enter key, and Page 3 

should present. 

c. Click the dropdown arrow of page number, a list of pages should appear, select 8, 

and click Enter key. Page 8 should present.  

7) Repeat Step 2 using Toolbar icon, left side navigation panel -> View Output -> Parent 

Dose Report, Iconic Navigator|Results|Parent Dose Report. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.13 TEST CASE 028-001 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-28-001 

Test 

Summary 

Test the functionality of Wresplot 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Wresplot 

Procedure 1) Run the code with initial concentration of 100 pCi/g for Ac-227 and sensitivity analysis for 

precipitation and contaminated zone distribution coefficient. Save the project to Test57.rof 

and run the code. 

2) Click View|Deterministics Graphics to open Wresplot displaying the graph of current 

calculation. 

3) Check the bottom of the right panel; it should include the input file name, file generation 

data, and the graphics file name, Graphics.Asc by default. 

4) In the left panel, it should include Plot Type (including Dose, Concentration, Soil 

Guidelines, and Risk), Radionuclide (including Summed, Individual, and Individual and 

Progeny), Pathways (including Summed, components, water independent/dependent, and 

Individual), and Sensitivity (Base Case, and dropdown list for each sensitivity analysis 

parameter) 

5) Click every option for Plot Type, Radionuclide, Pathways, and Sensitivity, and check the 

plot in the right panel, including X and Y-axis, plot title, legend, etc. Moving the cursor 

along X-axis, a textbox with information of the year where the cursor is at and the 

corresponding Y-axis value should display next to the cursor. 

6) Under Sensitivity section, select each of the two parameters, then check the plot in the 

right panel.  

7) The File menu should function as the self-description of each submenu.  

a. Print Review submenu should bring up a window similar to  Figure e. Clicking 

Print should bring up a printer selection window and clicking Export to should 

bring up a window as shown in Figure f for file format option. 

b. Export Graphics submenu should bring up a window similar to Figure f for file 

format selection. Depending on software installed in the testing computer, the 

formation options could be different for different computers. 
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c. Export Data submenu should enable to save the data to a .csv file. 

8) Repeat Step 2 using Toolbar icon, left side navigation panel -> View Output -> 

Deterministic Graphics, Iconic Navigator|Results| Deterministic Graphics. 

Required 

Data 

None. 

Expected 

Results 

The code should have the required elements and behave as described in each step. 
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11.14 TEST CASE 029-001 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-29-001 

Test 

Summary 

 

Test the functionality of Onsite Scenario Template.  

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Onsite Scenario Template. 

Procedure 1) Launch the code. Click Modify Data -> Site Layout. The default site should look like the left 

figures in the Expected Results section. 

2)  Click File -> Onsite Scenario Template. A new window with caption “Onsite Scenario 

Primary Contamination” should pop up. Click Save to close the window. 

3) Click Site Layout, and the site should look like the figure on the right side of the Expected 

Results section. 

Required 

Data 

None 
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Expected 

Results 
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11.15 TEST CASE 029-002 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-29-002 

Test 

Summary 

 

Test if Simulate the RESRAD-Onsite Code works properly.  

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Simulate the RESRAD-Onsite Code. 

Procedure 1) Launch the code. Click File -> Simulate the RESRAD-Onsite code. A new window with 

caption “Title & Radiological Data” should pop up. Click Close. 

2) Click Site Layout, and the site data should be identical to the figure shown in the Expected 

Results section. 

Required 

Data 

None 

Expected 

Results 
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11.16 TEST CASE 030-001 

 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-30-001 

Test 

Summary 

Test whether DCF Editor works properly. 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test DCF Editor interface. The response of DCF Editor to the main interface is tested in control 

level test and the data is checked elsewhere.  

Procedure 1) Launch DCF Editor by clicking File-> DCF Editor from the main interface, or by double 

clicking DCF Editor executable from DCF installation folder. The default DCF folder is in 

c:\RESRAD_Family\DCF\3.1 for RESRAD-OFFSITE. 

2) The DCF Editor version number, and creation date should display correctly. 

3) The default should be the following 

a. radionuclides library: ICRP107  

b. Library option: Create a new DCF library 

c. Base External DCF: DCFPAK3.02 

d. Base internal DCF: DCFPAK3.02 (Adult) 

e. Base risk library: DCFPAK3.02 Morbidity 

4) Changing radionuclide library to ICRP 38 will change the external, internal, and risk 

library to FGR 12, FGR 11, and FGR 13 Morbidity, respectively. 

5) With ICRP107 selected, click View a Default Library (Read Only), then View Library, and 

a new window of DCFPAK3.02 (Adult) library should pop out. 

6) In the window, the default Selected Nuclide should be Ac-233, and for tabs, namely, Dose 

Conversion Factors, Slope Factors, Radon, and Transfer Factors, should present. 

7) Click each tab and check whether all the layouts are shown properly, and whether the 

background of each text box is in yellow, whether the units are conventional units.  

8) Change to Cs-137, and repeat Step 7. 

9) Change to Zr-91 and repeat Step 7. 

10) With Zr-97 selected and try to change the external, internal, and ingestion DCF. Any 

changes should not be allowed. 
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11) Click Dose Factors Help button on the Upper-right corner, and check whether the Help file 

works properly. 

12) Click Another library, and the code should close this window and go back to the main 

interface of DCF Editor. 

13) Select library to view to DOE STD-1196-2011 (Reference Person), and repeat Steps 6-12. 

14) Select ICRP38 radionuclide library, and repeat Steps 6-13. 

15) Click Help -> General Hep and check whether the Help file window pop up and whether 

the content in the right panel presents accordingly to the click of the contents list in the left 

panel.  

16) Click F1 key from the main DCF Editor interface and repeat Step 15. 

17) Click Help -> Context-Sensitive Help and check whether the Help file works properly. 

18) Select ICRP107 and Create a new DCF library, type “Test DCF Editor’ in the Box of 

“Type the name of the new DCF library”, then type “This is test 006” in the Library 

Description box, and click Create Library button.  

19) In the pop-up window, select Ac-227, then click the selection circle under Default 

DCFPAK3.02 in the External and Ingestion DCF frame, and type 0 in the text box, and the 

click Exit Program. This will change the ingestion and external DCF of Ac-227 to zero and 

save it to a new library named Test DCF Editor. 

20) From RESRAD-OFFSITE main interface, click Change Title, then select Test DCF Editor 

from the drop-down list of Internal expose dose library.  

21) Select Ac-227 from the Initial Concentrations form 

22) Save the project as Test006.rof to UserFiles under the application folder, and run the code. 

23) Open test006.rof and check whether the library “Test DCF Editor” in used 

24) From the summary report (Page 2), check whether the external DCF was zero.  

 

Required 

Data 

None. 

Expected 

Results 

DCF Editor works properly.  

1) Available DCF libraries changes correctly when radionuclide library is changed. 

2) Can view DCF values 

3) Can create new library by modifying a set of base libraries 

4) The created library can be read in and used by RESRAD-OFFSITE code correctly 

5) Menu works properly. 
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11.17 TEST CASE 031-001 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-31-001 

Test 

Summary 

Test the functionality of Sensitivity Analysis (Single Parameter) 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Sensitivity Analysis (Single Parameter)  

Procedure 1) Launch the code and open Initial Concentration form and select Ac-227, then open 

Radionuclide Specific Release form. 

2) Make sure menu View|Sensitivity Input Summery is selected. Information as shown in Fig 1 

should present at the bottom left corner of the main interface. 

3) Put cursor focus on the second text box with default value of 20, then click Form 

Options|Sensitivity Analysis (Single Parameter) menu, a window like Fig 3 should pop up. 

Click OK. 

4) Check the bottom left corner of the main interface again. Information as shown in Fig 2 should 

present, indicating the available parameter for sensitivity analysis. 

5) Double clicking Fig 2 should bring up a window like Fig 3. Make sure the selected factor is 2. 

6) Open Distribution Coefficient  

7) Put cursor on Unsaturated Zone and click Form Options|Sensitivity Analysis (Single 

Parameter) menu. Select factor 5 from the pop-up sensitivity analysis setting form, then save 

the form. 

8) Check the bottom left corner of the main interface again. Information as shown in Fig 4 should 

present, indicating the available parameter for sensitivity analysis. 

9) Double clicking on the Variable DCACTU1 should bring up the sensitivity analysis setting 

window for the unsaturated zone 1 distribution coefficient, check if the selected factor is 5.  

10) Save project to Test52.rof, then open it in a text editor and check SDCACTC(1) = 2, 

SDCACTU1(1) = 5, NSENA = 2. 

11)  

Required 

Data 

None. 
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Expected 

Results 

The code should behave as described in each step. 
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11.18 TEST CASE 031-002 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-31-002 

Test 

Summary 

Test the functionality of setting Multiparameter Sensitivity Analysis  

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of setting Multiparameter Sensitivity Analysis  

Procedure 1) Launch the code and open Initial Concentration form and select Ac-227, then follow User’s 

Guide Section 6.3 to set multiparameter sensitivity analysis using the example shown in the 

left figure. 

2) Setting the Uniform Sensitivity range potions to 25%, 50%, and 99%, respectively.  

3) Save the form and then the project. 

4) Open the generated .rof file in a text editor and check NUM_SAMPS = 300, NUMVAR = 3, 

NUMRELVAR = 0. 

5) There should be file with file extension .LHS generated in the same folder as the .rof file. 

Open it in a text editor and it should look like the right figure.  

 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.19 TEST CASE 032-001 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-32-001 

Test 

Summary 

Test the functionality of setting Uncertainty/Probabilistic Analysis 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of setting Uncertainty/Probabilistic Analysis 

Procedure 1) Launch the code and open Initial Concentration form and select Ac-227, then open 

Distribution Coefficients form. Put the cursor on the Unsaturated Zone 1 text box, and 

click Form Options|Uncertainty/Probabilistic Analysis menu. Uncertainty Analysis 

window like Fig a should pop up. 

2) Open Physical and Hydrological form, put cursor on Precipitation text box, and the click 

Form Options|Uncertainty/Probabilistic Analysis menu. A window like Fig b should pop 

up. Note the two boxes in purple.  

3) Change the Distribution and associated values to those shown in Fig c, then click Update 

Parameters stats and distribution.  

4) Click OK to save the form and then save the project to Test53.rof. 

5) Open Test53.rof and check UM_SAMPS = 300, NUMVAR = 2, NUMRELVAR = 0. 

6) There should be file called Test53.LHS generated in the same folder as Test53.rof. Open it 

and it should look like Fig d. 

 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.20 TEST CASE 033-001 

 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-33-001 

Test 

Summary 

 

Test the File navigation function from the left panel of GUI.  

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test whether the File navigation button from the left panel work properly. 

Procedure 1) Launch the code. The default main window panel should be divided into left panel and a 

blank right-side panel with an Iconic Navigator located on the upper-right corner. The left 

side panel containing the version number of the code, and seven navigation buttons. 

2) Clicking File button should bring the File Options form up.  

3) Test New and Save functions in General Scenarios section following RESOFF-TEST-35-001. 

4) Test Open and Save as functions in General Scenarios section following RESOFF-TEST-35-

002. 

5) Test Onsite Scenario Template fie following RESOFF-TEST-35-004. 

6) Test Simulate RESARD (onsite) Code following RESOFF-TEST-35-005. 

Required 

Data 

None. 

Expected 

Results 

The same as test cases RESOFF-TEST-35-001, 002, 004 
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11.21 TEST CASE 033-002 

 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-33-002 

Test 

Summary 

 

Test the Change Title navigation function from the left panel of GUI.  

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test whether the Change Title navigation button from the left panel work properly. 

Procedure 1) Launch the code and click Change Title button on the left panel. The “Title & Radiological 

Data” window should pop up.  

2) Under default setup, it should be identical to the left screenshot shown in Expected Results 

section. 

3) Change to ICRP 38 database, and the form should be identical to the right screenshot. 

Required 

Data 

None. 
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Expected 

Results 
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11.22 TEST CASE 033-003 

 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-33-003 

Test 

Summary 

 

Test the functionality of Set Pathways navigation in the left panel of GUI. 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To Test the functionality of Set Pathways navigation in the left panel of GUI. 

Procedure 1) Launch the code and click Set Pathways in the left panel 

2) The Set Pathways form should pop up and stay right by the left panel. By default, all the 

pathways should be on except Radon pathway. 

3) Click all the press buttons one by one, the pathways should be turned off and the pathway 

icons should present an off marker 

4) Click all the press buttons one by one again to turn on all the pathways. The off marker on the 

pathway icons should go away. 

5) Clicking Radon pathway should not get any response at this time when no radionuclides are 

selected.  

6) Repeat Steps 3-4 by pressing the pathway icons, rather than the press button. 

7) Turn off all the pathways again except external pathway. 

8) Click Close, and the pathway form should be closed. 

9) Click Initial Concentrations form and select Ac-227. 

10) Save the input to file Test011.rof and Run the code. 

11) Open the input file Test011.rof in a text editor such asNotepad, and should see SELPATH = 

1, indicating only external pathway is selected. 

12) Open the file Summary.REP in  the  application folder using a text editor and look into the 

Summary of Pathway Selections section. All the pathways should be suppressed except that 

external gamma is active. 

13) Open Test011.rof and add Ra-226 from the Initial Concentrations form, and turn on Radon 

pathway. Save the file and Run the code again. 

14) Check TEST011.rof and the variable SELPATH should be 257. 
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15) Check Summary.REP and only external gamma and radon pathways should be active.  

Required 

Data 

None. 

Expected 

Results 

Pathway form should be opened and closed from the left panel navigation. 

Pathways can be turned on and off by pressing either the press buttons or the pathway icons.  

The selection of pathways should be correctly written into the input file and echoed in the report 

file. 
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11.23 TEST CASE 033-004 

 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-33-004 

Test 

Summary 

 

Test the functionality of Modify Data navigation in the left panel of GUI. 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Modify Data navigation in the left panel of GUI. 

Procedure 1) Click Modify Data button from the left navigation panel. The Modify Data form should pop 

up and stay right next the left panel. Depending on the setup of last run, it should like one of 

the three formats as shown in Expected Results section, namely, Case 1, 2, and 3. The default 

is the left one.  

2) Open the form again. For Case 1, click “Hide Subforms” button, it should look like Case 2. 

3) Click “Show Subforms Vertically” in Case 2, the form should change back to Case 1. 

4) In either Case 1 or 2, clicking “Show Subforms Horizontally”, the form should change to 

Case 3. 

5) In Case 3, clicking Hide Subforms should change the form to Case 2; and clicking Show 

Subforms Vertically should change the form to Case 1. 

6) Clicking Close in any Case should close the form.  

Required 

Data 

None. 



 

184 

Expected 

Results 
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11.24 TEST CASE 033-005 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-33-005 

Test 

Summary 

Test the functionality of Iconic Navigator  

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Iconic Navigator 

Procedure 1) Launch the code.  

2) Click Problem tab of Iconic Navigator. 

a. Clicking File icon should bring up the window for selection of input file. Select an 

input file, and the file should be loaded to the main interface. 

b. Clicking Title icon should bring up the Title & Radiological Data form 

c. Clicking Dose Factors should bring up the DCF Editor window. 

d. Clicking Input/Pathway should open the Inputs & Pathways tab of Iconic 

Navigator. 

e. Clicking Sensitivity icon should turn on/off the Sensitivity Input Summary at the 

bottom left corner of the main interface. 

f. Clicking Uncertainty Analysis button should bring up the Uncertainty and 

Probabilistic Analysis form. 

g. Clicking Run button should run the code using the loaded input file. 

h. Clicking Results should open the Results tab of the Iconic Navigator. 

3) Clicking Input & Pathways Tab.  

a. Clicking each icon should open one associated form. Then run the code. 

4) Click Results tab. 

a. Clicking Parent Dose Report button should open Summary.rep file. Clicking 

Deterministic Graphics icon should open the graphics Wresplot.exe with loaded 

data. 

b. Clicking Progeny Dose Report icon should open DAUDOSE.REP file, Clicking 

Health Risk Report icon should open INTRISK.REP file. 

c. Run the code with uncertainty analysis. 
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d. Clicking Graphics under Uncertainty/Probabilistic Analysis frame should open 

forms Uncertainty and Probabilistic Analysis, Probabilistic/Uncertainty Outputs, 

and Probabilistic Temporal Plots. 

e. Clicking Dose and Risk Report icon should open MCSUMMAR.REP file. 

f. Clicking Input Report icon should open LHS.REP file. 

5) Clicking Help tab and the REARD program website and contact information should 

present under this tab, as well as the function of F1 key for help. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.25 TEST CASE 034-001 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-001 

Test 

Summary 

Test the functionality of Form Preliminary Inputs 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Form Preliminary Inputs.  

Procedure 1) On the left panel, click Modify Data -> Preliminary Inputs. The form should pop up with 

Figure a as default setting, including the units and values in textboxes. The background of 

each textbox should be in yellow if the values are default values; otherwise, in white. 

2) Change the unit to Bq. The unit in Forms Initial Concentrations and Transfer Factors 

should change accordingly.  

3) Changing the selection of Conceptualization frame from top to bottom in order, the form 

should look like Figure a, b, c and d, respectively. Selection of “Model multiple forms of 

contaminated media” under settings of either Figure b or c will change the other’s setting. 

4) The Number of Unsaturated Zones should be able to be changed between 0 and 5. Once 

this value is change, need to check Form Unsaturated Zones to check if the number of 

unsaturated zone changed in that form accordingly. 

5) Submerged fraction of Primary Contamination should be able to changed 0-1; however, 

once its value is larger than 0, the Number of Unsaturated Zone should update to 0 

automatically. 

6) Change the values in textboxes and the units, save the input to Test13.rof, then check 

whether the input file is correctly written. The variables in this form include BRDL, ED, 

and NS. SUBMERGEDF, PCOPTION, and MULTIFORM. 

Required 

Data 

None. 
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Expected 

Results 
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11.26 TEST CASE 034-002 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-002 

Test 

Summary 

Test the functionality of Form Release Times 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Form Release Times.  

Procedure 1) On the left panel, clicking Modify Data -> Release Times should open a pop-up window 

with caption “Times at which Release Properties are Specified (years)”. 

2) Clicking “Insert New 1st time and shift down existing times and associated release 

data” 8 times. Every click should shift down the newly generated textbox by one row. 

The default of each generated textbox should be 0.  

3) Click “Delete 1st time and associated release data and shift up exiting data” for 8 times, 

all the newly generated textboxes should be deleted. 

4) Clicking “Add new xx-th time at which release changes” should generate a textbox 

corresponding to xx-th release time. 

5) Specifying a value to each box in an increasing order. Change the value of the top box 

to a negative value, an error message should pop-up. Similarly, changing the largest 

value to more than 100000 should also trigger an error message window. 

6) Change the third textbox value to a value less than the one in the second box, a warning 

message should show in the bottom-left box. Clicking Close. An error message should 

pop-up pointing out this error.  

7) Make sure the input to this form is correct, close the form. Check Form Nuclide 

Specific Release. The release time in the form should change accordingly. 

8) save the file to Test14.rof, and then check the values in the generated input file in a text 

editor. The variable to check is RELTIME(1) - (9).  

Required 

Data 

None. 

Expected 

Results 

The behavior of the code should be the same as described in each step. 
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11.27 TEST CASE 034-003 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-003 

Test 

Summary 

Test the functionality of Form Initial Concentrations 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Form Initial Concentrations. 

Procedure 1) Open the Initial Concentrations window and visually check the format, fonts, spelling, and 

default setting. 

2) Check the unit is correct according to Form Preliminary Inputs.  

3) The upper right box should indicate the radionuclide database and cutoff half-life. 

4) Frame “Transfer Mechanism” should be available. 

5) Select Ac-227, then click button “Add Ac-227 21.77y”, Ac-227 should be added to the left 

panel with a concentration of 100 unit. Highlight it and then change the Nuclide 

Concentration value to 50. Its concentration should update to 50 in the left panel. 

6) Clicking Delete “Ac-227” should remove it from the left panel. 

7) Select U-238 from right panel and add it. The radionuclides in the U-238 decay change 

with half-life larger than the cutoff halflife should be added to the left panel with U-238 

having a concentration of 50 units and all others zero concentration.  

8) Close the form and save the project to Test15.rof. Check the variables NUCNAM and S. 

Their values should be identical to the input to the form.  

Required 

Data 

None. 

Expected 

Results 

The behavior of the code should be the same as described in each step. 
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11.28 TEST CASE 034-004 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-004 

Test 

Summary 

Test the functionality of Form Nuclide Specific Release 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To the functionality of Form Nuclide Specific Release. 

Procedure 1) Select a conceptualization other than "RESRAD-ONSITE exponential release model" in 

Preliminary Inputs form  

2) Select U-238 in Form Initial Concentrations with all default setting, and set release time to 

0, 10, 100, and 1000 in Release Time form. 

3)  Open the Form “Nuclide Specific Release”. Initial Concentrations Form should also be 

opened automatically if not opened at the time. Visually check the format, fonts, spelling, 

and default setting. 

4) Check Radionuclide can be selected for each one in U-238 decay chain. 

5) A button called “Add Next Time” should be available next the last release time. Clicking it 

should close the Nuclide Specific Release form and open Release Times form. In the 

Release Time form, add the 5th release starting time, 5000 yr and close the form.  

6) Clicking a specific release time in the Nuclide Specific Release form should result in 

closing the form and open the Release Time form with the specified release time 

highlighted for modification. 

7) Open the Form “Nuclide Specific Release” again, the newly added release starting time of 

5000 should be added into the release time row. 

8) Changing the options in Transfer Mechanism frame should change the interface. Figures a-

c show the interfaces corresponding to First order release, Equilibrium Desorption, and 

Equilibrium Solubility release, respectively. 

9) Change one value or option for each radionuclide, close the form, and save the file to 

Test15.rof.  

10) Check the values in the generated input file match the inputs in the interface. The variables 

include RELTIME, RLEACH, SOLUB, RELFRAC, RELTIMEOPT, RELTIMEOPTP, 

RELOPT. 
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Required 

Data 

None. 

Expected 

Results 
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11.29 TEST CASE 034-005 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-005 

Test 

Summary 

Test the functionality of Distribution Coefficients form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Distribution Coefficients form.  

Procedure 1) With U-238 selected with default settings. Open Distribution Coefficients form and 

visually check the format, fonts, spelling, and default setting. 

2) The form should be available for inputs as shown in the Figure in Expected Results. 

3) When either of the first or second options in Conceptualization of Primary Contamination 

in Preliminary form is selected, the distribution coefficient input box for Contaminated 

Medium will be gray out.  

4) Clicking the value of Number of Unsaturated Zone should open the Preliminary Inputs 

form 

5) Change at least one value for each radionuclide, and save the project to Test17.rof. 

6) Check the following variables in the generated input file and their value should match the 

input, DCACTC, DCACTCM, DCACTDWE, DCACTSWB, DCACTSWS, DCACTU1, 

DCACTS, DCACTV1, DCACTV2, DCACTL1, DCACTL2. 

Required 

Data 

None. 

Expected 

Results 

The behavior of the code should be the same as described in each step. 
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11.30 TEST CASE 034-006 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-006 

Test 

Summary 

Test the functionality of Deposition Velocities form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Deposition Velocities form.  

Procedure 1) Select U-238 with default settings. Open Deposition Velocity form and visually check the 

format, fonts, spelling, and default setting. 

2) Change at least one value for each radionuclide in the U-238 decay chain. Save the form 

and the project to Test18.rof. 

3) Check the variables DEPVEL, and DEPVELT in the generated file; they should match the 

input values in the interface. 

Required 

Data 

None. 

Expected 

Results 

The behavior of the code should be the same as described in each step. 

 

 

  



 

196 

11.31 TEST CASE 034-007 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-007 

Test 

Summary 

Test the functionality of Transfer Factors form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Transfer Factors form.  

Procedure 1) Select U-238 with all default settings. Open Transfer Factors form, and visually check the 

format, fonts, spelling, and default setting. 

2) Change at least one value for each radionuclide, and save the form. 

3) Save the project to Test19.rof. Check the following variables’ values; they should match 

the input. RTF, I_M, BIOFAC.  

Required 

Data 

None. 

Expected 

Results 

The behavior of the code should be the same as described in each step. 
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11.32 TEST CASE 034-008 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-008 

Test 

Summary 

Test the functionality of Reporting Times form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Reporting Times form.  

Procedure 1) Click Modify Data -> Reporting Times. Visually check the format, fonts, and spelling. 

2) It should have contents as shown in the figure, allowing up to 9 input times.  

3) Check the lower and upper bounds. Each value should be (0, 100000] 

4) Check Add and Remove buttons 

5) Clicking “Storage times” button should bring the form up. 

6) Save the form and the project to Test20.rof. 

7) Check the variable T(1)-(10) in the file; they should be identical to the input in GUI. 

Required 

Data 

None. 

Expected 

Results 

The behavior of the code should be the same as described in each step. 

 

  



 

198 

11.33 TEST CASE 034-009 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-009 

Test 

Summary 

Test the functionality of Storage Times form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Storage Times form.  

Procedure 1) Click Modify Data -> Storage Times. Visually check the format, fonts, and spelling. 

2) Check the lower and upper bounds for each input box value. It should be no less than 0.  

3) Change two or more values.  

4) Save the form and the project to Test21.rof. 

5) Check the variable STOR_T(1)-(10) in the file; they should be identical to the input in 

GUI. 

Required 

Data 

None. 

Expected 

Results 

The behavior of the code should be the same as described in each step. 
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11.34 TEST CASE 034-010 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-010 

Test 

Summary 

Test the functionality of Site Layout form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Site Layout form.  

Procedure 1) Open Site Layout form and visually check the format, fonts, spelling, and default values 

with yellow background color. Check if F6 key can restore a changed value.  

2) Clicking Display Map should bring up the Map Interface window.  

3) Change the values for Bearing of X axis, X and Y dimensions, and at least one value on 

each row and column of the site coordinate table.  

4) Save the project to Test22.rof.  

5) Check the following variables in the file; they should be identical to the input in GUI. 

NXBEARING, SOURCEXY, AGRIXY, DWELLXY, SWXY.  

Required 

Data 

None. 

Expected 

Results 

The behavior of the code should be the same as described in each step. 
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11.35 TEST CASE 034-011 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-011 

Test 

Summary 

Test the functionality of Map Interface form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Map Interface form.  

Procedure 1) Open Map Interface form by clicking Modify Data -> Site Layout -> Display Map 

2) It should include the functions as shown in the figure. 

3) Check the following buttons: Print, How to use the Map, Accept/Cancel changes, 

Accept/Cancel Changes and Close. 

4) Move each icon in the map a little and the purple Y-axis line, then click Accept Changes 

and Close. The coordinate table in the Site Layout form should update accordingly. 

5) Click Get Image should direct to select an image file. Select the file 

HypotheticalSuburbanScenarioOutline.JPG under UserFiles folder. The image should load 

to the code. Click Clear Image should remove the file from the code. 

6) Change the scale value and click “Set Scale”. The image should change accordingly. 

7) Click Trace Groundwater Flow Line, the widow should update with GW line.  

8) Clicking How to Trace a Flow Line button should open a file named GwFlowLinRO.pdf. 

Following the procedure in the file and check each button functions as designed. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.36 TEST CASE 034-012 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-012 

Test 

Summary 

Test the functionality of Physical and Hydrological form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Physical and Hydrological form.  

Procedure 1) Open Physical and Hydrological form. Visually check the format, fonts, spelling, and 

default values with yellow background color. Check if F6 key can restore a changed value. 

2) It should contain Site Properties input, as shown in the figure.  

3) Clicking each of the five buttons in Sub-area Properties section should bring up the 

corresponding forms.  

4) Change the precipitation value and rainfall and runoff factor, save the form, and save the 

project to Test24.rof. 

5) Check the variables PRECI and RAINEROS in the generated file. They should be identical 

to the input in GUI. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.37 TEST CASE 034-013 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-013 

Test 

Summary 

Test the functionality of Primary Contamination form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Primary Contamination form.  

Procedure 1) Open Primary Contamination form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a changed value. 

2) It should contain Site Properties input, as shown in the figure. 

3) Check the consistence of Area of Primary Contamination with the X and Y dimesons in 

Site Layout form. 

4) Check the consistence of Factor of primary contamination that is submerged with the 

Submerged fraction of Primary Contamination in Preliminary Input.  

5) Modify at least two values in each column, save the form, and then save the project to 

Test25.rof. 

6) Check the following variables in the generated input file. They should be the same as input 

in the GUI. AREA, LCZPAQ, DM, MLFD, DEPVEL_DUSTT, RESPFRACPC, 

DEPVEL_DUST, RI, EVAPTR, RUNOFF, SLPLENSTPPC, CRPMANGPC, 

CONVPRACPC, THICK0, TPCZ, VCZ, DENSCZ, ERODIBILITYCZ, FCCZ, BCZ, 

HCCZ, EPCZ, ALPHALCZ, SUBMERGEDDEPTH, COVER0, TPCV, VCV, DENSCV, 

ERODIBILITYCV, PH2OCV 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.38 TEST CASE 034-014 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-014 

Test 

Summary 

Test the functionality of Sediment Delivery Ratio form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Sediment Delivery Ratio form.  

Procedure 1) Open Sediment Delivery Ratio form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a changed value. 

2) It should the input boxes, as shown in the figure. 

3) Check the lower and upper bounds, which should be 0 and 1, respectively. 

4) The summation of the values in this form should be 1. Make it more than one, and an error 

message should pop up. 

5) Check the values input in the form are consistent with the ones in Forms Dwelling Site, 

Agricultural Areas, Livestock Feed Areas, and Surface Water Body. 

6) Change three or more values, save the form, and then save the project to Test26.rof. 

7) Check the following variables in the generated input file; they should be identical to the 

input from GUI. SDR, SDROF(1)-(4) and SDRDELL 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.39 TEST CASE 034-015 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-015 

Test 

Summary 

Test the functionality of Agricultural Areas form 

Created 

By/Date 

CW 10/1/2019 

Test 

Objective 

To test the functionality of Agricultural Areas form.  

Procedure 1) Open Agricultural Areas form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a changed value. 

2) It should have the same input boxes as the figure has. 

3) Check the Area values; they should be grayed out in this form but match the inputs in Site 

Layout form. 

4) Check the Erosion rate and Total Porosity values; they should be grayed out in this form 

but match the ones in Primary Contamination form 

5) Check the Sediment delivery ratio values; they should be grayed out in this form but match 

the ones in Sediment Delivery Ratio form. Clicking the values in this form should bring up 

the Sediment Delivery Ratio form. 

6) Change at least three values in each column, save the form, and save the project to 

Test27.rof. 

7) Check the following variables in the generated file; they should be the same as inputs in 

GUI. AREAO(1) and (2), FAREA_PLANT(1) and (2), RIRRIG(1) and (2), EVAPTRN(1) 

and (2), RUNOF(1) and (2), DPTHMIXG(1) and (2), TMOF(1) and (2), EROSN(1) and 

(2), RHOB(1) and (2), ERODIBILITY(1) and (2), SLPLENSTP(1) and (2), 

CRPMANG(1) and (2), CONVPRAC(1) and (2), TPOF(1) and (2). 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.40 TEST CASE 034-016 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-016 

Test 

Summary 

Test the functionality of Livestock Feed Areas form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Livestock Feed Areas form.  

Procedure 1) This form should contain the same input content as Agricultural Areas form but for 

Livestock Feed Area, including Pasture Silage and Grain 

2) Follow the same procedure for testing Agricultural Areas form, except that the variables to 

be checked in the generated input file should be AREAO(3) and (4), FAREA_PLANT(3) 

and (4), RIRRIG(3) and (4), EVAPTRN(3) and (4), RUNOF(3) and (4), DPTHMIXG(3) 

and (4), TMOF(3) and (4), EROSN(3) and (4), RHOB(3) and (4), ERODIBILITY(3) and 

(4), SLPLENSTP(3) and (4), CRPMANG(3) and (4), CONVPRAC(3) and (4), TPOF(3) 

and (4). 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.41 TEST CASE 034-017 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-017 

Test 

Summary 

Test the functionality of Dwelling Site form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Dwelling Site form.  

Procedure 1) This form should contain the same input content as Agricultural Areas form but for Offsite 

Dwelling Area 

2) Follow the same procedure for testing Agricultural Areas form, except that the variables to 

be checked in the generated input file should be AREAODWELL, , RIRRIGDWELL, 

EVAPTRNDWELL, RUNOFDWELL, DPTHMIXGDWELL, TMOFDWELL, 

EROSNDWELL, RHOBDWELL, ERODIBILITYDWELL, SLPLENSTPDWELL, 

CRPMANGDWELL, CONVPRACDWELL, TPOFDWELL. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.42 TEST CASE 034-018 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-018 

Test 

Summary 

Test the functionality of Atmospheric Transport form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Atmospheric Transport form.  

Procedure 1) Open Atmospheric Transport form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a changed value. 

2) It should have the same input boxes as the figure has. 

3) Clicking Read Meteorological STAR file should allow to select a STAR file from the 

available list installed in Application folder\Metfiles. Loading of a selected STAR file 

should update the table. 

4) Clicking Deposition Velocities should bring up the Deposition Velocities form. 

5) Change at least one value in each input area, save the form, and save the project to 

Test30.rof. 

6) Check the following variables in the generated input file; they should be the same as the 

inputs from GUI. AIRRELHT, HEATFLX, ANH, TABK, AMIX, PMIX, AGRIELEV, 

DWELLELEV, SWELEV, WIND, WINDSPEED, DFREQ, ATGRID 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.43 TEST CASE 034-019 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-019 

Test 

Summary 

Test the functionality of Water Use form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Water Use form.  

Procedure 1) Open Water User form. Visually check the format, fonts, spelling, and default values with 

yellow background color. Check if F6 key can restore a changed value. 

2) It should have the same input boxes as the figure has. 

3) Check the Area of Plot; which should be grayed out and consistent with the inputs in Site 

Layout form. 

4) Check the Fraction of water values. The summation of two columns should be 1. 

5) Changes at least two values in each column, save the form, and save the project to 

Test31.rof.  

6) Check the following variables in the generated file; they should be the same as inputs in 

the GUI. DWI, FDWI, FSWD, FWWD, HHW, FSWHH, FWWHH, LWI, FSWLV, 

FWWLV, FSWIR, FWWIR, FSWIRDWELL, FWWIRDWELL, NDWI, NLWI, UW 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.44 TEST CASE 034-020 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-020 

Test 

Summary 

Test the functionality of Unsaturated Zones form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Unsaturated Zones form.  

Procedure 1) Open Unsaturated Zones form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a changed value. 

2) It should have the same input boxes as the figure has. 

3) Clicking the Number of Unsaturated Zones should bring up the Preliminary Inputs form 

4) Modify at least two values for each unsaturated zone, save the form, and the save the 

project to Test32.rof. 

5) Check the following variables in the generated file; they should be the same as inputs in 

GUI. H, DENSUZ, TPUZ, EPUZ, FCUZ, HCUZ, BUZ, ALPHALU 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.45 TEST CASE 034-021 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-021 

Test 

Summary 

Test the functionality of Saturated Zone form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Saturated Zone form.  

Procedure 1) Open Saturated Zone form. Visually check the format, fonts, spelling, and default values 

with yellow background color. Check if F6 key can restore a changed value. 

2) It should have the same input boxes as the figure has. 

3) Modify at least two values for each unsaturated zone, save the form, and the save the 

project to Test33.rof. 

4) Check the following variables in the generated file; they should be the same as inputs in 

GUI. DPTHAQ, DENSAQ, TPSZ, EPSZ, HCSZ, HGW, DWIBWT, ALPHALOW, 

ALPHATW, ALPHAVW, HGSW, DPTHAQSW, ALPHALOSW, ALPHATSW, 

ALPHAVSW 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.46 TEST CASE 034-022 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-022 

Test 

Summary 

Test the functionality of Groundwater Transport form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Groundwater Transport form.  

Procedure 1) Open Groundwater Transport form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a changed value. 

2) It should have the same input boxes as the figure has. 

3) Clicking the three buttons should bring up the forms of Water Use, Unsaturated Zones, and 

Saturated Zone 

4) Check the options for subzone dispersion; they should respond to selection 

5) Change at least three values, save the form, and then save the project to Test34.rof 

6) Check the following variables in the generated file; they should be the same as inputs in 

GUI. OFFLPAQW, OFFLPAQS, OFFLNAQW, OFFLNAQSN, OFFLNAQSF, EPS, 

NPCM, NPCMF, NPCZ, NPCZF, NSPCZ, NSPCZF, NPSS, NPSSF, NAQS, NAQSF 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.47 TEST CASE 034-023 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-023 

Test 

Summary 

Test the functionality of Surface Water Body form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Surface Water Body form.  

Procedure 1) Open Surface Water Body form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a changed value. 

2) It should have the same input boxes as the figure has. 

3) Check the Surface area of water body, which should be consistent with the inputs in Site 

Layout form 

4) Check the Sediment Delivery ration button, which should be consistent with the input in 

Sediment Delivery Ration form. Clicking it should bring up the Sediment Delivery Ratio 

form. 

5) Check the Number of catchment areas. The left and right arrow button should allow delete 

or add one catchment with default settings 

6) Validate the catchment are using the coordinates 

7) Modify at least three values in each column, save the form, and then save the project to 

Test35.rof 

8) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. ALAKE, VLAKE, EVAPOT, FSTMFLOW, FSTMFLOWIN, VSETTLE, 

RHOBSED, THICKSED, SDR, NCATCH, CATCHXY, AREACA, RUNOFFCA, 

ERODIBILITYCA, SLPLENSTPCA, CRPMANGCA, CONVPRACCA, SDRCA, 

SDRACOR, DDRCA, COMPUTEDEP, CONVCRITATM  

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.48 TEST CASE 034-024 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-024 

Test 

Summary 

Test the functionality of Ingestion Rates form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Ingestion Rates form.  

Procedure 1) Open Ingestion Rates form. Visually check the format, fonts, spelling, and default values 

with yellow background color. Check if F6 key can restore a changed value. 

2) It should have the same input boxes as the figure has. 

3) Check the Drinking Water Consumption rate, which should be consistent with the input in 

Water Use form. Modification on either one should change the other one automatically.  

4) Check the Drinking water fraction from affected area, which should be consistent with the 

inputs from Water Use form. Clicking of this button should bring up the Water Use form. 

5) Check the three buttons. Clicking them should bring up forms of Plant Factors, Livestock 

Factors, and Livestock Feed Factors. 

6) Modify at least two values in each column, save the form, and then save the project to 

Test36.rof. 

7) Check the following variables in the generated file; they should be the same as inputs in 

GUI. DFI,DVI, DMI, SOIL, FFISH, FVEG, FMEMI 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.49 TEST CASE 034-025 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-025 

Test 

Summary 

Test the functionality of Plant Factors form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Plant Factors form.  

Procedure 1) Open Plant Factors form. Visually check the format, fonts, spelling, and default values 

with yellow background color. Check if F6 key can restore a change value. 

2) It should have the same input boxes as the figure has. 

3) Modify at least two values in each column, save the form, and then save the project to 

Test37.rof. 

4) Check the following variables in the generated file; they should be the same as inputs in 

GUI. YIELD, GROWTIME, FOLI_F, RWEATHER, FINTCEPT, DROOT 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.50 TEST CASE 034-026 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-026 

Test 

Summary 

Test the functionality of Livestock Intakes form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Livestock Intakes form.  

Procedure 1) Follow the same procedure as testing of Plant Factors form, except checking the following 

variables, LWI, LFI, LSI. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.51 TEST CASE 034-027 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-027 

 

Test 

Summary 

Test the functionality of Livestock Feed Factors form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Livestock Feed Factors form.  

Procedure 1) Follow the same procedure as testing of Plant Factors form, except checking the following 

variables, YIELD(3), YIELD(4), GROWTIME(3), GROWTIME(4), FOLI_F(3), 

FOLI_F(4), RWEATHER(3), RWEATHER(4), FINTCEPT(3,2), FINTCEPT(4,2), 

FINTCEPT(3,1), FINTCEPT(4,1), DROOT(3), DROOT(4) 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.52 TEST CASE 034-028 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-028 

Test 

Summary 

Test the functionality of Inhalation, Gamma form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Inhalation, Gamma form.  

Procedure 1) Open Inhalation, Gamma form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a change value. 

2) It should have the same input boxes as the left figure has. 

3) Selection of Input different values under Massloading and respirable fraction at offsite 

locations should bring more input boxes, as shown in the right figure. 

4) Clicking the two buttons should bring up the forms of Shape Factors and Occupancy. 

5) With Input different values selected, modify at least three inputs, save the form, and then 

save the project to Test40.rof. 

6) Check the following variables in the input file; they should be the same as the inputs in 

GUI. INHALR, SAMEMLRF, MLTOTOF, RESPFRACOF, MLTOTDWELL, 

RESPFRACDWELL, SHF3, SHF1 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.53 TEST CASE 034-029 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-029 

Test 

Summary 

Test the functionality of Shape Factors form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Shape Factors form.  

Procedure 1) Open Shape Factors form. Visually check the format, fonts, spelling, and default values 

with yellow background color. Check if F6 key can restore a change value. 

2) It should have the same input boxes as the figure has. 

3) Select Onsite tab on the right panel. 

4) Select Circular for Shape of the primary contamination, a circle should appear in the 

center. Click “Calculate Radii and Fractions”, and the code should calculate and list the 

results in the table in right panel. 

5) Click Clear. The left panel should become blank. 

6) Select Polygonal for Shape of primary contamination. Generate a polygon on the left panel 

using mouse. The button “Calculate Radii and Fractions” should be available should 

become available upon a polygon is generated. Click it and the results should be listed in 

the table.  

7) Select Offsite tab on the right panel, and repeat Steps 4-6. 

8) Save the form, and then save the project to Test41.rof. 

9) Check the variable RAD_SHAPE in the generated input file; its value should be same as 

the calculated ones in the GUI. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.54 TEST CASE 034-030 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-030 

Test 

Summary 

Test the functionality of Occupancy form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Occupancy form.  

Procedure 1) Select Ac-227 in the Initial Concentrations form. 

2) Open Occupancy form. Visually check the format, fonts, spelling, and default values with 

yellow background color. Check if F6 key can restore a change value. 

3) It should have the same input boxes as the figure has. 

4) Modify at least three values, save the form, and then save the project as Test42.rof. 

5) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. FIND, FOTD, FINDDWELL, FOTDDWELL, OCCUPANCY(1) -(4) 

6) Clicking run should bring up a message window asking whether to save the changes and 

run the code. Click each button – Yes will run the code; No will open the Save function, 

Cancel Run will go back the main interface. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.55 TEST CASE 034-031 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-002 

Test 

Summary 

Test the functionality of Radon form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Radon form.  

Procedure 1) Open Radon form. Visually check the format, fonts, spelling, and default values with 

yellow background color. Check if F6 key can restore a change value. 

2) It should have the same input boxes as the figure has. 

3) All the input boxes in this form should be grayed out unless a radon parent Rn-222 or Rn-

220 is present in the contamination radionuclide list.  

4) Close the form. Select U-238 from the Initial Concentrations form and then turn on Radon 

pathway. 

5) Open Radon form again; it should be available for modification now.  

6) Modify at least three values, save the form, and then the project to Test43.rof. 

7) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. DIFCV, DIFCZ, DIFOS(1), DIFOS(2), DIFOS(3), DIFOS(4), DIFOS(5), DIFFL, 

FLOOR1, DENSFL, TPFL, PH2OFL, DMFL, HMIX, HRM, REXG, FAI, EMANA(1), 

EMANA(2) 

8) Open the form again. Clicking run should bring up a message window asking whether to 

save the changes and run the code. Click each button – Yes will run the code; No will open 

the Save function, Cancel Run will go back the main interface. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.56 TEST CASE 034-032 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-032 

Test 

Summary 

Test the functionality of Carbon-14 form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Carbon-14 form.  

Procedure 1) Open Carbon-14 form. Visually check the format, fonts, spelling, and default values with 

yellow background color. Check if F6 key can restore a change value. 

2) It should have the same input boxes as the figure has. 

3) All the input boxes in this form should be grayed out unless C-14 is present in the 

contamination radionuclide list.  

4) Select C-14 from the Initial Concentrations form. 

5) Open Carbon-14 form again; it should be available for modification now.  

6) Clicking Mass fractions of C-12 should bring up Mass fractions of C-12 form. 

7) Modify the Vertical dimension of mixing for inhalation, save the form, and then the project 

to Test44.rof. 

8) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. DMC, HMIXV, C14EVSN, C12EVSN, CAIR, CSOIL 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.57 TEST CASE 034-033 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-033 

Test 

Summary 

Test the functionality of Mass fraction of C-12 form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Mass fraction of C-12 form.  

Procedure 1) Open Mass fraction of C-12 form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a changed value. 

2) It should have the same input boxes as the figure has. 

3) Select C-12 from the Initial Concentrations form. 

4) Open Mass fraction of C-12 form again.  

5) Save the form, and then the project to Test45.rof. 

6) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. C12AIR, C12CZ, C12WTR, C12PLANT(1), C12PLANT(2), C12PLANT(3), 

C12PLANT(4), C12MEAT_MILK(1), C12MEAT_MILK(2) 

7) Open the form again. Clicking run should bring up a message window asking whether to 

save the changes and run the code. Click each button – Yes will run the code; No will open 

the Save function, Cancel Run will go back the main interface. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.58 TEST CASE 034-034 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-34-034 

Test 

Summary 

Test the functionality of H-3 form 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of H-3 form.  

Procedure 1) Select H-3 from the Initial Concentrations form.  

2) Open H-3 form. Visually check the format, fonts, spelling, and default values with yellow 

background color. Check if F6 key can restore a change value. 

3) It should have the same input boxes as the figure has. 

4) Modify the Vertical dimension of mixing for inhalation, save the form, and then the project 

to Test46.rof. 

5) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. HUMID, H2OPLANT(1), H2OPLANT(2), H2OPLANT(3), H2OPLANT(4), 

H2OMEAT_MILK(1), H2OMEAT_MILK(2), HMX 

6) Open the form again. Clicking run should bring up a message window asking whether to 

save the changes and run the code. Click each button – Yes will run the code; No will open 

the Save function, Cancel Run will go back the main interface. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.59 TEST CASE 035-001 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-35-001  

Test 

Summary 

 

Test if sub-menus File->New and Save work correctly 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test GUI menu File|New/Save 

Procedure 1) Make sure the application path in .ini file points to the application folder 

2) Launch the code. Remember the main window caption, say Site1.ROF” for example. 

3) Click File -> New. A new window with caption “Title & Radiological Data” should pop up.  

4) Change the Title text box to: test menu File -> New/Save, then click “Close” button. The 

pop-up windows should be closed. 

5) Click Set Pathways button on the left navigation panel, then check if all the pathways except 

Radon are on. If any is off, this test is failed. 

6) Click Modify Data button from the left navigation panel, open the following forms in order 

and check if all the text box background is in yellow. If not, this test is failed. 

I. Preliminary Inputs 

II. Release Times 

III. Initial Concentrations (check if the values in the top box is 100 pCi/g contaminated 

zone). 

IV. Reporting times 

V. Storage times 

VI. Site Layout 

VII. Physical and Hydrological 

VIII. Primary contamination 

IX. Sediment Delivery Ratio 

X. Agricultural areas 

XI. Livestock areas 

XII. Dwelling site 
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XIII. Atmospheric transport 

XIV. Water use 

XV. Unsaturated zones 

XVI. Saturated zones 

XVII. Groundwater Transport 

XVIII. Surface water transport 

XIX. Surface water body 

XX. Ingestion rates 

XXI. Plant factors 

XXII. Livestock intakes 

XXIII. Livestock feed factors 

XXIV. Inhalation, gamma 

XXV. Shape factors 

XXVI. Occupancy 

XXVII. Radon 

XXVIII. Carbon-14 

XXIX. Mass fraction of C-12 

XXX. H-3  

7) Click File -> Save 

8) Go to UserFiles folder under the application folder and open Site1.ROF file.  

9) Check if files “Site1.ROF” and “Site1.CHN” are created 

10) Open “Site1.ROF” and check if Variable Title = “test menu File -> New/Save” 

11) IF so, this test is passed, otherwise, failed. 

12) Repeat Steps 1-5 using icon “New” from tool bar.  

13) Click icon “Save” from tool bar, and then Steps 8-10. 

14) Repeat Steps 12 using keyboard Ctrl + S rather than tool bar, and then Step 13. 

 

Required 

Data 

None. 

Expected 

Results 

A new project can be generated from File|New, tool bar icon, and hotkey, and all the initial values 

are default values.  

The generated input can be saved from File|Save, tool bar icon, and hotkey Ctrl + S, with correct 

values.  
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11.60 TEST CASE 035-002 

 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-35-002s 

Test 

Summary 

 

Test if submenus File->Open and Save As work correctly 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test menu File|Open/Save as. 

Procedure 1) Launch the code 

2) Click File -> Open. A new window should pop up, requesting user to select which file to 

open. The default file location should be the folder where the input file was read to run the 

code last time.  

3) Go to the QAFiles folder and select the file with name ending with “US.ROF”, and click 

Open. 

4) The main interface should update after loading the input file. Check if the caption of the 

window is the same as the input file name. 

5) Click Modify Data from left navigation panel and then Initial Concentration button, and 

check if the unit is conventional unit in the pop-up window. If not, this test is failed. 

6) Click File -> Save as. A new window should pop out and the default path in the address box 

should be the QAFiles. If not, this test is failed. Change to UserFiles folder 

7) Type “Test002” in the File name box and click Save. A file named Test002.rof should be 

saved in the UserFiles folder.  

8) Go to UserFiles folder and compare file Test002.rof with the original file. They should be 

identical. If not, this test is failed.  

9) Repeat Steps 1-8 using Open icon in Tool bar.  

10) Repeat Steps 1-8 using keys Ctrl + O.  

11) Copy the QAFiles folder to a USB drive and repeat Steps 1-8.  
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Required 

Data 

QAFiles folder in the installation.  
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11.61 TEST CASE 035-003 

 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-35-003 

Test 

Summary 

 

Test if the submenu File-> Title works correctly.  

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test menu File|Title. 

Procedure 1) Launch the code.  

2) Click File -> New. A new window with caption “Title & Radiological Data” should pop up. 

3) Change the Title text box to: test menu Title, then click “Close” button. The pop-up windows 

should be closed. 

4) Click File -> Save as, change the file address to UserFiles under the application folder, and 

type “Test003” in the File name box in the pop-up window. 

5) Open “Test003.ROF” and check if Variable Title = “test menu Title” 

6) IF so, this test is passed, otherwise, failed.  

7) Repeat Steps 1-6 using hotkey Ctrl + T. 

Required 

Data 

None 

Expected 

Results 

The project tile should be able to be changed and saved correctly into the input file. 
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11.62 TEST CASE 035-004 

 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-35-004 

Test 

Summary 

 

Test if the DCF Editor can be called successfully from the menu of GUI. 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test DCF Editor from GUI 

Procedure 1) Launch the code 

2) Click File -> DCF Editor. The DCF Editor interface should pop up.  

3) Close the DCF Editor. 

4) Click Modify Data from the left navigation panel and then Initial Concentration. 

5) Select “Ac-227” in the pop-up Initial Concentration window. 

6) Click File->Run 

7) Repeat Step 2 and check if the DCF Editor pops up correctly.  

Required 

Data 

None. 

Expected 

Results 

The DCF Editor should be called from the GUI menu at the beginning phase of using code and in 

any phase of running the code.  
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11.63 TEST CASE 035-005 

 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-35-005 

Test 

Summary 

 

Test the menu Help works appropriately.  

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test menu Help. 

Procedure 1) Launch the code. 

2) Click Help-> Context Sensitive Help, the RESRAD-OFFSITE Help file should pop up.  

3) Click “Ambient Temperature”, “Darcy Velocity”, and “Wind Speed”, respectively, from the 

left panel under Tab Contents. The associated content should accordingly present on the right 

panel after each click.  

4) Close RESRAD-OFFSITE Help file by clicking mark X on the top right corner of the window. 

5) Press F1 at the main interface, the RESRAD-OFFSITE Help file should pop up. Repeat Steps 

3 and 4. 

6) Click Change Title from left navigation panel, put the cursor in Cut-off half life box in the 

pop-up Title & Radiological Data window, and then Press F1, the help file should pop up with 

the specific page “Half life limit for principle radionuclides” page open. Close the help file. 

7) Click Modify Data -> Primary Contamination, and put the cursor in the Box Depth of soil 

mixing layer. Pressing F1 should open the Help file with Page “Depth of Soil Mixing Layer” 

open. 

8) Click Modify Data -> Occupancy, and then put the cursor in Box Indoors on the top of the 

pop-out Occupancy window. Pressing F1 should open the Help file with page “Fraction of 

Time Spent Indoors Open Primary Contamination” open. 

9) From the main interface, click Help -> User’s Guide. A PDF file named UsersGuild.pdf should 

pop out. Close it. 

10) Repeat Step 9 by pressing F3.  

11) Click Help -> User’s Technical Manual. A PDF file named UsersManuel.pdf should pop out. 

Close it. 
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12) Repeat Step 11 by pressing F4.  

13) From the main interface, click Help -> About RESRAD-OFFSITE. The About RESRAD-

OFFSITE should pop up. 

14) Close all the windows. 

Required 

Data 

None 

Expected 

Results 

The GUI should be able to open the Help file from menu and open a specific help page by press 

F1 with the cursor focusing on a particular variable input box.  

The GUI should be able open User’s Guide and User’s Manual file from help menu or by pressing 

F3/F4 key at any window. 

Help menu should be able to open About RESRAD-OFFSITE window. 
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11.64 TEST CASE 035-006 

 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-35-006 

Test 

Summary 

 

Test the functionality of Pathways menu. 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To Test the functionality of Pathways menu. 

Procedure 1) Launch the code and clicking Set Pathways form the left panel. By default, all the 

pathways should be on except Radon pathway. 

2) Select U-238 from Initial Concentrations form. 

3) Click Pathways from the menu 

4) Click all the press buttons one by one, the check marker in front of nine pathways should 

go away and the pathway icons should present an off marker in the Set pathways form. 

5) Click all the press buttons one by one again to turn on all the pathways. The check marker 

in front of nine pathways in Pathways menu should appear again and the off marker on the 

pathway icons in the Set pathways form should go away. 

6) Turn off all the pathways again except external pathway. 

7) Save the input to file Test47.rof. 

8) Open the input file Test47.rof from notepad, and should see SELPATH = 1, indicating 

only external pathway is selected. 

9) Open project Test47.rof, and turn on Radon pathway. Save the file and Save the project 

again. 

10) Check TEST011.rof and the variable SELPATH should be 257. 

Required 

Data 

None. 

Expected 

Results 

Pathway form should be opened and closed from the menu. 

Pathways can be turned on and off by pressing either the press buttons or the pathway icons.  
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The selection of pathways should be correctly written into the input file and echoed in the report 

file. 
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11.65 TEST CASE 035-007 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-35-007 

Test 

Summary 

Test the functionality of Site Data menu 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Site Data menu.  

Procedure 1) Launch the code and click Site Data menu. It should look like the attached figure. Visually 

check the format, fonts, and spelling. 

2) Clicking the submenus one by one should open the corresponding form.  

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.66 TEST CASE 035-008 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-35-008 

Test 

Summary 

Test the functionality of View menu 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of View menu.  

Procedure 1) Launch the code and click View menu. It should look like the attached figure. Visually 

check the format, fonts, and spelling. 

2) Select U-238 and run the code. 

3) Clicking Message Log should open OUTPUT.FIL file from Viewer. 

4) Clicking Deterministic Graphics should open the graphics from WRESPLOT.EXE  

5) Clicking Uncertainty/Probabilistic Graphics should bring up the Uncertainty and 

Probabilistic Analysis interactive window. 

6) Clicking Iconic Navigator toggle Iconic Navigator window on the upper right corner of the 

main interface, and clicking it again should turn it on. 

7) Clicking Tool Bar should toggle the tool bar between on and off. 

8) Clicking Pathway Bar should toggle the pathway bar right under the main tool bar between 

on and off. 

9) Clicking Sensitivity Input Summary should toggle the sensitivity variable list at the bottom 

left corner of the main interface between on and off. 

10) Clicking Uncertainty/Probabilistic Interface should toggle the Uncertainty and 

Probabilistic Analysis interactive window between on and off. 

11) Clicking Map Interface should toggle the Map Interface window between on and off. 

12) Clicking Soil Strata Graphic should toggle the Soil Strata form between on and off 

13) Turing on Button Prompts will display a descriptive name as the cursor lingers over the 

button on tool bar or iconic navigator.  

14) Turning on Variable information will display the variable name, default value, and range 

of allowable value at the bottom of the main interface. Turn it on by clicking the submenu, 

and then open the Surface Water Body form. Put the cursor on Area of surface water body. 
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At the bottom of the windows should display the following information “Variable name: 

VLAKE   Default: 150000   Range: 1 to 1E34” 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.67 TEST CASE 035-009 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-35-009 

Test 

Summary 

Test the functionality of Text Output menu 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Text Output menu.  

Procedure 1) Launch the code and click View menu. It should look like the attached figure. Visually 

check the format, fonts, and spelling. 

2) Select U-238 and run the code. 

3) Clicking menu View -> Text Output -> Parent Dose Report should open Summary.rep by 

Viewer. 

4) Clicking View -> Text Output -> Risk Report should open INTRISK.REP by Viewer. 

5) Clicking View -> Text Output -> Progeny Dose Report should open DAUDOSE.REP by 

Viewer. 

6) Set up a parameter for uncertainty analysis and then run the code. Clicking View -> Text 

Output -> Uncertainty/Probabilistic Dose and Risk Report should open 

MCSUMMAR.REP by Viewer. 

7) Generate area factors from File|Generate area factors. Clicking View -> Text Output -> 

Area Factors Report should open AREAFACTORTEXT.REP by Viewer. 

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.68 TEST CASE 035-010 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-35-010 

Test 

Summary 

Test the functionality of Form Options menu 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Form Options menu. 

Procedure 1) Launch the code and click Form Options menu. It should look like the attached figure. 

Visually check the format, fonts, and spelling. 

2) Open Initial Concentration form and select Ac-227, then click Form Options -> Save 

Current Form. The form should be closed. Open the form again and check if Ac-227 is 

selected with concentration of 100 pCi/g. 

3) From Initial Concentration from, click Nuclide Specific Release button and the form 

should pop up. Change the value of “Specify the First Order Leach Rate Constant” from 0 

to 10, then click Form Option -> Cancel Current Form button. The Radionuclide Specific 

Release form should be closed. Open it and check if the value of “Specify the First Order 

Leach Rate Constant” is 0, rather than 10. 

4) Change the value 0 in Step 3 to 10, then save and close the Radionuclide Specific Release 

form. Open the form again, the value should be 10, rather than 0. Clicking Form Option -> 

Cancel Current Form button should close this form. Open it and check the value gain; it 

should be 10 rather than 0. 

5) Restore the value to 0 by pressing F6 on the text box and click Save to close the 

Radionuclide Specific Release form. At this time, the Initial Concentration should still be 

open. 

6) Clicking Form Option -> Cancel Current Form button should pop up a warning window 

with message “Changes to the Initial Concentration form cannot be canceled. Changes 

have to be reserved manually.” Click Ok and close the pop-up windowm. 

7) Open Distribution Coefficients form, put cursor focus on the Contaminated zone text box 

with default value of 20, then click Form Options|Sensitivity Analysis (Single Parameter) 

menu, the Set Sensitivity Analysis Range window should pop up. Click Cancel to close the 

form. 
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8) Open Distribution Coefficients form, put the cursor on the Unsaturated Zone 1 text box, 

and click Form Options|Uncertainty/Probabilistic Analysis menu. Uncertainty and 

Probabilistic Analysis window should pop up. Click Ok to close the window. 

9) Open Physical and Hydrological form, put cursor on Precipitation text box, and the click 

Form Options|Uncertainty/Probabilistic Analysis menu. Uncertainty and Probabilistic 

Analysis window should pop up again with one more variable present on the left panel. 

Click OK to close the form. 

10) Change the value of the Unsaturated Zone 1 text box to 10, and its background color 

should change to white. Click Form Options Form|Default, the default value (20) should 

replace the current value. Clicking Form Options Form|Lower Bound should change the 

value to its minimum allowable value and clicking Form Options Form|Upper Bound 

should change the value to its maximum allowable value. 

11) Repeat Steps 1-10 using hot-keys listed on the right of the submenus.  

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.69 TEST CASE 035-011 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-35-011 

Test 

Summary 

Test the functionality of Data Transfer menu. 

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the functionality of Data Transfer menu.  

Procedure 1) Launch the code and save the project to Test55.rof. 

2) Clicking Data Transfer|Generate Template files menu should bring up the Formatted Data 

Transfer form, as shown in the left figure. 

3) Click Generate files button and give a name Test55-1.rof on the pop-up Save as window. 

Close the Formatted Data Transfer form. 

4) Compare Test55.rof and Test55-1.rof. They should be identical. 

5) Clicking Data Transfer|Read Template files should bring up the Formatted Data Transfer 

form with Read files button available for clicking. 

6) Clicking Read files and select Test55-1.rof. A message window with warning message 

should popup. Click OK and then close the Formatted Data Transfer form. 

7) Test55-1.rof should be loaded.  

Required 

Data 

None. 

Expected 

Results 

The code should behave as described in each step. 
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11.70 TEST CASE 035-012 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-35-012 

Test 

Summary 

Test the GUI’s input functionality from control level.  

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test the GUI’s input functionality from control level. 

Procedure 1) Run the code and open the forms to be tested. 

2) Check the overall layout and spelling of the form. 

3) For each control (frame, text box, label.), check the following if applicable 

a. Spelling and legibility 

b. Alignment, size, and dimensions are appropriate. 

c. Whether the default values are loaded before any modification  

d. Whether the background of textbox is in yellow when default value is present and 

white when it is nondefault value. 

e. Check key F5, F6, F7 can restore the value to its minimum, default, and maximum 

f. Check its error checking function  

i. input a very small value (e.g., a negative value). An error message should 

present upon saving/closing the form with three options: change the 

currently input value to the lower bound of the variable, change to default 

value, and reentering the value. 

ii. input a very large number (e.g., 1e100 or 1.5 for fractions). An error 

message should present upon saving/closing the form with three options: 

change the current input value to the upper bound of the variable, change to 

default value, and reenter the value. 

g. Check if help works for this control. Put the cursor on the control and press F1 key, 

the help file should pop up, opening to the content for the specified variable. 

h. Check if the unit is consistent with the setting in Preliminary Input 

4) Each control should respond correctly to actions. 

Required 

Data 

None. 
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Expected 

Results 

The code should behave as described in each step. 
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11.71 TEST CASE 036-001 

 

Project RESRAD-OFFSITE 

Test Case 

ID 
RESOFF-TEST-36-001 

Test 

Summary 

 

Test the Help file works appropriately.  

Created 

By/Date 

CW 10/17/2019 

Test 

Objective 

To test Help file. 

Procedure 1) Launch the code and open the Help file from the main interface.  

2) It should have Contents, Index, and Search elements. 

3) It should include help information for parameters as shown in the figure. 

4) Click “Contaminant Flux to Surface Water Body” and then click two places on the right panel 

where the text shows a hyperlink. The help file page associated with the text should open. 

5) Click Search tab on the left panel, the type “precipitation” in the search bar and press Enter, 

then topics including the searching word should be listed in lower left panel. Clicking one 

should bring its content to the right panel. 

Required 

Data 

None 

Expected 

Results 

The Help file should have all the required content and functions.  
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11.72 TEST CASE 037 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-037 

Test 

Summary 

 

Tests OFFSITE’s DCF data 

Created 

By/Date 

DJL 11/26/2019  

Test 

Objective 

Tests OFFSITE’s DCF Data 

Procedure 1. Spot check based on PM scope request 

2.  Verify by comparing data in manual, input form, input echo in results 

3. ICRP60/ICRP72 External: Table A.2-3   

4. Further verification details are in the “Data Verification/DCF Verification”  V&V folder. 

 
Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure 
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11.73 TEST CASE 038 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-038 

Test 

Summary 

 

Tests OFFSITE’s Slope factor data 

Created 

By/Date 

DJL 11/26/2019  

Test 

Objective 

Tests OFFSITE’s Slope Factor Data 

Procedure 1. Spot check based on PM scope request 

2.  Verify by comparing data in manual, input form, input echo in results 

3. Further verification details are in the “Data Verification/slope factor Verification”  V&V 

folder. 

 
Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure 
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11.74 TEST CASE 039 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-039 

Test 

Summary 

 

Tests OFFSITE’s Transfer factor data 

Created 

By/Date 

DJL 11/26/2019  

Test 

Objective 

Tests OFFSITE’s Transfer factor Data 

Procedure 1. Spot check based on PM scope request 

2.  Verify by comparing data in manual, input form, input echo in results 

3. Further verification details are in the “Data Verification/Transfer factor Verification”  

V&V folder. 

 

 
Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure 
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11.75 TEST CASE 040 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-040 

Test 

Summary 

 

Tests OFFSITE’s Nuclide decay and ingrowth data 

Created 

By/Date 

DJL 11/26/2019  

Test 

Objective 

Tests OFFSITE’s Nuclide decay and ingrowth Data 

Procedure 1. Spot check based on PM scope request 

2.  Verify by comparing data in the .CHN file in the UsersFiles with Table A.1-1 in User’s 

Manual  

3. Further verification details are in the “Data Verification/Nuclide decay and ingrowth 

Verification”  V&V folder. 

 

 
Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure 
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11.76 TEST CASE 041 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-41 

Test 

Summary 

 

Tests OFFSITE’s external radiation model 

Created 

By/Date 

DJL 12/19/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE’s to external radiation model 

Procedure Run files below, compare to expected results, consult report spreadsheets in V&V folder on 
‘external-pathway’ 

Required 

Data 

EXTERNAL-1.ROF, EXTERNAL-2.ROF, 

Expected 

Results 

Compare with Table 1 of “Verification of External Model and External Exposure Pathway 

Dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\external-pathway\  
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11.77 TEST CASE 042 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-042 

Test 

Summary 

 

Tests OFFSITE’s default uncertainty distribution data 

Created 

By/Date 

DJL 11/26/2019  

Test 

Objective 

Tests default uncertainty distribution data 

Procedure 1. Spot check based on PM scope request 

2.  Verify by comparing data in probabilistic input form and Appendix C of “Default 

Parameter Values and Distribution in RESRAD-ONSITE V7.2, RESRAD-BUILD V3.5, 

and RESRAD-OFFSITE V4.0 Computer Codes 

3. Further verification details are in the “Data Verification/parameter distribution 

comparison”  V&V folder. 

 

 
Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure 
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11.78 TEST CASE 044 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-044 

Test 

Summary 

 

Tests OFFSITE’s validation of user’s email for download 

Created 

By/Date 

DJL 11/26/2019  

Test 

Objective 

Tests OFFSITE’s validation of user’s email for download 

Procedure 1. Go through download registration process on website. 

2. Verify receipt of email for access to download 

3. Verify email link allows access 

4. Verify download 

 
Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure 
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11.79 TEST CASE 047 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-047 

Test 

Summary 

 

Tests OFFSITE’s Area factor tool 

Created 

By/Date 

DJL 11/26/2019 BASED ON EG suggestion 

Test 

Objective 

Tests OFFSITE’s area factor tool 

Procedure 1. perform an area factors run with a very narrow range (or a point range if that is possible) 

of dimensions. 

2. Check that the area factors are calculated using the dose from the critical location. 

3. Manually input the values for the critical run and verify that the dose matches the dose 

from the area factors run. 

 

Required 

Data 

NA 

Expected 

Results 

Area factor from tool is the ratio of the peak dose from the limited and full contaminated area. 
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11.80 TEST CASE 048 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-048 

Test 

Summary 

 

Tests OFFSITE’s generation of template files tool 

Created 

By/Date 

DJL 11/26/2019 BASED ON EG suggestion 

Test 

Objective 

Tests OFFSITE’s generation of template files tool 

Procedure 1. generate the data transfer template files, make copies of these files for later use 

2. open them in excel 

3. multiply each input by some constant, not too large a constant to avoid exceeding the 

upper bound. 

a.  can do this by copying an expression and then copying back the value of the 

expression. 

4.  read the modified template file. 

5. do a few spot checks of inputs in the forms; automate the checking of all the inputs as in 

the steps below 

6. generate another set of template files. 

7. compare with the copies of the template files in 1 and verify that they are in the ratio of the 

constant used in 3. 

8. divide by the factor used in 3. 

9. read the modified template file. 

10. Chain through all the input forms to verify that the inputs are back at their defaults. 

 

Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure. 
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11.81 TEST CASE 049 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-049 

Test 

Summary 

 

Tests OFFSITE’s pathway option tool 

Created 

By/Date 

DJL 11/26/2019 BASED ON EG suggestion 

Test 

Objective 

Tests OFFSITE’s pathway option tool 

Procedure 1. create an input file with only one exposure pathway active. 

2. Chain through all the input forms to verify the enabled / disabled status of the inputs in the 

forms. 

3. Run the file and check the input echo. 

4. Repeat for each exposure pathway. 

 

Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure. 
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11.82 TEST CASE 050 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-050 

Test 

Summary 

 

Tests OFFSITE’s transformation database option tool 

Created 

By/Date 

DJL 11/26/2019 BASED ON EG suggestion 

Test 

Objective 

Tests OFFSITE’s transformation database option tool 

Procedure 1. create an input file under one choice of transformation data 

2. change all the radionuclide specific properties (release properties, distribution coefficients, 

transfer factors, deposition velocities). 

3. switch to the other transformation data. 

4. verify that the radionuclide specific properties that were input in 2 are still there. Can use 

the data transfer feature do this more easily. 

 

Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure. 
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11.83 TEST CASE 051 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-051 

Test 

Summary 

 

Tests OFFSITE’s transformation DCF database option tool 

Created 

By/Date 

DJL 11/26/2019 BASED ON EG suggestion 

Test 

Objective 

Tests OFFSITE’s transformation DCF database option tool 

Procedure 1. Select one of the transformation data choices. 

2. Verify the choices of libraries available for the internal dose library and the risk library. 

3. Repeat for the other choice of transformation data. 

4. Repeat the check after creating a user library under each of the transformation data 

choices. 

 

Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure. 
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11.84 TEST CASE 052 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-052 

Test 

Summary 

 

Tests OFFSITE’s transformation DCF database option tool 

Created 

By/Date 

DJL 11/26/2019 BASED ON EG suggestion 

Test 

Objective 

Tests OFFSITE’s transformation DCF database option tool 

Procedure 1. Use the example in Appendix E.4, but after verifying the calculations described there. 

 

Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure. 
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11.85 TEST CASE 053 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-053 

Test 

Summary 

 

Tests OFFSITE’s source conceptualization options tool 

Created 

By/Date 

DJL 11/26/2019 BASED ON EG suggestion 

Test 

Objective 

Tests OFFSITE’s source conceptualization options tool 

Procedure 1. Create an input file under each of the 4 main conceptualizations and the two sub 

conceptualizations. 

2. Verify that the appropriate release options are shown in the source form and or the release 

properties form. 

 

 
Required 

Data 

NA 

Expected 

Results 

Underlined steps in above procedure. 
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11.86 TEST CASE 054-001 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-054-001 

Test 

Summary 

 

Tests OFFSITE C14 concentration in primary contamination 

Created 

By/Date 

DJL 1/14/20 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE C14 concentration in primary contamination 

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘special radionuclides’ 

Required 

Data 

CARBON-14.ROF 

Expected 

Results 

Compare the primary contamination concentrations with c14.xlsx in V&V folder on ‘special 
radionuclides’ 
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11.87 TEST CASE 054-002 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-054-002 

Test 

Summary 

 

Tests OFFSITE C14 plant concentrations 

Created 

By/Date 

DJL 1/14/20 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE C14 plant concentrations 

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘special radionuclides’ 

Required 

Data 

CARBON-14.ROF 

Expected 

Results 

Compare the plant concentrations with c14.xlsx in V&V folder on ‘special radionuclides’ 
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11.88 TEST CASE 054-003 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-054-003 

Test 

Summary 

 

Tests OFFSITE C14 meat and milk concentrations 

Created 

By/Date 

DJL 1/14/20 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE C14 meat and milk concentrations 

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘special radionuclides’ 

Required 

Data 

CARBON-14.ROF 

Expected 

Results 

Compare the meat and milk concentrations with c14.xlsx in V&V folder on ‘special radionuclides’ 
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11.89 TEST CASE 054-004 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-054-004 

Test 

Summary 

 

Tests OFFSITE H3 concentration in primary contamination 

Created 

By/Date 

DJL 1/14/20 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE H3 concentration in primary contamination 

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘special radionuclides’ 

Required 

Data 

HYDROGEN-3.ROF 

Expected 

Results 

Compare the primary contamination concentrations with H3.xlsx in V&V folder on ‘special 
radionuclides’ 
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11.90 TEST CASE 054-005 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-054-005 

Test 

Summary 

 

Tests OFFSITE H3 plant concentrations 

Created 

By/Date 

DJL 1/14/20 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE H3 plant concentrations 

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘special radionuclides’ 

Required 

Data 

HYDROGEN-3.ROF 

Expected 

Results 

Compare the plant concentrations with h3.xlsx in V&V folder on ‘special radionuclides’ 
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11.91 TEST CASE 054-006 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-054-006 

Test 

Summary 

 

Tests OFFSITE H3 meat and milk concentrations 

Created 

By/Date 

DJL 1/14/20 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE H3 meat and milk concentrations 

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘special radionuclides’ 

Required 

Data 

HYDROGEN-3.ROF 

Expected 

Results 

Compare the meat and milk concentrations with H3.xlsx in V&V folder on ‘special radionuclides’ 
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11.92 TEST CASE 111 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-111 

Test 

Summary 

 

Tests OFFSITE Activated Metal Case I: new source term 

Created 

By/Date 

DJL 11/24/2019 BASED ON JJC VERIFICATION 

Test 

Objective 

Test features of OFFSITE new source term; delay 500 years 

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘Source Term Benchmarking with Dust’ 

Required 

Data 

ACTIVATED METAL-500_1000 COSTANT.ROF 

Expected 

Results 

Compare with Figures Manual 4.0, vol. 1, App M, Figures M3.2-11 
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11.93 TEST CASE 112 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docxRESOFF-

TEST-112 

Test 

Summary 

 

Tests OFFSITE Activated Metal Case II : new source term 

Created 

By/Date 

DJL 11/24/2019 BASED ON JJC VERIFICATION 

Test 

Objective 

Test features of OFFSITE new source term; delay 1000 years 

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘Source Term Benchmarking with Dust’ 

Required 

Data 

ACTIVATED METAL-1000_10000 COSTANT.ROF 

Expected 

Results 

Compare with Figures Manual 4.0, vol. 1, App M, Figgues M4.1-10 
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11.94 TEST CASE 113 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx-TEST-113 

Test 

Summary 

 

Tests OFFSITE Activated Metal Case III : increasing corrosion rate 

Created 

By/Date 

DJL 11/24/2019 BASED ON JJC VERIFICATION 

Test 

Objective 

Test features of OFFSITE new source term; increasing corrosion rate 

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘Source Term Benchmarking with Dust’ 

Required 

Data 

ACTIVATED METAL-500_1000 INCREASE.ROF 

Expected 

Results 

Compare with Figures Manual 4.0, vol. 1, App M, Figures M5.2-11 
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11.95 TEST CASE 114 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx-TEST-114 

Test 

Summary 

 

Tests OFFSITE Activated Metal Case IV : TRU Waste 

Created 

By/Date 

DJL 11/24/2019 BASED ON JJC VERIFICATION 

Test 

Objective 

Test features of OFFSITE new source term;  

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘Source Term Benchmarking with Dust’ 

Required 

Data 

OTHER WASTE-KD=0_500-V2_DT2.ROF 

Expected 

Results 

Compare with Figures Manual 4.0, vol. 1, App M, Figures M6.2-7 

 

 

 

 

 

 

  



 

293 

11.96 TEST CASE 115 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx 

Test 

Summary 

 

Tests OFFSITE Activated Metal Case V : Grouted TRU Waste 

Created 

By/Date 

DJL 11/24/2019 BASED ON JJC VERIFICATION 

Test 

Objective 

Test features of OFFSITE new source term;  

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘Source Term Benchmarking with Dust’ 

Required 

Data 

OTHER WASTE-KD=CEMENT_500_DT2-DUST-REVISED.ROF 

Expected 

Results 

Compare with Figures Manual 4.0, vol. 1, App M, Figures M7.2-7 
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11.97 TEST CASE 116 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx 

Test 

Summary 

 

Tests OFFSITE Activated Metal Case VI : Grouted TRU Waste 

Created 

By/Date 

DJL 11/24/2019 BASED ON JJC VERIFICATION 

Test 

Objective 

Test features of OFFSITE new source term;  

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘Source Term Benchmarking with Dust’ 

Required 

Data 

OTHER WASTE-KD=0_500_DT1-DIF-DUST-REVISED.ROF 

Expected 

Results 

Compare with Figures Manual 4.0, vol. 1, App M, Figures M8.2-7 
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11.98 TEST CASE 117 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx 

Test 

Summary 

 

Tests OFFSITE Activated Metal Case VII : Grouted TRU Waste w diffusion 

Created 

By/Date 

DJL 11/24/2019 BASED ON JJC VERIFICATION 

Test 

Objective 

Test features of OFFSITE new source term;  

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘Source Term Benchmarking with Dust’ 

Required 

Data 

SELAED SOURCES-TRENCH-LEACH_300-800-V2.ROF 

Expected 

Results 

Compare with Figures Manual 4.0, vol. 1, App M, Figures M9.2-3 
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11.99 TEST CASE 118 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx 

Test 

Summary 

 

Tests OFFSITE Activated Metal Case VII : Grouted TRU Waste w solubility-controlled release 

Created 

By/Date 

DJL 11/24/2019 BASED ON JJC VERIFICATION 

Test 

Objective 

Test features of OFFSITE new source term;  

Procedure Run file below, compare to expected results, consult Verification report and V&V folder on 
‘Source Term Benchmarking with Dust’ 

Required 

Data 

SELAED SOURCES-TRENCH-SOLUBILITY_300-800-V2.ROF 

Expected 

Results 

Compare with Figures Manual 4.0, vol. 1, App M, Figures M10.2-12 
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11.100 TEST CASE 401 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx 

Test 

Summary 

 

Tests OFFSITE Plant concentrations 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE plant concentrations;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘combined testing (food concentration and ingestion dose)” 

Required 

Data 

SR-90-COMPREHENSIVE.ROF 

Expected 

Results 

Compare with Figures  1-4 of “Verification of Plant meat milk aquatic food concentration and 

ingestion pathway dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\combined testing (food concentration and ingestion dose) 
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11.101 TEST CASE 402 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx 

Test 

Summary 

 

Tests OFFSITE Meat and Milk concentrations 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE Meat & milk concentrations;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘combined testing (food concentration and ingestion dose)” 

Required 

Data 

SR-90-COMPREHENSIVE.ROF 

Expected 

Results 

Compare with Figures  5-6 of “Verification of Plant meat milk aquatic food concentration and 

ingestion pathway dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\combined testing (food concentration and ingestion dose) 
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11.102 TEST CASE 403 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx 

Test 

Summary 

 

Tests OFFSITE Aquatic Foods concentrations 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE aquatic food concentrations;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘combined testing (food concentration and ingestion dose)” 

Required 

Data 

SR-90-COMPREHENSIVE.ROF 

Expected 

Results 

Compare with Figures  7-8 of “Verification of Plant meat milk aquatic food concentration and 

ingestion pathway dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\combined testing (food concentration and ingestion dose) 
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11.103 TEST CASE 404 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx 

Test 

Summary 

 

Tests OFFSITE Plant ingestion dose 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE plant pathway dose;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘combined testing (food concentration and ingestion dose)” 

Required 

Data 

SR-90-COMPREHENSIVE.ROF 

Expected 

Results 

Compare with Figures  9 of “Verification of Plant meat milk aquatic food concentration and 

ingestion pathway dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\combined testing (food concentration and ingestion dose) 
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11.104 TEST CASE 405 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx 

Test 

Summary 

 

Tests OFFSITE Meat and Milk Pathway Doses 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE Meat and Milk Pathway Doses;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘combined testing (food concentration and ingestion dose)” 

Required 

Data 

SR-90-COMPREHENSIVE.ROF 

Expected 

Results 

Compare with Figures  10 & 11 of “Verification of Plant meat milk aquatic food concentration 

and ingestion pathway dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\combined testing (food concentration and ingestion dose) 
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11.105 TEST CASE 406 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx 

Test 

Summary 

 

Tests OFFSITE Aquatic Pathway Doses 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE Aquatic Pathway Doses;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘combined testing (food concentration and ingestion dose)” 

Required 

Data 

SR-90-COMPREHENSIVE.ROF 

Expected 

Results 

Compare with Figure 12 of “Verification of Plant meat milk aquatic food concentration and 

ingestion pathway dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\combined testing (food concentration and ingestion dose) 
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11.106 TEST CASE 407 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

Compilation of verification of RESRAD-OFFSITE 4.0 formatted with test cases.docx 

Test 

Summary 

 

Tests OFFSITE Drinking Water Pathway Doses 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE Drinking Water Pathway Doses;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘combined testing (food concentration and ingestion dose)” 

Required 

Data 

SR-90-COMPREHENSIVE.ROF 

Expected 

Results 

Compare with Figure  13 of “Verification of Plant meat milk aquatic food concentration and 

ingestion pathway dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\combined testing (food concentration and ingestion dose) 
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11.107 TEST CASE 411 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-411 

Test 

Summary 

 

Tests OFFSITE’s Offsite soil concentration in leafy vegetable agricultural field 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE soil concentration in leafy vegetable agricultural field;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘accumulation-at-offsite-testing” 

Required 

Data 

offsite-accumulation-test1.rof 

Expected 

Results 

Compare with Figure 1 of “Verification of Accumulation at offsite location.docx” in  

R:\_QA_Files\OFFSITE\V&V\accumulation-at-offsite-testing 
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11.108 TEST CASE 412 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-412 

Test 

Summary 

 

Tests OFFSITE’s Offsite soil concentration in pasture agricultural field 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test Offsite soil concentration in pasture agricultural field;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘accumulation-at-offsite-testing” 

Required 

Data 

offsite-accumulation-test2.rof 

Expected 

Results 

Compare with Figure 2 of “Verification of Accumulation at offsite location.docx” in  

R:\_QA_Files\OFFSITE\V&V\accumulation-at-offsite-testing 
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11.109 TEST CASE 413 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-413 

Test 

Summary 

 

Tests OFFSITE’s Offsite soil concentration in grain agricultural field 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE soil concentration in grain agricultural field;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘accumulation-at-offsite-testing” 

Required 

Data 

offsite-accumulation-test3.rof 

Expected 

Results 

Compare with Figures  3 of “Verification of Accumulation at offsite location.docx” in  

R:\_QA_Files\OFFSITE\V&V\accumulation-at-offsite-testing 
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11.110 TEST CASE 414 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-414 

Test 

Summary 

 

Tests OFFSITE’s Offsite soil concentration in Non-leafy vegetable agricultural field 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE soil concentration in non-leafy vegetable agricultural field;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘accumulation-at-offsite-testing” 

Required 

Data 

offsite-accumulation-test4.rof 

Expected 

Results 

Compare with Figure  4 of “Verification of Accumulation at offsite location.docx” in  

R:\_QA_Files\OFFSITE\V&V\accumulation-at-offsite-testing 
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11.111 TEST CASE 415 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-415 

Test 

Summary 

 

Tests OFFSITE’s Offsite soil concentration in non-leafy vegetable agricultural field contributed by 
erosion 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE soil concentration in non-leafy vegetable agricultural field contributed by 
erosion;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘accumulation-at-offsite-testing” 

Required 

Data 

offsite-accumulation-Test4-erosion-only.rof.rof 

Expected 

Results 

Compare with Figures  5 of “Verification of Accumulation at offsite location.docx” in  

R:\_QA_Files\OFFSITE\V&V\accumulation-at-offsite-testing 
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11.112 TEST CASE 416 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-416 

Test 

Summary 

 

Tests OFFSITE’s Offsite soil concentration in non-leafy vegetable agricultural field contributed by 
air deposition 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE soil concentration in non-leafy vegetable agricultural field contributed by 
air deposition;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘accumulation-at-offsite-testing” 

Required 

Data 

offsite-accumulation-Test4-air-dep-only.rof.rof 

Expected 

Results 

Compare with Figure 6 of “Verification of Accumulation at offsite location.docx” in  

R:\_QA_Files\OFFSITE\V&V\accumulation-at-offsite-testing 

 

 

 

  



 

310 

11.113 TEST CASE 417 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-417 

Test 

Summary 

 

Tests OFFSITE’s Offsite soil concentration in non-leafy vegetable agricultural field contributed by 
surface water irrigation 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE soil concentration in non-leafy vegetable agricultural field contributed by 
surface water irrigation;  

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘accumulation-at-offsite-testing” 

Required 

Data 

offsite-accumulation-Test4-surface-water-only.rof.rof 

Expected 

Results 

Compare with Figures  7 of “Verification of Accumulation at offsite location.docx” in  

R:\_QA_Files\OFFSITE\V&V\accumulation-at-offsite-testing 
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11.114 TEST CASE 421 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-421 

Test 

Summary 

 

Tests OFFSITE’s Offsite air concentration (Briggs rural, no deposition, with plume rise) 

Created 

By/Date 

DJL 11/24/2019 based on SK Verification 

Test 

Objective 

Test features of OFFSITE air concentration (Briggs rural, no deposition, with plume rise) 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on ‘air-

dispersion-model-testing’ 

Required 

Data 

AIR DISPERSION RUN1.rof 

Expected 

Results 

Compare with Table 2 of “Verification of Atmospheric Transport Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\air-dispersion-model-testing 
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11.115 TEST CASE 422 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-422 

Test 

Summary 

 

Tests OFFSITE’s Offsite air concentration (PG, dry deposition, with plume rise) 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE air concentration (PG, dry deposition, with plume rise) 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on ‘air-

dispersion-model-testing’ 

Required 

Data 

AIR DISPERSION RUN2.rof 

Expected 

Results 

Compare with Table 2 of “Verification of Atmospheric Transport Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\air-dispersion-model-testing 
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11.116 TEST CASE 423 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-423 

Test 

Summary 

 

Tests OFFSITE’s Offsite air concentration (PG, dry & wet deposition, with plume rise) 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE air concentration (PG, dry & wet deposition, with plume rise) 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on ‘air-

dispersion-model-testing’ 

Required 

Data 

AIR DISPERSION RUN3.rof 

Expected 

Results 

Compare with Table 2  of “Verification of Atmospheric Transport Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\air-dispersion-model-testing 
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11.117 TEST CASE 424 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-424 

Test 

Summary 

 

Tests OFFSITE’s Offsite air concentration (PG, no deposition, no plume rise) 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE air concentration (PG, no deposition, no plume rise) 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on ‘air-

dispersion-model-testing’ 

Required 

Data 

AIR DISPERSION RUN4.rof 

Expected 

Results 

Compare with Table 3  of “Verification of Atmospheric Transport Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\air-dispersion-model-testing 
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11.118 TEST CASE 425 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-425 

Test 

Summary 

 

Tests OFFSITE’s Offsite air concentration (PG, dry deposition, no plume rise) 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE air concentration (PG, dry deposition, no plume rise) 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on ‘air-

dispersion-model-testing’ 

Required 

Data 

AIR DISPERSION RUN5.rof 

Expected 

Results 

Compare with Table 3  of “Verification of Atmospheric Transport Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\air-dispersion-model-testing 
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11.119 TEST CASE 426 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-426 

Test 

Summary 

 

Tests OFFSITE’s Offsite air concentration (PG, dry & wet deposition, no plume rise) 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE air concentration (PG, dry and wet deposition, no plume rise) 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on ‘air-

dispersion-model-testing’ 

Required 

Data 

AIR DISPERSION RUN6.rof 

Expected 

Results 

Compare with Table 3 of “Verification of Atmospheric Transport Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\air-dispersion-model-testing 
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11.120 TEST CASE 427 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-427 

Test 

Summary 

 

Tests OFFSITE’s Offsite air concentration (PG, wet deposition, no plume rise) 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE air concentration (PG, wet deposition, no plume rise) 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on ‘air-

dispersion-model-testing’ 

Required 

Data 

AIR DISPERSION RUN7.rof 

Expected 

Results 

Compare with Table 4 of “Verification of Atmospheric Transport Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\air-dispersion-model-testing 
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11.121 TEST CASE 428 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-428 

Test 

Summary 

 

Tests OFFSITE’s Offsite air depletion 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE air depletion 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on ‘air-

dispersion-model-testing’ 

Required 

Data 

AIR DISPERSION RUN5.rof 

Expected 

Results 

Compare with Table 5 & 6 of “Verification of Atmospheric Transport Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\air-dispersion-model-testing 
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11.122 TEST CASE 431 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-431 

Test 

Summary 

 

Tests OFFSITE’s Offsite surface water body accumulation with cover Tc-99 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE surface Water body accumulation with cover 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘surface-water-model-testing’ 

Required 

Data 

SURF-WATER-CHECK-TC99-TEST1.rof 

Expected 

Results 

Compare with Figure 1 of “Verification of Surface Water Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\surface-water-model-testing  
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11.123 TEST CASE 432 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-432 

Test 

Summary 

 

Tests OFFSITE’s Offsite surface water body accumulation no cover Tc-99 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE surface Water body accumulation no cover 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘surface-water-model-testing’ 

Required 

Data 

SURF-WATER-CHECK-TC99-TEST2.rof 

Expected 

Results 

Compare with figure 2 of “Verification of Surface Water Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\surface-water-model-testing  
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11.124 TEST CASE 433 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-433 

Test 

Summary 

 

Tests OFFSITE’s Offsite surface water body accumulation with cover, U-234 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE surface Water body accumulation no cover 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘surface-water-model-testing’ 

Required 

Data 

SURF-WATER-CHECK-U234-TEST1.rof 

Expected 

Results 

Compare with figure 3 of “Verification of Surface Water Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\surface-water-model-testing  
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11.125 TEST CASE 434 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-434 

Test 

Summary 

 

Tests OFFSITE’s Offsite surface water body accumulation no cover, U-234 

Created 

By/Date 

DJL 11/24/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE surface Water body accumulation no cover 

Procedure Run file below, compare to expected results, consult report spreadsheets in V&V folder on 
‘surface-water-model-testing’ 

Required 

Data 

SURF-WATER-CHECK-U234-TEST2.rof 

Expected 

Results 

Compare with figure 4 of “Verification of Surface Water Model.docx” in  

R:\_QA_Files\OFFSITE\V&V\surface-water-model-testing  
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11.126 TEST CASE 435 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-435 

Test 

Summary 

 

Tests OFFSITE’s release to air 

Created 

By/Date 

DJL 12/19/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE’s release to air 

Procedure Run files below, compare to expected results, consult report spreadsheets in V&V folder on ‘air 

release’ 

Required 

Data 

AIR RELEASE COMP CASE1.ROF, AIR RELEASE COMP CASE2.ROF 

Expected 

Results 

Compare with figure 1 & 2 of “Verification of Air Release from surface layer.docx” in  

R:\_QA_Files\OFFSITE\V&V\Air release\  
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11.127 TEST CASE 436 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-436 

Test 

Summary 

 

Tests OFFSITE’s release to erosion 

Created 

By/Date 

DJL 12/19/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE’s release to erosion 

Procedure Run files below, compare to expected results, consult report spreadsheets in V&V folder on 
‘erosion release’ 

Required 

Data 

EROSION RELEASE COMP CASE1.ROF, EROSION RELEASE COMP CASE2.ROF 

Expected 

Results 

Compare with figure 1 & 2 of “Verification of Erosion Release from surface layer.docx” in  

R:\_QA_Files\OFFSITE\V&V\Erosion release\  
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11.128 TEST CASE 437 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-437 

Test 

Summary 

 

Tests OFFSITE’s external radiation model 

Created 

By/Date 

DJL 12/19/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE’s to external radiation model 

Procedure Run files below, compare to expected results, consult report spreadsheets in V&V folder on 
‘external-pathway’ 

Required 

Data 

EXTERNAL-1.ROF, EXTERNAL-2.ROF, 

Expected 

Results 

Compare with Table 1 of “Verification of External Model and External Exposure Pathway 

Dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\external-pathway\  
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11.129 TEST CASE 438 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-438 

Test 

Summary 

 

Tests OFFSITE’s external radiation model 

Created 

By/Date 

DJL 12/19/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE’s external radiation model 

Procedure Run files below, compare to expected results, consult report spreadsheets in V&V folder on 
‘external-pathway’ 

Required 

Data 

EXTERNAL-3.ROF, EXTERNAL-4.ROF 

Expected 

Results 

Compare with Figures 1-4 of “Verification of External Model and External Exposure Pathway 

Dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\external-pathway\ 
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11.130 TEST CASE 439 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-439 

Test 

Summary 

 

Tests OFFSITE’s Particulate inhalation 

Created 

By/Date 

DJL 12/19/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE’s Particulate inhalation 

Procedure Run files below, compare to expected results, consult report spreadsheets in V&V folder on 
‘particulate inhalation pathway’ 

Required 

Data 

INHALATION-1.ROF, INHALATION-2.ROF, INHALATION-3.ROF, INHALATION-4.ROF 

Expected 

Results 

Compare with figure 1-8 of “Verification of Particulate Inhalation Pathway Dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\Particulate Inhalation Pathway 
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11.131 TEST CASE 440 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-440 

Test 

Summary 

 

Tests OFFSITE’s Soil ingestion 

Created 

By/Date 

DJL 12/19/2019 BASED ON SK VERIFICATION 

Test 

Objective 

Test features of OFFSITE’s Soil ingestion 

Procedure Run files below, compare to expected results, consult report spreadsheets in V&V folder on ‘soil 
ingestion pathway’ 

Required 

Data 

SOIL-INGESTION-1.ROF, SOIL-INGESTION-2.ROF, SOIL-INGESTION-3.ROF, SOIL-INGESTION-4.ROF 

Expected 

Results 

Compare with figure 1-8 of “Verification of Soil Ingestion Pathway Dose.docx” in  

R:\_QA_Files\OFFSITE\V&V\Soil ingestion pathway 
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11.132 TEST CASE 441 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-441 

Test 

Summary 

 

Tests OFFSITE’s groundwater transport model Kd=0  

Created 

By/Date 

DJL 11/24/2019 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE’s groundwater transport model Kd=0  

Procedure Copy AQFLUXIN.dat from the \KD0\AQFLUXIN1 folder to the OFFSITE root directory. Run file 
below, compare to expected results, consult report spreadsheets in V&V folder on ‘Groundwater 

transport\flux input’ 

Required 

Data 

UNSATURATED FLUXIN KD 0.rof 

Expected 

Results 

Compare results from WTFLUXIN.DAT with spreadsheet ‘unsaturated 0.xlsx’ in  

R:\_QA_Files\OFFSITE\V&V\Groundwater transport\flux input 
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11.133 TEST CASE 442 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-442 

Test 

Summary 

 

Tests OFFSITE’s groundwater transport model Kd=1  

Created 

By/Date 

DJL 11/24/2019 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE’s groundwater transport model Kd=1  

Procedure Copy AQFLUXIN.dat from the \KD1\AQFLUXIN1 folder to the OFFSITE root directory.  Run file 
below, compare to expected results, consult report spreadsheets in V&V folder on ‘Groundwater 

transport\flux input’ 

Required 

Data 

UNSATURATED FLUXIN KD 1.rof 

Expected 

Results 

Compare results from WTFLUXIN.DAT with spreadsheet unsaturated 1.xlsx in  

R:\_QA_Files\OFFSITE\V&V\Groundwater transport\flux input 
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11.134 TEST CASE 443 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-443 

Test 

Summary 

 

Tests OFFSITE’s groundwater transport model Kd=10 

Created 

By/Date 

DJL 11/24/2019 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE’s groundwater transport model Kd=10 

Procedure Copy AQFLUXIN.dat from the \KD10\AQFLUXIN1 folder to the OFFSITE root directory.  Run file 
below, compare to expected results, consult report spreadsheets in V&V folder on ‘Groundwater 

transport\flux input’ 

Required 

Data 

UNSATURATED FLUXIN KD 10.rof 

Expected 

Results 

Compare results from WTFLUXIN.DAT with spreadsheet unsaturated 10.xlsx in  

R:\_QA_Files\OFFSITE\V&V\Groundwater transport\flux input 
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11.135 TEST CASE 444 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-444 

Test 

Summary 

 

Tests OFFSITE’s groundwater transport model Kd=100 

Created 

By/Date 

DJL 11/24/2019 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE’s groundwater transport model Kd=100 

Procedure Copy AQFLUXIN.dat from the \KD10\AQFLUXIN1 folder to the OFFSITE root directory.  Run file 
below, compare to expected results, consult report spreadsheets in V&V folder on ‘Groundwater 

transport\flux input’ 

Required 

Data 

UNSATURATED FLUXIN KD 100.rof 

Expected 

Results 

Compare results from WTFLUXIN.DAT with spreadsheet unsaturated 100.xlsx in  

R:\_QA_Files\OFFSITE\V&V\Groundwater transport\flux input 
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11.136 TEST CASE 445 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-445 

Test 

Summary 

 

Tests OFFSITE’s groundwater transport model Kd=0  

Created 

By/Date 

DJL 01/14/20 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE’s groundwater transport model Kd=0  

Procedure Copy AQFLUXIN.dat from the \SKD0\AQFLUXIN1 folder to the OFFSITE root directory. Run file 
below, compare to expected results, consult report spreadsheets in V&V folder on ‘Groundwater 

transport\ pulse input over part of the transport zone\’ 

Required 

Data 

SATURATED FLUXIN KD 0.rof 

Expected 

Results 

Compare results from GWtoSWBFLUX.DAT with spreadsheet ‘saturated 0.xlsx’ in  

R:\_QA_Files\OFFSITE\V&V\Groundwater transport\pulse input over part of the transport zone\  
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11.137 TEST CASE 446 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-446 

Test 

Summary 

 

Tests OFFSITE’s groundwater transport model Kd=1  

Created 

By/Date 

DJL 01/14/20 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE’s groundwater transport model Kd=1  

Procedure Copy AQFLUXIN.dat from the \SKD1\AQFLUXIN1 folder to the OFFSITE root directory.  Run file 
below, compare to expected results, consult report spreadsheets in V&V folder on ‘Groundwater 

transport\ pulse input over part of the transport zone\’ 

Required 

Data 

SATURATED FLUXIN KD 1.rof 

Expected 

Results 

Compare results from GWtoSWBFLUX.DAT with spreadsheet unsaturated 1.xlsx in  

R:\_QA_Files\OFFSITE\V&V\Groundwater transport\ pulse input over part of the transport zone\ 
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11.138 TEST CASE 447 

 

Project RESRAD-OFFSITE 

Test Case 

ID 

RESOFF-TEST-447 

Test 

Summary 

 

Tests OFFSITE’s groundwater transport model Kd=10 

Created 

By/Date 

DJL 01/14/20 BASED ON EG VERIFICATION 

Test 

Objective 

Tests OFFSITE’s groundwater transport model Kd=10 

Procedure Copy AQFLUXIN.dat from the \SKD10\AQFLUXIN1 folder to the OFFSITE root directory.  Run file 
below, compare to expected results, consult report spreadsheets in V&V folder on ‘Groundwater 

transport\ pulse input over part of the transport zone\’ 

Required 

Data 

SATURATED FLUXIN KD 10.rof 

Expected 

Results 

Compare results from GWtoSWBFLUX.DAT with spreadsheet unsaturated 10.xlsx in  

R:\_QA_Files\OFFSITE\V&V\Groundwater transport\ pulse input over part of the transport 

zone\’ 
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APPENDIX 12: TESTERS’ REPORTS 

The reports written by those who performed the release testing for each of the tests 

defined in the previous section, while performing each test or soon after, are gathered in this 

section. These reports are similar to field notes or laboratory notes and are therefore not edited.  
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12.1 TEST CASE 001 TESTER’S REPORT 

Documented in Results_ Test Case 001.msg of 2/14/2020 3:09 PM 

Results: Test Case 001 

LePoire, David J.  Thu 2/14/2020 3:09 PM 

 

From Microsoft Windows support page: https://support.microsoft.com/en-

us/help/13853/windows-lifecycle-fact-sheet 

The two currently supported Windows Operating Systems are Windows 10 and Windows 

8.1:  (Windows 7 extended supported ended Jan 14, 2020) 

 

https://support.microsoft.com/en-us/help/13853/windows-lifecycle-fact-sheet
https://support.microsoft.com/en-us/help/13853/windows-lifecycle-fact-sheet
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Installing on VM Win 8: 
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On VM Win10 
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12.2 TEST CASE 002 TESTER’S REPORT 

Documented in Test-002_report.docx of 2/20/2020 6:32 AM 

Test Case 002 Report 

By cheng wang 2/13/2020 

 

Objective: To test OFFSITE Nuclide Decay and Ingrowth 

Conclusion: the code worked as expected.  

 

Procedure: 

 

1. Copy input files to the folder 

C:\Users\ChengWang\Research\Projects\RESRAD\OFFSITE\v4.0\ReleaseTesting\002 

2. Run the input file.  

3. Export the concentration for U-238, U-234, Th-230, Ra-226, Pb-210, Po-210 to the folder. 

4. Put all the results in file “test-001_comp.xlsx” and compare with the expected results. 

As shown in test-001_comp.xlsx, the results matched with the expected results, except the 

concentrations of Pb-210 and Po-210 at time 1 year. The discrepancies are acceptable.  

Year Pb-210 from 

code 

Pb-210 hand-

calculated 

Po-210 form 

code 

Po-210 hand-

calculated 

1 1.38E-15 1.40E-15 4.13E-16 4.01E-16 
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12.3 TEST CASE 003-001 TESTER'S REPORT 

Documented in Test-003-001_report.docx of 2/19/2020 3:16 PM 

Test Case 003-001 report 

By cheng wang 2/13/2020 

 

Objective: 

Conclusion: the code worked as expected. 

 

Procedure: 

1. Copy input files to the folder 

C:\Users\ChengWang\Research\Projects\RESRAD\OFFSITE\v4.0\ReleaseTesting\003-001 

2. Run the input file.  

3. Copy file “CZTHICK3.DAT” to the testing folder, rearrange the data to file 

“CZTHICK3.xlsx”, and compare the results with the expected ones. 

 

The results calculated by code matched with the expected results.  

  



 

352 

12.4 TEST CASE 003-002 TESTER’S REPORT 

Documented in Test-003-002_report.docx of 2/19/2020 3:16 PM 

Test Case 003-002 report 

By cheng wang 2/13/2020 

 

Objective: Tests OFFSITE Source Term Mixing Concentration 

Conclusion: the code worked as expected 

 

Procedure 

1. Copy input files to the folder 

C:\Users\ChengWang\Research\Projects\RESRAD\OFFSITE\v4.0\ReleaseTesting\003-002 

2. Run the input file.  

3. Copy file “CZTHICK3.DAT” to the testing folder, rearrange the data to file 

“CZTHICK3.xlsx”, and compare the results with the expected ones. 

 

The results calculated by code matched with the expected results. 
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12.5 TEST CASE 003-003 TESTER’S REPORT 

Documented in Test-003-003_report.docx of 2/19/2020 3:24 PM 

Test Case 003-003 report 

By cheng wang 2/13/2020 

 

Objective: Tests OFFSITE Source Term Mixing Concentration 

Conclusion: the code worked as expected 

 

Procedure 

1. Copy input files to the folder 

C:\Users\ChengWang\Research\Projects\RESRAD\OFFSITE\v4.0\ReleaseTesting\003-003 

2. Run the input file.  

3. Copy file “CZTHICK3.DAT” to the testing folder, rearrange the data to file 

“CZTHICK3.xlsx”, and compare the results with the expected ones. 

 

The results calculated by code matched with the expected results. 
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12.6 TEST CASE 005 TESTER’S REPORT 

Documented in Test-005_report.docx of 2/27/2020 9:13 AM 

Test Case 005 report 

By cheng wang 2/13/2020; corrected the Objective on 2/26/2020 

 

Objective: Test OFFSITE Source Term leaching 

Conclusion: the code worked as expected 

Suggest to remove Table 2.16 from the Expected Results section because the revised 

results in V&V folder is used now.  

 

Procedure 

1. Copy input files to the folder 
C:\Users\ChengWang\Research\Projects\RESRAD\OFFSITE\v4.0\ReleaseTesting\005 

2. Run the input file.  

3. Copy file “AQFLUXIN.DAT” to the testing folder, rearrange the data to file “AQFLUXIN.xlsx”, 
and compare the results with the expected release to groundwater in file “Revised Verification 
for U238.xls” tab “release” 

 

The results calculated by code matched with the expected results, except the minor 
discrepancies on the values for Pb-210 and Po-210 at year1. 

 

Year Pb-210 by code  Po-210 by code 
Pb-210 by hand-
calculation 

Po-210 by hand-
calculation 

1 6.87E-08 2.01E-07 6.94E-08 1.81E-07 
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12.7 TEST CASE 020-001 TESTER’S REPORT 

Documented in Test-020-001_report.docx of 2/19/2020 7:25 PM 

Test Case 020-001 report 

By cheng wang 2/13/2020 

 

Objective: Tests OFFSITE gaseous and particulate C-14 pathways 

Conclusion: the code worked as expected 

Need to modify the input file; change the initial concentration from 100 Bq/g to 1 Bq/g 

(according to file “20-001 inhalation of carbon 14.docx” in V&V\Special radionuclides\ folder)  

 

Procedure 

1. Copy input files to the folder 

C:\Users\ChengWang\Research\Projects\RESRAD\OFFSITE\v4.0\ReleaseTesting\020-001 

2. Run the input file.  

3. Export “Dose: C-14, Inhalation” data to file “C-14_inh.csv” using Wresplot. 

4. Export data from “C-14_inh.csv” to file “C-14_inh.xlsx”. Copy hand-calculated results from 

file “C14 inhalation.xlsx” tab “gas and particulates” to “C-14_inh.xlsx”, and compare them.  

The results calculated by code matched with the expected results. 
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12.8 TEST CASE 020-002 TESTER’S REPORT 

Documented in Test-020-002_report.docx of 2/20/2020 8:19 AM 

Test Case 020-002 report 

By cheng wang 2/13/2020 

 

Objective: To tess OFFSITE tritium inhalation pathways 

Conclusion: the code worked as expected 

 

Procedure 

1. Copy the input file to the folder 

C:\Users\ChengWang\Research\Projects\RESRAD\OFFSITE\v4.0\ReleaseTesting\020-002 

2. Run the input file.  

3. Export “Dose: H-3, Inhalation” data to file “H-3_inh.csv” using Wresplot. 

4. Export data from “H-3_inh.csv” to file “H-3_inh.xlsx”. Copy hand-calculated results from file 

“H3 inhalation.xlsx” tab “gas no particulates” to “H-3_inh.xlsx”, and compare them.  

The results calculated by code matched with the expected results. 
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12.9 TEST CASE 020-003 TESTER’S REPORT 

Documented in Test-020-003_report.docx of 2/19/2020 8:08 PM 

Test Case 020-003 report 

By cheng wang 2/13/2020 

 

Objective: Tests OFFSITE Rn-222 inhalation pathways 

Conclusion: the code worked as expected 

 

Procedure 

1. Copy the input file to the folder 

C:\Users\ChengWang\Research\Projects\RESRAD\OFFSITE\v4.0\ReleaseTesting\020-003 

2. Run the input file.  

3. Export “Dose: All Nuclides Summed, Radon (Waterborne)” data to file “Rn-222_water.csv” 

using Wresplot. 

4. Export data from “Rn-222_water.csv” to file “Rn-222_water.xlsx”. Copy hand-calculated 

results from file “Rn 222 household water.xlsx” tab “RnProgenyDose” to “Rn-222_water.xlsx”, 

and compare them.  

The results calculated by code matched with the expected results. 
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12.10 TEST CASE 020-004 TESTER’S REPORT 

Documented in Test-020-004_report.docx of 2/20/2020 5:00 AM 

Test Case 020-004 report 

By cheng wang 2/13/2020 

 

Objective: Test OFFSITE Rn-220 inhalation pathways 

Conclusion: the code worked as expected 

 

Procedure 

1. Copy the input file to the folder 

C:\Users\ChengWang\Research\Projects\RESRAD\OFFSITE\v4.0\ReleaseTesting\020-004 

2. Run the input file.  

3. Export “Dose: All Nuclides Summed, Radon (Waterborne)” data to file “Rn-220_water.csv” 

using Wresplot. 

4. Export data from “Rn-220_water.csv” to file “Rn-220_water.xlsx”. Copy hand-calculated 

results from file “Rn 220 household water.xlsx” tab “RnProgenyDose” to “Rn-220_water.xlsx”, 

and compare them.  

The results calculated by code matched with the expected results. 

  



 

359 

12.11 TEST CASE 027-001 TESTER’S REPORT 

Documented in Results-Test-27-1.docx of 2/26/2020 4:09 PM 

Results for Test Case 27-1 

 

 

Test performed as described. Went through the report files and found all elements and formatting 

worked as described in the test case. The three report files (summary.rep, intrisk.rep, and 

daudose.rep) are also saved. 
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12.12 TEST CASE 027-002 TESTER’S REPORT 

Documented in Results-Test-27-2.docx of 2/17/2020 8:00 AM 

Results for Test Case 27-2 

Step 1 Open RESRAD-OFFSITE Version 4.0 

Step 2 Click on “Modify Data” command button in DOS Emulator 

Step 3 Select “Initial Concentrations” Form 

Step 4 Add Ac-227 in “Initial Concentrations” Form 

Step5 Close the form and save file as Test_27-2.rof 

Step 6 Click on “Run” command button in DOS Emulator  

Step 7 The report Viewer pops up and opens SUMMARY.REP file.  

Step 8 Clicked on File menu and checked its functions (Save, Save All, Printer Setup, Print, 

Adjust Font, Make New MyFonts.Dat, View Another File, and Exit Viewer). Screenshots for 

some are below 

Figure 1 Printer Setup Screenshot 
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Figure Print Screenshot  

 

Clicking on “Adjust Font” changed the font size to 7(see screenshot below) 

 

Clicking on “Make New MyFonts.Dat” changed the font size to 7.4(see screenshot below) 
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Figure View Another File Screenshot 

Exit Viewer closes the file. 

 

Step 9  Edit menu enabled to select all and copy of the present page  

Step10  Help menu opened the help file for the code with Report Viewer topic page opened (see 

screenshot below) 
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Step 11 Checked Tool bar icons.  

The page up/down worked.  
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Step 12 Put the cursor on the page number box, type 3, and the press Enter key, and Page 

3 (see screenshot below).  

 

Step 13 Clicked the dropdown arrow of page number, a list of pages appeared (see 

screenshot below) 

Step 14 Used Toolbar icon->View>Test Output>Parent Dose Report, Left side navigation 

panel -> View Output -> Parent Dose Report, Iconic Navigator>Results|>Parent Dose Report. 

All opened “SUMMARY.REP.” 
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12.13 TEST CASE 028-001 TESTER’S REPORT 

Documented in RESOFF-TEST-001 Test Cases ekg.pdf of 2/12/2020 3:21 PM 
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12.14 TEST CASE 029-001 TESTER'S REPORT 

Documented in Results-Test-29-1.docx of 2/17/2020 8:302 AM 

Results for Test Case 29-1 

 

Step 1 Open RESRAD-OFFSITE Version 4.0 

Step 2 Click Modify Data on the Left Navigation Panel 

Step 3 Click on Site Layout. The Site Layout Looks as in the Screenshot below 

Figure Site Layout Screenshot 

Step 4 Click on Display Map (The Map of the site as in the Screenshot below) 

Figure Site Layout Map Screenshot 
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Step 5 Click File on the left Navigation Panel – File Options Window opens 

Figure File Options Window Screenshot 

Step 6 Check Onsite Scenario Template file button and click OK, A new window with caption 

(see Screenshot below) opens 

 

Figure Onsite Scenario Primary Contamination Window Screenshot 

Step 7 Click Save 
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Step 8 Click Site Layout (see Screenshot below) 

Figure Site Layout Screenshot (Note change in the Site Layout) 

Step 9  Click on Display Map (see Screenshot below) 

Figure Site Layout Map Screenshot – Note change in the Site Layout Map 
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12.15 TEST CASE 029-002 TESTER’S REPORT 

Documented in Test Case 31-1-JJCheng.docx of 2/17/2020 9:02 AM 

Results for Test Case 29-2 

Step 1 Open RESRAD-OFFSITE Version 4.0 

Step 2 Click File on the Left Navigation Panel– File Options Window opens 

 

Figure File Options Window Screenshot 

Step 3 Check Simulate RESRAD (onsite) Code button and click OK, A new window with 

caption (see Screenshot below) opens 

Figure Title & Radiological Data Window Screenshot 
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Step 4 Click Close 

Step 5 Click Modify Data on the Left Navigation Panel 

Step 6 Click Site Layout (see Screenshot below) 

 

 

 

Figure Site Layout Screenshot  
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Step 7  Click on Display Map (see Screenshot below) 

Figure Site Layout Map Screenshot  

Step 8 Compare Site Layout and Site Layout Map screenshots with the screenshots in the 

RESRAD-OFFSITE Test Cases file. 
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12.16 TEST CASE 030-001 TESTER’S REPORT 

Documented in Test Case 30-1.msg of 2/14/2020 11:40 AM 

Test Case 30-1 

LePoire, David J.  Thu 2/20/2020 11:40 AM 

Summary: Went through exercising the DCF editor.  Successfully created new library and 

connected it to input and used it. 

 

1-3) Default setting: 
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4) ICRP-38 setting: 

 

 

5-9) Default viewing:  Went through tabs and radionuclides Cs-137 and Zr-97. (Note: Zr-91 in 

not in the database. The test problem should be changed to refer to Zr-87 instead of Zr-91, as was 

done in step 10). 
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11) Help from DCF editor did not work:  

 

 

12-14) Repeated above for DOE STD and FGR 11           

 

16-17) Help works from the main screen: 
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Edit mode test: 
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See new library in list 
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New DCF data was used: 
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12.17 TEST CASE 031-001 TESTER’S REPORT 

Documented in Test Case 31-1-JJCheng.docx of 2/14/2020 9:49 PM 

Test Case 31-1 – Test the functionality of sensitivity analysis (single parameter) 

• Launched RESRAD-OFFSITE, used the default template, chose Ac-227 as the 

radionuclide of concern, entered an initial soil concentration of 100 pCi/g. 

• Set Kd of the contaminated zone (in the radionuclide specific release input screen), 

unsaturated zone (in the distribution coefficient input screen), and saturated zone (in the 

distribution coefficient input screen) for sensitivity analysis via the menu bar option 

[Form Options-Sensitivity Analysis (single parameter)], tool bar option (the rainbow 

button), and hot key (F9) option, respectively, and set an analysis range of 2, 5, and 2.5, 

respectively. 

 

• Saw the settings appeared at the sensitivity analysis information bar at the bottom of the 

main interface 

 

• Run calculations. Opened the Deterministic Graphics viewer. The sensitivity analysis 

options were available in the options selection panel. The graphic viewer displayed the 

sensitivity analysis results based on the selection. 



 

379 

 

• Cancelled each sensitivity analysis by clicking the “no analysis” tab in the Set Sensitivity 

Analysis Range window. All sensitivity analyses were cancelled successfully, verified by 

0 variable listed in the sensitivity analysis summary bar at the bottom of the main 

interface, and no sensitivity analysis options in the Deterministic Graphics viewer after 

running the code.  

  

• Chose the Equilibrium Desorption Transfer as the release mechanism for Ac-227. Chose 

the cumulative releasable fraction at time 0 (default value is 1) for sensitivity analysis, 

and set a range value of 2. The code successfully provided warning against the selected 

range. Cancelled the sensitivity analysis. 
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• Changed the cumulative releasable fraction at time 0 to 0.5, and reselected it for 

sensitivity analysis with a range of 2. Ran the code.  

  

• Opened the Deterministic Graphics Viewer. The sensitivity analysis results were 

displayed as shown below. The results make sense because the external radiation 

pathway is the dominant pathway and half-life of Ac-227 is short, 21.772 years. 
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• Deleted Ac-227 and chose I-129 (half-life 1.57e7 years). Kept the Equilibrium 

Desorption Transfer as the release mechanism. Changed the Kd in primary contamination 

to 1000 cm3/g and the cumulative releasable fraction to 0.5 at time 0. Set sensitivity 

analysis for the releasable fraction with a range of 2. Ran the code. 

 

• Opened the Deterministic Graphics Viewer. The sensitivity analysis results were 

displayed as shown below. The results make sense because the water-dependent 

pathways (milk, drinking water, and meat) are the dominant pathways, Kd of the primary 

contamination is large (1000 cm3/g) and I-129 is long-lived. 



 

382 

 

• The code is equipped with all the sensitivity analysis functions required for selecting one 

parameter at a time.  
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12.18 TEST CASE 031-002 TESTER’S REPORT 

Documented in Test Case 31-2-JJCheng.docx of 2/14/2020 12:25 PM 

Test Case 31-2 – Test the functionality of setting multiparamter sensitivity analysis 

• Used default input template. Chose Ac-227 as radionuclide of concern with an initial 

concentration of 100 pCi/g. 

• Selected Kd of the contaminated zone, unsaturated zone, and saturated zone for 

uncertainty analysis with a uniform sensitivity range by clicking Shift-F8. Chose Uniform 

distribution and set the range to be +-25%, +-50%, and +-99%, respectively. Saved the 

input file. 

 

• In the generated input file (Site2.rof), the total number of observation was shown as 300 

(NUM_SMPS=300) for three input parameters (NUMVAR=3). 
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• Opened the generated LHS input file (Site2.lhs) with Notepad, and noticed the recordings 

of the three Kd parameters for uncertainty analysis with the selected distribution function 

and range of distributions, the number of observation (default 100), and the number of 

repetition (3).    

 

• If the code were ran, an uncertainty analysis with the above settings would be performed. 

• The function of setting multiparameter sensitivity analysis was imeplemented 

successfully.   
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12.19 TEST CASE 032-001 TESTER’S REPORT 

Documented in Test-032-001_report.docx of 2/20/2020 6:44 AM 

Test-032-001 Report 

By cheng wang 2/17/2020 

 

Objective: To test the functionality of setting Uncertainty/Probabilistic Analysis 

Conclusion: the code worked as expected. 

 

Procedure: 

1. Followed the procedure described in test case 

2. The generated files were saved in the folder 032-001 

3. The screenshots were presented as follows. They matched the expected results. 

 

Figure a 
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Figure b 
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Figure c 

 

Figure c-1 
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Figure d 

  



 

389 

12.20 TEST CASE 033-001 TESTER’S REPORT 

Documented in Test-033-001_report.docx of 2/20/2020 9:05 AM 

Test-033-001 report 

By cheng wang 2/17/2020 

 

Objective: Test the File navigation function from the left panel of GUI. 

Conclusion: the code worked as expected. 

Suggest to modify the description of Test Case 035-001 which is use as Step 3) in this test case: 

remove “Reporting times” and “Surface water transport” from the bullet list in Step 6). 

“Reporting times” form was not designed to have yellow background, and there is no Surface 

Water Transport form. 

 

Procedure: 

1.Followed Step 1) in Test Case 033-001; worked as expected.  
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2. Followed Step 2): worked as expected 

 

3 (a). Followed Step 3) in test case description for testing “New” button; worked as expected 

except the following two issues: 

only the background of text boxes in Reporting times for are not in yellow. Reporting times are 

not model calculation parameters. Suggest removing this form in the bullet list of this step in the 

test case description. 

There is no Surface Water Transport form; suggest remove this bullet from the list of this step in 

the test case description 
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3.(b) Followed Step 3) in the test case for “Save” button: worked as expected 

 

4. Followed Step 4) of the test case description. Opened file “BASIC RESRAD-OFFSITE 

INSTALLATION QA.ROF” in the QAFiles folder rather than the file with file name ending 

with “US.ROF”. Worked as expected. 
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Compare the file generated by “Save as” button using the following command statement. The 

differences between the two files were output to the file named diff.txt. File diiff.txt indicates 

that there was no difference between the two files, meaning the “Save as” button worked as 

expected. 

 

5. Followed Step 5) of the test case. This step should follow Test Case 029-001, rather than Test 

Case 35-004. Worked as expected. 
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6. Followed Step 6) of the test case description. This step should follow Test Case 029-002, 

rather than Test Case 35-005. Worked as expected. 
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12.21 TEST CASE 033-002 TESTER’S REPORT 

Documented in Test-033-002_report.docx of 2/20/2020 6:47 AM 

Test Case 033-002 report 

By Cheng Wang 2/17/2020 

 

Objective: to test the Change Title navigation function from the left panel of GUI. 

Conclusion: the code worked as expected. 

 

Procedure: 

1.Followed the procedure in the test case description. Worked as expected. 

The left panel and the right panel of the expected results in test case description should switch. 
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12.22 TEST CASE 033-003 TESTER’S REPORT 

Documented in Test-033-003_report.docx of 2/20/2020 6:49 AM 

Test Case 033-003 report 

By cheng wang 2/17/2020 

 

Objective: To Test the functionality of Set Pathways navigation in the left panel of GUI. 

Conclusion: the code worked as expected. 

 

Procedure:  

1. Followed the procedure of the test case description. 

• Visually check for Steps 2 – 6; worked as expected 

• For Step 7), worked as expected 
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• For Step 11), worked as expected 

 

• For Step 12), worked as expected 

 

 

• For Step 14), worked as expected 

 

• For Step 15), worked as expected 
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12.23 TEST CASE 033-004 TESTER’S REPORT 

Documented in Test-033-004_report.docx of 2/20/2020 6:50 AM 

Test Case 033-004 report 

By Cheng Wang 2/17/2020 

 

Objective: Test the functionality of Modify Data navigation in the left panel of GUI. 

Conclusion: the code worked as expected. 

 

Procedure: 

1. Followed the procedure of test case description.  

• Screenshot for Step 1) of test case. Worked as expected. 
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• Screenshot for Step 2) of test case. Worked as expected. 
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• Screenshot for Step 3). Worked as expected. 
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• Screenshot for Step 4). Worked as expected. 

 

• Screenshot for Step 5). Worked as expected  
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12.24 TEST CASE 033-005 TESTER’S REPORT 

Documented in Test-033-005_report.docx of 2/20/2020 6:52 AM 

Test Case 033-005 report 

By Cheng Wagn 2/17/2020 

Test Objective: To test the functionality of Iconic Navigator. 

Results: the code worked as expected.  

Procedure:  

1) Launch the code.  

2) Click Problem tab of Iconic Navigator. 
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a. Clicking File icon should bring up the window for selection of input file. Select 

an input file, and the file should be loaded to the main interface. 

 

Worked as expected.  

b. Clicking Title icon should bring up the Title & Radiological Data form 
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Worked as expected. 

 

c. Clicking Dose Factors should bring up the DCF Editor window. 

 

Worked as expected. 
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d. Clicking Input/Pathway should open the Inputs & Pathways tab of Iconic 

Navigator. 

Worked as expected. 

e. Clicking Sensitivity icon should turn on/off the Sensitivity Input Summary at the 

bottom left corner of the main interface. 

Comparison with the screenshot in Step 2). a shows the code worked as expected by turning off 

the sensitivity parameter information. 
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f. Clicking Uncertainty Analysis button should bring up the Uncertainty and 

Probabilistic Analysis form. 

Worked as expected. 

g. Clicking Run button should run the code using the loaded input file. 

Worked as expected. 
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h. Clicking Results should open the Results tab of the Iconic Navigator. 

 

Worked as expected. 

3) Clicking Input & Pathways Tab.  

a. Clicking each icon should open one associated form. Then run the code. 

Worked as expected. 

4) Click Results tab. 
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a. Clicking Parent Dose Report button should open Summary.rep file. Clicking 

Deterministic Graphics icon should open the graphics Wresplot.exe with loaded 

data. 

Worked as expected. 



 

425 

 

b. Clicking Progeny Dose Report icon should open DAUDOSE.REP file, Clicking 

Health Risk Report icon should open INTRISK.REP file. 

Worked as expected. 

c. Run the code with uncertainty analysis. 
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d. Clicking Graphics under Uncertainty/Probabilistic Analysis frame should open 

forms Uncertainty and Probabilistic Analysis, Probabilistic/Uncertainty Outputs, 

and Probabilistic Temporal Plots. 

Worked as expected. 
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e. Clicking Dose and Risk Report icon should open MCSUMMAR.REP file. 

Worked as expected. 

f. Clicking Input Report icon should open LHS.REP file. 
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5) Clicking Help tab and the REARD program website and contact information should 

present under this tab, as well as the function of F1 key for help. 

Worked as expected. 
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12.25 TEST CASE 034-001 TESTER’S REPORT 

Documented in Test-034-001_report.docx of 2/20/2020 6:54 AM 

Test Case 034-001 report 

By Cheng Wang 2/18/2020 

Test Objective: To test the functionality of Form Preliminary Inputs. 

Test conclusion: the code worked as expected. 

 

Procedure: 

1) On the left panel, click Modify Data -> Preliminary Inputs. The form should pop up with 

Figure a as default setting, including the units and values in textboxes. The background of 

each textbox should be in yellow if the values are default values; otherwise, in white. 

Worked as expected. 
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2) Change the unit to Bq. The unit in Forms Initial Concentrations and Transfer Factors 

should change accordingly.  

Worked as expected. 

3) Changing the selection of Conceptualization frame from top to bottom in order, the form 

should look like Figure a, b, c and d, respectively. Selection of “Model multiple forms of 

contaminated media” under settings of either Figure b or c will change the other’s setting. 
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worked as expected. 

 

4) The Number of Unsaturated Zones should be able to be changed between 0 and 5. Once 

this value is change, need to check Form Unsaturated Zones to check if the number of 

unsaturated zone changed in that form accordingly. 

Worked as expected. 
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5) Submerged fraction of Primary Contamination should be able to changed 0-1; however, 

once its value is larger than 0, the Number of Unsaturated Zone should update to 0 

automatically. 

worked as expected. 
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6) Change the values in textboxes and the units, save the input to Test13.rof, then check 

whether the input file is correctly written. The variables in this form include BRDL, ED, 

and NS. SUBMERGEDF, PCOPTION, and MULTIFORM. 

 

Worked as expected. 
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12.26 TEST CASE 034-002 TESTER’S REPORT 

Documented in Test-034-002_report.docx of 2/20/2020 6:55 AM 

Test Case 034-002 report 

By Cheng Wang 2/18/2020 

 

Objective: To test the functionality of Form Release Times. 

Conclusion: the code worked as expected. 

Procedure: 

1) On the left panel, clicking Modify Data -> Release Times should open a pop-up 

window with caption “Times at which Release Properties are Specified (years)”. 

Worked as expected. 

2) Clicking “Insert New 1sth time and shift down existing times and associated release 

data” 8 times. Every click should shift down the newly generated textbox by one row. 

The default of each generated textbox should be 0.  

Worked as expected. 

3) Click “Delete 1st time and associated release data and shift up exiting data” for 8 

times, all the newly generated textboxes should be deleted. 
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Worked as expected. 

4) Clicking “Add new 2th time at which release changes” should generate a textbox 

corresponding to 2th release time. 

Continue from Step 3) screenshot. 

Worked as expected. 

 

5) Specifying a value to each box in an increasing order. Change the value if the top box 

to a negative value, an error message should pop-up. Similarly, changing the largest 

value to more than 100000 should also trigger an error message window. 
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Worked as expected. 
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6) Change the third textbox value to a value less than the one in the second box, a 

warning message should show in the bottom-left box. Clicking Close. An error 

message should pop-up pointing out this error. 

Worked as expected.  
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7) Make sure the input to this form is correct, close the form. Check Form Nuclide 

Specific Release. The release time in the form should change accordingly. 

Worked as expected. 

 

8) save the file to Test14.rof, and then check the values in the generated input file. The 

variable to check is RELTIME(1) - (9). 

Worked as expected. 
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12.27 TEST CASE 034-003 TESTER’S REPORT 

Documented in Test-034-003_report.docx of 2/18/2020 8:41 AM 

Test Case 034-003 report 

By Cheng Wang 2/18/2020 

 

Objective: To test the functionality of Form Initial Concentrations. 

Conclusion: The code worked as expected. 

• Suggest modify Step 4) of test case description to “Frame “Transfer 

Mechanism” should be available after a radionuclide is selected.” 

• Suggest modify Step 8) of test case description: change “identical” to 

“equivalent” 

Procedure: 

1) Open the Initial Concentrations window and visually check the format, fonts, spelling, 

and default setting. 

The form presents as expected. 
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2) Check the unit is correct according to Form Preliminary Inputs.  

Worked as expected. 

3) The upper right box should indicate the radionuclide database and cutoff half-life. 

Worked as expected. 
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4) Frame “Transfer Mechanism” should be available. 

Worked as expected after adding a radionuclide. 

 

5) Select Ac-227, then click button “Add Ac-227 21.77y”, Ac-227 should be added to the 

left panel with a concentration of 100 unit. Highlight it and then change the Nuclide 

Concentration value to 50. Its concentration should update to 50 in the left panel. 
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Worked as expected. 

6) Clicking Delete “Ac-227” should remove it from the left panel. 

Worked as expected. 

7) Select U-238 from right panel and add it. The radionuclides in the U-238 decay change 

with half-life larger than the cutoff halflife should be added to the left panel with U-2328 

having a concentration of 50 units and all others zero concentration.  
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Worked as expected. 

 

8) Close the form and save the project to Test15.rof. Check the variables NUCNAM and S. 

Their value should be identical to the input to the form. 

Note that 1351.351 pCi is equivalent to 50 Bq. Change the concentration to 50 pCi and save the 

input file to Test165.rof.  

 

Worked expected. Suggest to modify the test case description. 
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12.28 TEST CASE 034-004 TESTER’S REPORT 

Documented in Test_034-004_report.docx of 2/18/2020 9:05 AM 

Test Case 034-004 Report 

By Cheng Wang 2/18/2020 

 

Objective: To the functionality of Form Nuclide Specific Release. 

Conclusion: The code worked as expected. 

 

Procedure: 

1) Select U-238 in Form Initial Concentrations with all default setting, and set release time 

to 0, 10, 100, and 1000 in Release Time form. 
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2)  Open the Form “Nuclide Specific Release”. Initial Concentrations Form should also be 

opened automatically if not opened at the time. Visually check the format, fonts, spelling, 

and default setting. 

 

 

Worked as expected. 

3) Check Radionuclide can be selected for each one in U-238 decay chain. 

Worked as expected, as shown in the screenshots in Step 2). 
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4) A button called “Add Next Time” should be available next the last release time. Clicking 

it should close the Nuclide Specific Release form and open Release Times form. In the 

Release Time form, add the 5th release starting time, 5000 yr and close the form.  

Worked as expected. 

5) Clicking a specific release time in the Nuclide Specific Release form should result in 

closing the form and open the Release Time form with the specified release time 

highlighted for modification. 

Clicking the second release time “10” in the form generated the following screenshot. 

Worked as expected. 
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6) Open the Form “Nuclide Specific Release” again, the newly added release starting time 

of 5000 should be added into the release time row. 

Worked as expected. 

 

7) Changing the options in Transfer Mechanism frame should change the interface. Figures 

a-c show the interfaces corresponding to First order release, Equilibrium Desorption, and 

Equilibrium Solubility release, respectively. 
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Worked as expected. 

8) Change one value or option for each radionuclide, close the form, and save the file to 

Test15.rof.  

Changed Transfer mechanism to the following: 

Pb-210: First order rate controlled transfer 

Po-210: Equilibrium desorption  

Ra-226: Equilibrium solubility 

Th-230: First order rate controlled transfer 

U-234: Equilibrium desorption  

U-238: Equilibrium solubility 
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Changed the Cumulative fraction of radionuclide bearing material that is releasable to the 

following values. 

Pb-210: 0.1 

Po-210: 0.2  

Ra-226: 0.3 

Th-230: 0.4 

U-234: 0.5  

U-238: 0.6 

 

9) Check the values in the generated input file match the inputs in the interface. The 

variables include RELTIME, RLEACH, SOLUB, RELFRAC, RELTIMEOPT, 

RELTIMEOPTP, RELOPT. 

Worked as expected. 
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12.29 TEST CASE 034-005 TESTER’S REPORT 

Documented in Test-034-005_report.docx of 2/20/2020 7:27 AM 

Test Case 034-005 report 

By Cheng Wang 2/18/2020 

 

Objective: To test the functionality of Distribution Coefficients form. 

Conclusion: the code worked as expected. 

The following minor font format issues were identified when computer system locale is Chinese; 

no issues when English (US) is used.  
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Procedure: 

1) With U-238 selected with default settings. Open Distribution Coefficients form and 

visually check the format, fonts, spelling, and default setting. 

Worked as expected. 

 

 

2) The form should be available for inputs as shown in the Figure in Expected Results. 

Worked as expected, as shown in the screenshot of Step 2) 
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3) When either of the first or second options in Conceptualization of Primary Contamination 

in Preliminary form is selected, the distribution coefficient input box for Contaminated 

Medium will be gray out.  

 

worked as expected. 

4) Clicking the value of Number of Unsaturated Zone should open the Preliminary Inputs 

form 
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worked as expected. 

5) Change at least one value for each radionuclide, and save the project to Test17.rof. 

Made the changes as shown in the screenshot. 
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6) Check the following variables in the generated input file and their value should match the 

input, DCACTC, DCACTCM, DCACTDWE, DCACTSWB, DCACTSWS, DCACTU1, 

DCACTS, DCACTV1, DCACTV2, DCACTL1, DCACTL2. 
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worked as expected. 
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12.30 TEST CASE 034-006 TESTER’S REPORT 

Documented in Test-034-006_report.docx of 2/18/2020 11:50 AM 

Test Case 034-006 report 

By Cheng Wang 2/18/2020 

 

Objective: To test the functionality of Deposition Velocities form 

Conclusion: the code worked as expected. 

 

Procedure: 

1) Select U-238 with default settings. Open Deposition Velocity form and visually check the 

format, fonts, spelling, and default setting. 

 

Worked as expected. 

2) Change at least one value for each radionuclide in the U-238 decay chain. Save the form 

and the project to Test18.rof. 

Made the following changes: 

Deposition velocity of respirable particulates for Pb-210, Po-210, Ra-226 were changed to 0.002, 

0.003, 0.004, respectively. 

Deposition velocity of all particulates for Th-230, U-234, U-238 were changed to 0.005, 0.007, 

and 0.007, respectively. 
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3) Check the variables DEPVEL, and DEPVELT in the generated file; they should match 

the input values in the interface. 

Worked as expected. 
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12.31 TEST CASE 034-007 TESTER’S REPORT 

Documented in Test-034-007_report.docx of 2/18/2020 12:13 PM 

Test Case 034-007 report 

By Cheng Wang 2/18/2020 

 

Objective: To test the functionality of Transfer Factors form. 

Conclusion: the code worked as expected. 

 

 

Procedure: 

1) Select U-238 with all default settings. Open Transfer Factors form, and visually check the 

format, fonts, spelling, and default setting. 

Worked as expected. 

2) Change at least one value for each radionuclide, and save the form. 
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Made the following changes: 

 Pb-210 Po-210 Ra-226 Th-230 U-234 U-238 

Fruit, grain 0.01 .001 .05 .001 .0025 .0025 

Leafy .02 .002 .04 .002 .0026 .0026 

Pasture .02 .003 .04 .003 .0027 .0027 

Livestock .02 .004 .04 .004 .0028 .0028 

Meal .0009 .005 .001 .0001 .00035 .00035 

milk 0004 .00035 .001 .000005 .0007 .0007 

Fish 301 101 51 .100 11 11 

Crustacea 101 20001 250 501 61 61 

 

3) Save the project to Test19.rof. Check the following variables’ values; they should match 

the input. RTF, I_M, BIOFAC. 

Worked as expected. 
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12.32 TEST CASE 034-008 TESTER’S REPORT 

Documented in Test-034-008_report.docx of 2/18/2020 12:24 PM 

Test Case 034-008 report 

By cheng wang 2/18/2020 

 

 

Objective: To test the functionality of Reporting Times form 

Conclusion: The code worked as expected. 

 

Procedure: 

1) Click Modify Data -> Reporting Times. Visually check the format, fonts, and spelling. 

Worked as expected. 

2) It should have contents as shown in the figure, allowing up to 9 input times.  

Worked as expected. 



 

463 

3) Check the lower and upper bounds. Each value should be (0, 100000] 

 

When a number larger than 100000 was input, it is changed to 100000 automatically. 

Worked as expected. 

4) Check Add and Remove buttons 
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Worked as expected. 

 

5) Clicking “Storage times” button should bring the form up. 

Worked as expected.a 

6) Save the form and the project to Test20.rof. 

 

7) Check the variable T(1)-(10) in the file; they should be identical to the input in GUI. 

Worked as expected. 
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12.33 TEST CASE 034-009 TESTER’S REPORT 

Documented in Test-034-009_report.docx of 2/18/2020 12:31 PM 

Test Case 034-009 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Storage Times form. 

Conclusion: The code worked as expected 

 

Procedure: 

1) Click Modify Data -> Storage Times. Visually check the format, fonts, and spelling. 

Worked as expected. 
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2) Check the lower and upper bounds for each input box value. It should be no less than 0.  

 

Worked as expected. 

 

3) Change two or more values.  

Changed values for Surface water, Well water, and Crustacea and mollusks to 2, 3, and 10, 

respectively. 

4) Save the form and the project to Test21.rof. 

5) Check the variable STOR_T(1)-(10) in the file; they should be identical to the input in 

GUI. 

Worked as expected. 
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12.34 TEST CASE 034-010 TESTER’S REPORT 

Documented in Test-034-010_report.docx of 2/18/2020 12:39 PM 

Test Case 034-010 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Site Layout form. 

Conclusion: the code worked as expected. 

 

Procedure: 

1) Open Site Layout form and visually check the format, fonts, spelling, and default values 

with yellow background color. Check if F6 key can restore a change value.  

Worked as expected. F6 worked as expected. 

2) Clicking Display Map should bring up the Map Interface window.  

Worked as expected. 
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3) Change the values for Bearing of X axis, X and Y dimensions, and at least one value on 

each row and column of the site coordinate table.  

 

4) Save the project to Test22.rof.  

5) Check the following variables in the file; they should be identical to the input in GUI. 

NXBEARING, SOURCEXY, AGRIXY, DWELLXY, SWXY. 

Worked as expected.  
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12.35 TEST CASE 034-011 TESTER’S REPORT 

Documented in Test-034-011_report.docx of 2/18/2020 12:56 PM 

Test Case 034-011 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Map Interface form. 

Conclusion: the code worked as expected. 

 

Procedure: 

1) Open Map Interface form by clicking Modify Data -> Site Layout -> Display Map 

2) It should include the functions as shown in the figure. 
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3) Check the following buttons: Print, How to use the Map, Accept/Cancel changes, 

Accept/Cancel Changes and Close. 

How to use the map button opens file mapGuideRO.pdf 

Accept changes, Cancel Changes button, Accept Changes and Close button, and Cancel Changes 

and Close button worked as expected. 

 

4) Move each icon in the map a little and the purple Y-axis line, then click Accept Changes 

and Close. The coordinate table in the Site Layout form should update accordingly. 

Worked as expected 
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5) Click Get Image should direct to select an image file. Select the file 

HypotheticalSuburbanScenarioOutline.JPG under UserFiles folder. The image should 

load to the code. Click Clear Image should remove the file from the code. 

worked as expected. “Clear Image” just removed the loaded picture. 
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6) Change the scale value and click “Set Scale”. The image should change accordingly. 

Worked as expected. 

7) Click Trace Groundwater Flow Line, the widow should update with GW line.  
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worked as expected. 

8) Clicking How to Trace a Flow Line button should open a file named GwFlowLinRO.pdf. 

Following the procedure in the file and check each button functions as designed. 

Worked as expected. 
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12.36 TEST CASE 034-012 TESTER’S REPORT 

Documented in Test-034-12_report.docx of 2/18/2020 1:25 PM 

Test Case 034-012 report 

By cheng wang 2/8/2020 

 

Objective: To test the functionality of Physical and Hydrological form. 

Conclusion: the code worked as expected. 

 

Procedure: 

1) Open Physical and Hydrological form. Visually check the format, fonts, spelling, and 

default values with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

2) It should contain Site Properties input, as shown in the figure.  

Worked as expected. 

 

3) Clicking each of the five buttons in Sub-area Properties section should bring up the 

corresponding forms.  
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Worked as expected. 

 

4) Change the precipitation value and rainfall and runoff factor, save the form, and save the 

project to Test24.rof. 

Changed the values to 2 and 162 respectively. 

5) Check the variables PRECI and RAINEROS in the generated file. They should be 

identical to the input in GUI. 

Worked as expected. 
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12.37 TEST CASE 034-013 TESTER’S REPORT 

Documented in Test-034-013_report.docx of 2/20/2020 7:27 AM 

Test Case 034-013 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Primary Contamination form. 

Conclusion: the code worked as expected. 

minor issue on font format when computer system locale is Chinese; no issues when English 

(US) is used. 
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Procedure: 

1) Open Primary Contamination form. Visually check the format, fonts, spelling, and 

default values with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

2) It should contain Site Properties input, as shown in the figure. 

Worked as expected. 

3) Check the consistence of Area of Primary Contamination with the X and Y dimesons in 

Site Layout form. 

The values are consistent. 
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4) Check the consistence of Factor of primary contamination that is submerged with the 

Submerged fraction of Primary Contamination in Preliminary Input.  

The values matched. 
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5) Modify at least two values in each column, save the form, and then save the project to 

Test25.rof. 

Made the following changes. 

 

6) Check the following variables in the generated input file. They should be the same as 

input in the GUI. AREA, LCZPAQ, DM, MLFD, DEPVEL_DUSTT, RESPFRACPC, 

DEPVEL_DUST, RI, EVAPTR, RUNOFF, SLPLENSTPPC, CRPMANGPC, 

CONVPRACPC, THICK0, TPCZ, VCZ, DENSCZ, ERODIBILITYCZ, FCCZ, BCZ, 

HCCZ, EPCZ, ALPHALCZ, SUBMERGEDDEPTH, COVER0, TPCV, VCV, 

DENSCV, ERODIBILITYCV, PH2OCV 
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worked as expected. 
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12.38 TEST CASE 034-014 TESTER’S REPORT 

Documented in Test-034-014_report.docx of 2/18/2020 1:56 PM 

Test Case 034-014 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Sediment Delivery Ratio form  

Conclusion: the code worked as expected 

 

Procedure: 

1) Open Sediment Delivery Ratio form. Visually check the format, fonts, spelling, and 

default values with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

2) It should the input boxes, as shown in the figure. 

Worked as expected. 
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3) Check the lower and upper bounds, which should be 0 and 1, respectively. 

Worked as expected. 

4) The summation of the values in this form should be 1. Make it more than one, and an 

error message should pop up. 

Worked as expected. 
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5) Check the values input in the form are consistent with the ones in Forms Dwelling Site, 

Agricultural Areas, Livestock Feed Areas, and Surface Water Body. 
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Worked as expected. 

6) Change three or more values, save the form, and then save the project to Test26.rof. 

Made changes as shown in the screenshot in Step 5). 

7) Check the following variables in the generated input file; they should be identical to the 

input from GUI. SDR, SDROF(1)-(4) and SDRDELL 
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worked as expected. 
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12.39 TEST CASE 034-015 TESTER’S REPORT 

Documented in Test-034-015_report.docx of 2/20/2020 7:29 AM 

Test Case 034-015 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Agricultural Areas form. 

Conclusion: the code worked as expected. 

Minor issue on font format when computer system locale is Chinese; no issues when English 

(US) is used.. 
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Procedure: 

1) Open Agricultural Areas form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

2) It should have the same input boxes as the figure has. 

Worked as expected. 
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3) Check the Area values; they should be grayed out in this form but match the inputs in 

Site Layout form. 

Worked as expected. 
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4) Check the Erosion rate and Total Porosity values; they should be grayed out in this form 

but match the ones in Primary Contamination form 

worked as expected. 
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5) Check the Sediment delivery ratio values; they should be grayed out in this form but 

match the ones in Sediment Delivery Ratio form. Clicking the values in this form should 

bring up the Sediment Delivery Ratio form. 

worked as expected. 
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6) Change at least three values in each column, save the form, and save the project to 

Test27.rof. 

Made the following changes. 

 

7) Check the following variables in the generated file; they should be the same as inputs in 

GUI. AREAO(1) and (2), FAREA_PLANT(1) and (2), RIRRIG(1) and (2), 

EVAPTRN(1) and (2), RUNOF(1) and (2), DPTHMIXG(1) and (2), TMOF(1) and (2), 

EROSN(1) and (2), RHOB(1) and (2), ERODIBILITY(1) and (2), SLPLENSTP(1) and 

(2), CRPMANG(1) and (2), CONVPRAC(1) and (2), TPOF(1) and (2). 
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Worked as expected. 
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12.40 TEST CASE 034-016 TESTER’S REPORT 

Documented in Test-034-016_report.docx of 2/20/2020 7:30 AM 

Test Case 034-016 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Livestock Feed Areas form. 

Conclusion: the code worked as expected. 

Minor issue on font format when computer system locale is Chinese; no issues when English 

(US) is used.. 

 

Procedure: 
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1) This form should contain the same input content as Agricultural Areas form but for 

Livestock Feed Area, including Pasture Silage and Grain 

Worked as expected. 

2) Follow the same procedure for testing Agricultural Areas form, except that the variables 

to be checked in the generated input file should be AREAO(3) and (4), 

FAREA_PLANT(3) and (4), RIRRIG(3) and (4), EVAPTRN(3) and (4), RUNOF(3) and 

(4), DPTHMIXG(3) and (4), TMOF(3) and (4), EROSN(3) and (4), RHOB(3) and (4), 

ERODIBILITY(3) and (4), SLPLENSTP(3) and (4), CRPMANG(3) and (4), 

CONVPRAC(3) and (4), TPOF(3) and (4). 

 

Made the following changes to the file for Test Case 034-015 (test27.rof) and saved the input file 

as Test28.rof. 
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Worked as expected.   
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12.41 TEST CASE 034-017 TESTER’S REPORT 

Documented in Test-034-017_report.docx of 2/20/2020 7:31 AM 

Test Case 034-017 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Dwelling Site form. 

Conclusion: the code worked as expected 

Minor issue on the font format when computer system locale is Chinese; no issues when English 

(US) is used.. 
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Procedure: 

1) This form should contain the same input content as Agricultural Areas form but for 

Offsite Dwelling Area 

 

Worked as expected. 

2) Follow the same procedure for testing Agricultural Areas form, except that the variables 

to be checked in the generated input file should be AREAODWELL, 

FAREA_PLANTDWELL, RIRRIGDWELL, EVAPTRNDWELL, RUNOFDWELL, 

DPTHMIXGDWELL, TMOFDWELL, EROSNDWELL, RHOBDWELL, 

ERODIBILITYDWELL, SLPLENSTPDWELL, CRPMANGDWELL, 

CONVPRACDWELL, TPOFDWELL. 

 

Made the following changes based on the file for Test Case 034-016 (test28.rof).  
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worked as expected. 
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12.42 TEST CASE 034-018 TESTER’S REPORT 

Documented in Test-034-018_report.docx of 2/18/2020 2:52 PM 

Test Case 034-018 report 

By Cheng Wang 

 

Objective: To test the functionality of Atmospheric Transport form. 

Conclusion: the code worked as expected. 

 

Procedure 

1) Open Atmospheric Transport form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

 

2) It should have the same input boxes as the figure has. 

As shown in the screenshot of Step 1). 
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3) Clicking Read Meteorological STAR file should allow to select a STAR file from the 

available list installed in Application folder\Metfiles. Loading of a selected STAR file 

should update the table. 

Read in AZ_PHOENIX.str. 

worked as expected. 

 

4) Clicking Deposition Velocities should bring up the Deposition Velocities form. 

Added Ac-227 to initial contractions, and then click the mentioned button. 

Worked as expcted. 

 

5) Change at least one value in each input area, save the form, and save the project to 

Test30.rof. 
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6) Check the following variables in the generated input file; they should be the same as the 

inputs from GUI. AIRRELHT, HEATFLX, ANH, TABK, AMIX, PMIX, AGRIELEV, 

DWELLELEV, SWELEV, WIND, WINDSPEED, DFREQ, ATGRID 

 

Made the following changes. 
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Worked as expected.  
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12.43 TEST CASE 034-019 TESTER’S REPORT 

Documented in Test-034-019_report.docx of 2/20/2020 7:33 PM 

Test Case 034-019 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Water Use form. 

Conclusion: the code worked as expected. 

Minor issue on font format when computer system locale is Chinese; no issues when English 

(US) is used. 

 

Procedure: 

1) Open Water Use form. Visually check the format, fonts, spelling, and default values with 

yellow background color. Check if F6 key can restore a change value. 
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Worked as expected. 

2) It should have the same input boxes as the figure has. 

Worked as expected. 

3) Check the Area of Plot; which should be grayed out and consistent with the inputs in Site 

Layout form. 

 

Worked as expected, as shown in the screenshot of Step 1). 

4) Check the Fraction of water values. The summation of two columns should be 1. 

Worked as expected, as shown in the screenshot of Step 1). 

5) Changes at least two values in each column, save the form, and save the project to 

Test31.rof.  

Made the following changes. 
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6) Check the following variables in the generated file; they should be the same as inputs in 

the GUI. DWI, FDWI, FSWD, FWWD, HHW, FSWHH, FWWHH, LWI, FSWLV, 

FWWLV, FSWIR, FWWIR, FSWIRDWELL, FWWIRDWELL, NDWI, NLWI, UW 

 

Worked as expected. 
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12.44 TEST CASE 034-020 TESTER’S REPORT 

Documented in Test-034-020_report.docx of 2/20/2020 7:34 PM 

Test Case 034-020 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Unsaturated Zones form. 

Conclusion: the code worked as expected. 

Minor issue on font format when computer system locale is Chinese; no issues when English 

(US) is used. 
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Procedure: 

1) Open Unsaturated Zones form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

2) It should have the same input boxes as the figure has. 

As shown in the screenshot of Step 1). 

3) Clicking the Number of Unsaturated Zones should bring up the Preliminary Inputs form 

Worked as expected. 
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4) Modify at least two values for each unsaturated zone, save the form, and the save the 

project to Test32.rof. 

Made the following changes. 

5) Check the following variables in the generated file; they should be the same as inputs in 

GUI. H, DENSUZ, TPUZ, EPUZ, FCUZ, HCUZ, BUZ, ALPHALU 

 

Worked as expected.  
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12.45 TEST CASE 034-021 TESTER’S REPORT 

Documented in Test-034-021_report.docx of 2/20/2020 7:35 PM 

Test Case 034-021 report 

By Cheng Wang 2/18/2020 

 

Objective: Test the functionality of Saturated Zone form 

Conclusion: the code worked as expected 

Minor issue on font format when computer system locale is Chinese; no issues when English 

(US) is used. 

 

Procedure: 

1) Open Saturated Zone form. Visually check the format, fonts, spelling, and default values 

with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

2) It should have the same input boxes as the figure has. 
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As shown in the screenshot of Step 1). 

3) Modify at least two values for each unsaturated zone, save the form, and the save the 

project to Test33.rof. 

Made the following changes. 

 

4) Check the following variables in the generated file; they should be the same as inputs in 

GUI. DPTHAQ, DENSAQ, TPSZ, EPSZ, HCSZ, HGW, DWIBWT, ALPHALOW, 

ALPHATW, ALPHAVW, HGSW, DPTHAQSW, ALPHALOSW, ALPHATSW, 

ALPHAVSW 

Worked as expected. 
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12.46 TEST CASE 034-022 TESTER’S REPORT 

Documented in Test-034-022_report.docx of 2/18/2020 9:29 PM 

Test Case 034-022 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Groundwater Transport form. 

Conclusion: the code worked as expected. 

 

Procedure: 

1) Open Groundwater Transport form. Visually check the format, fonts, spelling, and 

default values with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

2) It should have the same input boxes as the figure has. 

As shown in the screenshot of Step 1). 

3) Clicking the three buttons should bring up the forms of Water Use, Unsaturated Zones, 

and Saturated Zone 
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Worked as expected. 

4) Check the options for subzone dispersion; they should respond to selection 

Worked as expected. 

5) Change at least three values, save the form, and then save the project to Test34.rof 

 

Made the following changes. 
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6) Check the following variables in the generated file; they should be the same as inputs in 

GUI. OFFLPAQW, OFFLPAQS, OFFLNAQW, OFFLNAQSN, OFFLNAQSF, EPS, 

NPCM, NPCMF, NPCZ, NPCZF, NSPCZ, NSPCZF, NPSS, NPSSF, NAQS, NAQSF 

Worked as expected. 
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12.47 TEST CASE 034-023 TESTER’S REPORT 

Documented in Test-034-023_report.docx of 2/20/2020 7:37 AM 

Test Case 034-023 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Surface Water Body form. 

Conclusion: the code worked as expected. 

Minor issue on font format when computer system locale is Chinese; no issues when English 

(US) is used. 
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Procedure: 

1) Open Surface Water Body form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

2) It should have the same input boxes as the figure has. 

As shown in the screenshot of Step 1). 
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3) Check the Surface area of water body, which should be consistent with the inputs in Site 

Layout form 

The values matched. 
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4) Check the Sediment Delivery ration button, which should be consistent with the input in 

Sediment Delivery Ration form. Clicking it should bring up the Sediment Delivery Ratio 

form. 

worked as expected. 
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5) Check the Number of catchment areas. The left and right arrow button should allow 

delete or add one catchment with default settings 

Worked as expected. 
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6) Validate the catchment area using the coordinates 

The values matched. 
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7) Modify at least three values in each column, save the form, and then save the project to 

Test35.rof 

Made the following changes. 

 

 

8) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. ALAKE, VLAKE, EVAPOT, FSTMFLOW, FSTMFLOWIN, VSETTLE, 

RHOBSED, THICKSED, SDR, NCATCH, CATCHXY, AREACA, RUNOFFCA, 

ERODIBILITYCA, SLPLENSTPCA, CRPMANGCA, CONVPRACCA, SDRCA, 

SDRACOR, DDRCA, COMPUTEDEP, CONVCRITATM 

 

Worked as expected. 
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12.48 TEST CASE 034-024 TESTER’S REPORT 

Documented in Test-034-024_report.docx of 2/20/2020 7:38 AM 

Test Case 034-024 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Ingestion Rates form. 

Conclusion: the code worked as expected. 

 

Procedure: 

1) Open Surface Water Body form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

2) It should have the same input boxes as the figure has. 

As shown in the screenshot of Step 1). 

3) Check the Drinking Water Consumption rate, which should be consistent with the input 

in Water Use form. Medication of either one should change the other one automatically.  



 

524 
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Worked as expected. 

4) Check the Drinking water fraction from affected area, which should be consistent with 

the inputs from Water Use form. Clicking of this button should bring up the Water Use 

form. 

Worked as expected. 

5) Check the three buttons. Clicking them should bring up forms of Plant Factors, Livestock 

Factors, and Livestock Feed Factors. 

Worked as expected. 
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6) Modify at least two values in each column, save the form, and then save the project to 

Test36.rof. 

Made the following changes. 

 

7) Check the following variables in the generated file; they should be the same as inputs in 

GUI. DFI,DVI, DMI, SOIL, FFISH, FVEG, FMEMI 

 

Worked as expected. 
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12.49 TEST CASE 034-025 TESTER’S REPORT 

Documented in Test-034-025_report.docx of 2/20/2020 7:39 AM 

Test Case 034-025 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Plant Factors form. 

Conclusion: the code worked as expected. 

Minor issue on the font format when computer system locale is Chinese; no issues when English 

(US) is used. 

 

Procedure: 

1) Open Plant Factors form. Visually check the format, fonts, spelling, and default values 

with yellow background color. Check if F6 key can restore a change value. 
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Worked as expected. 

2) It should have the same input boxes as the figure has. 

As shown in the screenshot of Step 1). 

3) Modify at least two values in each column, save the form, and then save the project to 

Test37.rof. 

Made the following changes. 

 

 

4) Check the following variables in the generated file; they should be the same as inputs in 

GUI. YIELD, GROWTIME, FOLI_F, RWEATHER, FINTCEPT, DROOT 

worked as expected. 
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12.50 TEST CASE 034-026 TESTER’S REPORT 

Documented in Test-034-026_report.docx of 2/18/2020 10:28 PM 

Test Case 034-026 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Livestock Intakes form. 

Conclusion: the code worked as expected. 

 

Procedure: 

1. Opened Livestock Intakes form and check it visually. Worked as expected. 

2. made the following changes and save the project as test38.rof. 
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3. checked the values of LWI, LFI, LSI in the generated input file with the input values in the 

GUI. 

Worked as expected.  
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12.51 TEST CASE 034-027 TESTER’S REPORT 

Documented in Test-034-027_report.docx of 2/20/2020 7:40 AM 

Test Case 034-027 report 

By cheng wang 2/18/2019 

 

Objective: To test the functionality of Livestock Feed Factors form. 

Conclusion: the code worked as expected. 

Minor issue on the font format when computer system locale is Chinese; no issues when 

English (US) is used. 

 

Procedure: 

1. open Livestock Feed Factors form; check it visually.  

Worked as expected. 
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2. made the following changes and save the project as test39.rof. 

 

3. Compared the value of the following variables in the test39.rof with the input one in the form: 

YIELD(3), YIELD(4), GROWTIME(3), GROWTIME(4), FOLI_F(3), FOLI_F(4), 

RWEATHER(3), RWEATHER(4), FINTCEPT(3,2), FINTCEPT(4,2), FINTCEPT(3,1), 

FINTCEPT(4,1), DROOT(3), DROOT(4) 

The values matched the one in the GUI.  
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12.52 TEST CASE 034-028 TESTER’S REPORT 

Documented in Test-034-028_report.docx of 2/20/2020 7:41 AM 

By cheng Wang 2/18/2020 

 

Objective: To test the functionality of Inhalation, Gamma form. 

Conclusion: the code worked as expected. 

Minor font format issue when computer system locale is Chinese; no issues when English (US) 

is used.  
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Procedure: 

1) Open Inhalation, Gamma form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a change value. 

2) It should have the same input boxes as the left figure has. 

As shown in the screenshot of Step 1). 

3) Selection of Input different values under Massloading and respirable fraction at offsite 

locations should bring more input boxes, as shown in the right figure. 

worked as expected. 
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4) Clicking the two buttons should bring up the forms of Shape Factors and Occupancy. 

Worked as expected. 

5) With Input different values selected, modify at least three inputs, save the form, and then 

save the project to Test40.rof. 

Made the following changes. 

6) Check the following variables in the input file; they should be the same as the inputs in 

GUI. INHALR, SAMEMLRF, MLTOTOF, RESPFRACOF, MLTOTDWELL, 

RESPFRACDWELL, SHF3, SHF1 

Worked as expected.  
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12.53 TEST CASE 034-029 TESTER’S REPORT 

Documented in Test-034-029_report.docx of 2/20/2020 7:42 AM 

Test Case 034-029 report 

By cheng wang 2/19/2020 

 

Objective: To test the functionality of Shape Factors form. 

Conclusion: the code worked as expected. 

Minor issue on font format when computer system locale is Chinese; no issues when 

English (US) is used. 
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Procedure: 

1) Open Shape Factors form. Visually check the format, fonts, spelling, and default values 

with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

 

2) It should have the same input boxes as the figure has. 

As shown in the screenshot of the Step 1). 

3) Select Onsite tab on the right panel. 

4) Select Circular for Shape of the primary contamination, a circle should appear in the 

center. Click “Calculate Radii and Fractions”, and the code should calculate and list the 

results in the table in right panel. 

Worked as expected. 
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5) Click Clear. The left panel should become blank. 

 

6) Select Polygonal for Shape of primary contamination. Generate a polygon on the left 

panel using mouse. The button “Calculate Radii and Fractions” should became available 

upon a polygon is generated. Click it and the results should be listed in the table.  

Worked as expected. 
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7) Select Offsite tab on the right panel, and repeat Steps 4-6. 

 

Worked as expected. 

 

8) Save the form, and then save the project to Test41.rof. 
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9) Check the variable RAD_SHAPE in the generated input file; its value should be same as 

the calculated ones in the GUI. 

Worked as expected. 
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12.54 TEST CASE 034-030 TESTER’S REPORT 

Documented in Test-034-030_report.docx of 2/20/2020 7:56 AM 

Test Case 034-030 report 

By cheng wang 2/18/2020 

 

Objective: To test the functionality of Occupancy form. 

Conclusion: the code worked as expected. 

Test-034-029_report 

Procedure: 

1) Select Ac-227 in the Initial Concentrations form. 

2) Open Occupancy form. Visually check the format, fonts, spelling, and default values with 

yellow background color. Check if F6 key can restore a change value. 

Worked as expected. 

3) It should have the same input boxes as the figure has. 

As shown in the screenshot of Step 1). 

4) Modify at least three values, save the form, and then save the project as Test42.rof. 
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Made the following changes. 

 

5) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. FIND, FOTD, FINDDWELL, FOTDDWELL, OCCUPANCY(1) -(4) 

Worked as expected. If the sum of fraction is over 1, error message will pop up. 

6) Clicking run should bring up a message window asking whether to save the changes and 

run the code. Click each button – Yes will run the code; No will open the Save function, 

Cancel Run will go back the main interface. 

Worked as expected. 

  



 

543 

12.55 TEST CASE 034-031 TESTER’S REPORT 

Documented in Test-034-031_report.docx of 2/20/2020 7:45 AM 

Test Case 034-031 report 

By Cheng Wang 2/19/2020 

 

Objective: To test the functionality of Radon form. 

Conclusion: the code worked as expected. 

Minor font format issues were identified when computer system locale is Chinese; no issues 

when English (US) is used.  

 

Procedure: 

1) Open Radon form. Visually check the format, fonts, spelling, and default values with 

yellow background color. Check if F6 key can restore a change value. 

Worked as expected. F6 key was checked after step 4 for at this step the textboxes are not 

editable. 

2) It should have the same input boxes as the figure has. 

As shown in the screenshot of Step 1). 
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3) All the input boxes in this form should be grayed out unless a radon parent Rn-222 or Rn-

220 is present in the contamination radionuclide list.  

Worked as expected. 

4) Close the form. Select U-238 from the Initial Concentrations form and then turn on 

Radon pathway. 

 

5) Open Radon form again; it should be available for modification now.  

 

 

worked as expected. 

6) Modify at least three values, save the form, and then the project to Test43.rof. 

Made the following changes. 
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7) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. DIFCV, DIFCZ, DIFOS(1), DIFOS(2), DIFOS(3), DIFOS(4), DIFOS(5), 

DIFFL, FLOOR1, DENSFL, TPFL, PH2OFL, DMFL, HMIX, HRM, REXG, FAI, 

EMANA(1), EMANA(2) 

Worked as expected. 
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8) Open the form again. Clicking run should bring up a message window asking whether to 

save the changes and run the code. Click each button – Yes will run the code; No will 

open the Save function, Cancel Run will go back the main interface. 

Worked as expected. 
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12.56 TEST CASE 034-032 TESTER’S REPORT 

Documented in Test-034-032_report.docx of 2/20/2020 7:53 AM 

Test Case 034-032 report 

By cheng wang 2/19/2020 

 

Objective: To test the functionality of Carbon-14 form. 

Conclusion: the code worked as expected. 

 

Procedure: 

1) Open Carbon-14 form. Visually check the format, fonts, spelling, and default values with 

yellow background color. Check if F6 key can restore a change value. 

Worked as expected. F6 key was checked after Step 4 for the textboxes are not editable at 

this point. 

2) It should have the same input boxes as the figure has. 

Worked as expected. 

3) All the input boxes in this form should be grayed out unless a radon parent Rn-222 or Rn-

220 is present in the contamination radionuclide list.  

Worked as expected. 

4) Select U-238 from the Initial Concentrations form and then turn on Radon pathway. 

 



 

548 

5) Open Carbon-14 form again; it should be available for modification now.  

 

Worked as expected.  

 

6) Clicking Mass fractions of C-12 should bring up Mass fractions of C-12 form. 

 

Worked as expected. 

7) Modify the Vertical dimension of mixing for inhalation, save the form, and then the 

project to Test44.rof. 

Changed the value from 2 to 3.67. This change also updated the corresponding value 

in Radon form. 

 

 



 

549 

 

 

 

 

 

8) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. DMC, HMIXV, C14EVSN, C12EVSN, CAIR,CSOIL 
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worked as expected.  

Worked as expected. 

 

9) Added C-14 to nuclide list and made the following changes. Save the file as Test44-C-

14.rof 

 

 

 

 

10) Check the variables mentioned in Step 8) and compare with the ones input in GUI. 

Worked as expected. 
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12.57 TEST CASE 034-033 TESTER’S REPORT 

Documented in Test-034-033_report_v2.docx of 2/26/2020 12:50 PM 

Test Case 034-033 report 

By cheng wang 2/19/2020 

 

Objective: To test the functionality of Mass fraction of C-12 form. 

Conclusion:  the code worked as expected. 

Modify Step 3) of test case description to “Select C-14 from the Initial Concentrations 

form”.  

Minor font format issues were identified when computer system locale is Chinese; no 

issues when English (US) is used.  

 

 

Procedure 

1) Open Mass fraction of C-12 form. Visually check the format, fonts, spelling, and default 

values with yellow background color. Check if F6 key can restore a change value. 

Worked as expected. F6 key was checked after Step 3). 

2) It should have the same input boxes as the figure has. 

Worked as expected. 
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3) Select C-14 from the Initial Concentrations. 

4) Open Mass fraction of C-12 form again, and change values for at least two variables. 

Changed values for Atmophere textbox, Local water, and Milk to 0.28, 0.000031, and 

0.072, respectively.  

5) Save the form, and then the project to Test45.rof. 

6) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. C12AIR, C12CZ, C12WTR, C12PLANT(1), C12PLANT(2), C12PLANT(3), 

C12PLANT(4), C12MEAT_MILK(1), C12MEAT_MILK(2) 

worked as expected. 

7) Open the form again. Clicking run should bring up a message window asking whether to 

save the changes and run the code. Click each button – Yes will run the code; No will 

open the Save function, Cancel Run will go back the main interface. 

 

Worked as expected. 
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12.58 TEST CASE 034-034 TESTER’S REPORT 

Documented in Test-034-034_report.docx of 2/20/2020 7:58 PM 

Test Case 034-034 report 

By cheng wang 2/19/2020 

 

Objective: To test the functionality of H-3 form. 

Conclusion: the code worked as expected. 

Minor font format issues were identified when computer system locale is Chinese; no 

issues when English (US) is used.  

 

Procedure: 

1) Select U-238 from the Initial Concentrations.  

2) Open H-3 form. Visually check the format, fonts, spelling, and default values with yellow 

background color. Check if F6 key can restore a change value. 

Worked as expected. 

3) It should have the same input boxes as the figure has. 

Worked as expected. 

4) Modify the Vertical dimension of mixing for inhalation, save the form, and then the 

project to Test46.rof. 
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Changed the value to 2.78. 

5) Check the following variables in the generated file; they should be the same as the inputs 

in GUI. HUMID, H2OPLANT(1), H2OPLANT(2), H2OPLANT(3), H2OPLANT(4), 

H2OMEAT_MILK(1), H2OMEAT_MILK(2), HMIX 

Worked as expected. 

 

Additional test. Added H-3, made the following change and checked the generated input 

file. The code worked as expected. 

 

6) Open the form again. Clicking run should bring up a message window asking whether to 

save the changes and run the code. Click each button – Yes will run the code; No will 

open the Save function, Cancel Run will go back the main interface. 

Worked as expected. 
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12.59 TEST CASE 035-001 TESTER’S REPORT 

Documented in Test Case 35-1-JJCheng.docx of 2/26/2020 12:29 PM 

Test Case 35-1 – Test if submenus File -> New and Save work correctly 

 
The test was conducted following the step-by-step instructions provided in the RESOFF-TEST-001, Test 

Cases document. The RESRAD-OFFSITE code behaved expectedly for each step performed. The File > New 

and Save functions were implemented successfully.  
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12.60 TEST CASE 035-002 TESTER’S REPORT 

Documented in Test Case 35-2-JJCheng.docx of 2/14/2020 3:37 PM 

Test Case 35-2 – Test if submenu File -> Open and Save As works correctly 

 
The following procedure was used in the testing – 

 

1) Launch the RESRAD-OFFSITE code.  

 

2) Click File -> Open. A new window should pop up, requesting user to select which input file to open. 

The default file location should be the folder from which an input file was read to run the code the last 

time.  

 

3) Redirect the location to the QAFiles subfolder of the current version under testing. Select the QA 

input file “BASIC RESRAD-OFFSITE INSTALLATION QA.ROF,” and click Open.  

 

4) The main interface should update after loading the input file. Check to see if at the top of the interface, 

the input file name displayed is that of the QA file.  

 

5) Click Modify Data from the left navigation panel and then the Initial Concentration tab on the 2nd 

panel. Check to see if the SI unit of Bq/g is shown in the Initial Concentrations input form. If not, the 

code does not read in the data in the QA input file correctly, and this test should be marked as “fail.” If 

Bq/g is displayed, continue the test. 

 

6) Check to see if radionuclides shown are C-14, H-3, Pb-210, Ra-226, Ra-228, and Th-228, with 

concentrations of 15, 200, 0, 0.01, 10, and 0, respectively. 

 

7) Change the concentration of H-3 to 300 Bq/g. Close the input form. 

 

8) Click File -> Save As. A new window should pop up and the default path shown at the top of the 

window should be the QAFiles subfolder. If not, this test should be marked as “fail.”  

 

9) Change the path to the UserFiles subfolder. Provide a new file name to save the input data, and click 

Save. A new file should be created in the UserFiles subfolder. Quit RESRAD-OFFSITE. 

 

10) Open the newly saved file in the UserFiles subfolder with Notepad (or any other utility tool with 

similar functions) and compare it with the QA input file in the QAFiles subfolder. Except for the 

initial concentration of H-3, other information should be identical. If not, this test should be marked as 

“fail.” 

 

11) Repeat Steps 1-10 using the Open button (2nd from left) in the Tool bar to open the QA input file.  

 

12) Repeat Steps 1-10 using the combination keys Ctrl + O to open the QA input file.  

 

13) Copy the QAFiles subfolder to a USB drive and repeat Steps 1-10 to open the QA input file from 

there.  

 

• The screenshots below show the QA input file and the new file created. The only difference between these two 

files is the initial concentration of H-3. It is 5404.405 in the QA input file but is 8108.108 in the created file. 
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Note: In RESRAD-OFFSITE input files, the values listed for initial concentrations of radionuclide are for the 

US unit, i.e., pCi/g. 200 Bq/g = 5404.405 pCi/g while 300 Bg/g = 8108.108 pCi/g. 
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12.61 TEST CASE 035-003 TESTER’S REPORT 

Documented in Test Case 35-3-JJCheng.docx of 2/26/2020 12:31 PM 

Test Case 35-3 – Test if submenu File -> Title works correctly 

 
The test was conducted following the step-by-step instructions provided in the RESOFF-TEST-001, Test 

Cases document. The RESRAD-OFFSITE code behaved expectedly for each step performed. The File > Title 

functions were implemented successfully.  
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12.62 TEST CASE 035-004 TESTER’S REPORT 

Documented in Test Case 35-4-JJCheng.docx of 2/26/2020 12:37 PM 

Test Case 35-4 – Test if the DCF Editor can be called successfully from the menu of GUI 

 
The test was conducted following the step-by-step instructions provided in the RESOFF-TEST-001, Test 

Cases document. In addition, the RESRAD-OFFSITE code was also tested to see if the DCF Editor could be 

called at any time during the maneuvering of the GUI. The DCF Editor appeared whenever called. The 

RESRAD-OFFSITE code behaved expectedly for each step performed.  
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12.63 TEST CASE 035-005 TESTER’S REPORT 

Documented in Test Case 35-5-JJCheng.docx of 2/26/2020 12:46 PM 

Test Case 35-5 – Test the menu Help works appropriately. 

• Tested RESRAD-OFFSITE version 4.0 following the procedure described in the Test 

Cases document. The code behaved as exepected. For example, placing the cursor on the 

Root Depth parameter for fruit, grain, and non-leafy vegetables, and then clicked “F1,” 

the context sensitive help appeared on the screen - 

 

• Tested the functions of the DCF editor. Chose the “Contents” tab, selected “Root Depth,” 

the corresponding help was displayed - 

 

• Scrolled the contents list up to the top to show the help “A Help on Getting Help.”  Chose 

“Index,” typed “Root Depth” in the input box, and then clicked the “Display” button at 

the bottom. The screen did not change. It seemed that a search of the help indexes was 

not conducted. However, this is a minor issue.  
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• Chose “Search,” typed “Root Depth” in the input box, and then clicked “List Topics.” 

Two topics appeared for selection. Chose “Root Depth,” and saw the information on 

“Root Depth” appeared on the screen. 

 

• Chose to print the information on “Root Depth” to a pdf. The DCF Editor did it 

successfully. 
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12.64 TEST CASE 035-006 TESTER’S REPORT 

Documented in Test Case 35-6-JJCheng.docx of 2/26/2020 12:46 PM 

Test Case 35-6 – Test the functionality of Pathway menu 

 
The RESRAD-OFFSITE code was tested for the selection of pathways via the Pathways menu in the menu 

bar, the buttons in the pathway bar, the Inputs & Pathways tab in the Iconic Navigator, and the Set Pathways 

option in the left vertical panel. All worked without any issue.   
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12.65 TEST CASE 035-007 TESTER’S REPORT 

Documented in Test Case 35-7-JJCheng.docx of 2/17/2020 9:56 AM 

Test Case 35-7 – Test the functionality of Site Data menu 

• Tested entering site data via the Site Data menu in the menu bar, the Inputs & Pathways 

tab in the Iconic Navigator, and the Modify Data option in the left vertical panel. 

• Tested entering data with and without subforms being displayed vertically and 

horizontally. Tested entering data to a subform with the subform tab within a major input 

form.  

• Tested entering data to different input forms via the right and left arrow tabs in an input 

form.  

• Observed the grayed input parameters which were associated with inactive pathways and 

were not required for the dose/risk calculations. 

• All the different ways tried allowed data entry of input parameters without any issue.  
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12.66 TEST CASE 035-008 TESTER’S REPORT 

Documented in Test Case 35-8-JJCheng.docx of 2/17/2020 2:15 PM 

Test Case 35-8 – Test the functionality of View menu 

 
Modified the procedure described in the Test Cases document to perform the testing - 

 

• Launch the code and click View menu. A drop down list should appear. Visually check the format, 

fonts, and spelling of the drop down list. 

 

 
 

• Set cut-off to 30 days. Set the number of graphic points to 256. Select Pb-210. Choose thickness and 

total porosity of the contaminated zone for uncertainty analysis. Enter acceptable distribution 

functions and ranges. Set the number of observation to 100 and number of repetition to 1. Run the 

code. 

 

• Click View -> text output to see if the following text reports are generated - Parent Dose, Risk, 

Progeny Dose, Uncertainty/Probabilistic Dose/Risk, Uncertainty/Probabilistic Inputs, and Linear 

Regression reports. 

 

The following shows the first page of the Uncertainty/Probabilistic Inputs report. There’s no table of 

contents like the other text reports, which gives the illusion that the report is empty. Suggest to add 

table of contents to the first page or put the title “Latin Hypercube Sample Input” on the 2nd page and 

make the 2nd page the starting page of the report. 
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• Choose the Message Log option to see if OUTPUT.FIL file is available and is shown in the Viewer.  

 

• Choose the Deterministic Graphics option to see if WRESPLOT.EXE is launched properly and the 

Graphics Viewer appears.  

 

• Choose the Uncertainty/Probabilistic Graphics option to see if the Uncertainty/Probabilistic Analysis 

interactive Graphics Viewer appears.  

 

• Check and uncheck the Iconic Navigator option to see if the Iconic Navigator window is turned on and 

off accordingly.   

 

• Check and uncheck the tool bar option to see if the tool bar is shown or not shown accordingly.   

 

• Check and uncheck the Pathway Bar option to see if the Pathway Bar is shown or not shown 

accordingly.  

 

• Similarly, check and uncheck the Sensitivity Input Summary, the Uncertainty/Probabilistic Interface, 

the Map Interface, and the Soil Strata Graphics options to see if the corresponding window is shown 

or not shown accordingly.   

 

• Check the Button Prompts option to see if descriptive information appears when the cursor is placed 

on any icon on the tool bar or on the Iconic Navigator.  

 

• Check the Variable Information option to see if a variable information bar appears at the bottom of the 

interface. The variable information bar contains the name in the FORTRAN code, default value, and 

range of accepted input value for the input parameter that is highlighted at the moment. Try with the 

Area of Surface Water Body input parameter in the Surface Water Body input form. The variable 

information bar should display “Variable name: VLAKE Default: 150000 Range: 1 to 1E34.”  

 

The RESRAD-OFFSITE code behaved as expected.  
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12.67 TEST CASE 035-009 TESTER’S REPORT 

Documented in Test Case 35-9-JJCheng.docx of 2/17/2020 2:56 PM 

Test Case 35-9 – Test the functionality of Text Output menu 

• The test focused on the generation of the Area Factors report, because the generation of 

the other reports was verified with the previous test case, Test Case 35-8. 

• Selected Generated Area Factors option under the File menu. 

• Made changes in the Area Factors input form, and then clicked on Generate Dimensions. 

The X-dimension vs. Y-dimension scatter plot was generated – 

 

• Run uncertainty/probabilistic analysis (with a cut-off of 30 days, graphic points 256, and 

Pb-210 as the radionuclide of concern). 

• The Area Factor report was successfully generated, which is shown below – 
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• In the text Report Viewer, the functions of File, Edit, and Help button were tested and all 

worked properly. The following shows the Report Viewer instruction after clicking on 

the Help button - 
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12.68 TEST CASE 035-010 TESTER’S REPORT 

Documented in Test Case 35-10-JJCheng.docx of 2/17/2020 4:50 PM 

Test Case 35-10 – Test the functionality of the Form Options menu 

Modified the procedure described in the Test Cases document to perform the test. The procedure 

after modification is listed below -  

• Launch the code and click the Form Options menu. Visually check the format, fonts, and spelling.  

 

• Open the Initial Concentration input form and select Ac-227 with the default concentration. Choose 

the Form Options -> Save Current Form menu. The input form should be closed. Open the input form 

again and check if Ac-227 is selected with a concentration of 100 pCi/g. 

 

• In the Initial Concentration input form, click the Nuclide Specific Release button and the 

corresponding input form should pop up. Select “Specify the First Order Leach Rate Constant,” 

change the value from 0 to 10, and then click the Form Option -> Cancel Current Form menu. The 

Radionuclide Specific Release input form should be closed. Open it again and check to see if the value 

of the First Order Leach Rate Constant is 0 rather than 10.  

 

• Change the First Order Leach Rate Constant to 10, then save and close the Radionuclide Specific 

Release input form. Open the input form again, the value for the leach rate constant should be changed 

to 10 now. Click the Form Option -> Cancel Current Form menu to close the input form. Open the 

input form and check the value of the leach rate constant again. The value should still be 10.  

 

• Restore the value of the leach rate constant to 0 by pressing the F6 key. Click Save to close the input 

form. At this time, the Initial Concentration input form should still be open.  

 

• While the cursor highlights the input field for the concentration of Ac-227, click the Form Option -> 

Cancel Current Form menu. A warning message “Changes to the Initial Concentration form cannot be 

canceled. Changes have to be reserved manually.” would pop up. Click Ok and close the message 

window.  

 

• Open the Distribution Coefficients input form, move cursor to the Contaminated zone input field, 

which has a default value of 20. Click the Form Options -> Sensitivity Analysis (Single Parameter) 

menu, the Set Sensitivity Analysis Range window should pop up. Click Cancel to close the window.  

 

• Open the Distribution Coefficients input form, move the cursor to the Unsaturated Zone 1 input field. 

Click the Form Options -> Uncertainty/Probabilistic Analysis menu. The Uncertainty and 

Probabilistic Analysis input window should pop up. Click Ok to close the window.  

 

• Open the Physical and Hydrological input form, put cursor on the precipitation input field. Choose 

the Form Options -> Uncertainty/Probabilistic Analysis menu. The Uncertainty and Probabilistic 

Analysis input window should pop up. There is no default distribution for the precipitation parameter. 

Enter 0.8 as the minimum and 1.2 as the maximum so that the uniform distribution function is 

accepted. Click Update Parameter Stats and Distribution to update the inputs and then OK to close the 

window. Choose the View -> Uncertainty/Probabilistic Interface menu again. The precipitation 

parameter should appear in the Uncertainty and Probabilistic Analysis input window. 
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• Choose Primary Contamination in the Modify Data vertical panel. In the Primary Contamination input 

form, move the cursor to the input field of the dry bulk density of the contaminated zone. (Make sure 

the variable information bar appears at the bottom of the screen. If not, choose the View -> Variable 

Information menu to show it. The accepted range of the dry bulk density is 0.001 – 22.5.) Choose the 

Form Options -> Lower Bound menu to change the input to the minimum value of 0.001. Choose the 

Form Options -> Upper Bound menu to change the input to the maximum value of 22.5. Choose the 

Form Options -> Default menu to reset the value back to the default of 0.4. 

 

• Repeat Steps 1-10 using the hot-keys for each of the menu option (shown below).  

 

 

The RESRAD-OFFSITE code behaved as expected. 
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12.69 TEST CASE 035-011 TESTER’S REPORT 

Documented in Test Case 35-11-JJCheng.docx of 2/18/2020 11:35 AM 

Test Case 35-11 – Test the functionality of Data Transfer menu 

Modified the procedure described in the Test Cases document to perform the test. The modified 

procedure is described below –  

• Launch RESRAD-OFFSITE, choose ICRP 38 database, and set the cut-off half-life to 

180 days in the Title & Radiological Data input form. Choose “pCi” and “mrem” as the 

radiological units and “Specify initial activity based on mass of contaminated medium” 

as the conceptualization choice for the primary contamination in the Preliminary Inputs 

form. Choose U-234, U-235, and U-238 each with an initial concentration of 100 pCi/g in 

the Initial Concentrations input form. Click on the Distribution Coefficients tab and 

specify a Kd of 100 cm3/g for the contaminated zone for all three uranium isotopes.  

 

• Choose Data Transfer -> Generate Template Files from the menu bar. The selection tabs 

should display the specifications made in the previous step – 

 

• Click on the “ICRP 38 Transformation Database” tab. The Title & Radiological Data 

input form should appear. Change the database from ICRP 38 to ICRP 107. Change the 

cut-off half-life from 180 days to 30 days. Close the input form. The tab with information 

on database should now show ICRP 107 as the selected transformation database, and the 

tab with information on cut-off half-life should now show 30 days as the selected cut-off 

value. 
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• Click the “Contaminated Medium Surrounded by Clean Soil in Primary Contamination” 

tab. The Preliminary Inputs input form should appear. Change the radiological units from 

pCi to Bq and from mrem to mSv. Change the conceptualization choice to “Specify 

initial activity based on mass of entire primary contamination.” Save the input form. The 

tab with information on conceptualization choice and radiological unit should now show 

the choices just made with the Preliminary Inputs input form.  

 

• Click on the “Specify Radionuclides at Site” tab. The Initial Concentrations input form 

should appear. Po-210 should appear in the nuclide list and the concentration of the three 

uranium isotopes should be 3.7 Bq/g. Equilibrium Desorption should be the choice of 

conceptualization.  

 

• Highlight U-235 and click the Distribution Coefficients tab. In the pop-up input form, the 

input field for the contaminated medium should be grayed (the value cannot be changed). 

Save the input form. Click the Nuclide Specific Release tab. In the pop-up input form, 
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change the transfer mechanism to “First Order Rate Controlled Transfer” and specify a 

leach rate of 0.001 /yr. Save the Radionuclide Specific Release input form. Close the 

Initial Concentrations input form.     

 

 

• Click on the Generate Files tab. Provide a file name, Test 35-11-data transfer, and save 

the file to the UserFiles subfolder. Close the Formatted Data Transfer input form. 

 

• In the main interface, the information displayed at the top should show “Test 35-11-data 

transfer.ROF” as the name of the input file. Open the Primary Contamination input form. 

Add a clean cover of 0.3 m and save the input form. Choose the File -> Save As menu 

and save the input data to a new file, “TEST 35-11.” Exit from RESRAD-OFFSITE. 
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• Go to the UserFiles subfolder. Two Excel files named “TEST 35-11-DATA 

TRANSFER.NID” and “TEST 35-11-DATA TRANSFER.NPD” should be generated. In 

addition, there should be two RESRAD-OFFSITE input files, TEST 35-11.ROF and 

TEST 35-11-DATA TRASFER.ROF. 

 

• Open the two *.ROF input files separately with Notepad and compare the contents. The 

only difference should be the value for the “COVER0” parameter. In TEST35-11-DATA 

TRANSFER.ROF, the value is 0, while in TEST35-11.ROF, the value is .3. 

 

 

• Open TEST35-11-DATA TRANSFER.ROF with Notepad, change the COVER0 value 

from 0 to 0.3, and then save and close the file. Open the Excel file TEST 35-11-DATA 

TRASFER.NID. In row 81, change the value for THICK0 from 2 to 2.5, and then save 



 

574 

and close the file. Note that the value for COVER0 is 0; do not change it. Open the Excel 

file TEST 35-11-DATA TRASFER.NDD; in column D for DCACTC, change the value 

for U-234, U-235, and U-238 from 100 to 70; in column R for Release Opt, change the 

value for U-234 and U-238 from 0 to 1 to be the same as that for U-235; and in column 

AT for LEACH1, change the value for U-234 and U-238 from 0 to 0.001 to be the same 

as the value for U-235; save and close the file. 
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• Launch RESRAD-OFFSITE again. Open and read in data from the input file TEST35-

11-DATA TRANSFER.ROF. In the Title & Radiological Data input form, the 

transformation database should be ICRP 107 and the cut-off half-life should be 30 days. 

In the Initial Concentrations input form, the concentration for the uranium isotopes 

should be 3.7 Bq/g. In the Distribution Coefficient input form, the value of U-234, U-

235, and U-238 for the contaminated zone should be 100 cm3/g. In the Radionuclide 

Specific Release input form, for U-234 and U-238, the transfer mechanism should be 

Equilibrium Desorption Transfer. For U-235, the transfer mechanism should be First 

Order Rate Controlled Transfer, with a leach rate of 0.001/yr. In the Primary 

Contamination input form, the thickness of clean cover should be 0.3 m, and the 

thickness of the contaminated zone should be 2 m.  

• Choose Data Transfer -> Read Template Files from the menu bar. Click the “Read Files” 

tab in the pop-up window. Choose to open TEST 35-11-DATA TRANSFER.ROF in the 

UserFiles subfolder. A message window should pop up giving warnings that the interface 

may crash and advising the user to cycle through input forms. Click OK to read in the 

data in the template files. Click Close to close the Formatted Data Transfer window. 

 

• Open the Initial Concentrations input form, then choose the Distribution Coefficients tab. 

The Kd of U-234, U-235, and U-238 for the contaminate zone should be changed to 70 

cm3/g. Close the Distribution Coefficients input form. 

Suggestion: Revise the 

statement highlighted.  
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• Choose the Nuclide Specific Release tab, the transfer mechanism for U-234 should be 

changed to First Order Rate Controlled Transfer with a leach rate of 0.001/yr. Same for 

U-238. 

 

• Open the Primary Contamination input form. The input value for thickness of the clean 

cover should be reset to 0 m, and the thickness for the contaminated zone should be 

changed to 2.5 m.  

 

During the testing, the RESRAD-OFFSITE behaved as expected.   
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12.70 TEST CASE 035-012 TESTER’S REPORT 

Documented in Test Case 35-12-JJCheng.docx of 2/26/2020 12:53 PM 

Test Case 35-12 – Test the GUI’s input functionality from control level 

 
The test was performed following the instructions in the Test Cases document. The RESRAD-OFFSITE code 

behaved expectedly for each step. It is noted that the functions of F5, F6, and F7 (change the input value to the 

min., default, and max., respectively) do not apply to the input parameters in the Nuclide Specific Release, 

Distribution Coefficients, Deposition Velocities, and Transfer Factors input forms as designed.  
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12.71 TEST CASE 036-001 TESTER’S REPORT 

Documented in Test Case 036-001.msg of 2/20/2020 11:14 AM 

Test Case 036-001 

LePoire, David J.  Thu 2/19/2020 1:46 PM 

 

 

Opened Help 
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Help topic comes up 

 

Links work: 
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Search works: 
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12.72 TEST CASE 037 TESTER’S REPORT 

Documented in Test Case 037.msg of 2/20/2020 11:13 AM 

Test Case 037 

LePoire, David J.  Thu 2/19/2020 2:24 PM 

Summary: compared 4 nuclides in DCF editor, input echo and manual.  All the same after 

putting in the same units. 

Comparison of Data 

 

Get PM scope: 
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Co-60 ICRP-38 FGR11 
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12.73 TEST CASE 038 TESTER’S REPORT 

Documented in Test Case 038.msg of 2/20/2020 11:13 AM 

Test Case 038 

LePoire, David J.  Thu 2/20/2020 6:52 AM 

Summary: compared the slope factors for a number of radionuclides with data from the DCF 

editor, the input echo, and the manual.  All were consistent. 
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587 

12.74 TEST CASE 039 TESTER’S REPORT 

Documented in Test Case 39.msg of 2/20/2020 11:13 AM 

Test Case 39 

LePoire, David J.  Thu 2/20/2020 7:32 AM 

Transfer factors were compared based on input form, input echo, and V&V table.  Co-60 and Ir-

192 matched.  The H-3 form and input echo showed that the non-aquatic transfer factors are 

calculated.  They match. 

 

 

The H-3 factors are calculated for plant, meat, milk.  They are the same for Fish and crustacea 

(1). 
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Compare to data in V&V Data Verification> transfer Factor verification (Plant Transfer Factor 

Comparison.xlsx is below) 
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TABLE 6.3.10  Comparison of RESRAD Default Plant Transfer Factors (Fresh-Weight 

Basis) with Those from Other References 
 

      
   

PNNL Fresh Weight (Staven et al. 2003)a  

Element 
RESRAD 

(default) 

NCRP 

(1999) 

Leafy 

Vegetables 
Fruits Grains Root Vegetables 

 

 

          

Ac 2.5 × 10-3 1.0 × 10-3 9.4 × 10-5 4.5 × 10-5 2.0 × 10-5 8.8 × 10-5  

Ag 1.5 × 10-1 4.0 × 10-3 5.4 × 10-5 1.4 × 10-4 2.3 × 10-1 3.3 × 10-4  

Al 4.0 × 10-3 4.0 × 10-3 NAb NA NA NA  

Am 1.0 × 10-3 1.0 × 10-3 9.4 × 10-5 4.5 × 10-5 2.0 × 10-5 8.8 × 10-5  

Ar          

As 8.0 × 10-2 8.0 × 10-2 8.0 × 10-3 1.1 × 10-3 5.5 × 10-3 1.5 × 10-3  

At 2.0 × 10-1 2.0 × 10-1 NA NA NA NA  

Au 1.0 × 10-1 1.0 × 10-1 2.0 × 10-3 2.5 × 10-3 2.3 × 10-1 4.5 × 10-3  

B NA 1.0 × 10-2 NA NA NA NA  

Ba 5.0 × 10-3 1.0 × 10-2 3.0 × 10-2 2.7 × 10-3 1.4 × 10-2 3.8 × 10-3  

Be 4.0 × 10-3 4.0 × 10-3 2.0 × 10-3 2.7 × 10-4 1.8 × 10-3 3.8 × 10-4  

Bi 1.0 × 10-1 1.0 × 10-1 1.0 × 10-1 9.0 × 10-2 4.6 × 10-1 1.3 × 10-1  

Bk 1.0 × 10-3 1.0 × 10-3 NA NA NA NA  

Br 7.6 × 10-1 4.0 × 10-1 3.0 × 10-1 2.7 × 10-1 1.4 × 100 3.8 × 10-1  

C 5.5 × 100 NA 1.4 × 10-1 1.3 × 10-1 6.4 × 10-1 1.8 × 10-1  

Ca 5.0 × 10-1 5.0 × 10-1 7.0 × 10-1 6.3 × 10-2 3.2 × 10-1 8.8 × 10-2  

Cd 3.0 × 10-1 5.0 × 10-1 1.1 × 10-1 2.7 × 10-2 1.4 × 10-1 3.8 × 10-2  

Ce 2.0 × 10-3 2.0 × 10-3 4.0 × 10-3 3.6 × 10-3 1.8 × 10-2 5.0 × 10-3  

Cf 1.0 × 10-3 1.0 × 10-3 9.4 × 10-5 4.5 × 10-5 2.0 × 10-5 8.8 × 10-5  

Cl 2.0 × 101 2.0 × 101 1.4 × 101 1.3 × 101 6.4 × 101 1.8 × 101  

Cm 1.0 × 10-3 1.0 × 10-3 1.5 × 10-4 2.7 × 10-6 1.9 × 10-5 1.1 × 10-4  
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Co 8.0 × 10-2 8.0 × 10-2 4.6 × 10-2 1.3 × 10-3 3.4 × 10-3 1.7 × 10-2  

Cr 2.5 × 10-4 1.0 × 10-2 1.5 × 10-3 8.1 × 10-4 4.1 × 10-3 1.1 × 10-3  

Cs 4.0 × 10-2 4.0 × 10-2 9.2 × 10-2 4.0 × 10-2 2.4 × 10-2 3.3 × 10-2  

Cu 1.3 × 10-1 5.0 × 10-2 8.0 × 10-2 4.5 × 10-2 2.3 × 10-1 6.3 × 10-2  

Dy 2.0 × 10-3 2.0 × 10-3 4.0 × 10-3 3.6 × 10-3 1.8 × 10-2 5.0 × 10-3  

Er 2.0 × 10-3 2.0 × 10-3 4.0 × 10-3 3.6 × 10-3 1.8 × 10-2 5.0 × 10-3  

Es 1.0 × 10-3 1.0 × 10-3 NA NA NA NA  

Eu 2.5 × 10-3 2.0 × 10-3 4.0 × 10-3 3.6 × 10-3 1.8 × 10-2 5. × 10-3  

F 2.0 × 10-2 2.0 × 10-2 1.2 × 10-2 1.1 × 10-3 5.5 × 10-3 1.5 × 10-3  

Fe 1.0 × 10-3 1.0 × 10-3 1.0 × 10-2 9.0 × 10-3 4.6 × 10-2 1.3 × 10-2  

Fm 2.0 × 10-3 2.0 × 10-3 NA NA NA NA  

Fr 3.0 × 10-2 3.0 × 10-2 NA NA NA NA  

Ga 3.0 × 10-3 3.0 × 10-3 8.0 × 10-4 7.2 × 10-5 3.6 × 10-4 1.0 × 10-4  

Gd 2.5 × 10-3 2.0 × 10-3 4.0 × 10-3 3.6 × 10-3 1.8 × 10-2 5.0 × 10-3  

Ge 4.0 × 10-1 4.0 × 10-1 NA NA NA NA  

H 4.8 × 100 NA NA NA NA NA  

He          

Hf 3.0 × 10-3 3.0 × 10-3 2.0 × 10-4 1.8 × 10-4 9.1 × 10-4 2.5 × 10-4  

Hg 3.8 × 10-1 3.0 × 10-1 1.7 × 10-1 6.7 × 10-2 4.5 × 10-1 5.0 × 10-2  

Ho 2.6 × 10-3 2.0 × 10-3 4.0 × 10-3 3.6 × 10-3 1.8 × 10-2 5.0 × 10-3  

I 2.0 × 10-2 2.0 × 10-2 NA NA NA NA  

In 3.0 × 10-3 3.0 × 10-3 8.0 × 10-4 7.2 × 10-5 3.6 × 10-4 1.0 × 10-4  

Ir 3.0 × 10-2 3.0 × 10-2 8.0 × 10-3 7.2 × 10-3 3.6 × 10-2 1.0 × 10-2  

K 3.0 × 10-1 3.0 × 10-1 2.0 × 10-1 9.9 × 10-2 5.0 × 10-1 1.4 × 10-1  

Kr          

La 2.5 × 10-3 2.0 × 10-3 1.0 × 10-3 7.2 × 10-4 3.6 × 10-3 8.8 × 10-5  

Li NA 1.0 × 10-3 NA NA NA NA  

Lr NA 2.0 × 10-3 NA NA NA NA  
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Lu 2.0 × 10-3 2.0 × 10-3 NA NA NA NA  

Md 2.0 × 10-3 2.0 × 10-3 NA NA NA NA  

Mg 3.0 × 10-2 3.0 × 10-2 2.0 × 10-1 9.9 × 10-2 5.0 × 10-1 1.4 × 10-1  

Mn 3.0 × 10-1 3.0 × 10-1 1.4 × 10-1 9.0 × 10-3 2.7 × 10-1 5.0 × 10-2  

Mo 1.3 × 10-1 1.0 × 10-1 1.6 × 10-1 9.0 × 10-3 7.3 × 10-1 2. 0× 10-1  

N 7.5 × 100 NA 1.1 × 10-2 5.4 × 10-3 1.2 × 10-1 1.2 × 10-2  

Na 5.0 × 10-2 5.0 × 10-2 6.0 × 10-2 5.4 × 10-2 2.7 × 10-1 7.5 × 10-2  

Nb 1.0 × 10-2 1.0 × 10-2 5.0 × 10-3 4.5 × 10-3 2.3 × 10-2 6.3 × 10-3  

Nd 2.4 × 10-3 2.0 × 10-3 4.0 × 10-3 3.6 × 10-3 1.8 × 10-2 5.0 × 10-3  

Ne          

Ni 5.0 × 10-2 5.0 × 10-2 5.6 × 10-2 1.1 × 10-2 2.7 × 10-2 1.5 × 10-2  

No NA 2.0 × 10-3 NA NA NA NA  

Np 2.0 × 10-2 2.0 × 10-2 6.4 × 10-3 1.8 × 10-3 2.5 × 10-3 3.3 × 10-3  

O 6.0 × 10-1 NA NA NA NA NA  

Os 3.0 × 10-2 3.0 × 10-2 3.0 × 10-3 8.1 × 10-3 3.2 × 10-3 8.8 × 10-4  

P 1.0 × 100 1.0 × 100 7.0 × 10-1 6.3 × 10-1 3.2 × 100 8.8 × 10-1  

Pa 1.0 × 10-2 1.0 × 10-2 9.4 × 10-5 4.5 × 10-5 2.0 × 10-5 8.8 × 10-5  

Pb 1.0 × 10-2 4.0 × 10-3 2.0 × 10-3 1.8 × 10-3 4.3 × 10-3 1.5 × 10-3  

Pd 1.0 × 10-1 1.0 × 10-1 3.0 × 10-2 7.2 × 10-3 3.6 × 10-2 1.0 × 10-2  

Pm 2.5 × 10-3 2.0 × 10-3 4.0 × 10-3 3.6 × 10-3 1.8 × 10-2 5.0 × 10-3  

Po 1.0 × 10-3 1.0 × 10-3 2.4 × 10-4 2.2 × 10-4 2.1 × 10-3 1.8 × 10-3  

Pr 2.5 × 10-3 2.0 × 10-3 4.0 × 10-3 3.6 × 10-3 1.8 × 10-2 5.0 × 10-3  

Pt 1.0 × 10-1 1.0 × 10-1 NA NA NA NA  

Pu 1.0 × 10-3 1.0 × 10-3 1.2 × 10-5 8.1 × 10-6 7.8 × 10-6 2.8 × 10-4  

Ra 4.0 × 10-2 4.0 × 10-2 9.8 × 10-3 1.1 × 10-3 1.1 × 10-3 5.0 × 10-4  

Rb 1.3 × 10-1 2.0 × 10-1 1.8 × 10-1 1.6 × 10-1 8.2 × 10-1 2.3 × 10-1  

Re 2.0 × 10-1 2.0 × 10-1 3.0 × 10-1 6.3 × 10-2 3.2 × 10-1 8.8 × 10-2  

Rh 1.3 × 10-1 3.0 × 10-2 3.0 × 10-2 7.2 × 10-3 3.6 × 10-2 1.0 × 10-2  
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Ru 3.0 × 10-2 3.0 × 10-2 8.0 × 10-3 7.2 × 10-3 4.6 × 10-3 1.0 × 10-2  

S 6.0 × 10-1 6.0 × 10-1 3.0 × 10-1 2.7 × 10-1 1.4 × 100 3.8 × 10-1  

Sb 1.0 × 10-2 1.0 × 10-2 2.6 × 10-5 1.4 × 10-5 2.7 × 10-2 1.4 × 10-4  

Sc 2.0 × 10-3 2.0 × 10-3 1.2 × 10-3 1.8 × 10-4 9.1 × 10-4 2.5 × 10-4  

Se 1.0 × 10-1 1.0 × 10-1 5.0 × 10-2 9.0 × 10-3 2.3 × 10-1 1.3 × 10-2  

Si 2.0 × 10-2 2.0 × 10-2 7.0 × 10-2 1.3 × 10-2 6.4 × 10-2 1.8 × 10-2  

Sm 2.5 × 10-3 2.0 × 10-3 4.0 × 10-3 3.6 × 10-3 1.8 × 10-2 5.0 × 10-3  

Sn 2.5 × 10-3 3.0 × 10-1 6.0 × 10-3 1.1 × 10-3 5.5 × 10-3 1.5 × 10-3  

Sr 3.0 × 10-1 3.0 × 10-1 6.0 × 10-1 3.6 × 10-2 1.9 × 10-1 1.3 × 10-1  

Ta 2.0 × 10-2 2.0 × 10-3 5.0 × 10-3 4.5 × 10-3 2.3 × 10-2 6.3 × 10-3  

Tb 2.6 × 10-3 2.0 × 10-3 4.0 × 10-3 3.6 × 10-3 1.8 × 10-2 5.0 × 10-3  

Tc 5.0 × 100 5.0 × 100 4.2 × 101 2.7 × 10-1 6.6 × 10-1 6.0 × 10-2  

Te 6.0 × 10-1 1.0 × 10-1 5.0 × 10-3 7.2 × 10-4 3.6 × 10-3 1.0 × 10-3  

Th 1.0 × 10-3 1.0 × 10-3 3.6 × 10-4 4.5 × 10-5 3.1 × 10-5 8.3 × 10-5  

Ti 1.0 × 10-3 5.0 × 10-4 NA NA NA NA  

Tl 2.0 × 10-1 2.0 × 10-1 8.0 × 10-4 7.2 × 10-5 3.6 × 10-4 1.0 × 10-4  

Tm 2.0 × 10-3 2.0 × 10-3 NA NA NA NA  

U 2.5 × 10-3 2.0 × 10-3 1.7 × 10-3 7.2 × 10-4 1.2 × 10-3 3.0 × 10-3  

V 2.0 × 10-3 2.0 × 10-3 NA NA NA NA  

W 1.8 × 10-2 8.0 × 10-1 6.0 × 10-1 5.4 × 10-1 2.7 × 100 7.5 × 10-1  

Xe          

Y 2.5 × 10-3 2.0 × 10-3 2.0 × 10-3 1.8 × 10-3 9.1 × 10-3 2.5 × 10-3  

Yb 2.0 × 10-3 2.0 × 10-3 NA NA NA NA  

Zn 4.0 × 10-1 4.0 × 10-1 2.6 × 10-1 1.6 × 10-1 1.5 × 100 8.8 × 10-2  

Zr 1.0 × 10-3 1.0 × 10-3 2.0 × 10-4 1.8 × 10-4 9.1 × 10-4 2.5 × 10-4  
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12.75 TEST CASE 040 TESTER’S REPORT 

Documented in Test Case 40.msg of 2/20/2020 11:13 AM 

Test Case 40  

LePoire, David J.  Thu 2/20/2020 7:47 AM 

Data was compared from V&V table below and the .CHN file for C0-60, Cs-137, and Ra-226.  All matched 
 
Extract from R:\_QA_Files\OFFSITE\V&V\Data Verification\Nuclide decay and ingrowth verification.xlsx 
> ICRP38-comparion tab: 

 

 

 

 

 
 
Chain file for C0-60, Cs-137, and Ra-226: 
All data in Nukes(), order matches NUCNAM list in .ROF file: 
#    Nuclide       Half-Life      AtWt       Kd Def      Fraction    nNuc  Decay Chain 
001   Co-60        5.27100E+00   059.9338   1.000E+03   1.000000E+00   01   Co-60 
002   Cs-137+D     3.00000E+01   136.9071   4.600E+03   1.000000E+00   01   Cs-137+D 
003   Pb-210+D     2.23000E+01   209.9842   1.000E+02   1.000000E+00   02   Pb-210+D Po-210 
004   Po-210       3.78864E-01   209.9829   1.000E+01   1. 
Cs-137+D  : (Ba-137m 9.4600E-01) 
Pb-210+D  : Bi-210000000E+00   01   Po-210 
005   Ra-226+D     1.60000E+03   226.0254   7.000E+01   1.000000E+00   03   Ra-226+D Pb-210+D Po-210 
--------------    DPlusAll() data: 
 
Ra-226+D  : Rn-222 Po-218 (Pb-214 9.9980E-01) Bi-214 (Po-214 9.9980E-01) (Tl-210 2.0000E-04) (At-218 
2.0000E-04) 
 
Decay Chain: Co-60 
                           First Branch          Second Branch           Third Branch          Fourth Branch 
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                      ---------------------- ---------------------- ---------------------- ---------------------- 
#  Nuclide Half-Life  #  Nuclide  Fraction   #  Nuclide  Fraction   #  Nuclide  Fraction   #  Nuclide  Fraction 
001 Co-60   5.271E+00 000         1.0000E+00 000         0.0000E+00 000         0.0000E+00 
000         0.0000E+00 
 
All Threads In Decay Chain: Co-60 
#   Fraction  Nuclides: 
001 1.0000E+00 Co-60   
Total Thread Fractions: 1.0000E+00 
1 - Total Thread Fractions: 0.0000E+00 
 
Condensed Threads In Decay Chain: Co-60    Fix Level = 0 
#   Fraction  Nuclides: 
001 1.0000E+00 Co-60      
  
Decay Chain: Cs-137 
                           First Branch          Second Branch           Third Branch          Fourth Branch 
                      ---------------------- ---------------------- ---------------------- ---------------------- 
#  Nuclide Half-Life  #  Nuclide  Fraction   #  Nuclide  Fraction   #  Nuclide  Fraction   #  Nuclide  Fraction 
001 Cs-137  3.000E+01 000 EOCB    5.4000E-02 002 Ba-137m 9.4600E-01 000         0.0000E+00 
000         0.0000E+00 
002 Ba-137m 4.852E-06 000         1.0000E+00 000         0.0000E+00 000         0.0000E+00 
000         0.0000E+00 
 
All Threads In Decay Chain: Cs-137 
#   Fraction  Nuclides: 
001 5.4000E-02 Cs-137  
002 9.4600E-01 Cs-137  Ba-137m 
Total Thread Fractions: 1.0000E+00 
1 - Total Thread Fractions: 0.0000E+00 
 
Condensed Threads In Decay Chain: Cs-137    Fix Level = 0 
#   Fraction  Nuclides: 
002 1.0000E+00 Cs-137+D   
  
Decay Chain: Ra-226 
                           First Branch          Second Branch           Third Branch          Fourth Branch 
                      ---------------------- ---------------------- ---------------------- ---------------------- 
#  Nuclide Half-Life  #  Nuclide  Fraction   #  Nuclide  Fraction   #  Nuclide  Fraction   #  Nuclide  Fraction 
001 Ra-226  1.600E+03 002 Rn-222  1.0000E+00 000         0.0000E+00 000         0.0000E+00 
000         0.0000E+00 
002 Rn-222  1.047E-02 003 Po-218  1.0000E+00 000         0.0000E+00 000         0.0000E+00 
000         0.0000E+00 
003 Po-218  5.799E-06 004 Pb-214  9.9980E-01 005 At-218  2.0000E-04 000         0.0000E+00 
000         0.0000E+00 
004 Pb-214  5.095E-05 006 Bi-214  1.0000E+00 000         0.0000E+00 000         0.0000E+00 
000         0.0000E+00 
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005 At-218  6.338E-08 006 Bi-214  1.0000E+00 000         0.0000E+00 000         0.0000E+00 
000         0.0000E+00 
006 Bi-214  3.784E-05 007 Po-214  9.9980E-01 008 Tl-210  2.0000E-04 000         0.0000E+00 
000         0.0000E+00 
007 Po-214  5.206E-12 009 Pb-210  1.0000E+00 000         0.0000E+00 000         0.0000E+00 
000         0.0000E+00 
008 Tl-210  2.472E-06 009 Pb-210  1.0000E+00 000         0.0000E+00 000         0.0000E+00 
000         0.0000E+00 
009 Pb-210  2.230E+01 010 Bi-210  1.0000E+00 000         0.0000E+00 000         0.0000E+00 
000         0.0000E+00 
010 Bi-210  1.372E-02 011 Po-210  1.0000E+00 000         0.0000E+00 000         0.0000E+00 
000         0.0000E+00 
011 Po-210  3.789E-01 000         1.0000E+00 000         0.0000E+00 000         0.0000E+00 
000         0.0000E+00 
 
All Threads In Decay Chain: Ra-226 
#   Fraction  Nuclides: 
001 9.9960E-01 Ra-226  Rn-222  Po-218  Pb-214  Bi-214  Po-214  Pb-210  Bi-210  Po-210  
002 1.9996E-04 Ra-226  Rn-222  Po-218  Pb-214  Bi-214  Tl-210  Pb-210  Bi-210  Po-210  
003 1.9996E-04 Ra-226  Rn-222  Po-218  At-218  Bi-214  Po-214  Pb-210  Bi-210  Po-210  
004 4.0000E-08 Ra-226  Rn-222  Po-218  At-218  Bi-214  Tl-210  Pb-210  Bi-210  Po-210  
Total Thread Fractions: 1.0000E+00 
1 - Total Thread Fractions: 0.0000E+00 
 
Condensed Threads In Decay Chain: Ra-226    Fix Level = 0 
#   Fraction  Nuclides: 
003 1.0000E+00 Ra-226+D   Pb-210+D   Po-210     
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12.76 TEST CASE 041 TESTER’S REPORT 

Documented in Test Case 41.msg of 2/20/2020 11:13 AM 

Test Case 41  

LePoire, David J.  Thu 2/20/2020 7:59 AM 

Summary: compared external pathway results with the two input files to Table 1 in the V&V 

folder.  Results are the same. 

 

Compare fifth column to results from External-1: results are the same 
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Compare eighth column to results from External-2: results are the same 
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12.77 TEST CASE 042 TESTER’S REPORT 

Documented in Test Case 42.msg of 2/20/2020 11:13 AM 

Test Case 42 

LePoire, David J.  Thu 2/20/2020 9:02 AM 

Summary : Compared 5 distributions.  Four were the same as what was reported in the new 

parameter report.  The Kd value in the softwar for Ra-266  was not consistent with the parameter 

report but was consistent with the latest Data Collection handbook (snippets below). 
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12.78 TEST CASE 044 TESTER’S REPORT 

Documented in Results_ Test Case 044.msg of 2/13/2020 7:13 AM 

Results: Test Case 044 

LePoire, David J.  Thu 2/13/2020 7:13 AM 

Summary: The 4 steps of Test Case 044 were successfully completed and documented 

(below). 

 

1. Go through download registration process on website. 

 

 

Result of “Submit” 
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2. Verify receipt of email for access to download  

 

Email received minutes later: 
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3. Verify email link allows access 

Result of clicking link: 
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4. Verify download 

Result of clicking RESRAD-OFFSITE 3.2 
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12.79 TEST CASE 047 TESTER’S REPORT 

Documented in Tase Case 47.msg of 2/20/2020 11:14 AM 

Tase Case 47 

LePoire, David J.  Thu 2/20/2020 6:25 AM 

Dose for wide area 
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Area Factor (consider up to 10 x 10 centered):
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Summary: Area factor run for 10x10 centered case.  Then doses for the full 100x100 are 

compared to the dose for the adjusted layout for the 10x10 area.  The area factor agree to about 

1%.  
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Set up deterministic setting for largest area. Find coordinates based on uncertainty distributions 

for related parameters example below):
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Dose for small area: 

 

 

Calculated area factor = 4.012/3.52e-2=113 
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12.80 TEST CASE 048 TESTER’S REPORT 

Documented in Test Case 48-JJCheng.docx of 2/18/2020 3:07 PM 

Test Case 48 – Tests OFFSITE’s generation of template files tool 

Base on instructions of the Test Cases document, the following procedure was performed – 

• Launched RESRAD-OFFSITE. Selected Ac-227 as the radionuclide of concern with an 

initial conc. of 100 Bq/g. Chose the Data Transfer -> Generate templet files menu to 

generate template files. The inputs were save to file SITE9-DATA TRANSFER.ROF. 

• Opened the Excel files, SITE9-DATA TRANSFER-NDP and SITE9-DATA 

TRANSFER-NIP. Made changes. The following screenshots compare the values before 

and after the changes. 

After the changes - 

 

Before the changes - 

 

After the changes - 

 

Before the changes - 
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After the changes - 

 

Before the changes - 

 

After the changes –                                                                      Before the changes - 
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• Launched RESRAD-OFFSITE and opend input file, SITE9-DATA TRANSFER.ROF. 

The inputs of radionuclide release and Kds were – 
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• Chose Data Transfer -> Read Template Files to read in the template files associated with 

the input file that were changed. After reading in data in the template files, the 

concentration of Ac-227 changed to 110 Bq/g, the Kds changed to 22 cm3/g, the number 

of release times changed to 9, and the transfer mechanism changed to First Order Rate 

Controlled Transfer, as shown in the screen shots below – 
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The Data Transfer Template files were generated and the data in them were read in successfully. 
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12.81 TEST CASE 049 TESTER’S REPORT 

Documented in Results for Test Case 049.msg of 2/14/2020 3:06 PM 

Results for Test Case 049  

LePoire, David J.  Fri 2/14/2020 3:06 PM 

Added Co-60 to the default case. 

 

External Pathway: 
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Water use by livestock is not used:

 

All ingestion disabled: 
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Inhalation parameters disabled: 

 

  



 

624 

Ran the case.  Looked at input echo: 

No ingestion pathway parameters used:
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No inhalation parameters used:

 

 

 

  



 

626 

No Radon or c-14 parameters used:

 

 

No tritium parameters used.   
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Reports correct Pathway selections:
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Now look at inhalation only pathway:

 

 

Livestock pathway still off:
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Ingestion still off 

 

 

External gamma penetration factor is off:

 



 

630 

Ran the case: 

Look at Dose report: 

No use of ingestion parameters:
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Inhalation parameters now used:

 

 

External parameters not used: 
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Tritium and C-14 not used 

Summary Pathway selections is correct
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Now Switch to Plant Ingestion Pathways only:

 

 

Livestock fields not used:

 



 

634 

However, agricultural (human plant food)  parameters are sued: 
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Same split in water use (plant on, livestock off) 

 

Inhalation and External pathways off. 
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Ran the case 

Plant fields used, livestock and dwelling site not used: 
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Plant fields used: 

 

Livestock Fields not used: 

 



 

638 

Plant info used, livestock info not used: 

 

  



 

639 

External pathway parameters not sued: 
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c-14 and H-3 not used 

Summary of athway selections is correct: 
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Now look at Meat Pathway only 

 

Plant areas  not used:

 



 

642 

Both Livestock areas used:

 

 



 

643 

Only Beef cattle need water to drink:

 

 



 

644 

Both fields used but only Beef cattle eat:
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Inhalation and external gamma not used:
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Ran the case 

Ag areas 1&2 not used but 3&4 for livestock are used: 
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Inhalation not used: 

 

 

External not used: 
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C-14 and H-3 not used 

Summary Pathway selection is correct: 
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Now look at Milk Pathway only 

 

 

Only livestock feed fields are used: 

 



 

650 
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652 

Surface Water Body still used: 
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Only milk ingestion used: 

 

 

Livestock Feed Factors used: 
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Inhalation and External not used: 
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Ran the Case 

Areas 1&2 not used; 3&4 used: 
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Inhalation and external not used:
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C-14 and H-3 not used 

Summary of Pathway selection is correct 
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Now Switch to Aquatic Pathway only: 

 

 

Only Pond location matters beside contamination: 

 



 

660 

Only need to know how much erosion goes to pond: 

 

 

No Ag areas used: 

 

 



 

661 

 

 

  



 

662 

Sediment from primary contamination delivery ratio is on?? 

 



 

663 

Try to set it give and Run-time Error 5

 

 

Now Switch to Drinking Water Pathway only: 
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Only pond area location matters
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Now Switch to Soil Ingestion Pathway only: 
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669 

Only soil ingestion is considered: 

 

External and inhalation parameters not used: 
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Irrigation not used: 



 

671 

 

No Vegetables considered 
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Now Switch to Radon only: 

 

All locations matter 
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Particulate inhalation and ingestion are not used
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Radon parameters are now accessible and editable

 



 

675 

Vegetable ingestion is off

 

 

Applicable Radon parameters used. 
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Bug: Test 049 

Documented in Bug_ Test 049.msg of 2/14/2020 3:09 PM 

LePoire, David J.  Thu 2/13/2020 9:32 AM 

 

If the aquatic pathway is the only one on, the “Sediment from Primary Contamination delivery 

ratio” on the Offsite Dwelling Area is still enabled. 

It is set to zero, but if I click on the button, I get a run-time error 5 and the code crashes. 

I repeated this and also made sure the button works when all pathways are enabled. 

 

I do not think this is a show-stopper since it is rare since the user would not think to go here, it 

has the correct default, and stops the program (i.e., does not give wrong results). 

 

Please let us know your decision on this issue. 

Thanks, 

Dave 
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12.82 TEST CASE 050 TESTER’S REPORT 

Documented in Results Test Case 050.msg of 2/14/2020 3:08 PM 

Results Test Case 050 

LePoire, David J. Thu 2/13/2020 1:14 PM 

Summary: Passed by maintaining a set of nuclide-specfic properties under a 

change from one radionculdie transformaton database (ICRP-38) to another 

(ICRP-107) 

 

Add U-238 at 100 pCi/g and Po-210 at 60 pCi/g 

Change some nuclide and element specific parameters for U-238 

Start with ICRP-38 and then change to ICRP-107 to see if the radionculide specific properties 

are maintained. 
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Then Change to ICRP-107 
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Values were maintained: 
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12.83 TEST CASE 051 TESTER’S REPORT 

Documented in Results_ Test Case 051.msg of 2/14/2020 3:08 PM 

Results: Test Case 051  

LePoire, David J. Thu 2/13/2020 2:01 PM 

Libraries available for ICRP-107 
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With ICRP-38 after creating NoBa137 
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ICRP-107 after adding library “Test-Release 4.0 
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12.84 TEST CASE 052 TESTER’S REPORT 

Documented in Results_ Test Case 052.msg of 2/14/2020 3:46 PM 

Results: Test Case 052 

LePoire, David J. Fri 2/14/2020 2:38 PM 

Summary: Pass, the numbers are the same in the manual and in the files after running the 

application 

 

Follow instructions in E.4 of the manual (volume 1) 

E.4.1 Pb-210 under ICRP-38 

Summary: the numbers are the same in the manual and in the files after running the 

application 
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Compare information in the .CHN file to steps 1-4 on page E-5 
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Compare DCF results to step 5 on page E-6: They are the same 
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Compare Slope Factor results to step 5 on page E-5: They are the same 
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E.4.2 Pb-210 under ICRP-107 

 

Summary: the numbers are the same in the manual and in the files after running the 

application 

From E.4.2 page E-6 

(Note: There was a minor typo identified in the manual.  The 210Hg should have been 206Hg 
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Compare DCF’s: 

 

 

 

 

  



 

690 

                                           Compare Slope Factors 
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E.4.3 Ac-227 under ICRP-107 

 

Summary: the numbers are the same in the manual and in the files after running the 

application 
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12.85 TEST CASE 053 TESTER’S REPORT 

Documented in Test Case 53-JJCheng.docx of 2/19/2020 4:34 PM 

Test Case – 53 – Tests OFFSITE’s source conceptualization options tool  

• Launched RESRAD-OFFSITE. Specified Ac-227 as the radionuclide of concern, and 

then selected “Use RESRAD-ONSITE exponential release model” as the 

conceptualization of primary contamination in the Preliminary Inputs form. The Times at 

which Release Properties are Specified, Distribution Coefficients, Radionuclide Specific 

Release, and the Primary Contamination input forms all displayed expectedly with input 

parameters associated with this conceptualization option.  
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• Selected “Specify initial activity based on mass of entire primary contamination” as the 

conceptualization of primary contamination in the Preliminary Inputs form. The Times at 

which Release Properties are Specified input form allowed the specification of up to 9th 

time periods. The Distribution Coefficients, Radionuclide Specific Release, and the 

Primary Contamination input forms all displayed expectedly with input parameters 

associated with this conceptualization option.  
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• Selected “Specify initial activity based on mass of entire primary contamination” as the 

conceptualization of primary contamination and checked “Model multiple forms of 

contaminated media” in the Preliminary Inputs form. The Times at which Release 

Properties are Specified input form allowed the specification of up to 9th time periods. 

The Distribution Coefficients, Radionuclide Specific Release (fixed the change pattern of 

releasable fraction and leach rate as stepwise between release time periods), and the 

Primary Contamination input forms all displayed expectedly with input parameters 

associated with this conceptualization option.  
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• Selected “Specify initial activity based on mass of contaminated medium” as the 

conceptualization of primary contamination in the Preliminary Inputs form. The Times at 

which Release Properties are Specified input form allowed the specification of up to 9th 

time periods. The Distribution Coefficients (allowed the specification of Kd for the 

contaminated medium), Radionuclide Specific Release, and the Primary Contamination 

(allowed the specification of total mass and volume of the contaminated medium) input 

forms all displayed expectedly with input parameters associated with this 

conceptualization option.  
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• Selected “Specify initial activity based on mass of contaminated medium” as the 

conceptualization of primary contamination and checked “Model multiple forms of 

contaminated media” in the Preliminary Inputs form. The Times at which Release 

Properties are Specified input form allowed the specification of up to 9th time periods. 

The Distribution Coefficients (allowed the specification of Kd for the contaminated 

medium), Radionuclide Specific Release (fixed the change pattern of releasable fraction 

and leach rate as stepwise between release time periods), and the Primary Contamination 

(allowed the specification of total mass and volume of the contaminated medium) input 

forms all displayed expectedly with input parameters associated with this 

conceptualization option.  
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• Selected “Model diffusive transport out of contaminated medium” as the 

conceptualization of primary contamination in the Preliminary Inputs form. The Times at 

which Release Properties are Specified input form allowed the specification of up to 9th 

time periods. The Distribution Coefficients (allowed the specification of Kd for the 

contaminated medium), Radionuclide Specific Release (fixed the transfer mechanism as 

Equilibrium Desorption Transfer and allowed the specification of diffusion coefficient in 

the contaminate medium), and the Primary Contamination (allowed the specification of 

total mass, volume, and volumetric water content of the contaminated medium, and 

length, width, and breadth of the individual fragment) input forms all displayed 

expectedly with input parameters associated with this conceptualization option.  
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705 
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12.86 TEST CASE 054-001 TESTER’S REPORT 

Documented in graph_primary_contamination_c14.csv of 2/18/2020 7:35 AM 

CONCENTRATION: C-14, Primary Contamination CONCENTRATION: C-14, Primary Contamination 
CARBON-14_test.ROF  02/17/2020  16:40  
Graphics.Asc 

CARBON-14.ROF  01/10/2020  15:37  
Graphics.Asc 

Year Value Year Value  
0 100 0 100 1 

0.0625 80.14947 0.0625 80.14947 1 
0.125 64.23934 0.125 64.23934 1 

0.1875 51.48744 0.1875 51.48744 1 
0.25 41.26685 0.25 41.26685 1 

0.3125 33.07509 0.3125 33.07509 1 
0.375 26.50945 0.375 26.50945 1 

0.4375 21.24711 0.4375 21.24711 1 
0.5 17.02939 0.5 17.02939 1 

0.5625 13.64891 0.5625 13.64891 1 
0.625 10.93948 0.625 10.93948 1 

0.6875 8.767893 0.6875 8.767893 1 
0.75 7.027381 0.75 7.027381 1 

0.8125 5.632375 0.8125 5.632375 1 
0.875 4.514289 0.875 4.514289 1 

0.9375 3.618154 0.9375 3.618154 1 
1 2.899909 1 2.899909 1 

1.0625 2.324244 1.0625 2.324244 1 
1.125 1.862853 1.125 1.862853 1 

1.1875 1.493054 1.1875 1.493054 1 
1.25 1.196663 1.25 1.196663 1 

1.3125 0.95911 1.3125 0.95911 1 
1.375 0.768713 1.375 0.768713 1 

1.4375 0.616113 1.4375 0.616113 1 
1.5 0.493806 1.5 0.493806 1 

1.5625 0.395778 1.5625 0.395778 1 
1.625 0.31721 1.625 0.31721 1 

1.6875 0.254239 1.6875 0.254239 1 
1.75 0.203768 1.75 0.203768 1 

1.8125 0.163317 1.8125 0.163317 1 
1.875 0.130896 1.875 0.130896 1 

1.9375 0.104911 1.9375 0.104911 1 
2 0.084084 2 0.084084 1 

2.0625 0.067392 2.0625 0.067392 1 
2.125 0.054013 2.125 0.054013 1 
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12.87 TEST CASE 054-002 TESTER’S REPORT 

Documented in graph_non_leafy_C14.csv of 2/18/2020 7:36 AM 

CONCENTRATION: C-14, Fruit, grain, non-leafy 
vegetables 

CONCENTRATION: C-14, Fruit, grain, non-leafy 
vegetables 

CARBON-14_test.ROF  02/17/2020  16:40  
Graphics.Asc 

CARBON-14.ROF  01/10/2020  15:37  
Graphics.Asc 

Year Value Year Value  
0 1088160 0 1088160 1 

0.0625 872156.9 0.0625 872156.9 1 
0.125 699030.9 0.125 699030.9 1 

0.1875 560270.6 0.1875 560270.6 1 
0.25 449054.5 0.25 449054.5 1 

0.3125 359915.1 0.3125 359915.1 1 
0.375 288470.1 0.375 288470.1 1 

0.4375 231207.2 0.4375 231207.2 1 
0.5 185311.3 0.5 185311.3 1 

0.5625 148525.8 0.5625 148525.8 1 
0.625 119042.5 0.625 119042.5 1 

0.6875 95411.7 0.6875 95411.7 1 
0.75 76471.77 0.75 76471.77 1 

0.8125 61291.53 0.8125 61291.53 1 
0.875 49124.66 0.875 49124.66 1 

0.9375 39373 0.9375 39373 1 
1 31557.1 1 31557.1 1 

1.0625 25292.72 1.0625 25292.72 1 
1.125 20271.87 1.125 20271.87 1 

1.1875 16247.7 1.1875 16247.7 1 
1.25 13022.36 1.25 13022.36 1 

1.3125 10437.28 1.3125 10437.28 1 
1.375 8365.359 1.375 8365.359 1 

1.4375 6704.736 1.4375 6704.736 1 
1.5 5373.765 1.5 5373.765 1 

1.5625 4307.005 1.5625 4307.005 1 
1.625 3452.009 1.625 3452.009 1 

1.6875 2766.739 1.6875 2766.739 1 
1.75 2217.503 1.75 2217.503 1 

1.8125 1777.297 1.8125 1777.297 1 
1.875 1424.478 1.875 1424.478 1 

1.9375 1141.698 1.9375 1141.698 1 
2 915.0533 2 915.0533 1 

2.0625 733.4008 2.0625 733.4008 1 
2.125 587.809 2.125 587.809 1 
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Documented in Graph_leafy_vegetable_c14.csv of 2/18/2020 7:37 AM 

CONCENTRATION: C-14, Leafy vegetable CONCENTRATION: C-14, Leafy vegetable 
CARBON-14_test.ROF  02/17/2020  16:40  
Graphics.Asc 

CARBON-14.ROF  01/10/2020  15:37  
Graphics.Asc 

Year Value Year Value  
0 208495.3 0 208495.3 1 

0.0625 167108.3 0.0625 167108.3 1 
0.125 133936.8 0.125 133936.8 1 

0.1875 107349.8 0.1875 107349.8 1 
0.25 86040.41 0.25 86040.41 1 

0.3125 68960.99 0.3125 68960.99 1 
0.375 55271.89 0.375 55271.89 1 

0.4375 44300.11 0.4375 44300.11 1 
0.5 35506.29 0.5 35506.29 1 

0.5625 28458.07 0.5625 28458.07 1 
0.625 22808.95 0.625 22808.95 1 

0.6875 18281.22 0.6875 18281.22 1 
0.75 14652.26 0.75 14652.26 1 

0.8125 11743.67 0.8125 11743.67 1 
0.875 9412.457 0.875 9412.457 1 

0.9375 7544.004 0.9375 7544.004 1 
1 6046.451 1 6046.451 1 

1.0625 4846.174 1.0625 4846.174 1 
1.125 3884.161 1.125 3884.161 1 

1.1875 3113.115 1.1875 3113.115 1 
1.25 2495.129 1.25 2495.129 1 

1.3125 1999.819 1.3125 1999.819 1 
1.375 1602.832 1.375 1602.832 1 

1.4375 1284.651 1.4375 1284.651 1 
1.5 1029.632 1.5 1029.632 1 

1.5625 825.2372 1.5625 825.2372 1 
1.625 661.417 1.625 661.417 1 

1.6875 530.1169 1.6875 530.1169 1 
1.75 424.8814 1.75 424.8814 1 

1.8125 340.5364 1.8125 340.5364 1 
1.875 272.935 1.875 272.935 1 

1.9375 218.7533 1.9375 218.7533 1 
2 175.3274 2 175.3274 1 

2.0625 140.5222 2.0625 140.5222 1 
2.125 112.6263 2.125 112.6263 1 
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12.88 TEST CASE 054-003 TESTER’S REPORT 

Documented in graph_meat_c14.csv of 2/18/2020 7:38 AM 

CONCENTRATION: C-14, Meat CONCENTRATION: C-14, Meat 
CARBON-14_test.ROF  02/17/2020  16:40  
Graphics.Asc 

CARBON-14.ROF  01/10/2020  15:37  
Graphics.Asc 

Year Value Year Value  
0 330987.8 0 330987.8 1 

0.0625 265285.7 0.0625 265285.7 1 
0.125 212625.6 0.125 212625.6 1 

0.1875 170418.6 0.1875 170418.6 1 
0.25 136589.8 0.25 136589.8 1 

0.3125 109476.1 0.3125 109476.1 1 
0.375 87744.52 0.375 87744.52 1 

0.4375 70326.75 0.4375 70326.75 1 
0.5 56366.48 0.5 56366.48 1 

0.5625 45177.38 0.5625 45177.38 1 
0.625 36209.38 0.625 36209.38 1 

0.6875 29021.56 0.6875 29021.56 1 
0.75 23260.57 0.75 23260.57 1 

0.8125 18643.16 0.8125 18643.16 1 
0.875 14942.34 0.875 14942.34 1 

0.9375 11976.16 0.9375 11976.16 1 
1 9598.785 1 9598.785 1 

1.0625 7693.335 1.0625 7693.335 1 
1.125 6166.134 1.125 6166.134 1 

1.1875 4942.093 1.1875 4942.093 1 
1.25 3961.036 1.25 3961.036 1 

1.3125 3174.727 1.3125 3174.727 1 
1.375 2544.507 1.375 2544.507 1 

1.4375 2039.393 1.4375 2039.393 1 
1.5 1634.548 1.5 1634.548 1 

1.5625 1310.07 1.5625 1310.07 1 
1.625 1050.004 1.625 1050.004 1 

1.6875 841.5643 1.6875 841.5643 1 
1.75 674.5023 1.75 674.5023 1 

1.8125 540.604 1.8125 540.604 1 
1.875 433.2862 1.875 433.2862 1 

1.9375 347.2724 1.9375 347.2724 1 
2 278.3336 2 278.3336 1 

2.0625 223.08 2.0625 223.08 1 
2.125 178.795 2.125 178.795 1 
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Documented in graph_Milk_c14.csv of 2/18/2020 7:39 AM 

CONCENTRATION: C-14, Milk CONCENTRATION: C-14, Milk 
CARBON-14_test.ROF  02/17/2020  16:40  
Graphics.Asc 

CARBON-14.ROF  01/10/2020  15:37  
Graphics.Asc 

Year Value Year Value  
0 78818.34 0 78818.34 1 

0.0625 63172.66 0.0625 63172.66 1 
0.125 50632.68 0.125 50632.68 1 

0.1875 40581.89 0.1875 40581.89 1 
0.25 32526.22 0.25 32526.22 1 

0.3125 26069.61 0.3125 26069.61 1 
0.375 20894.66 0.375 20894.66 1 

0.4375 16746.96 0.4375 16746.96 1 
0.5 13422.59 0.5 13422.59 1 

0.5625 10758.12 0.5625 10758.12 1 
0.625 8622.565 0.625 8622.565 1 

0.6875 6910.925 0.6875 6910.925 1 
0.75 5539.056 0.75 5539.056 1 

0.8125 4439.51 0.8125 4439.51 1 
0.875 3558.231 0.875 3558.231 1 

0.9375 2851.892 0.9375 2851.892 1 
1 2285.765 1 2285.765 1 

1.0625 1832.019 1.0625 1832.019 1 
1.125 1468.346 1.125 1468.346 1 

1.1875 1176.864 1.1875 1176.864 1 
1.25 943.2442 1.25 943.2442 1 

1.3125 755.9999 1.3125 755.9999 1 
1.375 605.9253 1.375 605.9253 1 

1.4375 485.642 1.4375 485.642 1 
1.5 389.2361 1.5 389.2361 1 

1.5625 311.9679 1.5625 311.9679 1 
1.625 250.0383 1.625 250.0383 1 

1.6875 200.4023 1.6875 200.4023 1 
1.75 160.6197 1.75 160.6197 1 

1.8125 128.7344 1.8125 128.7344 1 
1.875 103.1788 1.875 103.1788 1 

1.9375 82.69623 1.9375 82.69623 1 
2 66.27976 2 66.27976 1 

2.0625 53.12218 2.0625 53.12218 1 
2.125 42.57657 2.125 42.57657 1 
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12.89 TEST CASE 054-004 TESTER’S REPORT 

Documented in graph_primary_Contamination_H3.csv of 2/18/2020 7:44 AM 

CONCENTRATION: H-3, Primary Contamination CONCENTRATION: H-3, Primary Contamination 
HYDROGEN-3_test.ROF  02/17/2020  16:53  
Graphics.Asc 

Hydrogen-3.ROF  01/12/2020  18:07  
Graphics.Asc 

Year Value Year Value  
0 100 0 100 1 

0.0625 91.13956 0.0625 91.13956 1 
0.125 83.06419 0.125 83.06419 1 

0.1875 75.70432 0.1875 75.70432 1 
0.25 68.99655 0.25 68.99655 1 

0.3125 62.88312 0.3125 62.88312 1 
0.375 57.31136 0.375 57.31136 1 

0.4375 52.23329 0.4375 52.23329 1 
0.5 47.60515 0.5 47.60515 1 

0.5625 43.38708 0.5625 43.38708 1 
0.625 39.54275 0.625 39.54275 1 

0.6875 36.03905 0.6875 36.03905 1 
0.75 32.84579 0.75 32.84579 1 

0.8125 29.93546 0.8125 29.93546 1 
0.875 27.28301 0.875 27.28301 1 

0.9375 24.86557 0.9375 24.86557 1 
1 22.66233 1 22.66233 1 

1.0625 20.65431 1.0625 20.65431 1 
1.125 18.82421 1.125 18.82421 1 

1.1875 17.15627 1.1875 17.15627 1 
1.25 15.63611 1.25 15.63611 1 

1.3125 14.25065 1.3125 14.25065 1 
1.375 12.98795 1.375 12.98795 1 

1.4375 11.83713 1.4375 11.83713 1 
1.5 10.78828 1.5 10.78828 1 

1.5625 9.832363 1.5625 9.832363 1 
1.625 8.961145 1.625 8.961145 1 

1.6875 8.167124 1.6875 8.167124 1 
1.75 7.443457 1.75 7.443457 1 

1.8125 6.783911 1.8125 6.783911 1 
1.875 6.182806 1.875 6.182806 1 

1.9375 5.634963 1.9375 5.634963 1 
2 5.135662 2 5.135662 1 

2.0625 4.680602 2.0625 4.680602 1 
2.125 4.265863 2.125 4.265863 1 
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12.90 TEST CASE 054-005 TESTER’S REPORT 

Documented in Graph_leafy_vegetable_h3.csv of 2/18/2020 7:42 AM 

CONCENTRATION: H-3, Leafy vegetable CONCENTRATION: H-3, Leafy vegetable 
HYDROGEN-3_test.ROF  02/17/2020  16:53  
Graphics.Asc 

Hydrogen-3.ROF  01/12/2020  18:07  
Graphics.Asc 

Year Value Year Value  
0 0.026339 0 0.026339 1 

0.0625 0.026394 0.0625 0.026394 1 
0.125 0.025244 0.125 0.025244 1 

0.1875 0.023599 0.1875 0.023599 1 
0.25 0.021803 0.25 0.021803 1 

0.3125 0.020017 0.3125 0.020017 1 
0.375 0.018317 0.375 0.018317 1 

0.4375 0.01673 0.4375 0.01673 1 
0.5 0.015266 0.5 0.015266 1 

0.5625 0.013922 0.5625 0.013922 1 
0.625 0.012693 0.625 0.012693 1 

0.6875 0.011571 0.6875 0.011571 1 
0.75 0.010547 0.75 0.010547 1 

0.8125 0.009613 0.8125 0.009613 1 
0.875 0.008761 0.875 0.008761 1 

0.9375 0.007985 0.9375 0.007985 1 
1 0.007278 1 0.007278 1 

1.0625 0.006633 1.0625 0.006633 1 
1.125 0.006045 1.125 0.006045 1 

1.1875 0.00551 1.1875 0.00551 1 
1.25 0.005021 1.25 0.005021 1 

1.3125 0.004576 1.3125 0.004576 1 
1.375 0.004171 1.375 0.004171 1 

1.4375 0.003801 1.4375 0.003801 1 
1.5 0.003465 1.5 0.003465 1 

1.5625 0.003158 1.5625 0.003158 1 
1.625 0.002878 1.625 0.002878 1 

1.6875 0.002623 1.6875 0.002623 1 
1.75 0.00239 1.75 0.00239 1 

1.8125 0.002179 1.8125 0.002179 1 
1.875 0.001986 1.875 0.001986 1 

1.9375 0.00181 1.9375 0.00181 1 
2 0.001649 2 0.001649 1 

2.0625 0.001503 2.0625 0.001503 1 
2.125 0.00137 2.125 0.00137 1 
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Documented in graph_non_leafy_h3.csv of 2/18/2020 7:43 AM 

CONCENTRATION: H-3, Fruit, grain, non-leafy 
vegetables 

CONCENTRATION: H-3, Fruit, grain, non-leafy 
vegetables 

HYDROGEN-3_test.ROF  02/17/2020  16:53  
Graphics.Asc 

Hydrogen-3.ROF  01/12/2020  18:07  
Graphics.Asc 

Year Value Year Value  
0 0.006495 0 0.006495 1 

0.0625 0.008745 0.0625 0.008745 1 
0.125 0.009377 0.125 0.009377 1 

0.1875 0.009246 0.1875 0.009246 1 
0.25 0.008775 0.25 0.008775 1 

0.3125 0.008171 0.3125 0.008171 1 
0.375 0.007533 0.375 0.007533 1 

0.4375 0.006908 0.4375 0.006908 1 
0.5 0.006318 0.5 0.006318 1 

0.5625 0.005768 0.5625 0.005768 1 
0.625 0.005263 0.625 0.005263 1 

0.6875 0.004799 0.6875 0.004799 1 
0.75 0.004375 0.75 0.004375 1 

0.8125 0.003988 0.8125 0.003988 1 
0.875 0.003635 0.875 0.003635 1 

0.9375 0.003313 0.9375 0.003313 1 
1 0.00302 1 0.00302 1 

1.0625 0.002752 1.0625 0.002752 1 
1.125 0.002508 1.125 0.002508 1 

1.1875 0.002286 1.1875 0.002286 1 
1.25 0.002084 1.25 0.002084 1 

1.3125 0.001899 1.3125 0.001899 1 
1.375 0.001731 1.375 0.001731 1 

1.4375 0.001577 1.4375 0.001577 1 
1.5 0.001438 1.5 0.001438 1 

1.5625 0.00131 1.5625 0.00131 1 
1.625 0.001194 1.625 0.001194 1 

1.6875 0.001088 1.6875 0.001088 1 
1.75 0.000992 1.75 0.000992 1 

1.8125 0.000904 1.8125 0.000904 1 
1.875 0.000824 1.875 0.000824 1 

1.9375 0.000751 1.9375 0.000751 1 
2 0.000684 2 0.000684 1 

2.0625 0.000624 2.0625 0.000624 1 
2.125 0.000568 2.125 0.000568 1 
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12.91 TEST CASE 054-006 TESTER’S REPORT 

Documented in graph_Milk_h3.csv of 2/18/2020 7:41 AM 

CONCENTRATION: H-3, Milk CONCENTRATION: H-3, Milk 
HYDROGEN-3_test.ROF  02/17/2020  16:53  
Graphics.Asc 

Hydrogen-3.ROF  01/12/2020  18:07  
Graphics.Asc 

Year Value Year Value  
0 0.002015 0 0.002015 1 

0.0625 0.002059 0.0625 0.002059 1 
0.125 0.001988 0.125 0.001988 1 

0.1875 0.001867 0.1875 0.001867 1 
0.25 0.001729 0.25 0.001729 1 

0.3125 0.00159 0.3125 0.00159 1 
0.375 0.001456 0.375 0.001456 1 

0.4375 0.00133 0.4375 0.00133 1 
0.5 0.001214 0.5 0.001214 1 

0.5625 0.001107 0.5625 0.001107 1 
0.625 0.001009 0.625 0.001009 1 

0.6875 0.00092 0.6875 0.00092 1 
0.75 0.000839 0.75 0.000839 1 

0.8125 0.000764 0.8125 0.000764 1 
0.875 0.000697 0.875 0.000697 1 

0.9375 0.000635 0.9375 0.000635 1 
1 0.000579 1 0.000579 1 

1.0625 0.000528 1.0625 0.000528 1 
1.125 0.000481 1.125 0.000481 1 

1.1875 0.000438 1.1875 0.000438 1 
1.25 0.000399 1.25 0.000399 1 

1.3125 0.000364 1.3125 0.000364 1 
1.375 0.000332 1.375 0.000332 1 

1.4375 0.000302 1.4375 0.000302 1 
1.5 0.000276 1.5 0.000276 1 

1.5625 0.000251 1.5625 0.000251 1 
1.625 0.000229 1.625 0.000229 1 

1.6875 0.000209 1.6875 0.000209 1 
1.75 0.00019 1.75 0.00019 1 

1.8125 0.000173 1.8125 0.000173 1 
1.875 0.000158 1.875 0.000158 1 

1.9375 0.000144 1.9375 0.000144 1 
2 0.000131 2 0.000131 1 

2.0625 0.00012 2.0625 0.00012 1 
2.125 0.000109 2.125 0.000109 1 
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Documented in graph_meat_h3.csv of 2/18/2020 7:42 AM 

CONCENTRATION: H-3, Meat CONCENTRATION: H-3, Meat 
HYDROGEN-3_test.ROF  02/17/2020  16:53  
Graphics.Asc 

Hydrogen-3.ROF  01/12/2020  18:07  
Graphics.Asc 

Year Value Year Value  
0 0.001814 0 0.001814 1 

0.0625 0.002167 0.0625 0.002167 1 
0.125 0.00223 0.125 0.00223 1 

0.1875 0.00216 0.1875 0.00216 1 
0.25 0.002032 0.25 0.002032 1 

0.3125 0.001883 0.3125 0.001883 1 
0.375 0.001732 0.375 0.001732 1 

0.4375 0.001586 0.4375 0.001586 1 
0.5 0.00145 0.5 0.00145 1 

0.5625 0.001323 0.5625 0.001323 1 
0.625 0.001207 0.625 0.001207 1 

0.6875 0.0011 0.6875 0.0011 1 
0.75 0.001003 0.75 0.001003 1 

0.8125 0.000914 0.8125 0.000914 1 
0.875 0.000833 0.875 0.000833 1 

0.9375 0.00076 0.9375 0.00076 1 
1 0.000692 1 0.000692 1 

1.0625 0.000631 1.0625 0.000631 1 
1.125 0.000575 1.125 0.000575 1 

1.1875 0.000524 1.1875 0.000524 1 
1.25 0.000478 1.25 0.000478 1 

1.3125 0.000435 1.3125 0.000435 1 
1.375 0.000397 1.375 0.000397 1 

1.4375 0.000362 1.4375 0.000362 1 
1.5 0.00033 1.5 0.00033 1 

1.5625 0.0003 1.5625 0.0003 1 
1.625 0.000274 1.625 0.000274 1 

1.6875 0.00025 1.6875 0.00025 1 
1.75 0.000227 1.75 0.000227 1 

1.8125 0.000207 1.8125 0.000207 1 
1.875 0.000189 1.875 0.000189 1 

1.9375 0.000172 1.9375 0.000172 1 
2 0.000157 2 0.000157 1 

2.0625 0.000143 2.0625 0.000143 1 
2.125 0.00013 2.125 0.00013 1 
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12.92 TEST CASE 111 TESTER’S REPORT 

Documented in Test Case 111-JJCheng.docx of 2/20/2020 8:23 AM 

Test Case – 111 – Tests Offsite Activated Metal Case I: new source term 

 

• Suggestions for  revising the test descriptions in the Test Cases document - 
  

Test Summary Test OFFSITE's new source term model: Case I - activated metal with 
uniform release for 1000 years 
 

Test Objective  Test features of OFFSITE new source term model to simulate uniform 
release for 1000 years after delay for 500 years  
 

Expected Results  Compare with NUREG/CR 7268, User’s Manual for RESRAD-OFFSITE 
Code Version 4.0, Vol. 1, App M, Figure M.3  

 

• Launched RESRAD-OFFSITE. Opened the input file, ACTIVATED METAL-500_1000 

CONSTANT.ROF, according to the instructions in the Test Cases document. The 

following screen shots show the inputs related to the modeling of source release -   
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• Ran the code. Viewed the deterministic graphic results. The total dose as a function of 

time (1st figure below) matches Figure M-3 of the NUREG/CR-7268 Vol. 1 report (2nd 

figure below).   

(Note: Appendix M of NUREG/CR-7268 Vol. 1, User’s Manual for RESRAD-OFFSITE Code 

Version 4, Vol. 1 – Methodology and Models Used in RESRAD-OFFSITE Code, discusses 

benchmarking the RESRAD-OFFSITE results with the results of DUST-MS, based on the 

release rates of radionuclide to infiltration water that leaves the contaminated zone, i.e., the waste 

disposal area. This test case used the same input file employed in the benchmarking. The match 

of the RESRAD-OFFSITE graphic dose results obtained in this testing to the one shown in 

Appendix M indicates that the radionuclide release rates to infiltration water that leaves the 

contaminated zone would also match and would agree well with those calculated by DUST-MS.)    
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12.93 TEST CASE 112 TESTER’S REPORT 

Documented in Test Case 112-JJCheng.docx of 2/20/2020 8:09 AM 

Test Case – 112 – Tests Offsite Activated Metal Case II: new source term 

 

• Suggestions for  revising the test descriptions in the Test Cases document - 
  

Test Summary Test OFFSITE's new source term model: Case II - activated metal with 
uniform release for 10,000 years 
 

Test Objective  Test features of OFFSITE new source term model to simulate uniform 
release for 10,000 years after delay for 1000 years  
 

Expected Results  Compare with NUREG/CR 7268, User’s Manual for RESRAD-OFFSITE 
Code Version 4.0, Vol. 1, App M, Figure M.13  
 

• Launched RESRAD-OFFSITE. Opened the input file, ACTIVATED METAL-

1000_10000 CONSTANT.ROF, according to the instructions in the Test Cases 

document. The following screen shots show the inputs related to the modeling of source 

release -   
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• Saved the inputs to a different file. Ran the code. Viewed the deterministic graphic 

results. The total dose as a function of time (1st figure below) matches Figure M-24 of the 

NUREG/CR-7268 Vol. 1 report (2nd figure below).   

(Note: Appendix M of NUREG/CR-7268 Vol. 1, User’s Manual for RESRAD-OFFSITE Code 

Version 4, Vol. 1 – Methodology and Models Used in RESRAD-OFFSITE Code, discusses 

benchmarking of the RESRAD-OFFSITE results with the results of DUST-MS, based on the 

release rates of radionuclide to infiltration water that leaves the contaminated zone, i.e., the waste 

disposal area. This test used the same input file employed in the benchmarking. The match of the 

RESRAD-OFFSITE graphic dose results obtained in this testing to the one shown in Appendix 
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M indicates that the radionuclide release rates to infiltration water that leaves the contaminated 

zone would also match and would agree well with those calculated by DUST-MS.)    
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12.94 TEST CASE 113 TESTER’S REPORT 

Documented in Test Case 113-JJCheng.docx of 2/20/2020 8:15 AM 

Test Case – 113 – Tests Offsite Activated Metal Case III: increasing corrosion rate 

 

• Suggestions for revising the test descriptions in the Test Cases document - 
  

Test Summary Test OFFSITE's new source term model: Case III - activated metal 
with increasing uniform release 
 

Test Objective  Test features of OFFSITE new source term model to simulate uniform 
release with an increasing release rate over time  
 

Expected Results  Compare with NUREG/CR 7268, User’s Manual for RESRAD-OFFSITE 
Code Version 4.0, Vol. 1, App M, Figure M.24  

 

• Launched RESRAD-OFFSITE. Opened the input file, ACTIVATED METAL-500_1000 

INCREASE.ROF, according to the instructions in the Test Cases document. The 

following screen shots show the inputs related to the modeling of source release -   
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• Saved the inputs to a different file. Ran the code. Viewed the deterministic graphic 

results. The total dose as a function of time (1st figure below) matches Figure M-24 of the 

NUREG/CR-7268 Vol. 1 report (2nd figure below).   

(Note: Appendix M of NUREG/CR-7268 Vol. 1, User’s Manual for RESRAD-OFFSITE Code 

Version 4, Vol. 1 – Methodology and Models Used in RESRAD-OFFSITE Code, discusses 

benchmarking of the RESRAD-OFFSITE results with the results of DUST-MS, based on the 

release rates of radionuclide to infiltration water that leaves the contaminated zone, i.e., the waste 

disposal area.  This test used the same input file employed in the benchmarking. The match of 

the RESRAD-OFFSITE graphic dose results obtained in this testing to the one shown in 

Appendix M indicates that the radionuclide release rates to infiltration water that leaves the 

contaminated zone would also match and would agree well with those calculated by DUST-MS.)    
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12.95 TEST CASE 114 TESTER’S REPORT 

Documented in Test Case 114-JJCheng.docx of 2/20/2020 8:19 AM 

Test Case – 114 – Tests Offsite Activated Metal Case IV: TRU Waste 

 

• Suggestions for  revising the test descriptions in the Test Cases document - 
  

Test Summary Test OFFSITE's new source term model: Case IV - TRU waste with 
equilibrium desorption release 
 

Test Objective  Test features of OFFSITE new source term model to simulate 
equilibrium desorption release with no retardation from the 
contaminated medium   
 

Expected Results  Compare with NUREG/CR 7268, User’s Manual for RESRAD-OFFSITE 
Code Version 4.0, Vol. 1, App M, Figure M.35  

 

• Launched RESRAD-OFFSITE. Opened the input file, OTHER WASTE-KD=0_500-

V2_DT2.ROF, according to the instructions in the Test Cases document. The following 

screen shots show the inputs related to the modeling of source release -   
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• Saved the inputs to a different file. Ran the code. Viewed the deterministic graphic 

results. The total dose as a function of time (1st figure below) matches Figure M-35 of the 

NUREG/CR-7268 Vol. 1 report (2nd figure below).   

(Note: Appendix M of NUREG/CR-7268 Vol. 1, User’s Manual for RESRAD-OFFSITE Code 

Version 4, Vol. 1 – Methodology and Models Used in RESRAD-OFFSITE Code, discusses 

benchmarking of the RESRAD-OFFSITE results with the results of DUST-MS, based on the 

release rates of radionuclide to infiltration water that leaves the contaminated zone, i.e., the waste 

disposal area. This test used the same input file employed in the benchmarking. The match of the 

RESRAD-OFFSITE graphic dose results obtained in this testing to the one shown in Appendix 
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M indicates that the radionuclide release rates to infiltration water that leaves the contaminated 

zone would also match and would agree well with those calculated by DUST-MS.)    
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12.96 TEST CASE 115 TESTER’S REPORT 

Documented in Test Case 115-JJCheng.docx of 2/20/2020 8:23 AM 

Test Case – 115 – Tests Offsite Activated Metal Case V: Grouted TRU Waste 

 

• Suggestions for  revising the test descriptions in the Test Cases document - 
  

Test Summary Test OFFSITE's new source term model: Case V - Grouted TRU waste 
with equilibrium desorption release 
 

Test Objective  Test features of OFFSITE new source term model to simulate 
equilibrium desorption release with retardation from the 
contaminated medium   
 

Expected Results  Compare with NUREG/CR 7268, User’s Manual for RESRAD-OFFSITE 
Code Version 4.0, Vol. 1, App M, Figure M.42  

 

• Launched RESRAD-OFFSITE. Opened the input file, OTHER WASTE-

KD=CEMENT_500_DT2-DUST-REVISED.ROF, according to the instructions in the 

Test Cases document. The following screen shots show the inputs related to the modeling 

of source release -   
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• Saved the inputs to a different file. Ran the code. Viewed the deterministic graphic 

results. The total dose as a function of time (1st figure below) matches Figure M-35 of the 

NUREG/CR-7268 Vol. 1 report (2nd figure below).   

(Note: Appendix M of NUREG/CR-7268 Vol. 1, User’s Manual for RESRAD-OFFSITE Code 

Version 4, Vol. 1 – Methodology and Models Used in RESRAD-OFFSITE Code, discusses 

benchmarking of the RESRAD-OFFSITE results with the results of DUST-MS, based on the 

release rates of radionuclide to infiltration water that leaves the contaminated zone, i.e., the waste 

disposal area. This test case used the same input file employed in the benchmarking. The match 

of the RESRAD-OFFSITE graphic dose results obtained in this testing to the one shown in 

Appendix M indicates that the radionuclide release rates to infiltration water that leaves the 

contaminated zone would also match and would agree well with those calculated by DUST-MS.)    
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12.97 TEST CASE 116 TESTER’S REPORT 

Documented in Test Case 116-JJCheng.docx of 2/20/2020 8:26 AM 

Test Case – 116 – Tests Offsite Activated Metal Case VI: Grouted TRU Waste 

 

• Suggestions for  revising the test descriptions in the Test Cases document - 
  

Test Summary Test OFFSITE's new source term model: Case VI - Grouted TRU waste 
with diffusion controlled release 
 

Test Objective  Test features of OFFSITE new source term model to simulate 
diffusion controlled release   
 

Expected Results  Compare with NUREG/CR 7268, User’s Manual for RESRAD-OFFSITE 
Code Version 4.0, Vol. 1, App M, Figure M.49  

 

• Launched RESRAD-OFFSITE. Opened the input file, OTHER WASTE-

KD=0_500_DT1-DIF-DUST-REVISED.ROF, according to the instructions in the Test 

Cases document. The following screen shots show the inputs related to the modeling of 

source release -   
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738 

 

• Saved the inputs to a different file. Ran the code. Viewed the deterministic graphic 

results. The total dose as a function of time (1st figure below) matches Figure M-49 of the 

NUREG/CR-7268 Vol. 1 report (2nd figure below).   

(Note: Appendix M of NUREG/CR-7268 Vol. 1, User’s Manual for RESRAD-OFFSITE Code 

Version 4, Vol. 1 – Methodology and Models Used in RESRAD-OFFSITE Code, discusses 

benchmarking of the RESRAD-OFFSITE results with the results of DUST-MS, based on the 

release rates of radionuclide to infiltration water that leaves the contaminated zone, i.e., the waste 

disposal area. This test case used the same input file employed in the benchmarking. The match 

of the RESRAD-OFFSITE graphic dose results obtained in this testing to the one shown in 

Appendix M indicates that the radionuclide release rates to infiltration water that leaves the 

contaminated zone would also match and would agree well with those calculated by DUST-MS.)    
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740 

12.98 TEST CASE 117 TESTER’S REPORT 

Documented in Test Case 117-JJCheng.docx of 2/20/2020 8:33 AM 

Test Case – 117 – Tests Offsite Activated Metal Case VI: Grouted TRU Waste with 

diffusion 

 

• Suggestions for  revising the test descriptions in the Test Cases document - 
  

Test Summary Test OFFSITE's new source term model: Case VII - Sealed sources 
with 1st order rate controlled release 
 

Test Objective  Test features of OFFSITE new source term model to simulate 1st 
order rate controlled release  
 

Expected Results  Compare with NUREG/CR 7268, User’s Manual for RESRAD-OFFSITE 
Code Version 4.0, Vol. 1, App M, Figure M.56  

 

• Launched RESRAD-OFFSITE. Opened the input file, SEALED SOURCES-TRENCH-

LEACH_300-800-V2.ROF, according to the instructions in the Test Cases document. 

The following screen shots show the inputs related to the modeling of source release -   
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• Saved the inputs to a different file. Ran the code. Viewed the deterministic graphic 

results. The total dose as a function of time (1st figure below) matches Figure M-49 of the 

NUREG/CR-7268 Vol. 1 report (2nd figure below).   

(Note: Appendix M of NUREG/CR-7268 Vol. 1, User’s Manual for RESRAD-OFFSITE Code 

Version 4, Vol. 1 – Methodology and Models Used in RESRAD-OFFSITE Code, discusses 

benchmarking of the RESRAD-OFFSITE results with the results of DUST-MS, based on the 

release rates of radionuclide to infiltration water that leaves the contaminated zone, i.e., the waste 

disposal area.  This test case used the same input file employed in the benchmarking. The match 

of the RESRAD-OFFSITE graphic dose results obtained in this testing to the one shown in 

Appendix M indicates that the radionuclide release rates to infiltration water that leaves the 

contaminated zone would also match.)    
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12.99 TEST CASE 118 TESTER’S REPORT 

Documented in Test Case 118-JJCheng.docx of 2/20/2020 8:35 AM 

Test Case – 118 – Tests Offsite Activated Metal Case VI: Grouted TRU Waste with 

solubility-controlled release 

 

• Suggestions for  revising the test descriptions in the Test Cases document - 
  

Test Summary Test OFFSITE's new source term model: Case VIII - Sealed sources 
with solubility controlled release 
 

Test Objective  Test features of OFFSITE new source term model to simulate 
solubility controlled release   
 

Expected Results  Compare with NUREG/CR 7268, User’s Manual for RESRAD-OFFSITE 
Code Version 4.0, Vol. 1, App M, Figure M.59  
 

• Launched RESRAD-OFFSITE. Opened the input file, SEALED SOURCES-TRENCH-

SOLUBILITY_300-800-V2.ROF, according to the instructions in the Test Cases 

document. The following screen shots show the inputs related to the modeling of source 

release -   
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• Saved the inputs to a different file. Ran the code. Viewed the deterministic graphic 

results. The total dose as a function of time (1st figure below) matches Figure M-59 of the 

NUREG/CR-7268 Vol. 1 report (2nd figure below).   

(Note: Appendix M of NUREG/CR-7268 Vol. 1, User’s Manual for RESRAD-OFFSITE Code 

Version 4, Vol. 1 – Methodology and Models Used in RESRAD-OFFSITE Code, discusses 

benchmarking of the RESRAD-OFFSITE results with the results of DUST-MS, based on the 

release rates of radionuclide to infiltration water that leaves the contaminated zone, i.e., the waste 

disposal area. This test case used the same input file employed in the benchmarking. The match 

of the RESRAD-OFFSITE graphic dose results obtained in this testing to the one shown in 

Appendix M indicates that the radionuclide release rates to infiltration water that leaves the 

contaminated zone would also match and would agree well with those calculated by DUST-MS.)    
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12.100 TEST CASE 401 TESTER’S REPORT 

Documented in Results-Test-401.docx of 2/18/2020 2:48 AM 

RESOFF-TEST-401 

Objective: Test offsite plant concentrations 

 

The following steps were taken for Test-401 

Step 1 Opened SR-90-COMPREHENSIVE.ROF 

Step 2 Saved as Test-401.ROF 

Step 3 Ran Test-401.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Selected different plant type Media Concentration 

Step 7 Compared different plant type concentrations with the values in Figure 1 -4 in the V&V 

report 

 

Result: Test Passes 

Plant concentrations for different plant types in V&V Report matched with Test-401 plant 

concentrations as shown in the following figures.  
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Figure Concentrations in Pasture and Silage Plant Type from V&V Report 

 

Figure Concentration in Pasture and Silage Plant Type from Test-401 

Practically no difference in V&V results for pasture and silage concentrations and Test 401 

results 
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Figure Concentration in Grain Plant Type from V&V Report 

 

Figure Concentration in Grain Plant Type from Test-401 

Practically no difference in V&V results for grain concentration and Test 401 results 
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Figure Concentration in Fruit, Grain, Non-leafy Vegetables Plant Type from V&V Report 

 

Figure Concentration in Fruit, Grain, Non-leafy Vegetables Plant Type from Test-401 

Practically no difference in V&V results for fruit, grain, non-leafy vegetable concentrations and 

Test 401 results 



 

752 

 

Figure Concentration in Leafy Vegetables Plant Type from V&V Report 

 

Figure Concentration in Leafy Vegetables Plant Type from Test-401 

Practically no difference in V&V results for leafy vegetable concentrations and Test 401 results  
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12.101 TEST CASE 402 TESTER’S REPORT 

Documented in Results-Test-402.docx of 2/17/2020 1:46 PM 

RESOFF-TEST-402 

Objective: Test offsite meat and milk concentrations 

 

The following steps were taken for Test-402 

Step 1 Opened SR-90-COMPREHENSIVE.ROF 

Step 2 Saved as Test-402.ROF 

Step 3 Ran Test-402.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Selected Meat Media Concentration 

Step 7 Compared meat concentration with the values in Figure 5 in the V&V report 

Step 8 Selected Milk Media Concentration 

Step 9 Compared milk concentration with the values in Figure 6 in the V&V report 

 

Result: Test Passes 

Meat and milk concentrations in V&V Report matched with Test-402 meat and milk 

concentration as shown in the following figures.  
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Figure Meat Concentration from V&V 

 

Figure Meat Concentration from Test-402 

Practically no difference in V&V results for meat concentration and Test 402 meat concentration 

results  
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Figure  Milk Concentration from V&V Report 

 

Figure Milk Concentration from Test-402 

Practically no difference in V&V results for milk concentration and Test 402 milk concentration 

results  
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12.102 TEST CASE 403 TESTER’S REPORT 

Documented in Results-Test-403.docx of 2/17/2020 1:39 PM 

RESOFF-TEST-403 

Objective: Test offsite aquatic food concentrations 

 

The following steps were taken for Test-403 

Step 1 Opened SR-90-COMPREHENSIVE.ROF 

Step 2 Saved as Test-403.ROF 

Step 3 Ran Test-403.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Selected Fish Media Concentration 

Step 7 Compared Fish concentration with the values in Figure 7 in the V&V report 

Step 8 Selected Crustacean Media Concentration 

Step 9 Compared crustacean concentration with the values in Figure 8 in the V&V report 

 

Result: Test Passes 

Aquatic food concentrations in V&V Report matched with Test-403 aquatic food concentrations 

as shown in the following figures.  
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Figure Fish Concentration from V&V Report 

 

Figure Fish Concentration from Test-403 

Practically no difference in V&V results for fish concentrations and Test 403 fish concentration 

results 
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Figure  Crustacean Concentration from V&V Report 

 

Figure Crustacean Concentration from Test-403 

Practically no difference in V&V results for crustacean concentrations and Test 403 crustacean 

concentration results  
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12.103 TEST CASE 404 TESTER’S REPORT 

Documented in Results-Test-404.docx of 2/17/2020 1:25 PM 

RESOFF-TEST-404 

Objective: Test offsite plant ingestion dose 

 

The following steps were taken for Test-404 

Step 1 Opened SR-90-COMPREHENSIVE.ROF 

Step 2 Saved as Test-404.ROF 

Step 3 Selected Set Pathways from the left Navigation Panel 

Step 4 Only kept Plant Ingestion pathway active 

Step 4 Saved File 

Step 5 Ran Test-404.ROF file 

Step 6 Viewed Deterministic Graphic 

Step 7 Compared summed pathway dose with the values in Figure 9 in the V&V report (Since 

only plant ingestion pathway was active summed pathways gave plant ingestion dose)  

 

Result: Test Passes 

Plant ingestion pathway dose in V&V Report matched with Test-404 plant ingestion pathway 

dose as shown in the following figures.  
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Figure Plant Ingestion Dose from V&V Report 

 

Figure Plant Ingestion Dose from Test-404 

Practically no difference in V&V results for plant ingestion dose and Test 404 plant ingestion 

dose results  
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12.104 TEST CASE 405 TESTER’S REPORT 

Documented in Results-Test-405.docx of 2/17/2020 1:32 PM 

RESOFF-TEST-405 

Objective: Test offsite meat and milk dose 

 

The following steps were taken for Test-405 

Step 1 Opened SR-90-COMPREHENSIVE.ROF 

Step 2 Saved as Test-405-meat.ROF 

Step 3 Selected Set Pathways from the left Navigation Panel 

Step 4 Only kept Meat Ingestion pathway active and Saved File 

Step 5 Ran Test-405-meat.ROF file 

Step 6 Viewed Deterministic Graphic 

Step 7 Compared summed pathway dose with the values in Figure 10 in the V&V report (Since 

only meat ingestion pathway was active summed pathways gave meat ingestion dose)  

Step 8 Opened SR-90-COMPREHENSIVE.ROF 

Step 9 Saved as Test-405-milk.ROF 

Step 10 Selected Set Pathways from the left Navigation Panel 

Step 11 Only kept Milk Ingestion pathway active 

Step 12 Saved File 

Step 13 Ran Test-405-milk.ROF file 

Step 14 Viewed Deterministic Graphic 

Step 15 Compared summed pathway dose with the values in Figure 11 in the V&V report (Since 

only milk ingestion pathway was active summed pathways gave milk ingestion dose)  

Result: Test Passes 

Meat and milk doses in V&V Report matched with Test-405 meat and milk doses as shown in 

the following figures.   
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Figure Meat Ingestion Dose from V&V Report 

 

Figure Meat Ingestion Dose from Test-405-Meat 

Practically no difference in V&V results for meat dose and Test 405 meat dose results 
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Figure Milk Ingestion Dose from V&V Report 

 

Figure Milk Ingestion Dose from Test-405-Milk 

Practically no difference in V&V results for milk dose and Test 405 milk dose results  
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12.105 TEST CASE 406 TESTER’S REPORT 

Documented in Results-Test-406.docx of 2/17/2020 1:18 PM 

RESOFF-TEST-406 

Objective: Test offsite aquatic pathway doses 

 

The following steps were taken for Test-406 

Step 1 Opened SR-90-COMPREHENSIVE.ROF 

Step 2 Saved as Test-406.ROF 

Step 3 Selected Set Pathways from the left Navigation Panel 

Step 4 Only kept Aquatic Foods pathway active 

Step 4 Saved File 

Step 5 Ran Test-406.ROF 

Step 6 Viewed Deterministic Graphic 

Step 7 Compared summed pathway dose with the values in Figure 12 in the V&V report (Since 

only aquatic foods pathway was active summed pathways gave aquatic foods dose)  

 

Result: Test Passes 

Aquatic pathway dose in V&V Report matched with Test-406 aquatic pathway dose as shown in 

the following figures.  
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Figure Aquatic Foods Ingestion Dose from V&V Report 

 

Figure Aquatic Foods Ingestion Dose from Test-406 

Practically no difference in V&V aquatic food ingestion dose results and Test 406 dose results  
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12.106 TEST CASE 407 TESTER’S REPORT 

Documented in Results-Test-407.docx of 2/17/2020 1:57 PM 

RESOFF-TEST-407 

Objective: Test offsite drinking water pathway doses 

 

The following steps were taken for Test-407 

Step 1 Opened SR-90-COMPREHENSIVE.ROF 

Step 2 Saved as Test-407.ROF 

Step 3 Selected Set Pathways from the left Navigation Panel 

Step 4 Only kept Drinking water pathway active 

Step 4 Saved File 

Step 5 Ran Test-407.ROF 

Step 6 Viewed Deterministic Graphic 

Step 7 Compared summed pathway dose with the values in Figure 13 in the V&V report (Since 

only drinking water pathway was active summed pathways gave drinking water dose)  

 

Result: Test Passes 

Drinking water pathway dose in V&V Report matched with Test-407 drinking pathway dose as 

shown in the following figures.  
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Figure Drinking Water Ingestion Dose from V&V Report 

 

Figure Drinking Water Ingestion Dose from Test-407 

Practically no difference in V&V drinking water dose results and Test 407 dose results  
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12.107 TEST CASE 411 TESTER’S REPORT 

Documented in Results-Test-411.docx of 2/17/2020 2:19 PM 

RESOFF-TEST-411 

Objective: Test offsite soil concentration in leafy vegetable agricultural field 

 

The following steps were taken for Test-411 

Step 1 Opened offsite-accumulation-test1.ROF 

Step 2 Saved as Test-411.ROF 

Step 3 Ran Test-411.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Compared surface soil concentration in leafy vegetable field with the values in Figure 1 in 

the V&V report (Verification of Accumulation at offsite location.docx) 

 

Result: Test Passes 

Surface soil concentration in leafy vegetable field in V&V Report matched with Test-411 soil 

concentration as shown in the following figures.  
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Figure Surface soil Concentration in Leafy Vegetable Field from V&V Report 

 

Figure Surface Soil Concentration in Leafy Vegetable Field from Test-411 

Practically no difference in V&V results for surface soil concentration in leafy vegetable field 

and Test 411 results 
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12.108 TEST CASE 412 TESTER’S REPORT 

Documented in Results-Test-412.docx of 2/17/2020 2:43 PM 

RESOFF-TEST-412 

Objective: Test offsite soil concentration in pasture agricultural field 

 

The following steps were taken for Test-412 

Step 1 Opened offsite-accumulation-test2.ROF 

Step 2 Saved as Test-412.ROF 

Step 3 Ran Test-412.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Compared surface soil concentration in pasture field with the values in Figure 2 in the 

V&V report (Verification of Accumulation at offsite location.docx) 

 

Result: Test Passes 

Surface soil concentration in pasture field in V&V Report matched with Test-412 soil 

concentration as shown in the following figures.  
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Figure 

Surface soil Concentration in Pasture Growing Field from V&V Report 

 

Figure Surface Soil Concentration in Pasture and Silage Field from Test-412 

Practically no difference in V&V results for surface soil concentration in pasture and silage field 

and Test 412 results  
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12.109 TEST CASE 413 TESTER’S REPORT 

Documented in Results-Test-413.docx of 2/17/2020 2:41 PM 

RESOFF-TEST-413 

Objective: Test offsite soil concentration in grain agricultural field 

 

The following steps were taken for Test-413 

Step 1 Opened offsite-accumulation-test3.ROF 

Step 2 Saved as Test-413.ROF 

Step 3 Ran Test-413.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Compared surface soil concentration in grain field with the values in Figure 3 in the V&V 

report (Verification of Accumulation at offsite location.docx) 

 

Result: Test Passes 

Surface soil concentration in grain field in V&V Report matched with Test-413 soil 

concentration as shown in the following figures.  
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Figure Surface soil Concentration in Grain Field from V&V Report 

 

Figure Surface Soil Concentration in Grain Field from Test-413 

Practically no difference in V&V results for surface soil concentration in livestock grain field 

and Test 413 results 
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12.110 TEST CASE 414 TESTER’S REPORT 

Documented in Results-Test-414.docx of 2/17/2020 3:05 PM 

RESOFF-TEST-414 

Objective: Test offsite soil concentration in non-leafy vegetable field 

 

The following steps were taken for Test-414 

Step 1 Opened offsite-accumulation-test4.ROF 

Step 2 Saved as Test-414.ROF 

Step 3 Ran Test-414.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Compared surface soil concentration in non-leafy vegetable field with the values in Figure 

4 in the V&V report (Verification of Accumulation at offsite location.docx) 

 

Result: Test Passes 

Surface soil concentration in non-leafy vegetable field in V&V Report matched with Test-414 

soil concentration as shown in the following figures.  
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Figure Surface soil Concentration in Non-leafy Field from V&V Report 

 

Figure Surface Soil Concentration in Non-leafy Field from Test-414 

Practically no difference in V&V results for surface soil concentration in non-leafy vegetable 

field and Test 414 results 
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12.111 TEST CASE 415 TESTER’S REPORT 

Documented in Results-Test-415.docx of 2/17/2020 3:04 PM 

RESOFF-TEST-415 

Objective: Test features of offsite soil concentration in non-leafy vegetable agricultural 

field contributed by erosion 

 

The following steps were taken for Test-415 

Step 1 Opened offsite-accumulation-test4-erosion-only.ROF 

Step 2 Saved as Test-415.ROF 

Step 3 Ran Test-415.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Compared surface soil concentration in non-leafy vegetable field with the values in Figure 

5 in the V&V report (Verification of Accumulation at offsite location.docx) 

 

Result: Test Passes 

Surface soil concentration in non-leafy vegetable field in V&V Report matched with Test-415 

soil concentration as shown in the following figures.  
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Figure Surface soil Concentration in Non-leafy Field from Erosion in V&V Report 

 

Figure Surface Soil Concentration in Non-leafy Field from Test-415 

Practically no difference in V&V results for surface soil concentration in non-leafy vegetable 

field from erosion and Test 415 results 
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12.112 TEST CASE 416 TESTER’S REPORT 

Documented in Results-Test-416.docx of 2/17/2020 6:39 PM 

RESOFF-TEST-416 

Objective: Test features of offsite soil concentration in non-leafy vegetable agricultural 

field contributed by air deposition 

 

The following steps were taken for Test-416 

Step 1 Opened offsite-accumulation-test4-air-dep-only.ROF 

Step 2 Saved as Test-416.ROF 

Step 3 Ran Test-416.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Compared surface soil concentration in non-leafy vegetable field with the values in Figure 

6 in the V&V report (Verification of Accumulation at offsite location.docx) 

 

Result: Test Passes 

Surface soil concentration in non-leafy vegetable field in V&V Report matched with Test-416 

soil concentration as shown in the following figures.  
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Figure Surface soil Concentration in Non-leafy Field from Air Particulate Deposition in 

V&V Report 

 

Figure Surface Soil Concentration in Non-leafy Field from Test-416 

Practically no difference in V&V results for surface soil concentration in non-leafy vegetable 

field from air deposition and Test 416 results  
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12.113 TEST CASE 417 TESTER’S REPORT 

Documented in Results-Test-417.docx of 2/17/2020 6:58 PM 

RESOFF-TEST-417 

Objective: Test features of offsite soil concentration in non-leafy vegetable agricultural 

field contributed by surface water irrigation 

 

The following steps were taken for Test-417 

Step 1 Opened offsite-accumulation-test4-irrigation-only.ROF 

Step 2 Saved as Test-417.ROF 

Step 3 Ran Test-417.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Compared surface soil concentration in non-leafy vegetable field with the values in Figure 

7 in the V&V report (Verification of Accumulation at offsite location.docx) 

 

Result: Test Passes 

Surface soil concentration in non-leafy vegetable field in V&V Report matched with Test-417 

soil concentration as shown in the following figures.  
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Figure Surface soil Concentration in Non-leafy Field from Irrigation in V&V Report 

 

Figure Surface Soil Concentration in Non-leafy Field from Test-417 

Practically no difference in V&V results for surface soil concentration in non-leafy vegetable 

field from irrigation and Test 417 results 

  



 

782 

12.114 TEST CASE 421 TESTER’S REPORT 

Documented in Results-Test-421.docx of 2/18/2020 3:12 AM 

RESOFF-TEST-421 

Objective: Test offsite air concentration by selecting Dispersion Model Coefficients from 

Briggs Rural Coefficients Based on Rural Windspeed Terrain 

 

The following steps were taken for Test-421 

Step 1 Opened Air Dispersion Run1.ROF 

Step 2 Saved as Test-421.ROF 

Step 3 Ran Test-421.ROF file 

Step 4 Opened CHIOVERQ.OUT file 

Step 5 Compared normalized air concentrations in different fields for Run 1 listed in last column 

of Table 2 of the V&V report (Verification of atmospheric transport model.docx) with values in 

CHIOVERQ.OUT file 

 

Result: Test Passes 

Normalized air concentrations in different fields in V&V Report for Run 1 in Table 2 matched 

with Test-421 normalized air concentrations as shown in the following screenshots.  
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Table 2 Comparison of RESRAD-OFFSITE Normalized Air Concentrations (s/m3) in V&V Report (with 

Plume Rise) with RESRAD-OFFSITE Version 4 

 Values from V&V Report Table 4-2  

  Spreadsheet 

Spreadsheet x directional 

frequency 

Previous 

OFFSITE 

OFFSITE 

Version 4 

Run 1 - Briggs rural dispersion coefficients, no dry or wet deposition  

Fruit grain non-leafy vegetable 

plot 1.12E-03 5.60E-05 5.68E-05 5.60E-05 

Leafy vegetables plot 1.70E-04 1.70E-05 1.69E-05 1.69E-05 

Pasture, silage growing area 2.55E-05 6.38E-06 6.39E-06 6.38E-06 

Grain Field 6.14E-06 1.23E-06 1.23E-06 1.23E-06 

Dwelling site 5.22E-07 2.09E-07 2.09E-07 2.09E-07 

Run 2 - Pasquill-Gifford dispersion coefficient with dry deposition, no wet deposition 

Fruit grain non-leafy vegetable 

plot 1.54E-03 7.69E-05 7.81E-05 7.69E-05 

Leafy vegetables plot 2.00E-04 2.00E-05 1.99E-05 1.98E-05 

Pasture, silage growing area 3.12E-05 7.79E-06 7.80E-06 7.79E-06 

Grain Field 7.26E-06 1.45E-06 1.45E-06 1.45E-06 

Dwelling site 4.34E-07 1.74E-07 1.74E-07 1.74E-07 

Run 3 - Pasquill-Gifford dispersion coefficient with dry deposition and wet deposition 

Fruit grain non-leafy vegetable 

plot 1.51E-03 7.56E-05 7.68E-05 7.56E-05 

Leafy vegetables plot 1.98E-04 1.98E-05 1.97E-05 1.96E-05 

Pasture, silage growing area 3.08E-05 7.71E-06 7.71E-06 7.70E-06 

Grain Field 7.02E-06 1.40E-06 1.40E-06 1.40E-06 

Dwelling site 4.27E-07 1.71E-07 1.71E-07 1.72E-07 

Note: The spreadsheet calculations do not include the directional wind frequency. 

 

  



 

784 

 

Look normalized air concentrations in CHIOVERQ.OUT file on the left side of the screenshot 

(Note: IAGRI #1 represents non-leafy vegetable plot, IAGRI #2 represents leafy vegetable plot, 

IAGRI #3 represents pasture silage growing area, and IAGRI #4 represents grain field) 
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12.115 TEST CASE 422 TESTER’S REPORT 

Documented in Results-Test-422.docx of 2/18/2020 6:04 AM 

RESOFF-TEST-422 

Objective: Test offsite air concentration by selecting Dispersion Model Coefficients from 

Pasquill Gifford Coefficients Based on Rural Windspeed Terrain with Release heat flux of 

90 cal/s and with only dry deposition 

 

The following steps were taken for Test-422 

Step 1 Opened Air Dispersion Run2.ROF 

Step 2 Saved as Test-422.ROF 

Step 3 Ran Test-422.ROF file 

Step 4 Opened CHIOVERQ.OUT file 

Step 5 Compared normalized air concentrations in different fields for Run 2 listed in last column 

of Table 2 of the V&V report (Verification of atmospheric transport model.docx) with values in 

CHIOVERQ.OUT file 

 

Result: Test Passes 

Normalized air concentrations in different fields in V&V Report for Run 2 in Table 2 matched 

with Test-422 normalized air concentrations as shown in the following screenshots.  
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Table 2 Comparison of RESRAD-OFFSITE Normalized Air Concentrations (s/m3) in V&V Report (with 

Plume Rise) with RESRAD-OFFSITE Version 4 

 Values from V&V Report Table 4-2  

  Spreadsheet 

Spreadsheet x directional 

frequency 

Previous 

OFFSITE 

OFFSITE 

Version 4 

Run 1 - Briggs rural dispersion coefficients, no dry or wet deposition  

Fruit grain non-leafy vegetable 

plot 1.12E-03 5.60E-05 5.68E-05 5.60E-05 

Leafy vegetables plot 1.70E-04 1.70E-05 1.69E-05 1.69E-05 

Pasture, silage growing area 2.55E-05 6.38E-06 6.39E-06 6.38E-06 

Grain Field 6.14E-06 1.23E-06 1.23E-06 1.23E-06 

Dwelling site 5.22E-07 2.09E-07 2.09E-07 2.09E-07 

Run 2 - Pasquill-Gifford dispersion coefficient with dry deposition, no wet deposition 

Fruit grain non-leafy vegetable 

plot 1.54E-03 7.69E-05 7.81E-05 7.69E-05 

Leafy vegetables plot 2.00E-04 2.00E-05 1.99E-05 1.98E-05 

Pasture, silage growing area 3.12E-05 7.79E-06 7.80E-06 7.79E-06 

Grain Field 7.26E-06 1.45E-06 1.45E-06 1.45E-06 

Dwelling site 4.34E-07 1.74E-07 1.74E-07 1.74E-07 

Run 3 - Pasquill-Gifford dispersion coefficient with dry deposition and wet deposition 

Fruit grain non-leafy vegetable 

plot 1.51E-03 7.56E-05 7.68E-05 7.56E-05 

Leafy vegetables plot 1.98E-04 1.98E-05 1.97E-05 1.96E-05 

Pasture, silage growing area 3.08E-05 7.71E-06 7.71E-06 7.70E-06 

Grain Field 7.02E-06 1.40E-06 1.40E-06 1.40E-06 

Dwelling site 4.27E-07 1.71E-07 1.71E-07 1.72E-07 

Note: The spreadsheet calculations do not include the directional wind frequency. 
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Look normalized air concentrations in CHIOVERQ.OUT file in the above screenshot (Note: 

IAGRI #1 represents non-leafy vegetable plot, IAGRI #2 represents leafy vegetable plot, IAGRI 

#3 represents pasture silage growing area, and IAGRI #4 represents grain field)  

The normalized air concentrations in Table 2 for run 2 matched with air concentrations in 

CHIOVERQ.OUT file. 
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12.116 TEST CASE 423 TESTER’S REPORT 

Documented in Results-Test-423.docx of 2/18/2020 6:03 AM 

RESOFF-TEST-423 

Objective: Test offsite air concentration by selecting Dispersion Model Coefficients from 

Pasquill-Gilford Coefficients Based on Rural Windspeed Terrain and Release heat flux of 

90 cal/s for Dry and Wet Deposition 

 

The following steps were taken for Test-423 

Step 1 Opened Air Dispersion Run3.ROF 

Step 2 Saved as Test-423.ROF 

Step 3 Ran Test-423.ROF file 

Step 4 Opened CHIOVERQ.OUT file 

Step 5 Compared normalized air concentrations in different fields for Run 3 listed in last column 

of Table 2 of the V&V report (Verification of atmospheric transport model.docx) with values in 

CHIOVERQ.OUT file 

 

Result: Test Passes 

Normalized air concentrations in different fields in V&V Report for Run 3 in Table 2 matched 

with Test-423 normalized air concentrations as shown in the following screenshots.  
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Table 2 Comparison of RESRAD-OFFSITE Normalized Air Concentrations (s/m3) in V&V Report (with 

Plume Rise) with RESRAD-OFFSITE Version 4 

 Values from V&V Report Table 4-2  

  Spreadsheet 

Spreadsheet x directional 

frequency 

Previous 

OFFSITE 

OFFSITE 

Version 4 

Run 1 - Briggs rural dispersion coefficients, no dry or wet deposition  

Fruit grain non-leafy vegetable 

plot 1.12E-03 5.60E-05 5.68E-05 5.60E-05 

Leafy vegetables plot 1.70E-04 1.70E-05 1.69E-05 1.69E-05 

Pasture, silage growing area 2.55E-05 6.38E-06 6.39E-06 6.38E-06 

Grain Field 6.14E-06 1.23E-06 1.23E-06 1.23E-06 

Dwelling site 5.22E-07 2.09E-07 2.09E-07 2.09E-07 

Run 2 - Pasquill-Gifford dispersion coefficient with dry deposition, no wet deposition 

Fruit grain non-leafy vegetable 

plot 1.54E-03 7.69E-05 7.81E-05 7.69E-05 

Leafy vegetables plot 2.00E-04 2.00E-05 1.99E-05 1.98E-05 

Pasture, silage growing area 3.12E-05 7.79E-06 7.80E-06 7.79E-06 

Grain Field 7.26E-06 1.45E-06 1.45E-06 1.45E-06 

Dwelling site 4.34E-07 1.74E-07 1.74E-07 1.74E-07 

Run 3 - Pasquill-Gifford dispersion coefficient with dry deposition and wet deposition 

Fruit grain non-leafy vegetable 

plot 1.51E-03 7.56E-05 7.68E-05 7.56E-05 

Leafy vegetables plot 1.98E-04 1.98E-05 1.97E-05 1.96E-05 

Pasture, silage growing area 3.08E-05 7.71E-06 7.71E-06 7.70E-06 

Grain Field 7.02E-06 1.40E-06 1.40E-06 1.40E-06 

Dwelling site 4.27E-07 1.71E-07 1.71E-07 1.72E-07 

Note: The spreadsheet calculations do not include the directional wind frequency. 
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Looked normalized air concentrations in CHIOVERQ.OUT file in the above screenshot (Note: 

IAGRI #1 represents non-leafy vegetable plot, IAGRI #2 represents leafy vegetable plot, IAGRI 

#3 represents pasture silage growing area, and IAGRI #4 represents grain field) 

The normalized air concentrations in Table 2 for run 3 matched with air concentrations in 

CHIOVERQ.OUT file. 
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12.117 TEST CASE 424 TESTER’S REPORT 

Documented in Results-Test-424.docx of 2/18/2020 3:44 AM 

RESOFF-TEST-424 

Objective: Test offsite air concentration by selecting Dispersion Model Coefficients from 

Pasquill-Gilford Coefficients Based on Rural Windspeed Terrain and Release heat flux of 

90 cal/s for Dry and Wet Deposition 

 

The following steps were taken for Test-424 

Step 1 Opened Air Dispersion Run4.ROF 

Step 2 Saved as Test-424.ROF 

Step 3 Ran Test-424.ROF file 

Step 4 Opened CHIOVERQ.OUT file 

Step 5 Compared normalized air concentrations in different fields for Run 4 listed in last column 

of Table 3 of the V&V report (Verification of atmospheric transport model.docx) with values in 

CHIOVERQ.OUT file 

 

Result: Test Passes 

Normalized air concentrations in different fields in V&V Report for Run 4 in Table 3 matched 

with Test-424 normalized air concentrations as shown in the following screenshots.  
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Table 3 Comparison of RESRAD-OFFSITE Normalized Air Concentrations (s/m3) in V&V Report 

(without Plume Rise) with Version 4  

 Values from V&V Report Table 4-3  

  Spreadsheet 

Spreadsheet x directional 

frequency 

Previous 

OFFSITE 

OFFSITE 

Version 4 

Run 4 - Pasquill-Gifford rural dispersion coefficients, no dry or wet deposition  

Fruit grain non-leafy 

vegetable plot 1.57E-03 7.86E-05 7.94E-05 7.86E-05 

Leafy vegetables plot 2.02E-04 2.02E-05 2.01E-05 2.00E-05 

Pasture, silage growing 

area 3.14E-05 7.86E-06 7.87E-06 7.86E-06 

Grain Field 7.34E-06 1.47E-06 1.47E-06 1.47E-06 

Dwelling site 4.52E-07 1.81E-07 1.81E-07 1.81E-07 

Run 5 - Pasquill-Gifford dispersion coefficient with dry deposition, no wet deposition  

Fruit grain non-leafy 

vegetable plot 1.55E-03 7.73E-05 7.81E-05 7.73E-05 

Leafy vegetables plot 2.01E-04 2.01E-05 1.99E-05 1.98E-05 

Pasture, silage growing 

area 3.12E-05 7.79E-06 7.80E-06 7.79E-06 

Grain Field 7.26E-06 1.45E-06 1.45E-06 1.45E-06 

Dwelling site 4.36E-07 1.74E-07 1.74E-07 1.74E-07 

Run 6 - Pasquill-Gifford dispersion coefficient with dry deposition and wet deposition  

Fruit grain non-leafy 

vegetable plot 1.52E-03 7.61E-05 7.68E-05 7.60E-05 

Leafy vegetables plot 1.98E-04 1.98E-05 1.97E-05 1.96E-05 

Pasture, silage growing 

area 3.08E-05 7.71E-06 7.72E-06 7.70E-06 

Grain Field 7.03E-06 1.41E-06 1.40E-06 1.40E-06 

Dwelling site 4.29E-07 1.72E-07 1.72E-07 1.72E-07 
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Looked normalized air concentrations in CHIOVERQ.OUT file in the above screenshot (Note: 

IAGRI #1 represents non-leafy vegetable plot, IAGRI #2 represents leafy vegetable plot, IAGRI 

#3 represents pasture silage growing area, and IAGRI #4 represents grain field) 

The normalized air concentrations in Table 3 for run 4 match with air concentrations in 

CHIOVERQ.OUT file. 
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12.118 TEST CASE 425 TESTER’S REPORT 

Documented in Results-Test-425.docx of 2/18/2020 3:52 AM 

RESOFF-TEST-425 

Objective: Test offsite air concentration by selecting Dispersion Model Coefficients from 

Pasquill-Gilford Coefficients Based on Rural Windspeed Terrain for Dry Deposition 

 

The following steps were taken for Test-425 

Step 1 Opened Air Dispersion Run5.ROF 

Step 2 Saved as Test-425.ROF 

Step 3 Ran Test-425.ROF file 

Step 4 Opened CHIOVERQ.OUT file 

Step 5 Compared normalized air concentrations in different fields for Run 5 listed in last column 

of Table 3 of the V&V report (Verification of atmospheric transport model.docx) with values in 

CHIOVERQ.OUT file 

 

Result: Test Passes 

Normalized air concentrations in different fields in V&V Report for Run 5 in Table 3 matched 

with Test-425 normalized air concentrations as shown in the following screenshots.  
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Table 3 Comparison of RESRAD-OFFSITE Normalized Air Concentrations (s/m3) in V&V Report 

(without Plume Rise) with Version 4  

 Values from V&V Report Table 4-3  

  Spreadsheet 

Spreadsheet x directional 

frequency 

Previous 

OFFSITE 

OFFSITE 

Version 4 

Run 4 - Pasquill-Gifford rural dispersion coefficients, no dry or wet deposition  

Fruit grain non-leafy 

vegetable plot 1.57E-03 7.86E-05 7.94E-05 7.86E-05 

Leafy vegetables plot 2.02E-04 2.02E-05 2.01E-05 2.00E-05 

Pasture, silage growing 

area 3.14E-05 7.86E-06 7.87E-06 7.86E-06 

Grain Field 7.34E-06 1.47E-06 1.47E-06 1.47E-06 

Dwelling site 4.52E-07 1.81E-07 1.81E-07 1.81E-07 

Run 5 - Pasquill-Gifford dispersion coefficient with dry deposition, no wet deposition  

Fruit grain non-leafy 

vegetable plot 1.55E-03 7.73E-05 7.81E-05 7.73E-05 

Leafy vegetables plot 2.01E-04 2.01E-05 1.99E-05 1.98E-05 

Pasture, silage growing 

area 3.12E-05 7.79E-06 7.80E-06 7.79E-06 

Grain Field 7.26E-06 1.45E-06 1.45E-06 1.45E-06 

Dwelling site 4.36E-07 1.74E-07 1.74E-07 1.74E-07 

Run 6 - Pasquill-Gifford dispersion coefficient with dry deposition and wet deposition  

Fruit grain non-leafy 

vegetable plot 1.52E-03 7.61E-05 7.68E-05 7.60E-05 

Leafy vegetables plot 1.98E-04 1.98E-05 1.97E-05 1.96E-05 

Pasture, silage growing 

area 3.08E-05 7.71E-06 7.72E-06 7.70E-06 

Grain Field 7.03E-06 1.41E-06 1.40E-06 1.40E-06 

Dwelling site 4.29E-07 1.72E-07 1.72E-07 1.72E-07 
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Looked normalized air concentrations in CHIOVERQ.OUT file in the above screenshot (Note: 

IAGRI #1 represents non-leafy vegetable plot, IAGRI #2 represents leafy vegetable plot, IAGRI 

#3 represents pasture silage growing area, and IAGRI #4 represents grain field) 

The normalized air concentrations in Table 3 for run 5 match with air concentrations in 

CHIOVERQ.OUT file. 
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12.119 TEST CASE 426 TESTER’S REPORT 

Documented in Results-Test-426.docx of 2/18/2020 3:57 AM 

RESOFF-TEST-426 

Objective: Test offsite air concentration by selecting Dispersion Model Coefficients from 

Pasquill-Gilford Coefficients Based on Rural Windspeed Terrain for Dry and Wet 

Deposition 

 

The following steps were taken for Test-426 

Step 1 Opened Air Dispersion Run6.ROF 

Step 2 Saved as Test-426.ROF 

Step 3 Ran Test-426.ROF file 

Step 4 Opened CHIOVERQ.OUT file 

Step 5 Compared normalized air concentrations in different fields for Run 6 listed in last column 

of Table 3 of the V&V report (Verification of atmospheric transport model.docx) with values in 

CHIOVERQ.OUT file 

 

Result: Test Passes 

Normalized air concentrations in different fields in V&V Report for Run 6 in Table 3 matched 

with Test-426 normalized air concentrations as shown in the following screenshots.  
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Table 3 Comparison of RESRAD-OFFSITE Normalized Air Concentrations (s/m3) in V&V Report 

(without Plume Rise) with Version 4  

 Values from V&V Report Table 4-3  

  Spreadsheet 

Spreadsheet x directional 

frequency 

Previous 

OFFSITE 

OFFSITE 

Version 4 

Run 4 - Pasquill-Gifford rural dispersion coefficients, no dry or wet deposition  

Fruit grain non-leafy 

vegetable plot 1.57E-03 7.86E-05 7.94E-05 7.86E-05 

Leafy vegetables plot 2.02E-04 2.02E-05 2.01E-05 2.00E-05 

Pasture, silage growing 

area 3.14E-05 7.86E-06 7.87E-06 7.86E-06 

Grain Field 7.34E-06 1.47E-06 1.47E-06 1.47E-06 

Dwelling site 4.52E-07 1.81E-07 1.81E-07 1.81E-07 

Run 5 - Pasquill-Gifford dispersion coefficient with dry deposition, no wet deposition  

Fruit grain non-leafy 

vegetable plot 1.55E-03 7.73E-05 7.81E-05 7.73E-05 

Leafy vegetables plot 2.01E-04 2.01E-05 1.99E-05 1.98E-05 

Pasture, silage growing 

area 3.12E-05 7.79E-06 7.80E-06 7.79E-06 

Grain Field 7.26E-06 1.45E-06 1.45E-06 1.45E-06 

Dwelling site 4.36E-07 1.74E-07 1.74E-07 1.74E-07 

Run 6 - Pasquill-Gifford dispersion coefficient with dry deposition and wet deposition  

Fruit grain non-leafy 

vegetable plot 1.52E-03 7.61E-05 7.68E-05 7.60E-05 

Leafy vegetables plot 1.98E-04 1.98E-05 1.97E-05 1.96E-05 

Pasture, silage growing 

area 3.08E-05 7.71E-06 7.72E-06 7.70E-06 

Grain Field 7.03E-06 1.41E-06 1.40E-06 1.40E-06 

Dwelling site 4.29E-07 1.72E-07 1.72E-07 1.72E-07 
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Looked normalized air concentrations in CHIOVERQ.OUT file in the above screenshot (Note: 

IAGRI #1 represents non-leafy vegetable plot, IAGRI #2 represents leafy vegetable plot, IAGRI 

#3 represents pasture silage growing area, and IAGRI #4 represents grain field) 

The normalized air concentrations in Table 3 for run 6 match with air concentrations in 

CHIOVERQ.OUT file. 
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12.120 TEST CASE 427 TESTER’S REPORT 

Documented in Results-Test-427.docx of 2/18/2020 4:05 AM 

RESOFF-TEST-427 

Objective: Test offsite air concentration by selecting Dispersion Model Coefficients from 

Pasquill-Gilford Coefficients Based on Rural Windspeed Terrain for Wet Deposition 

 

The following steps were taken for Test-427 

Step 1 Opened Air Dispersion Run7.ROF 

Step 2 Saved as Test-427.ROF 

Step 3 Ran Test-427.ROF file 

Step 4 Opened CHIOVERQ.OUT file 

Step 5 Compared normalized air concentrations in different fields for Run 7 listed in last column 

of Table 4 of the V&V report (Verification of atmospheric transport model.docx) with values in 

CHIOVERQ.OUT file 

 

Result: Test Passes 

Normalized air concentrations in different fields in V&V Report for Run 7 in Table 4 matched 

with Test-427 normalized air concentrations as shown in the following screenshots.  
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Table 4 Comparison of RESRAD-OFFSITE (Version 4) Normalized Air Concentration with New 

Spreadsheet Calculations 

  

New 

Spreadsheet 

Spreadsheet x 

directional 

frequency Version 4.0 

Run 1 - Briggs rural dispersion coefficients, no dry or wet deposition  

Fruit grain non-leafy vegetable plot 1.12E-03 5.60E-05 5.60E-05 

Leafy vegetables plot 1.69E-04 1.69E-05 1.69E-05 

Pasture, silage growing area 2.55E-05 6.38E-06 6.38E-06 

Grain Field 6.14E-06 1.23E-06 1.23E-06 

Dwelling site 5.21E-07 2.09E-07 2.09E-07 

Run 4 - Pasquill-Gifford rural dispersion coefficients, no dry or wet deposition  

Fruit grain non-leafy vegetable plot 1.57E-03 7.86E-05 7.86E-05 

Leafy vegetables plot 2.02E-04 2.02E-05 2.00E-05 

Pasture, silage growing area 3.14E-05 7.85E-06 7.86E-06 

Grain Field 7.34E-06 1.47E-06 1.47E-06 

Dwelling site 4.52E-07 1.81E-07 1.81E-07 

Run 7 - Pasquill-Gifford dispersion coefficient with wet deposition  

Fruit grain non-leafy vegetable plot 1.55E-03 7.73E-05 7.73E-05 

Leafy vegetables plot 2.00E-04 2.00E-05 1.98E-05 

Pasture, silage growing area 3.11E-05 7.77E-06 7.77E-06 

Grain Field 7.10E-06 1.42E-06 1.42E-06 

Dwelling site 4.45E-07 1.78E-07 1.78E-07 
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Looked normalized air concentrations in CHIOVERQ.OUT file in the above screenshot (Note: 

IAGRI #1 represents non-leafy vegetable plot, IAGRI #2 represents leafy vegetable plot, IAGRI 

#3 represents pasture silage growing area, and IAGRI #4 represents grain field) 

The normalized air concentrations in Table 4 for run 7 match with air concentrations in 

CHIOVERQ.OUT file. 
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12.121 TEST CASE 428 TESTER’S REPORT 

Documented in FW_ Test Case 428.msg of 2/26/2020 12:40 PM 

FW: Test Case 428 

LePoire, David J. Wed 2/26/2020 12:40 PM 

 

(Table copied from test spreadsheet because the tester’s email report could not be reformatted to 

fit on this page.) 

  

Test Case 428.msg of 2/20/2020 11:12 AM 

Test Case 428 

LePoire, David J. Thu 2/20/2020 11:06 AM 

  



 

804 

12.122 TEST CASE 431 TESTER’S REPORT 

Documented in Results-Test-431.docx of 2/18/2020 6:34 PM 

Objective: Test offsite surface water body accumulation with cover for Tc-99 

 

The following steps were taken for Test-431 

Step 1 Opened SURF-WATER-CHECK-TC99-TEST1.ROF 

Step 2 Saved as Test-431.ROF 

Step 3 Ran Test-431.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Compared surface water concentration with the values in Figure 1 in the V&V report 

(Verification of Surface Water Model.docx) 

 

Result: Test Passes 

Surface water concentration in V&V Report matched with Test-431 surface water concentration 

as shown in the following figures.  

  



 

805 

 

Figure Surface Water Concentration from V&V Report 

 

Figure Surface Water Concentration from Test-431 

Practically no difference in V&V results for surface water concentration and Test 431 results 
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12.123 TEST CASE 432 TESTER’S REPORT 

Documented in Results-Test-432.docx of 2/18/2020 6:34 PM 

RESOFF-TEST-432 

Objective: Test offsite surface water body accumulation without cover for Tc-99 

 

The following steps were taken for Test-432 

Step 1 Opened SURF-WATER-CHECK-TC99-TEST2.ROF 

Step 2 Saved as Test-432.ROF 

Step 3 Ran Test-432.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Compared surface water concentration with the values in Figure 2 in the V&V report 

(Verification of Surface Water Model.docx) 

 

Result: Test Passes 

Surface water concentration in V&V Report matched with Test-432 surface water concentration 

as shown in the following figures.  
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Figure Surface Water Concentration from V&V Report 

 

Figure Surface Water Concentration from Test-432 

Practically no difference in V&V results for surface water concentration and Test 432 results 
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12.124 TEST CASE 433 TESTER’S REPORT 

Documented in Results-Test-433.docx of 2/18/2020 6:22 PM 

RESOFF-TEST-433 

Objective: Test offsite surface water body accumulation with cover for U-234 

 

The following steps were taken for Test-433 

Step 1 Opened SURF-WATER-CHECK-U234-TEST1.ROF 

Step 2 Saved as Test-433.ROF 

Step 3 Ran Test-433.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Compared surface water concentration with the values in Figure 3 in the V&V report 

(Verification of Surface Water Model.docx) 

 

Result: Test Passes 

Surface water concentration in V&V Report matched with Test-433 surface water concentration 

as shown in the following figures.  
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Figure Surface Water Concentration from V&V Report 

 

Figure Surface Water Concentration from Test-433 

Practically no difference in V&V results for surface water concentration and Test 433 results 
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12.125 TEST CASE 434 TESTER’S REPORT 

Documented in Results-Test-434.docx of 2/18/2020 6:31 PM 

RESOFF-TEST-434 

Objective: Test offsite surface water body accumulation with no cover for U-234 

 

The following steps were taken for Test-434 

Step 1 Opened SURF-WATER-CHECK-U234-TEST2.ROF 

Step 2 Saved as Test-434.ROF 

Step 3 Ran Test-434.ROF file 

Step 4 Viewed Deterministic Graphic 

Step 5 Selected Concentration Plot Type 

Step 6 Compared surface water concentration with the values in Figure 4 in the V&V report 

(Verification of Surface Water Model.docx) 

 

Result: Test Passes 

Surface water concentration in V&V Report matched with Test-434 surface water concentration 

as shown in the following figures.  
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Figure Surface Water Concentration from V&V Report 

 

Figure Surface Water Concentration from Test-434 

Practically no difference in V&V results for surface water concentration and Test 434 results  
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12.126 TEST CASE 435 TESTER’S REPORT 

Documented in Results-Test-435.docx of 2/19/2020 7:33 AM 

RESOFF-TEST-435 

Objective: Test features of offsite’s release to air 

 

The following steps were taken for Test-435 

Step 1 Opened AIR RELEASE COMP CASE1.ROF 

Step 2 Saved as Test-435-1.ROF 

Step 3 Ran Test-435-1.ROF file 

Step 4 Opened AIFLUXIN.DAT file from the main RESRAD-OFFSITE directory 

Step 5 Saved as AIFLUXIN-Test435-1.DAT 

Step 6 Compared with AIFLUXIN-case1.DAT file in the V&V\Air release folder  

Step 7 Opened AIR RELEASE COMP CASE2.ROF 

Step 8 Saved as Test-435-2.ROF 

Step 9 Ran Test-435-2.ROF file 

Step 10 Opened AIFLUXIN.DAT file from the main RESRAD-OFFSITE directory 

Step 11 Saved as AIFLUXIN-Test435-2.DAT 

Step 12 Compared with AIFLUXIN-case2.DAT file in the V&V\Air release folder  

Step 13 Saved AIFLUXIN-Test435-1.DAT and AIFLUXIN-Test435-2.DAT in the results folder 

Step 14 Saved Test435-1-FC and Test435-2-FC in the results folder 

 

Result: Test Passes 

Offsite release to air in V&V Report matched with Test-435 air release. 
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12.127 TEST CASE 436 TESTER’S REPORT 

Documented in Results-Test-436.docx of 2/19/2020 7:33 AM 

RESOFF-TEST-436 

Objective: Test features of offsite’s release to erosion 

 

The following steps were taken for Test-436 

Step 1 Opened EROSION RELEASE COMP CASE1.ROF 

Step 2 Saved as Test-436-1.ROF 

Step 3 Ran Test-436-1.ROF file 

Step 4 Opened SWFLUXIN.DAT file from the main RESRAD-OFFSITE directory 

Step 5 Saved as SWFLUXIN-Test436-1.DAT 

Step 6 Compared with SWFLUXIN-case1.DAT file in the V&V\Erosion release folder  

Step 7 Opened EROSION RELEASE COMP CASE2.ROF 

Step 8 Saved as Test-436-2.ROF 

Step 9 Ran Test-436-2.ROF file 

Step 10 Opened SWFLUXIN.DAT file from the main RESRAD-OFFSITE directory 

Step 11 Saved as SWFLUXIN-Test436-2.DAT 

Step 12 Compared with SWFLUXIN-case2.DAT file in the V&V\Erosion release folder  

Step 13 Saved SWFLUXIN-Test436-1.DAT and SWFLUXIN-Test436-2.DAT in the results 

folder 

Step 14 Saved Test436-1-FC and Test436-2-FC in the results folder 

 

Result: Test Passes 

Offsite release to erosion in V&V Report matched with Test-436 erosion release. 
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12.128 TEST CASE 437 TESTER’S REPORT 

Documented in Results-Test-437.docx of 2/19/2020 8:23 AM 

RESOFF-TEST-437 

Objective: Test features of offsite’s external radiation model 

 

The following steps were taken for Test-437 

Step 1 Opened External-1.ROF 

Step 2 Saved as Test-437-1.ROF 

Step 3 Ran Test-437-1.ROF file 

Step 4 Opened Summary report from the main RESRAD-OFFSITE directory 

Step 5 Noted external pathway dose for different radionuclides from page 44 

Step 6 Compared with Yearly dose (code) column for source area 1000000 m2 results in Table 1 

of the report Verification of External Model and External Exposure Pathway Dose.docx file in 

the V&V\External-Pathway folder  

Step 7 Opened External-2.ROF 

Step 8 Saved as Test-437-2.ROF 

Step 9 Ran Test-437-2.ROF file 

Step 10 Opened Summary report from the main RESRAD-OFFSITE directory 

Step 11 Noted external pathway dose for different radionuclides from page 44 

Step 12 Compared with Yearly dose (code) column for source area 100 m2 results in Table 1 of 

the report Verification of External Model and External Exposure Pathway Dose.docx file in the 

V&V\External-Pathway folder  

Step 13 Saved Summary-Test437-1.rep and Summary-Test437-2.rep in the results folder 

 

Result: Test Passes 

External pathway dose in V&V Report for two test cases matched with Test-437 results as 

shown below. 
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Table 1 Comparison of External Exposure Pathway Dose for On-site Receptor 

        
Source area = 1000000 m2, thickness = 
50 cm Source radius = 100 m2, thickness = 5 cm 

Radionu
clide Half-life, yr 

decay 
constant 
(/yr) 

Yearly 
average 
concentrati
on, pCi/g 

Yearly dose 
(Code), 
mrem/yr 

Calculated, 
mrem/yr 

ANL/EAD
/TM-84, 
mrem/yr 

Yearly dose 
(Code), 
mrem/yr 

Calculated, 
mrem/yr 

ANL/EAD/T
M-84, 
mrem/yr 

Al-26 7.16E+05 9.68E-07 1.00E+00 1.73E+01 1.73E+01 1.73E+01 5.82E+00 5.92E+00 5.92E+00 

Co-57 7.42E-01 9.35E-01 6.50E-01 3.31E-01 3.26E-01 5.01E-01 1.87E-01 1.84E-01 2.83E-01 

Co-60 5.27E+00 1.32E-01 9.37E-01 1.51E+01 1.52E+01 1.62E+01 5.20E+00 5.20E+00 5.55E+00 

Cs-137 3.00E+01 2.31E-02 9.89E-01 3.37E+00 3.37E+00 3.41E+00 1.32E+00 1.31E+00 1.33E+00 

Mn-54 8.56E-01 8.10E-01 6.85E-01 3.57E+00 3.54E+00 5.16E+00 1.34E+00 1.32E+00 1.93E+00 

U-234 2.45E+05 2.83E-06 1.00E+00 4.01E-04 4.02E-04 4.02E-04 2.71E-04 2.86E-04 2.86E-04 

U-235 7.04E+08 9.85E-10 1.00E+00 7.57E-01 7.57E-01 7.57E-01 3.90E-01 3.85E-01 3.85E-01 

Note: Used high Kd in contaminated zone (atleast 1,000 cm3/g), very less erosion (support practice factor = 0.001) 

The code results are taken from the summary report (page 44) at time zero after the run. 

The dose results in ANL/EAD/TM-84 are at time zero for instantaneous dose (do not account for yearly average) 

The calculated results correct ANL/EAD/TM-84 results for yearly average dose 

Summary Report Results for Test437-1 

Results match with the Yearly dose (code) column for source area 1000000 m2 results in Table 1 

of the report (highlighted in yellow) 
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Report Results for Test437-2 

Results match with the Yearly dose (code) column for source area 100 m2 results in Table 1 of 

the report (highlighted in green) 
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12.129 TEST CASE 438 TESTER’S REPORT 

Documented in Results-Test-438.docx of 2/19/2020 9:09 AM 

RESOFF-TEST-438 

Objective: Test features of OFFSITE’s external radiation model 

 

The following steps were taken for Test-438 

Step 1 Opened EXTERNAL-3.ROF 

Step 2 Saved as Test-438-1.ROF 

Step 3 Ran Test-438-1.ROF file 

Step 4 Noted only external exposure pathway is active and receptor is located 100% time in 

Pasture-Silage Field 

Step 5 Viewed Deterministic Graphic 

Step 6 Selected Individual Radionuclide Dose Plot Type 

Step 7 Compared dose results with the values in Figure 1 and 2 in the V&V report (Verification 

of External Model and external pathway.docx) 

Step 8 Opened EXTERNAL-4.ROF 

Step 9 Saved as Test-438-2.ROF 

Step 10 Ran Test-438-2.ROF file 

Step 11 Noted only external exposure pathway is active and receptor is located 100% time in 

Non-leafy Vegetable Field 

Step 12 Viewed Deterministic Graphic 

Step 13 Selected Individual Radionuclide Dose Plot Type 

Step 14 Compared dose results with the values in Figure 3 and 4 in the V&V report (Verification 

of External Model and external pathway.docx) 

 

Result: Test Passes 
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External pathway doses in V&V Report matched with Test-438 external dose results as shown in 

the following figures.  

 

Figure External Dose from Al-26 Contamination in Pasture Silage Field from V&V Report 

 

Figure External Dose from Al-26 Contamination in Pasture Silage Field from Test438-1 
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Figure External Dose from Cs-137 Contamination in Pasture Silage Field from V&V 

Report 

 

Figure External Dose from Cs-137 Contamination in Pasture Silage Field from Test438-1 
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Figure External Dose from Co-60 Contamination in Non-leafy Vegetable Field from V&V 

Report 

 

Figure External Dose from Co-60 Contamination in Non-leafy Vegetable Field from 

Test438-2 
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Figure External Dose from Mn-54 Contamination in Non-leafy Vegetable Field from V&V 

Report 

 

Figure External Dose from Mn-54 Contamination in Non-leafy Vegetable Field from 

Test438-2 

Practically no difference in V&V dose results for external exposure and Test 438 results  
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12.130 TEST CASE 439 TESTER’S REPORT 

Documented in Results-Test-439.docx of 2/19/2020 2:47 PM 

RESOFF-TEST-439 

Objective: Test features of OFFSITE’s particulate inhalation 

 

The following steps were taken for Test-439 

Step 1 Opened INHALATION-1.ROF 

Step 2 Saved as Test-439-1.ROF 

Step 3 Ran Test-439-1.ROF file 

Step 4 Noted only inhalation exposure pathway is active and receptor is located 100% time 

outside on primary contamination 

Step 5 Viewed Deterministic Graphic 

Step 6 Selected Individual Radionuclide Dose Plot Type 

Step 7 Compared dose results with the values in Figure 1 and 2 in the V&V report (Verification 

of particulate inhalation pathway dose.docx) 

Step 8 Opened INHALATION-2.ROF 

Step 9 Saved as Test-439-2.ROF 

Step 10 Ran Test-439-2.ROF file 

Step 11 Noted only inhalation exposure pathway is active and receptor is located 100% time 

inside on primary contamination 

Step 12 Viewed Deterministic Graphic 

Step 13 Selected Individual Radionuclide Dose Plot Type 

Step 14 Compared dose results with the values in Figure 3 and 4 in the V&V report (Verification 

of particulate inhalation pathway dose.docx) 

Step 15 Opened INHALATION-3.ROF 

Step 16 Saved as Test-439-3.ROF 

Step 17 Ran Test-439-3.ROF file 



 

823 

Step 18 Noted only inhalation exposure pathway is active and receptor is located 100% time 

outside on the Dwelling 

Step 19 Viewed Deterministic Graphic 

Step 20 Selected Individual Radionuclide Dose Plot Type 

Step 21 Compared dose results with the values in Figure 5 and 6 in the V&V report (Verification 

of particulate inhalation pathway dose.docx) 

Step 22 Opened INHALATION-4.ROF 

Step 23 Saved as Test-439-4.ROF 

Step 24 Ran Test-439-4.ROF file 

Step 25 Noted only inhalation exposure pathway is active and receptor is located 100% time 

inside on the Dwelling 

Step 26 Viewed Deterministic Graphic 

Step 27 Selected Individual Radionuclide Dose Plot Type 

Step 28 Compared dose results with the values in Figure 7 and 8 in the V&V report (Verification 

of particulate inhalation pathway dose.docx) 

 

Result: Test Passes 

Inhalation pathway doses in V&V Report matched with Test-439 inhalation dose results as 

shown in the following figures.  
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Figure Inhalation Dose from Al-26 Contamination outside on Primary Contamination from 

V&V Report 

Figure Inhalation Dose from Al-26 Contamination outside on Primary Contamination from 

Test439-1 
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Figure Inhalation Dose from Cs-137 Contamination Outside on Primary Contamination 

from V&V Report 

Figure Inhalation Dose from Cs-137 Contamination Outside on Primary Contamination 

from Test439-1 

0.00E+00

2.00E-05

4.00E-05

6.00E-05

8.00E-05

0 20 40 60 80 100 120

D
o

se
, m

re
m

/y
r

Time, yr

Comparison of Inhalation Dose from Cs-137 Contamination -
Case 1

(Receptor outside on primary contamination)

Yearly Average Inhalation Dose from the Code (mrem/yr)

Yearly Average Inhalation Dose Calculated (mrem/yr)



 

826 

 

Figure Inhalation Dose from Al-26 Contamination inside on Primary Contamination from 

V&V Report 

 Figure Inhalation Dose from Al-26 Contamination inside on Primary Contamination from 

Test439-2 
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Figure Inhalation Dose from Cs-137 Contamination inside on Primary Contamination 

from V&V Report 

Figure Inhalation Dose from Cs-137 Contamination inside on Primary Contamination 

from Test439-2 
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Figure Inhalation Dose from Al-26 Contamination outside on Dwelling from V&V Report 

Figure Inhalation Dose from Al-26 Contamination outside on Dwelling from Test439-3 
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Figure Inhalation Dose from Cs-137 Contamination outside on Dwelling from V&V Report 

 

Figure Inhalation Dose from Cs-137 Contamination outside on Dwelling from Test439-3 
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Figure Inhalation Dose from Al-26 Contamination inside on Dwelling from V&V Report 

Figure Inhalation Dose from Al-26 Contamination inside on Dwelling from Test439-4 

3.85E-06

3.86E-06

3.87E-06

3.88E-06

3.89E-06

3.90E-06

3.91E-06

3.92E-06

3.93E-06

0 20 40 60 80 100 120

D
o

se
, m

re
m

/y
r

Time, yr

Comparison of Inhalation Dose from Al-26 Contamination - Case 
4

(Receptor inside on the Dwelling)

Yearly Average Inhalation Dose from the Code (mrem/yr)

Yearly Average Inhalation Dose Calculated (mrem/yr)



 

831 

Figure Inhalation Dose from Cs-137 Contamination inside on Dwelling from V&V Report 

Figure Inhalation Dose from Cs-137 Contamination inside on Dwelling from Test439-4 

Practically no difference in V&V dose results for inhalation pathway and Test 439 results 
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12.131 TEST CASE 440 TESTER’S REPORT 

Documented in Results-Test-440.docx of 2/19/2020 2:44 PM 

RESOFF-TEST-440 

Objective: Test features of OFFSITE’s soil ingestion 

 

The following steps were taken for Test-440 

Step 1 Opened SOIL-INGESTION-1.ROF 

Step 2 Saved as Test-440-1.ROF 

Step 3 Ran Test-440-1.ROF file 

Step 4 Noted only SOIL INGESTION pathway is active and receptor is located 100% time 

outside on primary contamination 

Step 5 Viewed Deterministic Graphic 

Step 6 Selected Individual Radionuclide Dose Plot Type 

Step 7 Compared dose results with the values in Figure 1 and 2 in the V&V report (Verification 

of SOIL-INGESTION pathway dose.docx) 

Step 8 Opened SOIL-INGESTION-2.ROF 

Step 9 Saved as Test-440-2.ROF 

Step 10 Ran Test-440-2.ROF file 

Step 11 Noted only SOIL-INGESTION exposure pathway is active and receptor is located 100% 

time outside on primary contamination 

Step 12 Viewed Deterministic Graphic 

Step 13 Selected Individual Radionuclide Dose Plot Type 

Step 14 Compared dose results with the values in Figure 3 and 4 in the V&V report (Verification 

of particulate SOIL-INGESTION pathway dose.docx) 

Step 15 Opened SOIL-INGESTION-3.ROF 

Step 16 Saved as Test-440-3.ROF 

Step 17 Ran Test-440-3.ROF file 
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Step 18 Noted only SOIL-INGESTION exposure pathway is active and receptor is located 100% 

time outside on the Pasture and Silage field 

Step 19 Viewed Deterministic Graphic 

Step 20 Selected Individual Radionuclide Dose Plot Type 

Step 21 Compared dose results with the values in Figure 5 and 6 in the V&V report (Verification 

of particulate SOIL-INGESTION pathway dose.docx) 

Step 22 Opened SOIL-INGESTION-4.ROF 

Step 23 Saved as Test-440-4.ROF 

Step 24 Ran Test-440-4.ROF file 

Step 25 Noted only SOIL-INGESTION exposure pathway is active and receptor is located 100% 

time outside on the Non-Leafy Vegetable field 

Step 26 Viewed Deterministic Graphic 

Step 27 Selected Individual Radionuclide Dose Plot Type 

Step 28 Compared dose results with the values in Figure 7 and 8 in the V&V report (Verification 

of particulate SOIL-INGESTION pathway dose.docx) 

 

Result: Test Passes 

Soil ingestion pathway doses in V&V Report matched with Test-440 ingestion dose results as 

shown in the following figures.  
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Figure Soil Ingestion Dose from Al-26 Contamination outside on Primary Contamination 

from V&V Report 

 

Figure Soil Ingestion Dose from Al-26 Contamination outside on Primary Contamination 

from Test440-1 
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Figure Soil Ingestion Dose from Cs-137 Contamination Outside on Primary Contamination 

from V&V Report 

 

Figure Soil Ingestion Dose from Cs-137 Contamination Outside on Primary Contamination 

from Test440-1 
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Figure Soil Ingestion Dose from Al-26 Contamination outside on Primary Contamination 

from V&V Report 

 

Figure Soil Ingestion Dose from Al-26 Contamination outside on Primary Contamination 

from Test440-2 
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Figure Soil Ingestion Dose from Cs-137 Contamination outside on Primary Contamination 

from V&V Report 

 

Figure Soil Ingestion Dose from Cs-137 Contamination outside on Primary Contamination 

from Test440-2 
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Figure Soil Ingestion Dose from Al-26 Contamination outside on Pasture and Silage Field 

from V&V Report 

 

Figure Soil Ingestion Dose from Al-26 Contamination outside on Pasture and Silage Field 

from Test440-3 
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Figure Soil Ingestion Dose from Cs-137 Contamination outside on Pasture and Silage Field 

from V&V Report 

 

Figure Soil Ingestion Dose from Cs-137 Contamination outside on Pasture and Silage Field 

from Test440-3 
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Figure Soil Ingestion Dose from Co-60 Contamination outside on Non-leafy Vegetable Field 

from V&V Report 

 

Figure Soil Ingestion Dose from Co-60 Contamination outside on Non-leafy Vegetable Field 

from Test440-4 
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Figure Soil Ingestion Dose from Mn-54 Contamination outside on Non-Leafy Vegetable 

Field from V&V Report 

 

Figure Soil Ingestion Dose from Mn-54 Contamination outside on Non-Leafy Vegetable 

Field from Test440-4 

Practically no difference in V&V dose results for inhalation pathway and Test 440 results 
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12.132 TEST CASES 441 THROUGH 447 

The test reports for each of these 7 tests are spreadsheets comparing the candidate 

RESRAD-OFFSITE Version 4.0 output of the test run against the development RESRAD-

OFFSITE Version 4.0 output for one of the verification runs described in Section 3. Each of 

these spreadsheets has three tabs, the one tab has the output of the test (129 row and 17 columns 

of output), another has the output of the verification run with column headers added (131 rows 

and 17 columns), the third compares the data in the other two tabs, cell by cell, and shows that 

there is no difference between those two tabs. They are not in a format that can be easily 

incorporated into this report. They are a sub-set of the verification documented and illustrated in 

Section 3.  
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